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Feedback

Um Fehler zu berichten oder anderes Feedback zu geben, benutzen Sie bitte das englischsprachige GnuCash Bug-
Tracking System [https://bugs.gnucash.org/].

Für spezifisch deutsche Fehler oder Verbesserungsvorschläge (Übersetzung, Kontenrahmen, ...), benutzen
Sie bitte die deutsche GnuCash Email-Liste GnuCash-de [https://lists.gnucash.org/mailman/listinfo/gnucash-
de]. Tips zu ihrer Benutzung finden Sie in Feedback auf der Mailingliste [https://wiki.gnucash.org/wiki/De/
Feedback#Auf_der_Mailingliste].
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Kapitel 1. Einführung zu GnuCash
Wofür steht GnuCash?

GnuCash ist eine Finanzsoftware, die sich sowohl an den Bedürfnissen von Privatanwendern orientiert
als auch in Kleinbetrieben für deren Buchhaltung eingesetzt werden kann. Einfache Benutzerführung
ist hier vereinigt mit der konsequenten Umsetzung professioneller Prinzipien der Buchhaltung. In
GnuCash können Einnahmen und Ausgaben verfolgt werden. Kontoauszüge können abgeglichen und
Aktiendepots verwaltet werden. Und nicht zuletzt können mit GnuCash, wie oben bereits angedeutet,
Buchhaltungsaufgaben für Kleinbetriebe übernommen werden.
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Kapitel 2. Dieses Dokument verwenden
und Hilfe erhalten

Dieses Dokument ist in zwei Bereiche aufgeteilt:

• Von der grafischen Benutzeroberfläche (GUI), in der die verfügbaren Optionen und ihre Funktionen
erklärt werden, und Links zu weiterführenden Beschreibungen und Verwendung. Kapitel 4, GnuCash
Hauptfenster & Menüs

• Durch die Unterteilung in Vorgänge, Aufgaben oder Funktionen basierend darauf, ob es sich um ein
Konto, eine Buchung, eine Berichterstellung oder eine anders gelagerte Tätigkeit handelt. Beispiele
sind:

• Kontenaktionen - Kapitel 5, Konten anlegen, anpassen & benutzen

• Buchungs-/ Kontobuch Aktionen - Kapitel 6, Arbeiten mit Buchungen

• Werkzeuge und Assistenten - Kapitel 8, Tools & Assistants

• Berichte & Diagramme - Kapitel 9, Reports And Charts

• Benutzerdefinierte Anpassung - Kapitel 10, GnuCash anpassen

Hilfe aufrufen
Wenn GnuCash gestartet ist und diese Dokumentation installiert wurde 1 , wird dieses Fenster mit

• drücken der Taste F1 oder

• Auswahl aus dem Menü Hilfe → Inhalt geöffnet.

• Mit Hilfe → GnuCash-Kurs und Konzepte (Strg+H) wird der andere Teil dieser Dokumentation, das
Tutorial, geöffnet.

• In den meisten Dialogen führt die Hilfe Taste direkt zu der Seite, auf der der jeweilige Dialog
beschrieben wird.

Das komplette Hilfemenü wird in „Kontenübersicht - Hilfe-Menü“beschrieben.

Betriebssystem und Hilfeanzeigeprogramm

Abhängig von Ihrem Betriebssystem werden unterschiedliche Programme verwendet, um dieses
Hilfedokument anzuzeigen:

Linux Gnome Yelp
macOS Standard Webbrowser
Windows Windows-Hilfe

Beachten Sie die Handbücher des jeweiligen Betriebssystems zur Bedienung des verwendeten
Anzeigeprogramms.

1Ist in unseren Programmpaketen für FlatPak, macOS und Windows enthalten, aber unter Linux werden die gnucash-docs normalerweise als
zusätzliches Paket bereit gestellt.
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Dieses Dokument verwenden
und Hilfe erhalten

GnuCash Kurs und Konzepte
Das Gegenstück zu dieser Hilfe ist das Tutorial „Kurs und Konzepte“. Es erklärt die in GnuCash
verwendeten Konzepte und beinhaltet ein Lernprogramm das Sie durch die Verwendung von GnuCash
zur Verwaltung Ihrer Konten führt. Es wird angezeigt, wenn Sie Öffnen des neuen Benutzer-Tutorials in
dem Willkommen bei GnuCash! Menü wählen.

Um diese Anleitung manuell zu öffnen, gehen Sie zu Hilfe → GnuCash-Kurs und Konzepte oder betätigen
Sie Strg+H .

Wichtig

Es wird dringend empfohlen, dieses Handbuch zu lesen, wenn Sie mit der Nutzung von GnuCash
neu beginnen oder mit den Konzepten der Buchhaltung nicht vertraut sind.

GnuCash Wiki
Eine große Anzahl an weniger formeller, dafür aber oft aktuellerer Dokumentation, sowohl über GnuCash
selbst als auch über dessen Bedienung und Weiterentwicklung, wird von der Benutzergemeinschaft
im GnuCash Wiki [https://wiki.gnucash.org/wiki/De/] gesammelt; dort sollte die Seite Häufig
gestellten Fragen (FAQ) [https://wiki.gnucash.org/wiki/De/FAQ] die erste Anlaufstelle sein, wenn Sie
Schwierigkeiten bei der Bentzung von GnuCash haben.

Tipp

Sehr hilfreich ist auch die Suchseite [https://wiki.gnucash.org/wiki/Special:Search] oder die
Übersicht der Kategorien [https://wiki.gnucash.org/wiki/Special:Categories].

GnuCash Website
Die mehrsprachige GnuCash Website [https://www.gnucash.org/] enthält:

Ankündigungen von neuen Programmversionen oder zur Server-Wartung - meist nur auf
Englisch;

Downloads des Programms oder der Dokumentation in verschiedenen Varianten;
Links zum Einreichen von Fehlern oder Verbesserungsvorschlägen und mehr.

GnuCash Online Unterstützung

Mailing Liste

Eine weitere wichtige Quelle für die Unterstützung der Anwender ist die deutschsprachige User
Mailing List [mailto:gnucash-de@gnucash.org]. Sollten Sie eine andere Sprache bevorzugen, können
Sie unter wiki:user mailing lists [https://wiki.gnucash.org/wiki/Mailing_Lists#User_Lists] weitere
Maillisten finden. Die Seite enthält auch weiter nützliche Informationen wie z.B. Netiquette
[https://wiki.gnucash.org/wiki/Mailing_Lists#Netiquette] oder Mailing List Management [https://
wiki.gnucash.org/wiki/Mailing_Lists#Mailing_List_Management].

Für den Fall, dass Sie eher eine andere Form bevorzugen, gibt es 3rd party services, die einige der, meist
englisch sprachigen, Listen in andere Formate konvertieren:

Web Forum Nabble [http://gnucash.1415818.n4.nabble.com/GnuCash-
f1415818.subapps.html];
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Dieses Dokument verwenden
und Hilfe erhalten

NNTP News Feed Gmane [nntp://news.gmane.org/
gmane.comp.gnome.apps.gnucash.user].

Sie müssen sich jedoch registrieren [https://lists.gnucash.org/mailman/listinfo/gnucash-de] bevor Sie
einen Beitrag veröffentlichen können.

IRC

Einige der Entwickler und erfahrene Benutzer verfolgen den #gnucash-Kanal bei irc.gnome.org [irc://
irc.gnome.org/gnucash]. Sie sind meist auch mit etwas anderem beschäftigt und natürlich nicht immer an
ihrem Computer. Loggen Sie sich ein, stellen Sie Ihre Frage, und bleiben Sie eingeloggt; es kann einige
Stunden dauern, bis Ihre Frage bemerkt und beantwortet wird.

• Um zu sehen, ob Sie während Ihrer Abwesenheit etwas verpasst haben prüfen Sie die IRC-Protokolle
[https://lists.gnucash.org/logs/].

• Die Vorraussetzungen zur Nutzung, Netiquette und andere Details werden in der IRC wiki Seite [https://
wiki.gnucash.org/wiki/IRC] erläutert.
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Kapitel 3. Aller Anfang …
… mit GnuCash ist leicht!

Lassen Sie sich mit diesem Hilfedokument und dem Assistenten „Willkommen in GnuCash!“ schnell und
einfach in die Arbeit mit GnuCash einführen.

Willkommen in GnuCash!
Abbildung 3.1. Der „Willkommen in GnuCash!“-Dialog

Dieser Dialog soll Sie dabei unterstützen, dass Sie schnell mit Ihrer Arbeit in GnuCash beginnen können.
Er enthält die folgenden Steuerungselemente:

Neue Konten erstellen Startet den Assistenten „Neuen Kontenplan
einrichten“, der Ihnen dabei behilflich ist,
eine erste sinnvolle Struktur für Konten,
einen sogenannten Kontenplan, in GnuCash
anzulegen.

QIF-Dateien importieren Sind Sie bereits im Besitz von z.B.
Quicken-Dateien (.qif-Dateien) aus einem
anderen Finanzprogramm und möchten diese
importieren, dann entscheiden Sie sich für
diesen Punkt (siehe hierzu „Importieren von
QIF Dateien“).

Die Einführung für neue Benutzer öffnen Benutzen Sie GnuCash das erste Mal
und wollen sich vorerst nur über die
Möglichkeiten der Anwendung informieren
oder kennen sich noch nicht mit
doppelter Buchführung aus, so kann
die Lektüre von GnuCash Kurs und
Konzepte [https://code.gnucash.org/docs/de/
gnucash-guide] eine gute Wahl sein.
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Aller Anfang …

Ok Mit Ok wird die zuvor gewählte Aktion
gestartet.

Abbrechen Die Schaltfläche dient dazu, diesen
Eingabebildschirm zu verlassen. Es wird
dann wie folgt gefragt:

Abbildung 3.2. Soll das Begrüßungsfenster erneut angezeigt werden?

Nein Wenn Sie das Willkommen bei
GnuCash! Fenster nicht nochmal
sehen wollen klicken Sie diese
Schaltfläche.

Ja Klicken Sie diese Schaltfläche
oder drücken Sie Enter auf Ihrer
Tastatur damit der Willkommen
bei GnuCash! Bildschirm abermals
angezeigt wird.

Anmerkung

Nach Auswahl einer der
beiden oberen Antworten lässt
Sie GnuCash mit einem
minimalen GnuCash-Hauptfenster
alleine. Welche Möglichkeiten
Ihnen dann für Ihre weitere
Arbeit zur Verfügung stehen
wird in „GnuCash Hauptfenster“
beschrieben.
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Aller Anfang …

Abbildung 3.3. Minimales GnuCash Hauptfenster

Anmerkung

Es besteht auch die Möglichkeit, dass Sie sich später mit den anderen Auswahlmöglichkeiten
beschäftigen. In diesem Fall ist aber der Willkommen bei GnuCash!-Dialog dann nicht mehr
zugänglich. Um die anderen Auswahlmöglichkeiten zu testen, lesen Sie bitte in „Neuen
Kontenplan einrichten“, „Importieren von QIF Dateien“ sowie in GnuCash Kurs und Konzepte
[https://code.gnucash.org/docs/de/gnucash-guide] nach. Dort erfahren Sie, wie Sie diese aus dem
GnuCash-Menü heraus starten können.

Tipp des Tages
Das Fenster GnuCash Tipp des Tages öffnet sich immer dann, wenn Sie GnuCash starten, es sei denn,
er wurde in den GnuCash Einstellungen deaktiviert. Er gibt Tipps zu Funktionen und Verwendung von
GnuCash. Sie können die drei Schaltflächen am unteren Rand des Bildschirms verwenden, um sich die
einzelnen Tipps durchzulesen.
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Aller Anfang …

Abbildung 3.4. Der „Tipp des Tages“.

Vorheriger Zeigt den vorherigen Tipp an.

Nächster Geht zum nächsten Tipp weiter.

Schließen Verlässt diese Darstellung mit den hilfreichen Tipps des Tages.

Mit dem Kontrollkästchen Tipps beim Programmstart anzeigen können Sie festlegen, ob Sie einen Tipp
des Tages beim jedem Programmstart von GnuCash lesen wollen oder nicht.

Auf der Registerkarte Allgemein in den Bearbeiten → Einstellungen ist möglich, den Tipp des Tages wieder
zu aktivieren, falls Sie die Anzeige einmal abgestellt haben. Das Tipp des Tages- Fenster kann auch
manuell geöffnet werden, indem Sie im Menü Hilfe → Tipp des Tages auswählen.
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Kapitel 4. GnuCash Hauptfenster &
Menüs
GnuCash Hauptfenster und Menüpunkte

Abbildung 4.1. Die Bereiche des GnuCash-Hauptfensters

Die Bereiche, die zur Bedienung von GnuCash im Hauptfenster zur Verfügung stehen.

Das Hauptfenster von GnuCash zeigt die Konten, Berichte, Menüs und Werkzeuge, die Sie zur Bearbeitung
Ihrer Finanzdaten verwenden können. Dieser Abschnitt gibt Ihnen einen Überblick über die verschiedenen
Fenster und Fensterbereiche, die Sie in GnuCash vorfinden.

GnuCash Hauptfenster
Sie können auf häufig verwendete Unterfenster und Werkzeuge über dieses Fenster zugreifen.

Wenn Sie GnuCash starten, wird nach ein paar Fenstern (Begrüßungsbildschirm, Tipp des Tages) das
Hauptfenster angezeigt. Dieses Fenster ist in die folgenden Bereiche unterteilt (vergleiche Abbildung 4.1,
„Die Bereiche des GnuCash-Hauptfensters“ zur Information):

In diese Bereiche ist das Hauptfenster von GnuCash eingeteilt:

Titelleiste Zeigt den Namen der aktuell geöffneten Datei und
den Namen der aktiven Registerkarte an.

Menüleiste Enthält die Menüs für die Kontenübersicht. Der
Umfang der Menueinträge wird dynamisch an
den Inhalt des Anzeigebereichs angepasst. Das
bedeutet, wenn Sie z.B. ein Kontobuch geöffent
haben, dann wird für die Arbeit mit Buchungen ein
zusätzliches Menü eingeblendet.

Werkzeugleiste Enthält Schaltflächen (Knöpfe) für den Zugriff auf
typische kontextbezogene Funktionen.
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Tipp

Das gesamte Erscheinungsbild der
CSS [https://wiki.gnucash.org/wiki/CSS]
-basierten GnuCash-Oberfläche läßt sich
über die Konfiguration von GTK [https://
wiki.gnucash.org/wiki/GTK3] gestalten.
So läßt sich z.B. die Darstellung der
Werkzeugleiste (Größe der Symbole,
Abstand, Text unter dem Symbol uvm.)
mit Hilfe einer Konfigurationsdatei
anpassen. Wenn Sie also das Aussehen
von GnuCash konfigurieren wollen,
zeigen Ihnen diese, zuvor genannten
englischsprachigen, Seiten im Wiki wie
Sie dies bewerkstelligen können.

Registerleiste Enthält, ähnlich in einem „Notizbuch/
Aktenordner“, mehrere Registerkarten für die
Kontenübersicht, offene Kontobücher, Berichte,
uvm.

Anzeigebereich Der meiste Platz in GnuCash nimmt der
Anzeigebereich ein. Hier wird der Inhalt der
aktuell ausgewählten Registerkarte angezeigt

Zusammenfassungsleiste Enthält eine kurze Zusammenfassung Ihrer
Finanzdaten.

Statusleiste Enthält eine Beschreibung des aktiven
Menüpunkts und zeigt einen Fortschrittsbalken an.

Anmerkung

Die Inhalte und Optionen in den verschiedenen Untermenüs der einzelnen Bereiche des
Hauptfensters in GnuCash variieren je nach dem aktiven Anzeigefenster.

Die Kontenübersicht ist mit Konten auf dem Reiter der Registerleiste beschriftet und zeigt alle Ihre Konten
und deren Salden an, gruppiert gemäß der üblichen Buchhaltungspraxis.

Tipp

Um eine zusätzliche Ansicht der Kontenübersicht zu öffnen, gehen Sie auf Ansicht → Neue
Kontenübersicht . Dadurch wird eine weitere Kontenübersicht im bestehenden Fenster geöffnet.

Tipp

Um ein neues Fenster mit der Kontenübersicht zu öffnen, gehen Sie zu Fenster → Neues Fenster
mit Seite .
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GnuCash Hauptfenster & Menüs

Kontenübersicht
Abbildung 4.2. Die Anzeige der Kontenübersicht

Dies ist das Beispiel einer Kontenübersicht.

Anzeigebereich der Kontenübersicht
Die Kontenübersicht zeigt Ihren gegenwärtigen Kontenplan in einer Baumstruktur an. Dies ermöglicht,
dass Sie Ihre Konten nach Kontenarten organisieren können. Dies eröffnet Ihnen diese Möglichkeiten:

• Überblick bedeutet Vergleich von Basiskennzahlen wie etwa aktueller Saldo ohne Berichte starten zu
müssen.

• Verwalten von Konten wie z.B. Einfügen, ändern, neu ordnen.
• Navigation, also das schnelle Springen in ein Konto.
• Ein-/Ausblenden von Spalten mit unterschiedlichen Informationen zu den Konten.
• Ein/Ausblenden von Zeilen, also Konten, um die Kontenliste übersichtlich zu gestalten.

Tipp

Die Dreiecksform (oder das Pluszeichen) vor jedem Kontonamen , der kein Blatt bezeichnet, also
Unterkonten hat, dient zum Anzeigen oder Ausblenden (des Teilbaums) der Unterkonten. Wenn
Sie auf das Dreieck (Pluszeichen) klicken, ändert es sich von einem nach rechts zeigenden in ein
nach unten zeigendes Zeichen (Minuszeichen), um anzuzeigen, dass der Baum geöffnet ist. Sie
sehen dann versetzt unterhalb des Kontonamens entweder eine Liste der Unterkonten oder ein
weiteres Dreieck (Pluszeichen) links neben einem Konto. Dieses zeigt eine weitere untere Ebene
der Kontenübersicht an.

Im Hauptfenster werden außerdem standardmäßig vier Spalten angezeigt: Kontobezeichnung, Kontoart,
Beschreibung und Gesamt. Für jedes Konto werden diese Informationen, sofern vorhanden, in der
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gleichen Zeile des Kontos angezeigt. Wenn die Gesamtbreite der Spalten die Breite des Anzeigebereichs
überschreitet, erscheint, normalerweise am unteren Rand, ein Rollbalken um die Ansicht horizontal zu
verschieben.

Die Spalten, die für jedes Konto in der Kontenübersicht angezeigt werden, sowie die zeilenweise
Darstellung der Konten, können an Ihre Bedürfnisse angepasst werden. Siehe hierzu Tabelle 4.1, „Dialog
zur Anpassung der Kontenübersicht“

Die angezeigten Spalten in der Kontenübersicht lassen sich mit Betätigen des Spaltenselektors in der
Kontenübersicht, ganz rechts in der Reihe der Spaltenüberschriften, direkt neben dem Rollbalken,
auswählen.

Abbildung 4.3. Der Spaltenselektor

In der sich öffnenden Dropdown-Liste werden Ihnen eine Vielzahl an Spaltennamen angezeigt, die zur
Anzeige in der Kontenübersicht zur Verfügung stehen.
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Abbildung 4.4. Die Spaltenauswahl im Spaltenselektor

Die Spalte Kontobezeichnung kann nicht deaktiviert werden. Die momentan in der Kontenübersicht
aktiven Spalten werden in der Liste markiert angezeigt. Einige Spalten die zur Auswahl stehen, zeigen
die statischen Eigenschaften der Konten an und sind in „Neues Konto erstellen“ beschrieben. Daneben
stehen weitere Spalten zur Anzeige von dynamischen Inhalten zur Verfügung. Diese gibt es in zwei
unterschiedliche Ausprägungen.

1. Kontowährung —ohne Klammern– als nominelle Darstellung.
2. Buchwährung —in Klammern dahinter— um verschiedene Konten miteinander leichter vergleichen zu

können. Die Standardwährung wird in den GnuCash-Einstellungen unter „Konten“ angegeben.

Kontenübersichtsspalten

Letzte Nummer Die letzte vergebene Transaktionsnummer.
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Aktuell (CUR) Der letzte bekannte Kontostand, die übergeordneten Konten zeigen
die Summe ihrer Unterkonten an.

Saldo (CUR) Der Saldo der einzelnen Konten.

Bilanz (periodenbezogen) Die Summe der neuen Buchungen der einzelnen Konten. 1

Bestätigt (CUR) Die Summe der bestätigten Buchungen.2

Abgeglichen (CUR) Die Summe der abgeglichenen Buchungen. 2

Letztes Abgleich-Datum Datum des letzten Abgleichs des Kontos mit einem Kontoauszug.2

Zukünftiges Minimum (CUR) Der Kontostand inklusive zukünfitger Buchungen.

Summe Auf dem übergeordneten Konto wird die Summe der Unterkonten
angezeigt.

Gesamt (CUR) Auf dem übergeordneten Konto wird die Summe der Unterkonten
angezeigt.

Saldo (periodenbezogen) Enthält die Summe aller neuen Buchungen in dem Geschäftsjahr.1

Klicken Sie auf einen Eintrag, um die Spalte in die Kontenübersicht hinzuzufügen. Klicken Sie erneut auf
die Spaltenbeschreibung, um sie auszublenden.

Der Dialog Konten filtern nach… wird mit dem Menüpunkt Ansicht → Filter nach… geöffnet und
beeinflusst die Darstellung in den einzelnen geöffneten Fenstern der Kontenübersicht in der Art, dass die
Auswahl der darzustellenden Zeilen Ihren Anforderungen angepasst wird.

Tabelle 4.1. Dialog zur Anpassung der Kontenübersicht

Abbildung 4.5. Der Reiter „Kontoart“ Abbildung 4.6. Der Reiter „Weitere“

1In den GnuCash-Einstellung kann die ausgewählte (Buchführungs-)Periode unter „Buchführungsperioden“ angepasst werden.
2Das Vorgehen beim Abgleichen von Buchungen ist in „Konto mit einem Kontoauszug abgleichen“ beschrieben.
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Die Abbildungen zeigen die Grundeinstellung zur Filterung der Kontoarten

Kontoart Auf diesem Reiter wird Ihnen die Auswahl der Kontoarten, die angezeigt werden
sollen, ermöglicht. Sie besteht aus 2 Spalten: Links befinden sich die Kontoarten
wie in Tabelle 5.1, „Arten von GnuCash Konten.“ beschrieben, rechts Knöpfe zur
Vorauswahl:

Alle auswählen Aktiviert die Kontrollkästchen für alle
Kontoarten.

Keine auswählen Entfernt für alle Kontoarten die Markierung.

Voreinstellung Setzt die Auswahl wieder auf die
Voreinstellungen zurück was auch Alle
auswählen entspricht.

Weitere Der Reiter Weitere bietet Ihnen die Möglichkeit, einige spezielle Optionen
auszuwählen.

Versteckte Konten anzeigen Haben Sie einige
Konten als versteckt
gekennzeichnet, so
können Sie mit
diesem Kontrollkästchen
diese Konten in der
Kontenübersicht aus-
und einblenden, um dann
diese wieder sichtbar zu
machen.

Konten mit Saldo Null anzeigen Wenn dieses
Kontrollkästchen
ausgewählt ist, werden
auch die Konten
angezeigt, deren
Kontostand gleich Null
ist. Das Ausblenden kann
bei der Fehlersuche eine
kompaktere Übersicht
verschaffen.

Unbenutzte Konten anzeigen Wenn Sie in Ihrer
Kontenübersicht auch
Konten ohne Buchungen
sehen wollen, so nutzen
Sie diesen Eintrag. Das
Ausblenden kann bei
der Fehlersuche eine
kompaktere Übersicht
verschaffen.

Die Standardanzeige für die Kontenübersicht ist der Karteikartenmodus. Dies erkennen Sie an dem Reiter
auf der linken Seite des Hauptfensters. Wenn Sie Berichte oder weitere Kontenübersicht-Fenster öffnen,
erscheinen dort zusätzliche Reiter.

Menüleiste

Die Menüleiste für die Kontenübersicht enthält die nachfolgend aufgeführten Menüpunkte.
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Kontenübersicht - Datei-Menü

In der folgenden Tabelle werden die Möglichkeiten im Menü Datei beschrieben.

Durch Klicken auf den Menüpunkt Datei in der Menüleiste werden die Möglichkeiten angezeigt
die in Tabelle 4.2, „Kontenübersicht - Datei-Menü - Zugriff auf Datei- und Kontenoperation sowie
Druckfunktion“ beschrieben sind.

Tabelle 4.2. Kontenübersicht - Datei-Menü - Zugriff auf Datei- und
Kontenoperation sowie Druckfunktion

Menüpunkt Beschreibung

Neue Datei (Strg+N) Erzeugt eine neue Datei mit Hilfe des Assistenten Neuen
Kontenplan erstellen.

Öffnen… (Strg+O) Öffnet eine vorhandene GnuCash Datei.

Importieren → Öffnet das Untermenü Importieren um Daten
aus anderen Finanzprogrammen einzulesen.

Rechnungen importieren… Mit dem Assistenten Buchungen
aus Textdatei importieren
können Sie Kunden- oder
Lieferantenrechnungen aus einer
CSV-Datei importieren.

Konten importiern Startet den CSV Kontodatei-
Importprozess. Die zu
importierende Datei muss
dasselbe Format haben wie die
mit GnuCash exportierte Datei.

Buchungen importieren von
CSV…

Startet den Buchungsimport-
Assistent. Hiermit kann eine
CSV-Datei mit Buchungsdaten
importiert werden.

Kurse aus CSV-Datei
importieren…

Startet den Preis-Import-
Assistent. Hiermit können
Kurswerte aus einer CSV-Datei
importiert werden.

Kunden und Lieferanten
importieren …

Öffnet das Fenster Importiert
Kunden oder Lieferanten aus
Textdatei.

QIF-Datei importieren… Startet den QIF
Dateiimportprozess.

Einträge aus Logdatei
einspielen…

Startet das Zurückspielen
einer GnuCash Protokolldatei.
Wird verwendet zur
Datenwiederherstellung nach
"Abstürzen".

OFX/QFX importieren… Startet den OFX/QFX
Dateiimportprozess.
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Menüpunkt Beschreibung

MT940 importieren Importiert einen
Tagesendkontoauszug im SWIFT
MT940-Format in GnuCash.

MT942 importieren Importiert einen
Zwischenkontoauszug im SWIFT
MT942-Format in GnuCash.

DTAUS importieren Importiert eine herkömmliche
deutsche DTAUS-Datei in
GnuCash. a

DTAUS importieren und senden Import einer DTAUS-Datei in
GnuCash und Übermittlung der
Aufträge per Online Banking.a

Speichern (Strg+S) Speichert die aktuell geöffnete Datei.

Speichern unter…
(Umschalt+Strg+S)

Speichert die aktuell geöffnete Datei unter einem anderen Namen. b

Änderungen verwerfen Lädt die zuletzt gespeicherte Version der aktuell geöffneten Datei
neu. Nützlich, wenn Sie Änderungen verwerfen die an den Daten
vorgenommen und noch nicht gespeichert wurden.

Drucken… (Strg+P) Dieser Eintrag ist nur aktiv, wenn ein druckbares Element wie ein
Bericht oder eine Rechnung ausgewählt ist..

Seite einrichten…
(Umschalt+Strg+P)

Ermöglicht die Auswahl des Papierformats, der Seitenausrichtung
und der Ränder für den Druck.

Exportieren → Öffnet das Untermenü Export.

Kontenhierarchie nach CSV
exportieren…

Exportiert die Kontohierarchie
in eine durch Trennzeichen
abgegrenzte CSV-Datei. Es
werden keine Daten exportiert.

Buchungen nach CSV
exportieren…

Exportiert Buchungen in eine
durch Trennzeichen abgegrenzte
CSV-Datei.

Aktives Kontobuch als CSV-
Datei exportieren…

Exportiert das aktive Register in
eine CSV-Datei.

Konten exportieren Exportiert das aktive Konto in
eine Datei.

Eigenschaften (Alt+Eingabe) Legt Optionen für die GnuCash Datendatei fest.

Zuletzt geöffnete Dateien Nummerierte Liste der zuletzt geöffneten GnuCash Datendateien.

Schließen (Strg+W) Schließt die aktuelle Registerkarte.

Anmerkung

Für die erste Registerkarte ist dieser Eintrag nicht
verfügbar - er wird ausgegraut dargestellt.

Beenden (Strg+Q) Beendet GnuCash.
aDas DTAUS [https://de.wikipedia.org/wiki/DTAUS]-Verfahren wurde im Jahr 2016, also quasi mit der SEPA [https://
de.wikipedia.org/wiki/SEPA]-Einführung, offiziell eingestellt. Mit Hilfe dieses Menüpunkts besteht in GnuCash die Möglichkeit,
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die Aufträge aus älteren Drittprogrammen zu importieren und im Anschluss mittels FinTS [https://de.wikipedia.org/wiki/
Financial_Transaction_Services] zu versenden.
bBis zu GnuCash Version 2.6.21 sollten Sie aufpassen, dass Sie Ihre Datendatei NICHT in ~/.gnucash/books speichern.

Kontenübersicht - Bearbeiten-Menü

Tabelle 4.3. Kontenübersicht - Bearbeiten-Menü - Bearbeitungsfunktionen für
Dateien und Konten sowie Einstellungen

Menüpunkt Beschreibung

Ausschneiden (Strg+X) Führt eine gewöhnliche Ausschneiden-Operation
aus.

Kopieren (Strg+C) Führt eine gewöhnliche Kopieren-Operation aus.

Einfügen (Strg+V) Führt eine gewöhnliche Einfügen-Operation aus.

Konto bearbeiten (Strg+E) Ändert den Namen oder die Eigenschaften des
ausgewählten Kontos. „Konto bearbeiten“

Konto löschen (Entf) Löscht ein Konto. Siehe „Konto löschen“

Konto suchen (Strg+I) Öffnet den Assistenten Konto suchen. Hiermit
kann die Kontenstruktur durchsucht werden um
das gewünschte Konto zu öffnen.

Kontoeigenschaften übernehmen… Öffnet den Dialog Konto Eigenschaften
übertragen. Übernimmt die gewählten
Kontoeigenschaften in die untergeordneten
Konten.

Anmerkung

Dieser Punkt ist nur wählbar, wenn
Sie ein Konto mit mindestens einem
Unterkonto in der Kontenstruktur
markiert haben.

Unterkonten neu nummerieren… Startet den Assistenten Konto neu nummerieren.
Siehe „Neunummerierung der Unterkonten“.

Anmerkung

Dieser Punkt ist nur wählbar, wenn
Sie ein Konto mit mindestens einem
Unterkonto in der Kontenstruktur
markiert haben.

Konto öffnen Öffnet das Buchungsfenster für das aktuell
gewählte Konto.

Unterkonto öffnen Öffnet ein Registerfenster, das alle Buchungen
für das ausgewählte Konto und für alle seine
Unterkonten anzeigt.

Suchen… (Strg+F) Legt die Kriterien für eine Suche nach einer
bestimmten Buchung fest. Siehe „Find“ für Details
zur Suche.
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Menüpunkt Beschreibung

Einstellungen ( GnuCash → Einstellungen bei
macOS).

Anpassung von GnuCash hinsichtlich regionaler
Vorgaben, Stil und zahlreicher anderer
Einstellungen. Siehe „Benutzer Einstellungen“.

Stilvorlagen Ändern/Anpassen der Stilvorlagen für Berichte.
Siehe „Stilvorlagen organisieren“.

Optionen Steuerbericht Steuermerkmale (USt.)für Konto/ Konten
festlegen. Zuordnung von Steuerformular und
Zeilennummer zum Konto. Siehe „Setting Tax
Report Options“

Kontenübersicht - Ansicht-Menü

Tabelle 4.4. Kontenübersicht - Ansicht-Menü - Ändern der Ansicht der
Kontenübersicht.

Menüpunkt Beschreibung

Werkzeugleiste Kontrollkästchen zum Ein-/Ausblenden der
Werkzeugleiste.

Zusammenfassungsleiste Kontrollkästchen zum Ein-/Ausblenden der
Zusammenfassungsleiste.

Statusleiste Kontrollkästchen zum Ein-/Ausblenden der
Statusleiste.

Filtern nach… Filter für Konten einstellen, die in der
Kontenübersicht angezeigt werden.

Aktualisieren (Strg+R) Anzeige des Bildschirminhalts aktualisieren.

Neue Kontenübersicht Öffnet eine neue Registerkarte, die die
Kontenübersicht anzeigt.

Kontenübersicht - Aktionen-Menü

Tabelle 4.5. Kontenübersicht - Aktionen-Menü - Anlegen terminierter Buchungen,
Überprüfen von Konten, Durchführen von Aktienteilungen, Buchen und
Abgleichen von Geschäftsvorgängen

Menüpunkt Beschreibung

Online Aktionen → Untermenü Online Banking

Anmerkung

Dies wird nur angezeigt, wenn WITH_AQBANKING beim
Erstellen von GnuCash aktiviert wurde.

Wichtig

Die Menüeinträge werden erst nach dem vollständigen
Bearbeiten von Werkzeug → Onlinebanking Einrichtung…
aktiviert.
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Menüpunkt Beschreibung

Anmerkung

Nicht alle Optionen sind für alle Bankinstitute verfügbar.

Saldenabfrage… Fragt per Onlinebanking den
Kontossaldo für das ausgewählte
Konto ab.

Abfrage Kontoumsätze… Holt die Buchungen für das
ausgewählte Konto bei dem
Geldinstitut per Onlinebanking
ab.

Anmerkung

Das Senden von Aufträgen an die Bank ist nur für EBICS
und FinTS verfügbar.

SEPA Einzelüberweisung… Erstellt eine SEPA Überweisung
per Onlinebanking.

Interne Umbuchung… Erstellt eine bankinterne
Umbuchung per Online Banking.

SEPA Lastschriftmandat
erstellen…

Anmerkung

Mit der Umstellung
auf SEPA ist
dieser Menüeintrag
verschwunden, ist
aber mit Hilfe von
AqBanking weiterhin
möglich. Siehe https://
wiki.gnucash.org/wiki/
De/SEPA-Lastschrift.

Verlaufsfenster anzeigen Öffnet das Onlinebanking
Verbindungsfenster mit dem
Verlauf der letzten Sitzung.

Terminierte Buchungen → Untermenü Terminierte Buchungen

Terminierte Buchungen Editor… Ruft das Werkzeug zum
Bearbeiten von terminierten
Buchungen auf. Siehe
„Bearbeiten von terminierten
Buchungen“

Seit letztem Aufruf… Zeigt die terminierten Buchungen
seit der letzten Benutzung von
GnuCash. „Since Last Run
Assistant“

Hypothek & Darlehen
Assistent…

Startet den Hypotheken- &
Darlehen-Assistenten zum
Einrichten von Rückzahlungen.
„Mortgage & Loan Repayment
Assistant“

20

https://wiki.gnucash.org/wiki/De/SEPA-Lastschrift
https://wiki.gnucash.org/wiki/De/SEPA-Lastschrift
https://wiki.gnucash.org/wiki/De/SEPA-Lastschrift


GnuCash Hauptfenster & Menüs

Menüpunkt Beschreibung

Budget → Untermenü Budget

Neues Budget Erstellt ein neues Budget
und öffnet es in einer neuen
Registerkarte.

Budget öffnen Wenn kein Budget vorhanden
ist, wird ein neues Budget
erstellt und geöffnet. Falls nur
ein Budget vorhanden ist, wird
es geöffnet; andernfalls kann
ein Budget im Dialog Budget
auswählen zum Öffnen gewählt
werden.

Budget kopieren Wenn noch kein Budget
vorhanden sind, wird ein Neues
erstellt. Ist nur ein Budget
vorhanden, wird eine Kopie
davon erstellt; andernfalls kann
Eines zum Kopieren im Dialog
Budget auswählen ausgewählt
werden. Das Budget wird in einer
neuen Registerkarte geöffnet.

Budget löschen Wenn die aktive Registerkarte
eine Budgetansicht ist, dann
wird das geöffnete Budget
gelöscht. Andernfalls wird im
Dialog Budget auswählen eine
Auflistung vorhandener Budgets
zum Löschen angezeigt.

Neues Konto… Legt ein neues Konto an und öffnet das Fenster mit den
Kontoeigenschaften.

Kontenhierarchie hinzufügen… Startet den Neuen Kontenplan erstellen Assistent.

Buchen… (Strg+T) Startet den Buchungsassistenten für die Buchung zwischen Konten.

Abgleichen… Startet den Abgleichen-Assistenten für das ausgewählte Konto.
„Konto mit einem Kontoauszug abgleichen“

Automatisch abgleichen… Öffnet den Dialog automatischer Abgleich, in dem Sie die
Informationen für das automatische Abgleichen eingeben können.

Aktienteilung… Startet den Aktienteilungs-Assistenten. Zusätzliche Details
„Recording a Stock Split“

Posten anzeigen… Öffnet das Formular Posten im Konto .

Überprüfen → Untermenü Überprüfen

Konto überprüfen Überprüft das Konto auf nicht
abgeglichene Buchungen und
verwaiste Buchungsteile und
repariert diese.

Unterkonten überprüfen Überprüft das Konto inkusive
Unterkonten auf nicht
abgeglichene Buchungen und
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Menüpunkt Beschreibung

verwaiste Buchungsteile und
repariert diese.

Alle überprüfen Überprüft alle Konto auf nicht
abgeglichene Buchungen und
verwaiste Buchungsteile und
repariert diese.

Warnungen zurücksetzen… GnuCash gibt Warnungen aus, wenn bestimmte Operationen,
wie z.B. das Löschen einer Buchung oder eines Buchungsteils,
durchgeführt werden. Der Dialog für diese Warnmeldung bietet
die Möglichkeit, die Antwort zu speichern. Kontrollkästchen mit
der Bezeichnung Antwort speichern und nicht wieder anzeigen
und Antwort speichern und in dieser Sitzung nicht wieder anzeigen
erlauben die Deaktivierung der Warnmeldung. Dieser Menüpunkt
setzt die Warnungen auf den Standard zurück, d.h. die Warnungen
werden wieder angezeigt.

Tipp

Warnungen können selektiv aktiviert werden.

Seite umbenennen Ermöglicht das Umbenennen der aktuellen Seite oder Registerkarte.

Kontenübersicht - Geschäft-Menü

Tabelle 4.6. Kontenübersicht - Geschäft-Menü - GnuCash-Funktionen für
Kleinunternehmen

Menüpunkt Beschreibung

Kunde → Durchführen von kundenbezogenen Tätigkeiten.

Kundenübersicht Öffnet eine Übersichtsseite mit
Kundendaten.

Neuer Kunde… Startet das Formular Neuer
Kunde zum Erfassen von
Kundendaten.

Kunde suchen… Ruft den Assistenten Kunden
suchen auf.

Neue Rechnung… Öffnet das Formular zur
Erstellung einer neuen Rechnung.

Rechnung suchen… Ruft den Assistenten Rechnung
suchen auf.

Neuer Auftrag… Öffnet das Formular, um einen
neuen Auftrag anzulegen.

Auftrag suchen… Ruft den Assistenten Auftrag
suchen auf.

Zahlung verarbeiten… Startet den Assistenten Zahlung
verarbeiten. Um den Assistenten
zu nutzten muss ein Konto
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Menüpunkt Beschreibung

vom Typ "offene Forderungen"
vorhanden sein.

Erinnerungen an fällige
Rechnungen

Öffnet ein neues Fenster um an
fällige Rechnungen zu erinnern.

Lieferant → Durchführen von lieferantenbezogenen Vorgängen.

Lieferantenübersicht Öffnet eine Übersichtsseite mit
Lieferantendaten.

Neuer Lieferant… Startet das Formular Neuer
Lieferant zum Erfassen von
Lieferantendaten.

Lieferant suchen… Ruft den Assistenten Lieferanten
suchen auf.

Neue Lieferantenrechnung… Öffnet das Formular zur
Erstellung einer neuen
Lieferantenrechnung.

Lieferantenrechnung suchen… Ruft den Assistenten
Lieferantenrechnung suchen auf.

Neuer Auftrag… Öffnet das Formular, um einen
neuen Auftrag anzulegen.

Auftrag suchen… Ruft den Assistenten Auftrag
suchen auf.

Zahlung verarbeiten… Startet den Assistenten Zahlung
verarbeiten. Um den Assistenten
zu nutzten muss ein Konto vom
Typ "offene Verbindlichkeiten"
vorhanden sein.

Erinnerungen an fällige
Rechnungen

Öffnet ein neues Fenster um an
fällige Rechnungen zu erinnern.

Mitarbeiter → Durchführen von mitarbeiterbezogenen Tätigkeiten.

Mitarbeiterübersicht Öffnet eine Übersichtsseite mit
Angaben zu den Mitarbeitern.

Neuer Mitarbeiter… Startet das Formular Neuer
Mitarbeiter zur Erfassung der
Daten eines Mitarbeiters.

Mitarbeiter suchen… Ruft den Assistenten Mitarbeiter
suchen auf.

Neue Auslagenerstattung… Öffnet das Formular zur
Erstellung einer neuen
Auslagenerstattung.

Auslagenerstattung suchen… Ruft den Assistenten
Auslagenerstattung suchen auf.

Zahlung verarbeiten… Startet den Assistenten Zahlung
verarbeiten. Um den Assistenten
zu nutzten muss ein Konto vom
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Menüpunkt Beschreibung

Typ "offene Verbindlichkeiten"
vorhanden sein.

Verknüpfte Geschäftsdokumente Alle zugehörigen Rechnungen anzeigen.

USt.-Steuertabelle… Anzeigen und Bearbeiten der Steuertabellen (MwSt./ USt.).

Tabelle für Zahlungsbedingungen Anzeigen und Bearbeiten der Zahlungsbedingungen.

Kontenübersicht - Berichte-Menü

Nachfolgend finden Sie eine Auflistung aller verfügbaren Berichte und Diagramme. Siehe „Reports Listed
By Class“ für spezifische Berichtsdetails. Jeder Bericht oder jedes Diagramm kann durch eine andere
Stilvorlage oder durch Drücken der Optionen Schaltfläche in der Symbolleiste angepasst werden.

Tabelle 4.7. Kontenübersicht - Berichte-Menu - Zugriff auf GnuCash Berichte und
Diagramme

Menüpunkt Beschreibung

Aktiva & Passiva →

Aktiva-Diagramm

Aktiva Tortendiagramm

Bilanze

Bilanze (mit eguile)

Erweitertes Portfolio

Fremdkapitel-Diagramm

Hauptbuch Journal

Journal

Kursdiagramm

Reinvermögen-Balkendiagramm

Reinvermögen Liniendiagramm

Saldo-Vorhersage

Verbindlichkeiten
Tortendiagramm

Wertpapierbestand

Wertpapiere Tortendiagramm

Aufwand & Ertrag →

Aufwand & Ertrags-
Liniendiagramm

Aufwand & Ertrags-
Säulendiagramm

Aufwendungen-Diagramm

Aufwendungen Tortendiagramm

Eigenkapitalbilanz
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Menüpunkt Beschreibung

Einkommen- und
Umsatzsteuererklärung

Ergebnisrechnung

Erträge Tortendiagramm

Ertrags-Diagramm

Gewinn- und Verlustrechnung

Kapitalfluss

Kapitalfluss-Diagramm

Rohbilanz

Beispiele →

Aufwendungen pro Wochentag

Beispielbericht

Beispiel-Diagramme

Durchschnittlicher Kontostand

Erträge pro Wochentag

Willkommen zu GnuCash

Budget →

Budget-Bericht Der Budgetbericht zeigt alle
Konten und alle Perioden an.
Für jede Periode werden der
budgetierte Betrag und der
tatsächliche Betrag angezeigt. Es
gibt eine Option zum Hinzufügen
einer weiteren Spalte, die
die Differenz (budgetiert -
tatsächlich) anzeigt.

Budget-Bilanze

Budget Diagramm

Budget
Einnahmeüberschussrechnung

Budgetfluss Dieser Bericht enthält
Informationen aus jeweils
einer Budgetperiode. Die
linke Zahlenspalte zeigt die
budgetierten Beträge, und die
rechte Spalte die tatsächlichen
Beträge. Es werden nur solche
Konten angezeigt die keine
Unterkonten haben.

Budget Gewinn- und
Verlustrechnung

Dieser Bericht ist identisch
mit dem Bericht "Budget
Einnahmeüberschussrechnung".

Experimentell →
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Menüpunkt Beschreibung

Bilanz (mehrspaltig)

Ergebnisrechnung (mehrspaltig)

Geschäft →

Auftragsbericht

Australische Rechnung mit
Steuerangaben

Druckbare Rechnung

Einfache Rechnung

Elegante Rechnung

Entwicklung Forderungen

Entwicklung Verbindlichkeiten

Kundenbericht

Kundenübersicht

Lieferantenbericht

Mitarbeiterbericht

Quittung

Rechnung mit Steuerangaben

Mehrspaltig →

Benutzerdefiniert Mehrspaltig

Übersicht

Abgleichungsbericht

Buchungsbericht

Kontenübersicht Bericht mit dem Saldo der ausgewählten Konten.

Zukünftig Terminierte Buchunge Bericht mit einer Auflistung der zukünftigen Buchungen..

Steuer-Bericht & Elster Export Erstellt einen Steuerbericht und/oder exportiert Daten für den Elster
Export.

Gespeicherte
Berichtskonfigurationen

Öffnet die Übersicht gespeicherte Berichtskonfigurationen um
benutzerdefinierte Berichte zu verwalten und auszuführen.

Kontenübersicht - Werkzeuge-Menü

Tabelle 4.8. Kontenübersicht - Werkzeuge-Menü - Verschiedene Hilfsmittel und
Editoren

Menüpunkt Beschreibung

Onlinebanking Einrichtung… Führt die Ersteinrichtung eines Kontos
für den Onlinebanking-Zugang (FinTs,
OFX DirectConnect, …) mittels AqBanking
durch, sofern GnuCash mit der Option
WITH_AQBANKING gebaut wurde. „The Online
Banking Setup Assistant“
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Menüpunkt Beschreibung

Kurs-Datenbank Werkzeug zum Eingeben oder Ändern von Aktien-/
Fondspreisen. Details unter „Price Editor“

Wertpapier-Editor Werkzeug zum Eingeben oder Ändern von Devisen
oder Wertpapieren. Details unter „Security Editor“

Darlehensrechner Details unter „Loan Repayment Calculator“

Buchabschluss Öffnet den Dialog Buch abschliessen, in dem die
erforderlichen Informationen zum Abschluss der
aktuellen Buchhaltungsperiode eingeben werden
können. Siehe „Close Book“.

Import-Zuordnungen Editor Öffnet das Werkzeug Import-Zuordnungen
bearbeiten zum Anzeigen, Bearbeiten oder Löschen
von Importzuordnungen (z.B. Bayes-Algorithmus)

Buchungsverknüpfungen In dem Dialog Buchungen mit Verknüpfung können
Dokumente mit einer Buchung verbunden werden.

Hauptbuch Journal Stellt alle Buchungssätz von allen Konten in einem
einzigen Journal dar. Siehe „Journal“

Kontenübersicht - Fenster-Menü

Tabelle 4.9. Kontenübersicht - Fenster-Menü

Menüpunkt Beschreibung

Neues Fenster Öffnet ein neues, leeres GnuCash Fenster.

Neues Fenster mit Seite Verschiebt die aktuelle Registerkarte in ein neues
Fenster.

Geöffnete Fenster Eine nummerierte Liste der geöffneten Fenster.

Kontenübersicht - Hilfe-Menü

Tabelle 4.10. Kontenübersicht - Hilfe-Menü - Diese Hilfe sowie das Dokument
GnuCash-Kurs und Konzepte

Menüpunkt Beschreibung

GnuCash-Kurs und Konzepte Erläuterung der Buchhaltungsprinzipien und deren
Anwendung in GnuCash.

Tipp des Tages Zeigt kurze Hinweise auf Funktionen an, die Sie
sonst übersehen könnten.

Inhalt Öffnet dieses Dokument.

Info Anzeigen des Informationsfensters mit GnuCash
Version, Lizenz und Mitwkirkende. Wenn Sie der
Meinung sind, dass Sie einen Fehler gefunden
haben, sind in dem Bereich „Mitwirkende“ Links
zu diversen Kommunikatonskanälen enthalten. Sie
können hier mit anderen Anwendern und auch
Entwicklern direkt in Kontakt treten.
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Werkzeugleiste
Das GnuCash Hauptfenster hat eine Reihe von Schaltflächen in der Werkzeugleiste um schnell auf
einige allgemeine Funktionen zuzugreifen, die mit der jeweils aktiven Registerkarte interagieren. Die
Werkzeugleiste kann unter Ansicht → Werkzeugleiste ein- oder ausgeblendet werden.

Anmerkung

Die spezifischen Optionen, die in der Werkzeugleiste angezeigt werden, variieren mit den
Funktionen, die auf der „aktiven Registerkarte“ verfügbar sind.

Tipp

Eine kurze Beschreibung der Funktion einer Werkzeug-Schaltfläche wird angezeigt, wenn der
Mauszeiger für einige Sekunden über dem Symbol platziert wird.

Tabelle 4.11. Kontenübersicht - Werkzeugleiste

Schaltfläche Beschreibung

Speichern (Strg+S) Führt ein Speichern der Datendatei durch, überträgt
alle Buchungen in die Datendatei.

Anmerkung

Ist nur aktiv wenn geänderten Daten noch
nicht gespeichert wurden.

Schließen (Strg+W) Schließt die aktuell aktive Registerkarte.

Anmerkung

Diese Funktion steht für die erste
Registerkarte, meist die Kontenübersicht,
nicht zur Verfügung. Sie ist für alle weitere
Registerkarten nutzbar.

Öffnen Öffnet das Buchungsregister des ausgewählten
Kontos.

Bearbeiten Bearbeitet die Eigenschaften für das ausgewählte
Konto. „Konto bearbeiten“

Neu Startet den Assistenten zum Erstellen eines neuen
Kontos. „Neues Konto erstellen“

Löschen Entfernt das ausgewählte Konto. „Konto löschen“

Zusammenfassungsleiste
Die Zusammenfassungsleiste der Kontenübersicht zeigt auf einen Blick das Eigenkapital und den
Gewinn an. Wertpapierkonten hingegen zeigen Stückzahl und Devisenkonten deren Wert an. Die
Zusammenfassungsleiste kann im Menü Ansicht → Zusammenfassungsleiste ein- und ausgeblendet
werden.

Möchten Sie die angezeigte Auswahl der Zusammenfassungsleiste umstellen, so klicken Sie einfach in
die Zusammenfassungsleiste und es öffnet sich eine Auswahlliste mit unterschiedlichen Inhalten. Dies
Auswahl ist nur für die aktuell geöffenten Ansicht der Kontenstruktur gültig.
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Abbildung 4.7. Die Zusammenfassungsleiste der Kontenübersicht

Tipp

Die angezeigten Werte in der Liste werden von den in „Buchführungsperioden“ eingestellten
Periode beeinflusst. Zeilen mit der Ergänzung „Gesamt“ geben die Werte inklusive zukünftiger
Buchungen an, die anderen Einträge entsprechend der Buchhaltungsperiode.

Statusleiste
Die Statusleiste zeigt kurze Hilfetexte über den aktuell markierten Menüpunkt an. Es zeigt auch einen
Fortschrittsbalken beim Öffnen oder Speichern einer GnuCash Datendatei oder beim Erzeugen von
Berichten an. Die Statusleiste kann ein- oder ausgeblendet werden, indem Sie den Punkt Statusleiste im
Menü Ansicht auswählen.

Ansicht von Konten und Journal
Abbildung 4.8. Die Ansicht des Kontobuchs

Dies ist ein Beispiel für die Registerkarte eines Kontenbuchs.
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Anzeigebereich des Kontobuchs & Journals
Dieses Fenster dient der Eingabe und Bearbeitung Ihrer Kontodaten. Es bietet außerdem Werkzeuge zum
Planen zukünftiger Geschäftsvorgänge, zum Suchen und Protokollieren von Buchungen und Drucken von
Schecks. Dieses Fenster wird auch Buchungsansicht genannt werden.

Um die Buchungsansicht für ein Konto zu öffnen, wählen Sie das Konto in der Kontenübersicht und
gehen Sie dann zu Bearbeiten → Konto öffnen oder betätigen Sie die Strg+O Schaltfläche . Dies öffnet ein
neues Fenster mit dem gewähltem Kontobuch. Das Drücken von Öffnen in der Werkzeugleiste im Fenster
Kontenübersicht oder die Schaltfläche Springen im Fenster Kontobuch sind weiter Möglichkeiten.

Tipp

Das Aussehen der Anzeige eines Kontobuchs ist in hohem Maße konfigurierbar. (siehe  GnuCash
Kurs und Konzepte, Auswahl eines Registerstils [https://code.gnucash.org/docs/de/gnucash-
guide/chapter_txns.html#txns-regstyle1]).

Anmerkung

Die Methoden zur Eingabe von Buchungen sind detailliert beschrieben in Kapitel 6, Arbeiten mit
Buchungen.

In der Liste der Buchungen erscheinen die von Ihnen eingegebenen Buchungen sowie der fortlaufende
Saldo. Außerdem steht eine leere Zeile zur Eingabe neuer Buchungen zur Verfügung. Die Spaltentitel
können je nach Kontoart des geöffneten Kontos unterschiedlich sein. Allgemein gleichlautende Spalten
Datum, Beschreibung, Buchen und Saldo.

Sie können das Menü Ansicht verwenden, um das Erscheinungsbild der Liste zu verändert. Beispielsweise
ist es möglich, die Anzahl der angezeigten Buchungen einzuschränken, eine andere Sortierreihenfolge
zu verwenden oder den Anzeigestil zu ändern, um die Buchungen übersichtlicher darzustellen. Darüber
hinaus gestattet die Schaltfläche Vollständig einen schnellen Zugriff auf alle Buchungsbestandteile.

Menüleiste
Die Menüleiste in der Buchungsansicht enthält die nachfolgenden aufgeführten Menüpunkte.

Kontobuch - Datei-Menü

Wenn Sie in der Menüleiste auf Datei klicken, wird das Menü mit den in Tabelle 4.2, „Kontenübersicht
- Datei-Menü - Zugriff auf Datei- und Kontenoperation sowie Druckfunktion“ beschriebenen
Auswahlmöglichkeiten geöffnet.

Für die Arbeit in der Buchungsansicht sind zusätzlich die nachfolgend beschriebenen Menüeinträge
verfügbar.

Tabelle 4.12. Kontobuch - Datei-Menü - Zugriff auf Datei- und Kontenoperationen
sowie Druckenfunktion

Menüpunkt Beschreibung

Schecks drucken… (Strg+P) Öffnet den Scheck drucken Assistenten. Siehe „Schecks drucken“.

Schließen (Strg+W) Schließt die aktuelle Registerkarte.
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Kontobuch - Bearbeiten-Menü

Die Menüleiste im Menü Bearbeiten umfasst neben den in Tabelle 4.3, „Kontenübersicht - Bearbeiten-
Menü - Bearbeitungsfunktionen für Dateien und Konten sowie Einstellungen“ beschriebenen Einträge
noch zusätzlich die folgenden Menpunkte.

Tabelle 4.13. Kontobuch - Bearbeiten-Menü - Bearbeitungsfunktionen für Dateien
und Konten sowie Einstellungen.

Menüpunkt Beschreibung

Als Zahlung zuweisen… Weist die ausgewählte Buchung als Zahlung einer
Rechnung zu.

Kontobuch - Ansicht-Menü

Das Ansicht-Menü in der Menüleiste Tabelle 4.4, „Kontenübersicht - Ansicht-Menü - Ändern der Ansicht
der Kontenübersicht.“ wird für die Buchungsansicht um die nachfolgenden Einträge ergänzt.

Tabelle 4.14. Kontobuch - Ansicht-Menü - Ändern der Ansicht des
Buchungsfensters.

Menüpunkt Beschreibung

Einzeilig Optionsfeld zur Auswahl der Buchungsanzeige. Siehe  GnuCash
Kurs und Konzepte, Auswählen eines Registerstils [https://
code.gnucash.org/docs/de/gnucash-guide/chapter_txns.html#txns-
regstyle1].

Aktive vollständig Optionsfeld zur Auswahl der Buchungsanzeige.

Vollständig Optionsfeld zur Auswahl der Buchungsanzeige.

Zweizeilig Kontrollkästchen zum Aktivieren/Deaktivieren der zweizeiligen
Anzeige.

Sortieren nach… Legt die Sortierreihenfolge für die Anzeige der Buchungen fest.
Erfordert einen Klick um das Optionsformular zu starten. Der
Dialog wird mit Abbrechen/OK geschlossen.

Standardreihenfolge Gewöhnliche Reihenfolge
beibehalten: Buchungsdatum
[Tag], Nummer, Eingabedatum
[zweitens] a , Beschreibung.

Datum Sortierung nach Datum.

Eingabe-Datum Sortierung nach Eingabedatum.

Datum des Kontoauszuges Sortierung nach dem Datum
des Kontoauszuges (nicht
abgeglichene Posten zuletzt).

Nummer Sortierung nach der Nummer.

Betrag Sortierung nach dem Betrag.

Buchungstext Sortierung nach dem
Buchungstext.

Beschreibung Sortierung nach der
Beschreibung.
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Menüpunkt Beschreibung

Aktionen Sortierung nach Aktionsfeld.

Bemerkung Sortierung nach der Bemerkung.

Umgekehrte Reihenfolge Sortierreihenfolge umkehren.

Sortierreihenfolge speichern Speichern der Sortierreihenfolge
zwischen Sitzungen.

aDas „Eingabedatum“ ist normalerweise unsichtbar. Verwenden Sie einen Bericht, um es anzuzeigen.

Kontobuch - Buchung-Menü

Tabelle 4.15. Kontobuch - Buchung-Menü - Zugriff auf Buchungswerkzeuge.

Menüpunkt Beschreibung

Buchung ausschneiden Die ausgewählte Buchung ausschneiden und in die
Zwischenablage kopieren.

Buchung kopieren Die ausgewählte Buchung in die Zwischenablage
kopieren.

Buchung einfügen Buchungungssatz aus der Zwischenablage
einfügen.

Buchung duplizieren Eine Kopie des aktuellen Buchungssatzes erstellen.

Buchung löschen Ausgewählten Buchungssatz löschen.

Andere Buchungsteile löschen Alle Buchungsteile aus dem ausgewählten
Buchungssatz entfernen.

Buchung eingeben Änderungen des aktuellen Buchungssatzes
übernehmen.

Buchung abbrechen Löscht alle Felder des ausgewählten
Buchungssatzes, so sie noch nicht übernommen
wurden.

Buchung ungültig machen Markiert die aktuelle Buchung als ungültig. Eine
Begründung ist einzugeben.

Ungültige Buchung wiederherstellen Macht die ausgewählte Buchung wieder gültig.

Anmerkung

Dieser Menüpunkt wird nur angezeigt,
wenn die ausgewählte Buchung als
ungültig markiert ist.

Stornobuchung hinzufügen Hinzufügen einer Kopie der ausgewählten
Buchung mit einem invertierten Betrag.

Verknüpfung bearbeiten Ein Dokument mit dem ausgewählten
Buchungssatz verknüpfen oder die Verknüpfung
bearbeiten.

Verknüpfung öffnen Öffnet das mit dem Buchungssatz verknüpfte
Dokument.
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Menüpunkt Beschreibung

Anmerkung

Nur Verfügbar, wenn ein Dokument
oder ein Speicherort mit der aktuell
ausgewählten Buchung verknüpft ist.

Zur Rechnung springen Öffnet die Rechnung zu der aktuellen Buchung.

Anmerkung

Nur Verfügbar, wenn eine Rechnung
tatsächlich zugewiesen ist.

Kontobuch - Aktionen-Menü

Der Grundumfang des Menüs Aktionen in der Menüleiste ist in Tabelle 4.5, „Kontenübersicht - Aktionen-
Menü - Anlegen terminierter Buchungen, Überprüfen von Konten, Durchführen von Aktienteilungen,
Buchen und Abgleichen von Geschäftsvorgängen“ beschrieben. Ergänzend stehen die folgenden
Menüpunkte zur Verfügung.

Tabelle 4.16. Kontobuch - Aktionen-Menu - Anlegen terminierter Buchungen,
Überprüfen von Konten, Durchführen von Aktienteilungen, Buchen und
Abgleichen von Geschäftsvorgängen.

Menüpunkt Beschreibung

Leere Buchung (Strg+Bild ab) Geht zur leeren Buchungszeile am unteren Ende dieses Kontobuchs.

Zu Datum gehen (Strg+G) Zum Buchungsteil mit dem gewählten Datum gehen.

Mehrteilige Buchung Zeigt alle Buchungsteile des aktuellen Buchungssatze an.

Wechselkurs bearbeiten… Den Wechselkurs für die gewählte Buchung bearbeiten.

Terminiert… Eine terminierte Buchung mit dem aktuellen Buchungssatz als
Vorlage erstellen.

Zum Gegenkonto springen Ein neues Kontofenster für das Gegenkonto öffnen und die aktuelle
Buchung auswählen.

Kontobuch - Geschäft-Menü

Die im Menü Geschäft angezeigten Elemente sind die gleichen wie in Tabelle 4.6, „Kontenübersicht -
Geschäft-Menü - GnuCash-Funktionen für Kleinunternehmen“.

Kontobuch - Berichte-Menü

Die im Menü Berichte angezeigten Elemente sind die gleichen wie in Tabelle 4.7, „Kontenübersicht -
Berichte-Menu - Zugriff auf GnuCash Berichte und Diagramme“ und zusätzlich die zwei Berichte, die im
Folgenden aufgeführt sind.

Tabelle 4.17. Kontobuch - Berichte-Menü - Zugriff auf GnuCash Berichte und
Diagramme.

Menüpunkt Beschreibung

Kontenbericht Kontobuch als Bericht für dieses Konto öffnen.
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Menüpunkt Beschreibung

Kontenbuch - Einzelbuchung Kontobuch als Bericht für den ausgewählten
Buchungssatz öffnen.

Kontobuch - Werkzeuge-Menü

Die im Menü Werkzeuge genannten Einträge sind in Tabelle 4.8, „Kontenübersicht - Werkzeuge-Menü -
Verschiedene Hilfsmittel und Editoren“ beschrieben.

Kontobuch - Fenster-Menü

Die Einträge im Fenstermenü entsprechen den Menüpunkten in Tabelle 4.9, „Kontenübersicht - Fenster-
Menü“.

Kontobuch - Hilfe-Menü

Das Hilfe Menü wird in Tabelle 4.10, „Kontenübersicht - Hilfe-Menü - Diese Hilfe sowie das Dokument
GnuCash-Kurs und Konzepte“ beschrieben.

Werkzeugleiste
Das Kontobuch verfügt über eine Reihe von Schaltflächen in der Werkzeugleiste um schnell auf
einige allgemeine Funktionen zuzugreifen, die mit der jeweils aktiven Registerkarte interagieren. Die
Werkzeugleiste kann unter Ansicht → Werkzeugleiste ein- oder ausgeblendet werden.

Anmerkung

Die spezifischen Optionen, die in der Werkzeugleiste angezeigt werden, variieren mit den
Funktionen, die auf der „aktiven Registerkarte“ verfügbar sind.

Tipp

Eine kurze Beschreibung der Funktion einer Werkzeug-Schaltfläche wird angezeigt, wenn der
Mauszeiger für einige Sekunden über dem Symbol platziert wird.

Tabelle 4.18. Kontobuch (Buchungsansicht) Werkzeugleiste

Schaltfläche Beschreibung

Speichern Führt ein Speichern der Datendatei durch, überträgt
alle Buchungen in die Datendatei.

Anmerkung

Ist nur aktiv wenn geänderten Daten noch
nicht gespeichert wurden.

Schließen Schließt das aktuelle Kontobuch.

Anmerkung

Diese Funktion steht für die erste
Registerkarte nicht zur Verfügung. Sie ist
für weitere Registerkarten nutzbar.
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Schaltfläche Beschreibung

Duplizieren Eine Kopie des aktuellen Buchungssatzes erstellen.

Löschen Ausgewählten Buchungssatz löschen.

Eingeben Änderungen des aktuellen Buchungssatzes
übernehmen.

Abbrechen Löscht alle Felder des ausgewählten
Buchungssatzes, sofern sie noch nicht übernommen
wurden.

Neu Geht zur leeren Buchungszeile am unteren Ende
dieses Kontobuchs.

Vollständig Alle Buchungsteile des aktuellen Buchungssatzes
anzeigen. Nicht hervorgehoben, wenn Ansicht →
Aktive vollständig aktiviert ist.

Zum Gegenkonto springen Ein neues Kontofenster für das Gegenkonto öffnen
und die aktuelle Buchung auswählen.

Terminiert Eine terminierte Buchung mit dem aktuellen
Buchungssatz als Vorlage erstellen.

Buchen Startet den Buchungsassistenten für die Buchung
zwischen Konten.

Abgleichen Startet den Abgleichen-Assistenten für das
ausgewählte Konto. „Konto mit einem Kontoauszug
abgleichen“

Zusammenfassungsleiste

Die Zusammenfassungsleiste zeigt verschiedene Salden, die zum aktuell geöffneten Konto gehören, auf
einen Blick an. Im Normalfall werden zu einem Konto der tagesaktuelle Saldo, ein möglicher zukünftiger
Saldo, ein Saldo für bestätigte Einträge, ein abgeglichener Saldo und ein vorraussichtliches Minimum
angezeigt. Eine Ausnahme bilden Aktienkonten, hier erscheint stattdessen die Summe der Anteile und
deren aktueller Wert. Die Zusammenfassungsleiste kann im Menü Ansicht → Zusammenfassung ein- und
ausgeblendet werden.
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Berichte
Abbildung 4.9. Das Berichtsfenster

Dies ist die Darstellung des Berichts Aufwendungen-Diagramm.

Anzeigebereich für Berichte
Dieses Ansicht wird immer dann angezeigt, wenn Sie einen Bericht oder ein Diagramm aus dem Menü
Berichte aufrufen.

Um das Berichtsfenster zu öffnen, wählen Sie einen Bericht aus dem Menü Berichte in der Menüleiste.
Dadurch wird ein neues Fenster mit dem angezeigten Bericht geöffnet. Es bietet eine webbrowserartige
Anzeige mit aktiven Links zu Kontodaten.

Anmerkung

Je nach Bericht kann es zu einer Verzögerung kommen, während der Bericht generiert wird. Eine
Annäherung an den Fortschritt bis zur Fertigstellung wird in der Statusleiste angezeigt, wenn die
Anzeige nicht abgeschaltet wurde.

In dieser Ansicht wird der von Ihnen gewählte Bericht bzw. das Diagramm angezeigt. Die Eigenschaften
dieses Fensters können auf zweierlei Art angepasst werden. Mit der Schaltfläche Optionen in der
Werkzeugleiste können Sie bearbeiten, was der Bericht anzeigt und von welchen Konten die Informationen
bezogen werden. Durch Auswahl von Bearbeiten → Stilvorlagen können Sie die Eigenschaften der HTML-
Seite auswählen, in welcher ihr Bericht angezeigt wird.

Der Bericht verhält sich wie ein Webbrowser, wenn er Links zu externen Webseiten enthält. Die
Schaltflächen Zurück und Vorwärts der Werkzeugleiste ermöglichen es Ihnen, zwischen Web-Seiten zu
navigieren. Wenn Sie bestimmte Hyperlinks im Bericht, welche auf ein Konto verweisen, anklicken,
öffnen sich die dazugehörigen Kontendaten im Kontobuch-Fenster.
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Mit der Schaltfläche Exportieren in der Werkzeugleiste können Sie den angezeigten Bericht in einer Datei
speichern und oder Drucken.

Menüleiste
Die Menüleiste im Berichtsfenster enthält die nachfolgenden aufgeführten Menüpunkte.

Berichte - Datei-Menü

Wenn Sie in der Menüleiste auf Datei klicken, wird das Menü mit den in Tabelle 4.2, „Kontenübersicht
- Datei-Menü - Zugriff auf Datei- und Kontenoperation sowie Druckfunktion“ beschriebenen
Auswahlmöglichkeiten geöffnet.

Ergänzend stehen diese Menüeinträge zur Verfügung.

Tabelle 4.19. Berichte - Datei-Menü - Zugriff auf Datei- und Kontenoperation sowie
Druckfunktion

Menüpunkt Beschreibung

Bericht drucken.. (Strg+P) Aktuellen Bericht drucken.

Exportieren → Öffnet das Untermenü Export.

Bericht exportieren Exportiert den aktuellen Bericht
in eine Datei. Als Export-Format
stehen HTML und HTML zur
Verfügung.

Schließen (Strg+W) Schließt den aktuellen Bericht.

Berichte - Bearbeiten-Menü

Die Menüleiste im Menü Bearbeiten umfasst neben den in Tabelle 4.3, „Kontenübersicht - Bearbeiten-
Menü - Bearbeitungsfunktionen für Dateien und Konten sowie Einstellungen“ beschriebenen Einträge
noch zusätzlich die folgenden Menpunkte.

Tabelle 4.20. Berichte - Bearbeiten-Menü - Bearbeitungsfunktionen für Dateien
und Konten sowie Einstellungen.

Menüpunkt Beschreibung

Berichtsoptionen Öffnet ein Formular zum Bearbeiten/Ändern
von Berichtsauswahlkriterien, Stilvorlagen,
Datumsbereiche und viele andere Parameter.

Berichte - Ansicht-Menü

Mit Ausnahme des Menüpunktes Filtern nach… entspricht das Ansicht-Menü in der Menüleiste
der Beschreibung in Tabelle 4.4, „Kontenübersicht - Ansicht-Menü - Ändern der Ansicht der
Kontenübersicht.“.

Berichte - Aktionen-Menü

Die im Menü Aktionen angezeigten Elemente sind die gleichen wie in Tabelle 4.5, „Kontenübersicht
- Aktionen-Menü - Anlegen terminierter Buchungen, Überprüfen von Konten, Durchführen von
Aktienteilungen, Buchen und Abgleichen von Geschäftsvorgängen“.
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Der Umfang an Menüpunkte ist jedoch erheblich reduziert.

Berichte - Geschäft-Menü

Die im Menü Geschäft angezeigten Elemente sind die gleichen wie in Tabelle 4.6, „Kontenübersicht -
Geschäft-Menü - GnuCash-Funktionen für Kleinunternehmen“.

Berichte - Berichte-Menü

Die im Menü Berichte angezeigten Elemente sind die gleichen wie in Tabelle 4.7, „Kontenübersicht -
Berichte-Menu - Zugriff auf GnuCash Berichte und Diagramme“ und zusätzlich die zwei Menüpunkte,
die im Folgenden aufgeführt sind.

Tabelle 4.21. Berichte - Berichte-Menü - Zugriff auf GnuCash Berichte und
Diagramme.

Menüpunkt Beschreibung

Berichtskonfiguration speichern
(Strg+Alt+S)

Speichert die aktuelle Berichtskonfiguration. Wenn Sie mit einer
nicht gespeicherten Berichtskonfiguration arbeiten, werden Sie
aufgefordert einen Namen zu vergeben. Sie können den Bericht
erneut öffnen, indem Sie die Funktion Berichte  → Gespeicherte
Berichtskonfigurationen aufrufen.

Berichtskonfiguration speichern
unter… (Umschalt+Strg+Alt+S)

Speichert die aktuelle Berichtskonfiguration unter einem neuen
Namen. Sie können den Bericht erneut öffnen, indem Sie die
Funktion Berichte → Gespeicherte Berichtskonfigurationen aufrufen.

Berichte - Werkzeuge-Menü

Die im Menü Werkzeuge genannten Einträge sind in Tabelle 4.8, „Kontenübersicht - Werkzeuge-Menü -
Verschiedene Hilfsmittel und Editoren“ beschrieben.

Berichte - Fenster-Menü

Die Einträge im Fenstermenü entsprechen den Menüpunkten in Tabelle 4.9, „Kontenübersicht - Fenster-
Menü“.

Berichte - Hilfe-Menü

Das Hilfe Menü wird in Tabelle 4.10, „Kontenübersicht - Hilfe-Menü - Diese Hilfe sowie das Dokument
GnuCash-Kurs und Konzepte“ beschrieben.

Werkzeugleiste
Das Berichtsfenster verfügt über eine Reihe von Schaltflächen in der Werkzeugleiste um schnell auf
einige allgemeine Funktionen zuzugreifen, die mit der jeweils aktiven Registerkarte interagieren. Die
Werkzeugleiste kann unter Ansicht → Werkzeugleiste ein- oder ausgeblendet werden.

Anmerkung

Die spezifischen Optionen, die in der Werkzeugleiste angezeigt werden, variieren mit den
Funktionen, die auf der „aktiven Registerkarte“ verfügbar sind.
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Tipp

Eine kurze Beschreibung der Funktion einer Werkzeug-Schaltfläche wird angezeigt, wenn der
Mauszeiger für einige Sekunden über dem Symbol platziert wird.

Tabelle 4.22. Berichte - Werkzeugleiste

Schaltfläche Beschreibung

Speichern Führt ein Speichern der Datendatei durch, überträgt
alle Buchungen in die Datendatei.

Anmerkung

Ist nur aktiv wenn geänderten Daten noch
nicht gespeichert wurden.

Schließen Schließt den aktuellen Bericht.

Anmerkung

Diese Funktion steht für die erste
Registerkarte nicht zur Verfügung. Sie ist
für weitere Registerkarten nutzbar.

Zurück Geht in dem Verlauf einen Schritt zurück.

Vorwärts Geht in dem Verlauf einen Schritt vorwärts.

Neu laden Aktuellen Bericht neu laden (erneut ausführen).

Abbrechen Unbeantwortete HTML-Anfagen abbrechen.

Optionen Öffnet ein Formular zum Bearbeiten/
Ändern von Berichtsauswahlkriterien, Stilvorlagen,
Datumsbereiche und viele andere Parameter.

Berichtskonfiguration speichern Speichert die aktuelle Berichtskonfiguration.
Wenn Sie mit einer nicht gespeicherten
Berichtskonfiguration arbeiten, werden Sie
aufgefordert einen Namen zu vergeben. Sie können
den Bericht erneut öffnen, indem Sie die Funktion
Berichte → Gespeicherte Berichtskonfigurationen
aufrufen.

Berichtskonfiguration speichern unter… Speichert die aktuelle Berichtskonfiguration unter
einem neuen Namen. Sie können den Bericht
erneut öffnen, indem Sie die Funktion Berichte →
Gespeicherte Berichtskonfigurationen aufrufen.

Bericht exportieren Exportiert den aktuellen Bericht in eine Datei.
Als Export-Format stehen HTML und CSV zur
Verfügung.

Bericht drucken Druckt den aktuellen Bericht.
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Abgleichen
Abbildung 4.10. Der Assistent zum Abgleichen von Buchungen

Die Darstellung des Abgleichen- Dialogs.

Fenster zum Abgleichen von Buchungen

Tipp

Das Vorgehen beim Abgleichen eines Kontos ist in „Konto mit einem Kontoauszug abgleichen“
ausführlich beschrieben.

Um das Fenster Abgleichen zu öffnen, wählen Sie auf Aktionen → Abgleichen… in der Menüleiste oder
klicken die Schaltfläche Abgleichen aus der Werkzeugleiste eines Kontobuchs an. Dadurch wird ein
Abgleichen-Dialog geöffnet, in dem Sie das Datum des Kontoauszugs und den Schlusssaldo eingeben
müssen. Wenn Sie die Option Unterkonten einbeziehen anwählen, werden alle Buchungen in den
Unterkonten des ausgewählten Kontos ebenfalls für das Abgleichen berücksichtigt. Durch Drücken der
Schaltfläche OK öffnet sich ein weiters Abgleichen Fenster, in dem Sie Gutschrift und Belastung mit
Ihrem Kontoauszug vergleichen können.

Abgleichen - Fenster

Tabelle 4.23. Abgleichen - Bestandteile des Dialogs Abgleichen.

Bestandteil Beschreibung

Menüleiste Enthält die Menüs für das Abgleichen-Fenster.

Werkzeugleiste, Symbole/Schaltflächen Enthält Schaltflächen für den Zugriff auf häufig
benötigte Funktionen zum Abgleich eines Kontos.

Gutschrift Enthält eine Liste der Zugänge auf dieses Konto.

Belastung Enthält eine Liste der Abgänge von diesem Konto.
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Bestandteil Beschreibung

Saldoanzeige Dieser Bereich unten rechts enthält einige Salden,
die für den Abgleich benötigt werden.

Menüleiste
Die Menüleiste des Abgleichenfensters enthält die nachfolgenden aufgeführten Menüpunkte.

Abgleichen - Abgleichen-Menü

Tabelle 4.24. Abgleichen - Abgleichen-Menü - Informationen zum Abgleich sowie
Fertigstellen und Unterbrechen.

Menüpunkt Beschreibung

Informationen zum Abgleich… Öffnet das Fenster Informationen zum Abgleich.

Fertig (Strg+W) Kontoabstimmung beenden.

Unterbrechen (Strg+P) Das Abgleichen dieses Kontos unterbrechen.

Abbrechen Die Abstimmung dieses Kontos abbrechen.

Abgleichen - Konto-Menü

Tabelle 4.25. Abgleichen - Konto-Menü - Kontenfunktionen

Menüpunkt Beschreibung

Konto öffnen Öffnet das Kontobuch.

Konto bearbeiten Ändert den Namen oder die Eigenschaften des
ausgewählten Kontos. „Konto bearbeiten“

Buchen… (Strg+T) Startet den Buchungsassistenten für die Buchung
zwischen Konten.

Überprüfen Überprüft das Konto auf nicht abgeglichene
Buchungen und verwaiste Buchungsteile und
repariert diese.

Abgleichen - Buchung-Menü

Tabelle 4.26. Abgleichen - Buchung-Menü - Funktionen zur Bearbeitung von
Geschäftsvorgängen

Menüpukt Beschreibung

Saldo (Strg+B) Öffnet das Kontobuch und fügt eine vorbereitete
Ausgleichsbuchung ein.

Bearbeiten (Strg+E) Bearbeitet die aktuell ausgewählte Buchung.

Auswahl abgleichen (Strg+R) Abgleichen der ausgewählten Buchungen.

Nicht abgeglichene Auswahl (Strg+U) Nimmt den Abgleich der ausgewählten Buchungen
zurück.

Löschen (Strg+D) Löscht die aktuell ausgewählte Buchung.
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Abgleichen - Hilfe-Menü

Tabelle 4.27. Agbleichen - Hilfe-Menü - Diese Hilfe sowie das Dokument GnuCash-
Kurs und Konzepte

Menüpunkt Beschreibung

Hilfe Öffnet dieses Dokument im Abschnitt
„Abgleichen“.

Werkzeugleiste
Das Abgleichen-fenster verfügt über eine Reihe von Schaltflächen in der Werkzeugleiste um schnell auf
einige allgemeine Funktionen zuzugreifen, die mit der jeweils aktiven Registerkarte interagieren.

Anmerkung

Die spezifischen Optionen, die in der Werkzeugleiste angezeigt werden, variieren mit den
Funktionen, die in dem „Abgleichenfenster“ verfügbar sind.

Anmerkung

Einige Schaltflächen in der Werkzeugleiste werden erst aktiv sobald in dem „Abgleichenfenster“
eine Buchung markiert ist.

Tipp

Eine kurze Beschreibung der Funktion einer Werkzeug-Schaltfläche wird angezeigt, wenn der
Mauszeiger für einige Sekunden über dem Symbol platziert wird.

Tabelle 4.28. Abgleichen - Werkzeugleiste

Schaltfläche Beschreibung

Saldo Öffnet das Kontobuch und fügt eine vorbereitete
Ausgleichsbuchung ein.

Bearbeiten Bearbeitet die aktuell ausgewählte Buchung.

Auswahl abgleichen Abgleichen der ausgewählten Buchungen.

Nicht abgeglichene Auswahl Nimmt den Abgleich der ausgewählten Buchungen
zurück.

Löschen Löscht die aktuell ausgewählte Buchung.

Öffnen Öffnet das Kontobuch.

Fertig Kontoabstimmung beenden.

Anmerkung

Diese Schaltfläche wird erst aktiv, wenn
der Differenz Wert im Abgleichenfenster
(unten rechts) 0 ist.

Unterbrechen Das Abgleichen dieses Kontos unterbrechen.

Abbrechen Den Abgleich dieses Kontos abbrechen.

42



GnuCash Hauptfenster & Menüs

Terminierte Buchungen
Abbildung 4.11. Arbeiten mit terminierten Buchungen

Eine Übersicht zur Anwendung von terminierten Buchungen.

Anzeigebereich für Terminierte Buchungen

Anmerkung

Die Arbeitsweise mit terminierten Buchungen wird in „Buchungen terminieren“ beschrieben.

Dieses Ansicht wird geöffnet, wenn Aktionen → Terminierte Buchungen → Terminierte Buchungen Editor
in der Menüleiste ausgewählt wird. Dadurch wird eine neue Registerkarte geöffnet, in dem die terminierten
Buchungen geplant werden.

Terminierte Buchungen - Ansicht

Tabelle 4.29. Komponenten des Fensters Terminierte Buchungen

Elemente Beschreibung

Menüleiste Enthält die im Fenster „Terminierte Buchungen“
verwendeten Menüs. Es bietet den Grundumfang
der Menüleiste und den zusätzlichen Menüeintrag
Terminiert.

Anmerkung

Einige Schaltflächen in der Menüleiste
werden erst aktiv wenn in der Übersicht
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Elemente Beschreibung

„Terminierte Buchungen“ eine Buchung
markiert ist.

Werkzeugleiste, Symbole/Schaltflächen Enthält Schaltflächen für den Zugriff auf geplante
Buchungen.

Registerleiste Reiter zum Umschalten zwischen geöffneten
Anzeigen.

Buchungen Der Bereich Buchungen enthält eine Übersicht über
die Buchungen die terminiert wurden sowie die
zugehörigen Eigenschaften.

Bevorstehende Buchungen Der Bereich Bevorstehende Buchungen enthält
einen Kalender für die nächsten Monate In diesem
Kalender sind die Tage, in denen eine oder mehrere
Buchungen geplant sind, mit einem Kreis markiert.

Das im Kalender angezeigte Zeitintervall kann
geändert werden, indem ein anderer Zeitraum aus
der Auswahlliste Ansicht am rechten Seitenrand
ausgewählt wird.

Tipp

Wenn Sie im Kalender ein Datum
anklicken, öffnet sich eine Liste der
terminierten Buchungen für dieses Datum.
Bewegen Sie danach die Maus über
andere Datumsfelder, so ändert sich die
angezeigte Liste entsprechend dem gerade
berührten Datum. Ein weiterer Mausklick
auf den Kalender schließt die Liste.

Menüleiste
Die folgende Tabelle beschreibt die Menüpunkte im Terminiert-Menü der Menüleiste die zur Arbeit in der
Ansicht Terminierte Buchungen zur Verfügung stehen.

Terminierte Buchungen - Terminiert-Menü

Tabelle 4.30. Terminierte Buchungen - Terminiert-Menü - Funktionen zur
Bearbeitung von terminierten Buchungen

Menüpunkt Beschreibung

Neu Neue terminierte Buchung erstellen.

Bearbeiten Ausgewählte terminierte Buchung bearbeiten.

Löschen Ausgewählte terminierte Buchung löschen.

Werkzeugleiste
Das Fenster Terminierte Buchungen hat eine Werkzeugleiste für den schnellen Zugriff auf einige gängigen
Funktionen, die bei der Terminierung verwendet werden.
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Tipp

Eine kurze Beschreibung der Funktion einer Werkzeug-Schaltfläche wird angezeigt, wenn der
Mauszeiger für einige Sekunden über dem Symbol platziert wird.

Tabelle 4.31. Terminierte Buchungen - Werkzeugleiste

Schaltfläche Beschreibung

Speichern Führt ein Speichern der Datendatei durch, überträgt
alle Buchungen in die Datendatei.

Anmerkung

Ist nur aktiv wenn geänderten Daten noch
nicht gespeichert wurden.

Schließen Schließt die Terminierte Buchungen Ansicht.

Neu Neue terminierte Buchung erstellen.

Bearbeiten Ausgewählte terminierte Buchung bearbeiten.

Löschen Ausgewählte terminierte Buchung löschen.

Budget
Abbildung 4.12. Die Budgetansicht

Die Ansicht zur Planung von Budgets.

Anzeigebereich für das Budget
Das Budgetfenster enthält auf der linken Seite eine Liste von Konten und in der rechten Fensterhälfte
mehrere Spalten, die die Budgetwerte enthalten. Jede Spalte entspricht einem Budget für die gewählte

45



GnuCash Hauptfenster & Menüs

Periode. Die Anzahl der Perioden für ein Budget kann mit dem Budget Optionen- Dialog angepasst
werden.

Prozedur 4.1. Einen Budgetwert eingeben

1. Markiere das zu budgetierende Konto.

2. Wähle den Zeitraum für den das Budget eingetragen werden soll und klicke in die entsprechende Zelle.

3. Schreibe das Budget in die Zelle.

4. Betätige Enter um die Eingabe zu beenden.

Menüleiste
Der Menüeintrag Aktionen → Budget → Budget öffnen öffnet das Standardbudget oder bietet eine Auswahl
an, wenn es mehr als ein Budget gibt. Es wird eine neue Registerkarte mit dem angezeigten Budget
geöffnet.

Im Folgenden werden die Menüpunkte beschrieben, die für die Budgetplanung nützlich sind.

Budget - Bearbeiten-Menü

Tabelle 4.32. Budget - Bearbeiten-Menü - Spezielle Menüpunkte für das
Budgetfenster.

Menüpunkt Beschreibung

Budget abschätzen… Startet den Assistenten Budget abschätzen um die
Budgetwerte, basierend auf frühere Buchungen, für
die ausgewählten Konten zu kalkulieren.

Alle Perioden… Budgetwerte für alle Perioden ändern.

Budget löschen… Das gewählte Budget löschen.

Bemerkung bearbeiten Eine Bemerkung für das markierte Konto oder die
ausgewählte Zelle in der Budgetplanung eintragen.

Budget Optionen… Öffnet den Budget Optionen- Assistenten mit dem
die Einstellungen für das Budget angepasst werden.

Budget - Aktionen-Menü

Tabelle 4.33. Budget - Aktionen-Menü - Einträge im Standardmenü die sich auf
Budgets beziehen.

Menüpunkt Beschreibung

Budget → Öffnet das Untermenü Budget zur
Auswahl von Budgetaktionen.

Tipp

Die Menüpunkte, die zur Planung
von Budgets gebraucht werden,
sind ausführlich in Tabelle 4.5,
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Menüpunkt Beschreibung

„Kontenübersicht - Aktionen-Menü
- Anlegen terminierter Buchungen,

Überprüfen von Konten, Durchführen von
Aktienteilungen, Buchen und Abgleichen
von Geschäftsvorgängen“ beschrieben.

Budget - Berichte-Menü

Arbeiten mit mehreren Budgets

Wenn es mehr als ein Budget gibt, verwenden die Berichte das standardmäßig in den
Buchoptionen ausgewählte Budget. Siehe „Buch Einstellungen“ und „Reiter Budgets“ für weitere
Details. Nachdem der Bericht angezeigt wurde, kann das darin verwendete Budget unter dem
Menüeintrag Bearbeiten → Berichtsoptionen Reiter Allgemein geändert werden.

Tabelle 4.34. Budget - Berichte-Menü - Einträge im Standardmenü, die sich auf
Budgets beziehen

Menüpunkt Beschreibung

Budget → Öffnet das Untermenü "Budget"
zur Auswahl eines Budgetberichts.

Tipp

Die Menüpunkte, die zur Anzeige
von Budgetberichten vorhanden

sind, sind ausführlich in Tabelle 4.7,
„Kontenübersicht - Berichte-Menu

- Zugriff auf GnuCash Berichte
und Diagramme“ beschrieben.

Werkzeugleiste
Das Budgetfenster verfügt über eine Reihe von Schaltflächen in der Werkzeugleiste die zur Budgetierung
gebraucht werden.

Tipp

Eine kurze Beschreibung der Funktion einer Werkzeug-Schaltfläche wird angezeigt, wenn der
Mauszeiger für einige Sekunden über dem Symbol platziert wird.

Tabelle 4.35. Budget Werkzeugleiste

Schaltfläche Beschreibung

Speichern Führt ein Speichern der Datendatei durch, überträgt
alle Buchungen in die Datendatei.

Anmerkung

Ist nur aktiv wenn geänderten Daten noch
nicht gespeichert wurden.
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Schaltfläche Beschreibung

Schließen Schließt das aktuelle Budgetfenster.

Öffnen Öffnet das Buchungsregister des ausgewählten
Kontos.

Optionen Öffnet den Budget Optionen- Assistenten mit dem
die Einstellungen für das Budget angepasst werden.

Abschätzen Startet den Assistenten Budget abschätzen um die
Budgetwerte, basierend auf frühere Buchungen, für
die ausgewählten Konten zu kalkulieren.

Alle Perioden Budgetwerte für alle Perioden ändern.

Löschen Das gewählte Budget löschen.

Bemerkung bearbeiten Eine Bemerkung für das markierte Konto oder die
ausgewählte Zelle in der Budgetplanung eintragen.

Optionen

Tabelle 4.36. Budget Optionen und Einstellungen

Option Beschreibung

Budgetname Der Budgetname wird als Bezeichnung des Reiters
verwendet und auch in allen Berichten, die auf Basis
des Budgets erstellt werden.

Bemerkung Eine Erläuterung zu der Budgetplanung eintragen.

Budget Perioden Die Budgetperiode beschreibt, wann das Budget
beginnt (Startdatum) und wie lange jede
Budgetperiode dauert.

Anzahl der Perioden Die Anzahl der Perioden im Budget.

Geschäftliches

Kundenübersicht
Um die Anzeige der Kundenübersicht zu öffnen, klicken Sie auf Geschäft → Kunden  → Kundenübersicht .

Tabelle 4.37. Werkzeugleiste

Schaltfläche Beschreibung

Neu Den Dialog zum Anlegen eines neuen Kunden
öffnen.

Bearbeiten Die Angaben des ausgewählten Kunden bearbeiten.

Neue Rechnung Den Dialog für das Erstellen einer Rechnung öffnen.
Der markierte Kunde wird in den Dialog als
Rechnungsempfänger eingetragen.

Liste der Kunden Fälligkeitsübersicht aller Kunden anzeigen.

Zahlung verarbeiten Den Dialog für die Verarbeitung einer Zahlung
öffnen.
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Tabelle 4.38. Kontextmenü

Menüpunkt Beschreibung

Seite umbenennen Die Bezeichnung der Registerkarte ändern.

Kunden bearbeiten Die Angaben des ausgewählten Kunden bearbeiten.

Neue Rechnung Den Dialog für das Erstellen einer Rechnung öffnen.
Der markierte Kunde wird in den Dialog als
Rechnungsempfänger eingetragen.

Kundenbericht Den Bericht über den ausgewählten Kunden
anzeigen.

Zahlung verarbeiten Den Dialog für die Verarbeitung einer Zahlung
öffnen.

Anmerkung

Das Kontextmenü erscheint, wenn Sie mit der rechten Maustaste auf einen Kunden in der Liste
klicken.

Lieferantenübersicht
Um die Anzeige der Lieferantenübersicht zu öffnen, klicken Sie auf Geschäft → Lieferanten  →
Lieferantenübersicht .

Tabelle 4.39. Werkzeugleiste

Schaltfläche Beschreibung

Neu Den Dialog zum Anlegen eines neuen Lieferanten
öffnen.

Bearbeiten Die Angaben des ausgewählten Lieferanten
bearbeiten.

Neue Lieferantenrechnung Den Dialog für das Erstellen einer Rechnung öffnen.
Der markierte Lieferant wird in den Dialog als
Rechnungsempfänger eingetragen.

Liste der Lieferanten Fälligkeitsübersicht aller Lieferanten anzeigen.

Zahlung verarbeiten Den Dialog für die Verarbeitung einer Zahlung
öffnen.

Tabelle 4.40. Kontextmenü

Menüpunkt Beschreibung

Seite umbenennen Die Bezeichnung der Registerkarte ändern.

Lieferant bearbeiten Die Angaben des ausgewählten Lieferanten
bearbeiten.

Neue Lieferantenrechnung Den Dialog für das Erstellen einer Rechnung öffnen.
Der markierte Lieferant wird in den Dialog als
Rechnungsempfänger eingetragen.

Lieferantenbericht Den Bericht über den ausgewählten Lieferanten
anzeigen.
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Menüpunkt Beschreibung

Zahlung verarbeiten Den Dialog für die Verarbeitung einer Zahlung
öffnen.

Anmerkung

Das Kontextmenü erscheint, wenn Sie mit der rechten Maustaste auf einen Lieferanten in der
Liste klicken.

Mitarbeiterübersicht
Um die Anzeige der Mitarbeiterübersicht zu öffnen, klicken Sie auf Geschäft → Mitarbeiter  →
Mitarbeiterübersicht .

Tabelle 4.41. Werkzeugleiste

Schaltfläche Beschreibung

Neu Den Dialog zum Anlegen eines neuen Mitarbeiters
öffnen.

Bearbeiten Die Angaben des ausgewählten Mitarbeiters
bearbeiten.

Neue Auslagenerstattung Den Dialog für das Anlegen von
Auslagenerstattungen öffnen. Der markierte
Mitarbeiter wird in den Dialog als Empfänger
eingetragen.

Zahlung verarbeiten Den Dialog für die Verarbeitung einer Zahlung
öffnen.

Tabelle 4.42. Kontextmenü

Menüpunkt Beschreibung

Seite umbenennen Die Bezeichnung der Registerkarte ändern.

Mitarbeiter bearbeiten Die Angaben des ausgewählten Mitarbeiters
bearbeiten.

Neuer Auslagenbeleg… Den Dialog für das Anlegen von
Auslagenerstattungen öffnen. Der markierte
Mitarbeiter wird in den Dialog als Empfänger
eingetragen.

Mitarbeiterbericht Den Bericht über den ausgewählten Mitarbeiter
anzeigen.

Zahlung verarbeiten Den Dialog für die Verarbeitung einer Zahlung
öffnen.

Anmerkung

Das Kontextmenü erscheint, wenn Sie mit der rechten Maustaste auf einen Mitarbeiter in der
Liste klicken.
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Kapitel 5. Konten anlegen, anpassen &
benutzen

In diesem Abschnitt wird die Vorgehensweise für die Anlage von Konten in GnuCash beschrieben. Ein
Konto dient in GnuCash als grundlegendes Mittel, um die Aufzeichnung, von wo nach wo Geldflüsse
stattfinden, zu organisieren. GnuCash erweitert dabei den allgemein geläufigen Kontobegriff (z.B.
Bankkonto, Kreditkonto) auf gruppierbare Ertrags- und Aufwandskonten. Auf diese Weise können Sie
leicht feststellen, wohin Ihr Geld fließt und was Ihre größten Einkünfte und Aufwendungen sind. GnuCash
definiert die im nächsten Abschnitt beschriebenen Kontoarten, um die Systematisierung und Gruppierung
der Konten zu unterstützen. Mittels dieser Kontoarten ist es möglich, einen Kontenplan (Kontenhierarchie)
zu erstellen.

Arten von GnuCash Konten
GnuCash unterstützt eine Anzahl verschiedener Kontoarten. Es wird empfohlen, dass Sie aus der folgenden
Liste der Kontoarten jeweils die passende Kontoart auswählen.

Tipp

Bei der Erstellung neuer Konten sind die verfügbaren Möglichkeit für die Kontoart eingeschränkt,
je nachdem, welche Kontoart das übergeordnete Konto (Hauptkonto) hat.

Neben den im GnuCash Tutorial und Konzepte [https://code.gnucash.org/docs/de/gnucash-guide/accts-
types1.html] beschriebenen grundsätzlichen Kontoarten bietet GnuCash noch ein paar spezielle. Diese
zeichnen sich insbesondere durch angepasste Vorschlagslisten –Zins- oder Dividendenzahlung– im
Aktion-Feld und angepaßte Aktionen –z.B. gibt es beim Bankkonto keine Aktienteilung– aus.

Tabelle 5.1. Arten von GnuCash Konten.

Kontotyp Kontoart Beschreibung übergeordnetes Konto
(Hauptkonto)

Bestandskonten Die Auswertung Berichte → Aktiva & Passiva
→ Bilanz gibt Ihnen eine Übersicht zu jedem
beliebigen Stichtag.

Aktiva bezeichnet die Mittelverwendung und
steht auf der linken Seite der Bilanz. Auf der
nächsten Ebene der Kontenstruktur bietet es sich
an, zwichen Umlauf- und Anlagevermögen zu
unterscheiden. Das kann Ihnen dabei helfen,
Liquiditätsengpässe frühzeitig zu erkennen.

Aktiva Nutzen sie diese
allgemeine Art für alle
Vermögensgegenstände,
für die es keine
speziellere Kontenart
gibt.

(Umlaufvermögen; kurzfristig)

Aktiva

Bargeld Diese Kontoart
bezeichnet das Bargeld,

alle Konten außer
Eigenkapital-,
Aufwands- und
Ertragskonten
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Konten anlegen, anpassen & benutzen

Kontotyp Kontoart Beschreibung übergeordnetes Konto
(Hauptkonto)

welches Sie z.B.
in der Brieftasche,
einem Schuhkarton,
einer Sparbüchse
oder unter Ihrer
Matraze aufbewahren.
Bei geschäftlicher
Anwendung kann
hiermit auch die
Registrierkasse gemeint
sein.

Bank Die Kontoart Bank
bezeichnet Spar- oder
Girokonten die bei
einer Bank oder einem
anderen Finanzinstitut
geführt werden. Einige
dieser Konten können
Zinsen tragen. Diese
Kontoart eignet sich
auch für das PayPal-
Konto sowie Debit- und
andere Guthaben-Karten
wie z.B. Bonus-Meilen
und Geldkarte. a

(Offene) Forderungen b Forderungskonten
(Debitoren) werden von
einem Unternehmen
verwendet, um
die Rechnung
über erbrachte
Leistungen (Waren
oder Dienstleistungen)
zu verbuchen, deren
Zahlung später erfolgt.

(Anlagevermögen; langfristig)

Aktienkonto Die Aktie ist ein
Wertpapier, das
den Anteil an einer
Aktiengesellschaft
oder einer
Kommanditgesellschaft
auf Aktien (KGaA)
verbrieft. c d

Investmentfonds Ein Portfolio aus Aktien,
Anleihen oder anderen
Geldanlagen, das sich in
Anteile teilen läßt.
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Kontotyp Kontoart Beschreibung übergeordnetes Konto
(Hauptkonto)

Passiva stehen auf der rechten Seite der Bilanz und
bezeichnen die Mittelherkunft. Sie bestehen aus
dem Eigen- und Fremdkapital Ihres „Betriebes“.

Fremdkapital bezeichnet alle Ihre
Schuldverhältnisse vom
Deckel in der Kneipe
bis zur Hypothek aufs
Häuschen.

Kreditkarte Die Kontoart
Kreditkarte kommt
für die Konten zu
zum Einsatz die, im
Gegensatz zu normalen
Bankkonten, häufig
im Minus sind. Diese
Kontoart kann sowohl
für Kreditkarten die eine
gleitende Kreditlinie
erlauben (z. B. VISA,
oder MasterCard)
als auch bei Karten,
die keine laufenden
Guthaben zulassen (z.
B. American Express),
verwendet werden.

(Offene)
Verbindlichkeiten b

Verbindlichkeitskonten
(Kreditoren) erfassen
Rechnungen, die ihre
Begleichung zu einem
späteren Zeitpunkt
erlauben.

Passiva

Eigenkapital Eigenkapital
repräsentiert Ihren
wirtschaftlichen
Nettowert. Diese
Kontenart wird nur
an zwei Zeitpunkten
bebucht: Wenn sie
Ihr Buch beginnen,
werden hier die
Anfangsbestände
gegengebucht. (siehe
„Anfangsbestand“)
Und am Ende einer
Buchungsperiode
verwendet GnuCash
dieses Konto um den
„Close Book“ zu
erfassen. Bei einem

nur Eigenkapitalkonten
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Kontotyp Kontoart Beschreibung übergeordnetes Konto
(Hauptkonto)

Haushalt empfiehlt es
sich, ein(en) Konto/
enbaum pro Bewohner
anzulegen.

Erfolgskonten e Bei Bedarf können Sie auf der nächsten
Kontoebene die Unterscheidung zwischen
steuerpflichtig/-frei, bzw. steuerabzugsfähig
oder nicht, einfügen. Die Auswertung
Berichte → Aufwand & Ertrag → Gewinn- und
Verlustrechnung gibt Ihnen eine Übersicht
für jeden beliebigen Zeitraum wie z.B. das
Geschäftsjahr.

Erträge Einnahmen jeder Art,
die Sie z.B. durch
Gehalt, geldwerte
Vorteile (Dienstwagen),
Zinsen, Dividenden oder
auch Geschenke usw.
haben. e

Aufwand Ausgaben jeder Art, z.B.
Steuern und Abgaben,
Miete, Lebensmittel,
Kleidung uvm. e

nur Aufwands- und
Ertragskonten

aFür einige dieser Konten besteht die Möglichkeit, per Online-Banking Aufträge an das Geldinstitute zu senden sowie Buchungen
abzurufen und zu importieren. (siehe hierzu auch „Online Aktionen“)
b

Warnung

Die Kontenarten Verbindlichkeiten und Forderungen werden zur Verwaltung offener Rechnungen, auch „offene Posten“
genannt, verwendet. Buchungen, die diese Konten betreffen, sollten ausschließlich durch Verwendung von

• einbuchen/ausbuchen von Lieferantenrechnung/Rechnung/Auslagenerstattung oder
• verarbeiten von Zahlung

hinzugefügt, geändert oder gelöscht werden.

Tipp

Legen Sie nur ein Konto pro benötigter Währung an. Die verschiedenen Kunden, bzw Lieferanten hält GnuCash
automatisch auseinander.

chttps://de.wikipedia.org/wiki/Aktie
d

Tipp

Solange Kryptowährungen von GnuCash nicht als Währungen unterstützt werden, wird empfohlen, sie ebenfalls als Aktie
anzulegen.

eWird in Quicken bzw. Lexware FinanzManager und anderen, nicht auf doppelter Buchführung basierenden, Programmen als
„Kategorie“ bezeichnet.

Der Assistent „Erstellen eines Kontenplans“ bietet eine bequeme Methode sich ein brauchbares
Grundgerüst zu konfigurieren.
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Anmerkung

In bestimmten Situationen legt GnuCash automatisch einige interne Konten an. Nachfolgend
finden Sie eine kurze Aufstellung, warum diese Konten in Ihrer Kontostruktur plötzlich enthalten
sind und wie Sie damit umgehen.

Tabelle 5.2. Arten von GnuCash internen Konten.

Status Kontoart/-name Beschreibung übergeordnetes Konto
(Hauptkonto)

Interne Konten Interne Konten werden nicht vom Benutzer,
sondern bei Bedarf von GnuCash angelegt.

in Ordnung Devisenhandel Devisenhandelskonten
repräsentieren/
gleichen aus das
schwebende Ergebnis
Ihres Wertpapier-
und Devisenhandels.
Sobald sie den ersten
Kauf tätigen, etwa
Umtausch Ihrer
Heimwährung in die des
Urlaubslandes, wird für
beide Währungen ein
Konto angelegt, sofern
es nicht bereits existiert.
Die Details sind in
Tutorial on multiple
currency accounting
und Multiple currency
accounting in GnuCash
in Englisch beschrieben.

nur
Devisenhandelskonten

Fehler Ausbuchungskonto-
XXX,
Ausgleichskonto-XXX

Sie haben mindestens
eine unausgeglichene
Buchung eingegeben.
Zur Behebung
verschieben Sie die
enthaltenen Buchungen
in die richtigen Konten.
Anschließend können
sie das Konto löschen.

nur Aktiva und Passiva

Erstellen eines Kontenplans
Der Kontenplan ist das – hierarchisch angeordnete – Inhaltsverzeichnis ihrer Konten. GnuCash kann Sie
mit dem Assistenten zur „Neuen Kontenplan einrichten“ bei der Arbeit unterstützen.

Am besten denkt man sich einen Kontenplan als Baum: Die Äste stehen für ganze Kategorien oder
Gruppen, während die Blätter einzelne Bankkonten oder Aufwandsarten bezeichnen. Wenn Sie einen
zusammenfassenden Bericht aufrufen, werden typischerweise nur die Hauptäste im Bericht dargestellt und
nicht die Einzelkonten.
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Eine Kontenhierarchie könnte beispielsweise wie folgt aussehen:

300             Aufwendungen
 |
 +--310         Lebenshaltungskosten
 |   |
 |   +--311     Getränke
 |   |
 |   +--312     Kommunikationsdienste
 |
 +--320         Betriebsausgaben
 |   |
 |   +--321     Datenspeicher
 |   |
 :   :

Kontonummer

Da man mit der alphabetischen Sortierung nach Kontonamen sachliche Zusammenhänge nur
schwer visualisieren kann, empfiehlt sich die Verwendung und Sortierung von alphanumerischen
Kontonummern. Wenn Sie einen Bericht erstellen, wird die Sortierreihenfolge nach der Nummer
bestimmt. Es ist üblich, dass die Nummern der „Blatt“-Konten nicht mit Null enden, während
die Nummern der höheren Hierarchieebenen jeweils mehr Nullen am Ende haben und als
Platzhalter [62] gekennzeichnet sind.

Tipp

GnuCash verbietet nicht die doppelte Vergabe von Nummern, jedoch wird empfohlen, dass
Sie dies vermeiden um eine Eindeutigkeit zu erzielen. Es bietet sich an, bei der Festlegung
der Kontonummern zunächst die Ziffern zu verwenden. Reichen die nicht aus, können Sie
auch die Buchstaben „a“ bis „z“ benutzen. GnuCash kann Sie bei der Nummerierung Ihre
Konten unterstützen. Verwenden Sie hierfür den Assistenten Bearbeiten → Unterkonten neu
nummerieren… zu Hilfe. Ein Beispiel ist in „Neunummerierung der Unterkonten“ beschrieben

Neuen Kontenplan einrichten
Mit Unterstützung dieses Assistenten legen Sie in GnuCash einen vollständigen Kontenplan für Ihre
tägliche Arbeit an. Es wird eine neue, leere GnuCash-Datei erzeugt und der Assistent Neuen Kontenplan
erstellen gestartet.

Tipp

Sie können den Assistenten später erneut ausführen. Hierfür gehen Sie im Menü zu Datei → Neue
Datei (Strg+N) falls Sie eine neue Datei erstellen wollen. Wenn Sie den Assistenten innerhalb
der geöffneten Datei laufen lassen wollen, benutzen Sie stattdessen Aktionen → Kontenhierachie
hinzufügen wenn das Kontenhierarchie- Register angezeigt wird.
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Abbildung 5.1. Der Assistent „Neuen Kontoplan erstellen“

Dialogführung

Die Schaltflächen in dem Assistenten werden erst dann sichtbar bzw. aktiviert, wenn Sie die notwendigen
Einstellungen in dem Dialogschritt getätigt haben.

Abbrechen Beendet den Vorgang und bricht die Erstellung einer neuen
Kontenstruktur ab.

Warnung

Wenn Sie auf diese Schaltfläche klicken, gehen alle
Änderungen, die Sie bis zu diesem Punkt vorgenommen haben,
verloren.

Zurück Bringt Sie zur vorherigen Anzeige zurück, so das Sie Ihre Eingaben noch
einmal ändern können.

Weiter Mit der Taste bestätigen Sie Ihre Eingaben und gehen weiter zum
nächsten Bildschirm.

Fertigstellen Überspringt den nächsten Schritt Ausgewählte Konten feinabstimmen
und bringt Sie direkt zum letzten Schritt des Assistenten.

Anwenden Hiermit beenden Sie Ihre Eingaben und die neuen Kontostruktur wird in
der GnuCash-Datei angelegt.

Prozedur 5.1. Beschreibung der Arbeitsschritte in dem Assistenten

1. Neuen Kontenplan erstellen

Der Assistent startet mit einer kurzen Einführungsseite.

2. Buch-Optionen für neues Buch

Anmerkung

Dieser Dialogschritt wird nicht angezeigt, wenn Sie den Assistenten in der Kontenansicht
einer bestehen GnuCash-Datei mit dem Menüpunkt Aktionen → Kontenhierachie hinzufügen
starten.
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In diesem Schritt können Sie generelle Einstellungen für die GnuCash-Datei vornehmen, die in der
Datei gespeichert werden und somit für alle Benutzer gelten. Der Dialog wird ausführlich in „Buch
Einstellungen“ beschrieben.

3. Währung wählen

Im nächsten Bildschirm können Sie die Währung auswählen, die Sie als Vorgabe für die
buchspezifische Basiswährung verwenden wollen.

Die Dropdown-Liste ist standardmäßig auf die Währung eingestellt, die in der Registerkarte „Konten“
in den GnuCash Einstellungen eingestellt ist. Sie erreichen diesen Dialog im Menü Bearbeiten →
Einstellungen . Wenn Sie stattdessen für Ihre Konten eine andere Standardwährung verwenden
wollen, wählen Sie diese aus der Liste aus.

4. zu erstellende Konten auszuwählen

Dieser Schritt wird dafür verwendet, um die Kontenstruktur zu erstellen. Sie sehen einen Bildschirm,
der in drei Teile unterteilt ist.

a. Kategorien

Im linken oberen Teil befinden sich zwei Dropdownfelder, mit denen Sie die sprach- und
regionsspezifischen Kategorien filtern können. Wählen Sie aus dem Listenfeld unterhalb der
Auswahlfelder die Arten von Konten aus, die Sie für Ihre Arbeit in GnuCash verwenden
möchten. So können Sie viele der Kategorien aus einem Gebietsschema für Ihre Konten
auswählen. Wollen Sie Konten aus verschiedenen Gebietsschemen mischen, müssen Sie den
Assistenten für jedes Schema einmal durchlaufen.

b. Alle auswählen

Mit der Schaltfläche können Sie alle Kontokategorien auswählen.

c. Keine auswählen

Mit dieser Schaltfläche können Sie die Auswahl aller ausgewählten Kategorien aufheben.

d. Kategorie-Beschreibung

Im linken unteren Bereich befindet sich ein Feld, in dem eine detaillierte Beschreibung der
aktuell markierten Kategorie angezeigt wird. Hier haben die Ersteller der regionsspezifischen
Module z.T. ausführliche Hinweise zu den einzelnen Modulen geben.

e. Konten in …

Auf der rechten Seite befindet sich eine Vorschau der Konten, die der links hervorgehobenen
Kategorie entsprechen.

Tipp

In diesem Arbeitsschritt bietet der Assistent Ihnen eine Abkürzung an. Die Schaltfläche
Fertigstellen bringt Sie direkt zum letzten Schritt.

5. Ausgewählte Konten feinabstimmen

Weiter geht es mit dem Schritt, bei dem Sie für jedes einzelne Konto bei Bedarf den Kontonamen
anpassen können, einen Anfangsbestand eingeben oder definieren, ob ein Konto als ein Platzhalter
fungieren soll.
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Anmerkung

Platzhalterkonten bilden eine Art Gruppenüberschrift und werden verwendet, um eine
Hierarchie von Konten zu erstellen. Das Kontobuch der so markierte Konten ist
schreibgeschützt.

Anmerkung

Da das Anfangsbestandkonto ein Eigenkapital-Konto ist, wird die Eingabe für diese Art
von Konten unterbunden und von GnuCash auf Null gesetzt. Der Anfangsbestand wird als
eine normale Buchung in das Kontobuch eingetragen und kann von Ihnen später ergänzt,
korrigiert oder gelöscht werden.

Folgen Sie den Anweisungen im Display, um ein Konto auswählen und einen Anfangsbestand
einzugeben. Ein einfacher Klick wird verwendet, um ein Konto zu markieren.

Die Spaltenüberschriften der Tabelle

Sie können einige Einträge für die Konten ändern, indem Sie den entsprechenden Eintrag in der Spalte
auswählen und anschließend in die Zelle klicken die Sie bearbeiten wollen.

Kontobezeichnung Die erste Spalte enthält die Bezeichnungen
für die Konten. Sie können die
Kontobezeichnung entsprechend Ihren
Wünschen anpassen.

Kontoart Die Einträge in dieser Spalte dienen Ihrer
Information und können nicht geändert
werden.

Platzhalter Die dritte Spalte enthält ein
Kontrollkästchen, mit dem Sie angeben
können, ob dieses Konto ein
Platzhalterkonto sein soll. Somit haben
Sie die Möglichkeit, eine hierarchische
Strukturierung Ihrer Konten vorzunehmen.

Anfangsbestand In dieses Feld der vierten Spalte können Sie
bei Bedarf einen Anfangsbestand eintragen
indem Sie diesen in die Zelle eingeben.
Weiterhin wird hier von GnuCash ein
Hinweis eingetragen, ob dieses Konto
in einer vorhanden Kontostruktur schon
existiert und somit nicht neu angelegt wird.

Existierendes verwenden In der letzten Spalte wird Ihnen zur
Information mitgeteilt, ob ein Konto mit
diesem Namen in Ihrer Struktur bereits
vorhanden ist oder nicht.

6. Der letzte Schritt Konteneinrichtung fertigstellen ist der letzte Bildschirm und gibt Ihnen eine
abschließende Übersicht der drei Auswahlmöglichkeiten, um den Assistenten zu beenden.

Sie haben nun eine Struktur der Konten in Ihrer GnuCash Kontenübersicht.
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Kontenplan bearbeiten
Den Kontenplan können Sie mithilfe des Eingabebereichs Hauptkonto im Dialogfenster Konto bearbeiten
verändern. Dort ist es möglich, ein Konto an eine beliebige Stelle in der Kontenübersicht zu bewegen. Es
wird empfohlen, Konten generell als Unterkonten eines Hauptkontos mit verwandter Kontoart zu führen.
Einzelheiten hierzu sind im Abschnitt „Arten von GnuCash Konten“ beschrieben. Dies dient dazu, die
Struktur der Kontenübersicht konsistent zu halten.

Achtung

Zumindest wenn Sie planen, aus Ihren Daten offizielle Dokumente wie Steuererklärungen
zu erstellen, sollten Sie die gängigen Regeln Ihrer Gesetzgebung beachten. Fragen Sie im
Zweifelsfall Ihren Steuerberater.

Tipp

Für einige Länder wie AT, CH, DE haben Anwender Vorlagen beigesteuert, die Sie im
dritten Schritt des Assistenten zur „Neuen Kontenplan einrichten“ auswählen können. Sofern
Sie auch einen noch fehlenden Kontenrahmen oder Verbesserungen an einem vorhandenen
beisteuern möchten, lesen sie bitte https://wiki.gnucash.org/wiki/Account_Hierarchy_Template
(in Englisch).

Um das ausgewählte Konto unter ein bestimmtes Hauptkonto zu verschieben, wählen Sie das gewünschte
Hauptkonto im Eingabebereich Hauptkonto aus. Wenn Sie Neues Konto der obersten Ebene auswählen,
so wird das Konto auf die oberste Ebene der Kontenübersicht verschoben.

Neues Konto erstellen
Um ein neues Konto anzulegen wählen Sie in der Kontenübersicht in dem Menü Aktionen → Neues
Konto… oder klicken auf die Schaltfläche Neu in der Werkzeugleiste und der Dialog Neues Konto wird
geöffnet.

Das Dialogfenster Neues Konto besitzt zwei Karteiseiten: Allgemein und Anfangsbestand.

Um ein neues Konto zu erstellen, sollten Sie sich im Voraus einige Einzelheiten überlegen, die im
Dialogfenster Neues Konto benötigt werden.

• Welche Kontoart wird benötigt?

• Wo lässt sich das Konto in der Kontenhierarchie einordnen?

• Gibt es einen Anfangsbestand oder soll dieses Konto Anfangsbestand-Buchungen enthalten?

• Soll das Konto Fremdwährungen oder Wertpapiere aufnehmen? Dann benötigen Sie pro Währung
vielleicht auch noch zusätzlich ein Konto für die Buchungen des Anfangsbestands.

Tipp

Eigenkapital und seine temporären Varianten Ertrag und Aufwand sollten
grundsätzlich in der Basiswährung geführt werden.

• Wird eine Online-Aktualisierung des Währungs- oder Aktienkurses gewünscht?

Im folgenden werden diese Einzelheiten beschrieben.
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Allgemeine Information
Die Karteiseite Allgemein dient zur Pflege der grundlegenden Angaben zum Konto. Hier steht auch die
Möglichkeit zur Verfügung, das Konto mit einer Börsenkursquelle zu verknüpfen falls es sich um ein
Währungs-, Investmentfonds- oder Aktienkonto handelt. Weiterhin kann es als ein Platzhalter [62]-
Konto markiert werden und zusätzlich wird angezeigt, wenn es als Steuerrelevant gekennzeichnet ist (was
in dem Bearbeiten → Optionen Steuerbericht -Dialog erfolgt).

Im oberen Abschnitt Identifizierung dieser Registerkarte stehen sieben Eingabefelder zur Verfügung.

Kontobezeichnung Geben Sie einen Namen für das Konto ein, z.B. "Mein
Girokonto".

Kontonummer Der optionale Nummernschlüssel wie in Kontonummer
beschrieben.

Beschreibung Eine zusätzliche Beschreibung des Kontos.
Wertpapier/Währung Anmerkung

Der Typ im Feld des Wertpapier auswählen-
Dialogs ist abhängig von der Auswahl der
Kontoart in der Neues Konto Anzeige.

• Für die meisten Konten wird hier die Standardwährung,
d.h. Ihre Landeswährung, z.B. „EUR (Euro)“ angezeigt.
Falls das Konto für eine Fremdwährung vorgesehen
ist, benutzen Sie die Auswählen…-Schaltfläche und
wählen im folgenden Auswahldialog eine andere
Währung.

• Für Konten, die Wertpapiere enthalten, wählen Sie
zunächst Aktie oder Investmentfonds in dem Feld
Kontoart aus, dann das Hauptkonto und im Anschluss
benutzen Sie die Schaltfläche Auswählen…, um den
Typ auszuwählen sowie das Wertpapier im Wertpapier
wählen-Dialog.

Anmerkung

Ähnlich der Kontonummer bietet der Typ, der
intern Namensraum heißt, eine Möglichkeit,
seine Investments sachlich zu sortieren.
Grundsätzlich bietet es sich an, sie nach
Risiko zu gruppieren. Zum Beispiel kann
als erste Ebene der Typ des Wertpapiers
angegeben werden und als optionale 2. Ebene
die Nominalwährung.

:
|
+--Bond
|   |--CHF
|   |--EUR
+--Aktie
|   |--CAD
|   |--CHF
|   |--EUR
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|
:

Wenn das gewünschte Wertpapier nicht in der
Liste enthalten ist und Sie den richtigen Typ
kenen, müssen Sie das neu Wertpapier anlegen.
Hierfür betätigen Sie die Schaltfläche Neu… in dem
Dialog Wertpapier auswählen, um das Fenster Neues
Wertpapier aufzurufen. Die Möglichkeiten werden
detailiert im „Security Editor“ beschrieben. Geben
Sie einen Namen, das Symbol und den Typ ein und
betätigen Sie OK, um das Wertpapier zu erstellen. Ist
dies erfolgt, können Sie den Typ und den Namen in der
Dropdown-Liste Währung/Wertpapier auswählen und
mit Schließen den Dialog beenden.

Kleinste Stückelung Die kleinste Teilung, die gehandelt/transferiert werden
kann. Bei Aktien sind das meist ganze Stücke, aber bei
Währungen und Fonds oft Hundertstel oder Tausendstel.

Basierend auf GnuCashs interner Darstellung als rationale
Zahlen –um Rundungsfehler zu minimieren– und
heutiger 64-bit-Prozessorarchitektur werden maximal 9
Dezimalstellen unterstützt. Wenn Ihre schöne neue
Kryptowährung ZZZ nun 12 Dezimalstellen hat, empfiehlt
es sich, sie zur korrekten Darstellung in Tausendstel zu
erfassen und mit mZZZ zu bezeichnen.

Kontofarbe Die Farbe, die der Registerkarte des Kontos zugewiesen
werden soll. Klicken Sie auf die Schaltfläche Farbe, um
die Anzeige Farbe auswählen zu öffnen. Wollen Sie die
Farbeinstellung für das Kontos zurückzusetzen betätigen
Sie die Schaltfläche Voreinstellung.

Bemerkung Dies ist ein Freitextfeld, das für zusätzliche Notizen über
das Konto verwendet werden kann.

Unterhalb des Bereichs befinden sich 5 Kontrollkästchen: eines, um anzuzeigen, ob das Konto
steuerrelevant ist, eines um das Konto als versteckt zu kennzeichnen. Ein weiteres Kontrollkästchen
wenn das Konto als Platzhalter verwendet wird, zusätzlich eine Auswahl, ob für das Konto automatische
Zinsbuchungen erfolgen sollen und letztendlich eines, mit der das Konto für die Aufnahme eines
Anfangsbestand genutzt wird.

Das Steuerrelevant Kontrollkästchen bedeutet, dass das Konto ausgewählt wurde, um in einem Steuer-
Bericht berücksichtigt zu werden. Dieses Kennzeichen wird hier nur angezeigt und ist im Dialog Optionen
Steuerbericht einzustellen ( Bearbeiten → Optionen Steuerbericht ). Der dazu gehörige Bericht ist im Menü
Berichte → Steuer-Bericht & Elster-Export zu finden. Siehe auch „Country Specific Reports“.

Das Kontrollkästchen Platzhalter setzt für ein Konto den Status „schreibgeschützt“ und verhindert das
Hinzufügen von Geschäftsvorgängen zu diesem Konto. So kann zum Einen das Konto zur Gruppierung
weiterer untergeorenter Konten genutzt werden und zum Anderen um versehentliche Änderungen an einem
„stillgelegten“ Konto zu verhindern. Gewöhnlich sollte das Konto dann einen Saldo von 0 aufweisen.

Tipp

Enthält ein Konto weitere Unterkonten, dann empfiehlt es sich, dieses als Platzhalter zu
kennzeichnen. Dies bringt den Vorteil, dass es beim Eingeben von Buchungen nicht mehr in der
Kontenauswahlliste erscheint, wodurch die Liste deutlich kürzer wird.
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Anmerkung

Wenn Sie ein Konto als Platzhalter deklarieren, wird dieses Konto auch in der Popup Kontoliste
eines Registers ausgeblendet. Unterkonten des Platzhalterkontos werden jedoch weiterhin im
Popup-Fenster angezeigt.

Das Kontrollkästchen Versteckt blendet ein Konto (und alle Unterkonten) in der Kontenübersicht aus.
Um diese Option zurückzusetzen, müssen Sie zunächst den Ansicht → Filtern nach… Dialog für den
Kontenbaum öffnen und die Option Versteckte Konten anzeigen aktivieren. Auf diese Weise können Sie
das Konto auswählen und diesen Dialog erneut öffnen.

Anmerkung

Versteckte Konten erscheinen weiterhin in der Popup-Kontoliste eines Registers. Um ein Konto
auch aus dieser Popup-Kontoliste zu entfernen, aktivieren Sie das Kontrollkästchen Platzhalter.

Durch Auswahl des Kontrollkästchens Automatische Zinsbuchungen wird angegeben, dass vor dem
Abgleichen eines Kontos mit Haben- oder Sollzinsen nachgefragt wird, ob eine Buchung für die
Zinszahlung erstellt wird. Zurzeit ist das nur für Konten der Art Aktiva, Bank, Investmentfonds, offene
Forderungen, Fremdkapital, offene Verbindlichkeiten und Kreditkarte möglich.

Wenn dieses Konto die Anfangsbestand-Buchungen enthalten soll, dann ist das Kontrollkästchen
Anfangsbestand zu aktivieren. Pro Aktie/Währung kann nur ein Konto die Anfangsbestand-Buchungen
enthalten. Nur Konten vom Typ Eigenkapital können die Buchungen des Anfangsbestands aufnehmen.

Unterhalb dieser Kontrollkästchen befindet sich im linken Bereich, eine Auflistung von Kontoarten.
Verwenden Sie eine Kontoart entsprechend den Beschreibungen in „Arten von GnuCash Konten“.

Der rechte Bereich enthält die Auswahl des Hauptkontos. Zum Erstellen eines neuen Kontenbaums, wählen
Sie Neues Konto der obersten Ebene.

Anmerkung

Die verfügbaren Auswahlmöglichkeiten im Bereich Kontoart hängen von dem ausgewählten
Konto im Bereich Hauptkonto ab. (vgl. „Arten von GnuCash Konten“) Dies dient dazu, die
Struktur der Kontenübersicht konsistent zu halten.

Vorgehensweise zur Aktivierung der Online-Preisaktualisierung

1. GnuCash bedient sich eines externen Tools zum Abrufen von Online-Kursen. Dieses Tool ist ein Perl-
Modul namens Finance::Quote und muss zusätzlich zu GnuCash auf Ihrem Computer installiert werden.

Tipp

Die Installation wird in detailiert beschrieben.
2. Legen Sie das Konto für den Investmentfonds bzw. die Aktie an und stellen Sie sicher, dass das

gewünschte Papier im Feld Wertpapier/Währung, wie oben beschrieben, aufgeführt wird.

Tipp

Das Einrichten dieser Konten ist ein guter Zeitpunkt, Einkommenskonten zur Verfolgung von
Dividenden, Kapitalgewinne, aus lang- und kurzfristigen Anlagen, sowie Aufwandskonten
zur Erfassung von Provisionen und Verlusten (Wenn Sie Verluste als Ausgaben verbuchen)
anzulegen.
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3. Legen Sie das Wertpapier an. Verwenden Sie entweder den Werkzeug → Wertpaper-Editor für
bestehende Aktien/Fonds oder, wie oben beschrieben, den Neue Wertpapier/Währung Dialog für eine
neue Aktie/Fonds.

Wählen Sie Börsenkurse online abrufen, die Art der Kursabruf-Quelle und die Zeitzone.

Online-Währungskurse erfordern, dass das Kontrollkästchen für die Art der Kursabruf-Quelle und
die Zeitzone im Dialog Währung ausgewählt werden, nachdem das Kontrollkästchen für Börsenkurse
online abrufen im Währungs-Editor für die Währungen, die heruntergeladen werden sollen, aktivert ist.

Börsenkurse online abrufen Diese Option steht nur dann
zur Verfügung, wenn die Kontoart
Devisenhandel, Investmentfonds oder
Aktienkonto ist. Sie bewirkt, dass
für dieses Konto die Kurse von
einer Online-Datenquelle heruntergeladen
werden können.

Art der Kursabruf-Quelle Verwenden Sie die Optionsfelder, um die
Quelle für die Online-Kurse auszuwählen.

Einzel Diese
Auswahl
ruft
die
Daten
nur
aus
der
angegebenen
Quelle
ab.

Mehrere Kursquellen Kursquellen
wie
„Europa“
sollten
verwendet
werden,
wenn
eine
Ausfallsicherung
gegenüber
mehreren
Datenquellen
erwünscht
ist.

Achtung

Die
Option
Mehrere
Kursquellen
ist
nur
sinnvoll,
wenn
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alle
ausgewählten
Quellen
das
gleiche
Symbol
für
Ihre
Wertpapier
verwenden.

unbekannt GnuCash
hat
hier
kein
Hintergrundwissen
über
die
Quelle.
Das
kann
zwei
verschiedene
Gründe
haben.
Sie
versuchen
eine
Quelle
zu
verwenden,
die

• es
nicht
mehr
in
Finance::Quote
gibt
oder

• neu
in
Finance::Quote
ist,
aber
noch
nicht
in
GnuCash
eingepflegt
wurde.

Überprüfen
Sie,
ob
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gnc-
fq-
check
Ihre
Quelle
listet
und
schlagen
Sie
in
„Die
Datenquellen
in
Finance::Quote“
die
Umsetzung
der
Namen
nach.

Nachdem Sie die Art der Quelle für
Kursangebote ausgewählt haben, wählen
Sie eine Datenquelle aus dem Pulldown-
Menü. Details zu den derzeit unterstützten
Datenquellen finden Sie unter „Die
Datenquellen in Finance::Quote“.

Anmerkung

Die Kursdatenquelle „Yahoo“
liefert dabei auch die Kurse
für die übrigen genannten
Unternehmen (z.B. Fidelity
Investments, T.Rowe Price und
The Vanguard Group) und
gibt den Kurs normalerweise
zeitverzögert zur Original-
Datenquelle an.

Beachten Sie allerdings, dass Sie bei
Verwendung von „Yahoo as JSON“
zusätzlich das Börsenplatzkürzel des
Wertpapiers anfügen sollten, z.B. „PA“
für Paris, „BE“ für Berlin usw. Beispiel:
12150.PA (ein Peugeot-Papier am Pariser
Markt). Tabelle A.4, „Yahoo-Kürzel für
Börsen und Märkte“ enthält eine Liste von
Suffixen für verschiedene Märkte auf der
ganzen Welt.

Pseudo-Symbole für den amerikanischen
Lehrer-Pensionsfond TIAA-CREF-Fonds
sind in der Tabelle Tabelle A.5,
„Pseudo-Symbole, welche für TIAA-
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CREF Kursabfragen verwendet werden
können“ aufgeführt.

Zeitzone dieser Kurse Wählen Sie die Zeitzone für die Quelle
der von Ihnen empfangenen Online-
Börsenkurse. Beispielsweise verwendet
Yahoo gewöhnlich die US-Eastern-
Zeitzone, wählen Sie also „America/New
York“, wenn Sie diese Börsenkursquelle
verwenden.

4. Fügen Sie ein Wertpapier zum Kurs-Editor hinzu. Einzelheiten werden im Abschnitt „Price Editor“
beschrieben.

5. Betätigen Sie Kurse abrufen in der Kurs-Datenbank.
6. Prüfen Sie den aktuellen Preis für das ausgewählte Wertpapier.

Denken Sie daran, dass die „Kurse“ von Investmentfonds in Wirklichkeit der „Nettoanteilswert“ ist. und
erst mehrere Stunden nach Börsenschluss verfügbar sind. Wenn die „Kurse“ aktualisiert werden, bevor
die Nettoanteilswerte des aktuellen Tages ermittelt werden, werden die Werte von gestern abgerufen.

Anfangsbestand
Die Registerkarte Anfangsbestand ist nur beim Anlegen eines neuen Kontos sichtbar, und für Konten vom
Typ Aktien und Investmentfonds deaktiviert. Sie können hier den Anfangsbestand für das Konto angeben.
Hierfür gibt es zwei verschiedene Anwendungsfälle: Wenn Sie zum ersten Mal Geschäftsvorgänge mit
GnuCash erfassen, ist dies der Anfangsbestand des Kontos. Wenn Sie bereits bestehende Konten zum
Ende einer Buchungsperiode abschließen und anschließend Konten neu eröffnen, können Sie hier den
Abschlusssaldo in die neue Periode übertragen.

Wenn Sie ihre GnuCash-Datei über einen längeren Zeitraum fortlaufend nutzen, können Sie mit Hilfe des
„Close Book“ ( Werkzeug → Buchabschluss ) den Anfangsbestand automatisch berechnen lassen. Hierbei
ist der Abschlußsaldo der vorherigen Periode der Anfangsbestand der neuen Periode.

Anmerkung

Für Konten vom Typ Aktien und Investmentfonds müssen Sie die Anfangsbestände
händisch eingeben. Bitte lesen Sie hierfür im GnuCash Tutorial und Konzepte [https://
code.gnucash.org/docs/de/gnucash-guide/invest-buy-stock1.html] die Beispiele, wie Sie diese
Eingaben vornehmen können.

Die Karteiseite besitzt drei Bereiche. Der erste Eingabebereich enthält die Saldo- Informationen.

Saldo Geben Sie hier den Saldo an, mit dem das Konto eröffnet werden soll.
Datum Wählen Sie hier das Datum, zu welchem der Eröffnungssaldo erfasst werden soll.

Der nächste Bereich betrifft den Buchung Anfangssaldo.

Benutze Eigenkapitalkonto Überlicherweise wird der Eröffnungssaldo
eines Kontos dem speziellen Eigenkapital-
Konto namens „Anfangsbestand“
zugewiesen.

Herkunftskonto auswählen Möchten Sie für die Erfassung des
„Anfangsbestand“ ein anderes Eigenkapital-
Konto nutzen, können Sie diesen
Optionspunkt auswählen. Darauf hin wird der
dritte Bereich aktiviert.
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Der letzte Eingabebereich betrifft das Herkunftskonto. Wählen Sie das Konto, das für den Anfangsbestand
verwendet werden soll, aus der Kontostruktur aus.

Konto bearbeiten
Das Dialogfenster Konto bearbeiten besteht nur aus der Karteiseite Allgemeines. Diese Karteiseite
enthält dieselben Informationen wie im zuvor beschriebenen Dialog „Neues Konto erstellen“. Um das
Dialogfenster Konto bearbeiten zu öffnen, wählen Sie Bearbeiten → Konto bearbeiten (Strg+E) oder
klicken Sie die Bearbeiten Schaltfläche in der Werkzeugleiste des Fensters „Account“ an.

Neunummerierung der Unterkonten
Verwenden Sie Unterkonten neu nummerieren…, um die Kontonummern für alle Unterkonten des
aktuellen Kontos neu zu schreiben. Sie haben zum Beispiel die folgende Kontostruktur:

Tabelle 5.3. vorhandene Kontonummern

Nummer Name

10 Farben

10-1 Rot

10-2 Orange

10-3 Gelb

10-4 Blau

10-5 Violet

Sie möchten nun das Konto Grün hinzufügen, aber Sie wollen, dass es zwischen den Konten Gelb und
Blau einsortiert wird. Anstatt alle Konten manuell, beginnend mit Blau, neu zu nummerieren, können Sie
den Befehl Unterkonto neu nummerieren… für das Konto Farben verwenden. In dem Popup-Dialog sollte
der Präfix-Wert standardmäßig „10“ lauten, entsprechend der Kontonummer für das Farben-Konto. Wenn
Sie einen Intervallwert von „5“ einstellen und auf Neu nummerieren klicken, erhalten Sie die folgende
Kontostruktur:

Tabelle 5.4. Neu nummerierte Kontonummern

Nummer Name

10 Farben

10-05 Rot

10-10 Orange

10-15 Gelb

10-20 Blau

10-25 Violet

Jetzt haben Sie im Nummernband für die Konten Platz, um das Konto Grün mit einer Kontonummer zu
versehen und in det richtigen Reihenfolge einzusortiern.

Tabelle 5.5. Die endgültigen Kontonummern

Nummer Name

10 Farben
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Nummer Name

10-05 Rot

10-10 Orange

10-15 Gelb

10-18 Grün

10-20 Blau

10-25 Violet

Konto löschen
Wenn Sie ein Konto löschen wollen, dann können Sie dies mit Bearbeiten → Konto löschen… (Entf)
vornehmen oder Sie betätigen die Löschen Schaltfläche in der Werkzeugleiste des Fensters „Account“.

Tipp

Es empfiehlt sich, dass Sie vor dem Löschen eines Kontos die GnuCash-Datei speichern. Habe Sie
aus Versehen ein Konto gelöscht, so können Sie mit dem Befehl Datei → Änderungen verwerfen
sich aus der Bedrouille befreien. GnuCash bietet Ihnen dann in einem Dialog an, ob Sie die
Änderungen verwerfen möchten und die Datei erneut laden wollen.

Entfernen Sie ein Konto, welches weder ein Unterkonten noch Buchungen enthält, so wird das Löschen
sofort ausgeführt.

Wenn das Konto stattdessen ein Unterkonto oder Buchungen enthält dann wird der Dialog Konto löschen
geöffnet. Dieser Dialog enthält drei Bereiche mit Optionen, die Sie bei dem Vorgehen zum Löschen der
der Daten unterstützt.

Unterkonten Dem ausgewählten Konto ist ein Unterkonto
zugeordnet.
Unterkonto löschen Das

Unterkonto
wird
entfernt.

Verschieben nach In
der
Auswahlbox
können
Sie
definieren,
welchem
Konto
die
Unterkonten
zugeordnet
werden
sollen.
Zur
Auswahl
stehen
hier
nur
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Konten
der
Kontoart
Aktiva
zur
Verfügung.

Buchungen Das zu löschende Konto enthält noch
Buchungen.
Alle Buchungen löschen Alle

Buchungen
werden
gelöscht.

Verschieben nach In
der
Auswahlbox
kann
definiert
werden,
in
welches
Konto
die
Buchungen
verschoben
werden.
Die
Buchungen
können
nur
in
das
Ausbuchungskonto
mit
der
gleichen
Währung
oder
in
Konten
mit
der
selben
Kontoart
verschoben
werden.

Buchungen in Unterkonten Das Unterkonto, das Sie löschen möchten,
enthält noch Buchungen.
Alle Buchungen löschen Alle

Buchungen
in
dem
Unterkonto
werden
gelöscht.
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Verschieben nach In
der
Auswahlbox
kann
definiert
werden,
in
welches
Konto
die
Buchungen
verschoben
werden.

Tipp

Wenn das zu löschende Konto mehrere Unterkonten enthält, so werden Sie durch einen Hinweis
darauf aufmerksam gemacht und gebeten, diese Kontenstruktur manuell aufzulösen.

Anmerkung

Ein Seiteneffekt beim Löschen eines Kontos, welches noch Buchungen enthält, besteht darin, dass
anschließend bei einigen Konten die von dem Löschen betroffenen Buchungsteile automatisch
dem Ausgleichkonto zugewiesen werden. Sie können diese Buchungen manuell wieder einem
richtigen Konto zuweisen.

Konto mit einem Kontoauszug abgleichen
Die Abstimmung der Konten in GnuCash mit den Kontoauszügen einer Bank oder eines anderen Instituts
ist eine Möglichkeit, um die Richtigkeit Ihrer Buchungen (und der Ihrer Bank) und den Saldo Ihrer Konten
zu überprüfen. Dies ist auch nützlich, um zu verfolgen, welche Schecks noch nicht eingelöst sind und
welche sonstigen Buchungen noch ausstehen.

Der Vorgang zum Abgleichen in GnuCash umfasst zwei Dialoge: den „Informationen zum
Kontenabgleich“ Dialog gefolgt von dem „Das Abgleichen-Fenster“ Fenster. Beide bieten Zugriff auf
verschiedene GnuCash Funktionen, die die Eingabe und Aktualisierung von Kontoinformationen während
des Abgleichs erleichtern.

Anmerkung

Wenn Sie ein Konto vom Typ Kreditkarte anhand einer Kreditkartenabrechnung abgleichen,
haben Sie die Möglichkeit, mit Hilfe des sich automatisch öffnenden Buchen-Dialogs eine
Überweisung zum Bezahlen der offenen Rechnung zu erfassen. Dieses Verhalten können Sie in
den GnuCash Einstellungen im Menü Bearbeiten → Einstellungen im Reiter Kontobuch durch
betätigen des Kontrollkästchens Automatische Kreditkartenbezahlung beeinflussen.

Tipp

Das Fenster Abgleichen wird aus der Kontohierarchie oder dem Buchungsfenster aufgerufen,
indem Sie im Menü Aktionen → Abgleichen… auswählen oder Sie verwenden die Abgleichen
Schaltfläche in der Werkzeugleiste.

Die Zusammenfassungs-Leiste im unteren Bereich des „Kontobuchs“ weist den Betrag als aktueller (Saldo)
und ein zukünftiger (Saldo), bestätigte (Buchung), abgeglichene (Buchung) sowie ein vorraussichtliches
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Minimum aus. Es ist möglich, über eine Online-Abfrage der Kontodaten (oder auch manuell) die
Kennzeichnung vorzunehmen, welche Buchungen die Bank bereits verarbeitet hat. In diesem Fall wird
in der Spalte A (abgeglichen) des Kontobuchs der Eintrag n (neu) zu b (bestätigt). Anschließend wird im
Fenster Abgleichen der Kontoauszug verwendet, um das Konto abzugleichen, wodurch sich in Spalte A
der Eintrag in j (abgeglichen: ja) ändert.

Informationen zum Kontenabgleich
Das Dialogfenster Informationen zum Kontenabgleich dient zur Eingabe des Datum des Kontoauszugs,
des Anfangssaldo (fixiert vom letzten Abgleich) und des Schlusssaldo auf dem Kontoauszug. Die Option
Unterkonten mit einbeziehen wird benötigt, wenn zwei oder mehr Konten verwendet werden, um ein
einzelnes Bankkonto abzubilden. Die Schaltfläche Zahlung Habenzins eingeben… (bei Aktivakonten)
bzw. Zahlung Sollzins eingeben… (bei Passivkonten) kann benutzt werden, um die Buchung einer
Zinszahlung für das Konto hinzuzufügen. Wenn Sie diesen Knopf betätigen, erscheint ein weiteres
Dialogfenster, mit dem Sie die „Zinszahlung“ anlegen können.

Anmerkung

Die Schaltfläche Zahlung Habenzins eingeben… wird angezeigt, wenn Sie ein Konto vom
Typ Bank abgleichen. Wohingegen bei Abgleich eines Kontos vom Typ Fremdkapital die
Schaltfläche mit Zahlung Sollzins eingeben… beschriftet wird.

Wenn Sie alle relevanten Daten eingegeben haben, drücken Sie Ok, um zum Dialogfenster „Das
Abgleichen-Fenster“ zu gelangen oder Abbrechen, um den Abgleichvorgang zu verwerfen.

Zinszahlung

Wenn Sie eine Zinszahlung für ein Konto erfassen, dann öffnet sich der Buchen Dialog. Da Sie eine
Zinszahlung erfassen, ist der zuvor im Buchen Dialog beschriebene Abschnitt für die Währungsbuchung
nicht relevant.

Anmerkung

Wenn es sich um eine Zinszahlung für ein Kredit- oder Darlehenskonto handelt, erfolgt die
Zahlung normalerweise von einem Aufwandskonto (Passiva). Falls es sich um eine Zinszahlung
für ein Giro- oder Sparkonto handelt (Aktiva), so erfolgt die Zahlung normalerweise von einem
Ertragskonto.

Wählen Sie OK, um die Zinsbuchung zu erfassen (oder Abbrechen um die Zahlung zu verwerfen) und
zum Einstiegsbild des Abgleichs zurückzukehren.

Das Abgleichen-Fenster

Anmerkung

Eine detaillierte Beschreibung der Menüpunkte und Schaltflächen im Fenster finden Sie unter
„Abgleichen“.

Im Abgleichen-Fenster findet der eigentliche Vorgang des Abgleichs Ihrer Bankauszüge mit den GnuCash-
Daten für jeden einzelnen Geschäftsvorfall statt.

Das Fenster besteht aus einer Werkzeugleiste und den beiden Listenbereichen Gutschrift auf der linken
Seite, Belastung auf der rechten Seite sowie einem Saldobereich im unteren Teil.
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Anmerkung

Wenn Sie die Option Buchungsüberschriften aus Rechnungswesen in dem Abschnitt Konten im
GnuCash Menü Bearbeiten → Einstellungen aktiviert haben, werden die beiden Listenbereiche
mit Soll und Haben anstelle von Gutschrift und Belastung bezeichnet sein.

Der Bereich Gutschrift und Belastung zeigt alle nicht abgeglichenen Geschäftsvorgänge für das Konto.
Beide Listenbereiche bestehen aus fünf Spalten.

Tipp

Um die aufgelisteten Buchungen nach einem bevorzugten Kriterium zu ordnen, klicken Sie auf
die entsprechende Spaltenüberschrift. Um die gewählte Reihenfolge umzukehren, klicken Sie ein
zweites Mal auf die Spaltenüberschrift.

Datum Das Datum der nicht abgeglichenen Buchung.
Nummer Die Buchungsnummer.
Beschreibung Die Beschreibung der abzugleichenden Buchung.
Betrag Der Betrag der Buchung.
A Ein Häkchen zeigt an, ob die Buchung nach Abschluss abgeglichen wird.

Um eine Buchung als abgeglichen zu kennzeichnen, markieren Sie diese und klicken in der entsprechenden
A-Spalte auf das Kästchen. Ein Häkchen zeigt an, das die Buchung abgeglichen ist.

Tipp

Sie können alle Buchungen gleichzeit in einem der beiden Bereiche auswählen und als
abgeglichen kennzeichnen, indem Sie auf eine Buchung im gewünschten Bereich klicken und
dann die Tastenkombination Strg+A+Leertaste betätigen. Dies schaltet den Status des Abgleichs
für alle Buchungen im Fensterbereich gleichzeitig entweder auf markiert oder nicht markiert.
Der Vorgang kann wiederholt werden, um den gewünschten Status für die Geschäftsvorgänge
im Fensterbereich zu erreichen.

Anmerkung

Unter jedem Listenbereich wird ein Gesamtbetrag für abgestimmte Buchungen angezeigt.

Der Saldobereich zeigt eine Zusammenfassung der Salden, die für den Abgleich verwendet werden.

Datum des Kontoauszugs Das Datum auf dem Kontoauszug, das als
„Informationen zum Kontenabgleich“ eingetragen
wurde.

Anfangssaldo Der Saldo am Ende des letzten Abgleichs.
Schlusssaldo Der eingegebene Saldo aus dem Kontoauszug.
Abgeglichener Saldo Der Saldo der als abgeglichen gekennzeichneten

Buchungen.
Differenz Die Differenz zwischen dem Abgeglichenem- und

dem Schlusssaldo.

Die nicht abgeglichenen Buchungen in den Listenbereichen Gutschrift und Belastung können geändert
werden, indem Sie mittels der Menübefehle oder der Werkzeugleiste auf das Konto und die
Buchungsinformationen zugreifen. Sie können eine Neue Buchung anlegen, eine ausgewählte Buchung
Bearbeiten, eine Saldo-Buchung hinzufügen (mit demselben Betrag, der unter Differenz im Saldobereich
aufgeführt ist), und die ausgewählte Buchung löschen.
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Tipp

Um eine aufgelistete Buchung zu ändern, machen Sie einen Doppelklick darauf.

Durch Drücken der Schaltfläche Öffnen wird das entsprechende Kontobuch geöffnet.

Wenn Sie den Abgleich bis zu einem späteren Zeitpunkt unterbechen wollen, wählen Sie im Menü
Abgleichen… → Unterbrechen (Strg+P) oder verwenden die Schaltfläche Unterbrechen. Zum Abbrechen
des Abgleichvorgangs verwenden Sie den Menüpunkt Abgleichen… → Abbrechen oder drücken Sie
Abbrechen.

Wählen Sie jeden nicht abgeglichenen Geschäftsvorgang, der sich auf dem Kontoauszug wiederfindet,
an, so dass in der Spalte A ein Häkchen erscheint. Die im unteren Fensterbereich ausgewiesenen Salden
verändern sich entsprechend den gewählten Geschäftsvorgängen, bis am Ende der Schlusssaldo gleich
dem abgeglichenem Saldo ist und die Differenz Null beträgt. Sobald dies erreicht ist, betätigen Sie die
Schaltfläche Fertig oder den Befehl Abgleichen… → Fertig (Strg+F) um den Abgleich zu beenden.

Importieren von Konten
Dieser Assistent wird Sie dabei unterstützen, Konten aus einer CSV-Datei zu importieren. Die Datei muss
im dem gleichen Format vorliegen wie das, welches von GnuCash beim CSV Export erstellt wird, da es
sich um ein festes Format handelt. Falls ein Konto mit der vollständigen Kontobezeichnung bisher nicht
existiert, wird es erstellt, sofern die Währung oder das Wertpapier, in dem es notiert wird, bereits im
Programm oder Ihrer GnuCash-Datei definiert ist.

Anmerkung

Eine weitere Möglichkeit, Konten zu importieren, bietet der Assistent für das „Importieren
von QIF Dateien“. Im Zuge diese Importvorgangs werden ebenfalls Konten in Ihre GnuCash-
Datendatei importiert.

Falls das Konto bereits existiert, werden diese vier Felder aktualisiert:

• Kontonummer

• Beschreibung

• Bemerkungen

• Farbe
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Abbildung 5.2. Assistent für den Import von Konten im CSV-Format

Dialogführung

Im linken Fensterbereich sind die einzelnen Schritte des Assistenten aufgelistet. Erläuternder Text und die
Bedienelemente zum Durchführen des jeweiligen Schritts werden im rechten Fensterbereich angezeigt.

Anmerkung

Die Schaltflächen befinden sich normalerweise im „Aktionsbereich“ an der Unterkante des
Dialogs. Bei einigen Fenstermanagern werden sie in die Titelleiste integriert.
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Wichtig

Die nachfolgend beschriebenen Schaltflächen werden immer erst dann aktiviert, wenn die
Navigation vom aktuellen Schritt zum Zielschritt gültig ist. D.h. solange nicht alle notwendigen
Angaben gemacht sind, sind manche Schaltflächen deaktiviert.

Abbrechen oder ESC Beendet den Assistenten, ohne Änderungen an Ihren Daten
oder, bei Exporten, dem Dateisystem vorzunehmen.

Warnung

Wenn Sie auf diese Schaltfläche klicken, gehen alle
Änderungen, die Sie bis zu diesem Punkt in den
Assistenten eingetragen haben, verloren.

Zurück Geht zum vorherigen Schritt. Stehen Sie noch im
ersten Schritt des Assistenten ist das gleichbedeutend mit
Abbrechen.

Weiter Geht zum nächsten Schritt.

Anmerkung

Sind Sie im letzten Schritt, dann wird stattdessen
die Schaltfläche Anwenden eingeblendet.

Anwenden Haben Sie alle notwendigen Daten in dem Assistenten
eingegeben, wird im letzten Schritt die Schaltfläche
Anwenden an Stelle von Weiter eingeblendet. Erst wenn
Sie diese Schaltfläche betätigen werden Ihre Eingaben
verarbeitet und die Daten modifiziert.

Prozedur 5.2. Schritte des CSV-Importprozesses

Die Funktion der Steuerelemente jedes Schritts sind nachstehend beschrieben. Sie werden aber auch als
Tooltip im Assistenten angezeigt.

1. Konten-Import-Assistent

Übersichtsseite mit einer kurzen Erklärung hinsichtlich der Anforderungen an die zu importierende
CSV-Datei.

2. Wählen Sie die zu importierende Datei

Navigieren Sie zu der Datei die Sie importieren möchten und wählen Sie diese aus.

3. Kontenimport-Vorschau der ersten 10 Zeilen

Das Fenster Kontenimport-Vorschau steuert die Einstelloptionen für den Import von CSV-Dateien
und bietet eine Vorschau der zu importierenden Konten.

76



Konten anlegen, anpassen & benutzen

Abbildung 5.3. Der CSV Import Vorschau Bereich

Das Vorschaufenster für den CSV-Import mit Einstellungen zum Importieren der angezeigten Konten.

a. Anzahl der Kopfzeilen

Dieses Feld definiert die Anzahl der Überschriftzeilen in der Datei. In der Vorschau werden,
entsprechend Ihrer Eingabe, die Zeilen farbig hinterlegt, die Sie als Überschrift gekennzeichnet
haben und somit nicht importiert werden.

b. Wählen Sie das Trennzeichen

Mit diesen Optionsfeldern können Sie auswählen, mit welchem Spaltentrenner Ihre Daten
separiert sind:

i. Komma (,)

Das , sollte im deutschen Sprachraum nicht als Spaltentrennzeichen verwendet werden, es
sei denn, der Punkt dient als Dezimaltrennzeichen in der Datei.

ii. Semikolon (;)

Wählen Sie ein ; um die Spalten zu trennen, wenn das Komma als Dezimaltrennzeichen
verwendet wird.

iii. Doppelpunkt (:)

Verwenden Sie einen : als Spaltentrennzeichen. Wird gerne von GNU-Programmen
verwendet.

iv. Benutzerdefinierter regulärer Ausdruck

Mit Auswahl dieser Option öffnet sich ein kleines Eingabefenster in dem Sie einen
„regulären Ausdruck“ 1 , auch als RegEx bekannt, eingeben können.

1Für weitere Informationen können Sie den Artikel Regulärer Ausdruck [https://de.wikipedia.org/wiki/Regul%C3%A4rer_Ausdruck] im Wikipedia
lesen.
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c. Vorschau

In dem großen mittleren Bereich wird eine Vorschau auf die ersten 10 Zeilen der zuvor
ausgewählten Importdatei angezeigt. Hier können Sie gut überprüfen, ob Sie die richtige Datei
ausgewählt und das richtige Spaltentrennzeichen gewählt haben.

Tipp

Wenn in der Vorschau keine Daten angezeigt werden oder die Darstellung nicht Ihren
Vorstellungen entspricht, dann probieren Sie einfach andere Trennzeichen aus.

d. Spaltenüberschriften

Der Aufbau der zu importierenden Datei ist seitens GnuCash vorgeschrieben und kann nicht
konfiguriert werden. Aus dem Grund müssen, für einen erfolgreichen Import der Kontenstruktur,
die Inhalte in den einzelnen Spalten der CSV-Datei der Reihenfolge wie nachfolgend aufgelistet
entsprechen. Die Bedeutung der einzelnen Felder ist ausführlich in „Allgemeine Information“
erklärt.

1. Kontoart

2. Volle Kontobezeichnung

3. Kontobezeichnung

4. Kontonummer

5. Beschreibung

6. Kontofarbe

7. Bemerkungen

8. Symbol

9. Namensraum

10.Versteckt

11.Steuerrelevante Information

12.Platzhalter

4. Konten jetzt importieren

Der Dateiname und Pfad der zu importierenden Datei wird angezeigt. Um die Kontenstruktur jetzt
endgültig zu importieren betätigen Sie die Anwenden Schaltfläche.

Nach einer kurzen Zeit, in der die Daten verarbeitet werden, öffnet sich der Dialog Buch-Optionen
für neues Buch. Sie können jetzt einige Einstellungen für das Buch vornehmen, siehe „Buch
Einstellungen“. Wenn Sie das nicht wollen und stattdessen auf Abbrechen drücken, werden die
Konten trotzdem importiert.

5. Importübersicht

Zeigt eine Zusammenfassung des Importvorgangs an. Diese besteht aus der Angabe, wieviele Konten
erfolgreich hinzugefügt und aktualisiert wurden, sowie ob Fehler aufgetreten sind inklusive einer
Auflistung der fehlerhaften Stellen mit Angabe der Zeilennummer in der CSV-Datei.

Exportieren von Konten
Wenn Sie den Bedarf haben, Ihre GnuCash-Konten zu exportieren, so haben Sie hierzu die Auswahl
zwischen zwei unterschiedlichen Exportformaten:
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• XML-Format oder auch Datenbankformate. Welche Datenbank-Schnittstelle zur Verfügung steht, hängt
von den bei Ihnen installierten Systemen ab. GnuCash unterstützt z.B. SQLite3, mysql und postgres.

• CSV-Format als gängiges Austausch-Format für Tabellen.

GnuCash wird bei beiden Verfahren jeweils die vollständige Kontenstruktur ohne weiter Inhalte, wie z.B.
Buchungsdaten und Kontenstände oder auch Kunden, Lieferanten, Budgets sowie terminierte Buchungen,
exportieren.

Konten in ein neues GnuCash-Buch exportieren

Mit dem Menüpunkt Datei → Exportieren → Konten exportieren können Sie Ihre vollständige GnuCash-
Kontenhierarchie in eine XML- oder SQLite3-Datei oder auch in eine Datenbank exportieren. Mit dieser
Funktion haben Sie die Möglichkeit z.B. am Ende eines Jahres einen Buchabschluss vorzunehmen und
mit einer leeren GnuCash-Datei in das neue Jahr zu starten.

Es wird der übliche Datei-Speichern-Dialog geöffnet, der im oberen Bereich ein Auswahlfeld für die
Datenausgabe im XML oder SQLite3-Format anbietet. Haben Sie bereits konfigurierte Datenbank-
Systeme installiert, so werden diese ebenfalls hier zur Auswahl angeboten.

Tabelle 5.6. Dialog zum Exportieren von Konten

Abbildung 5.4. Exportieren in Datei Abbildung 5.5. Exportieren in
Datenbank

XML, SQLite3 In dem Dateiauswahldialog können Sie Angaben zu dem Dateinamen und zu dem
Verzeichnis/Ordner, in dem die Datei gespeichert werden soll, machen. Mit Betätigen
der Schaltfläche Speichern unter… wird die Datei geschrieben. Sie haben hierbei
keinen weiteren Einfluss auf das Ergebnis der Exportdatei.

mysql, postgres Die Ansicht des Dialogs ändert sich und es werden Eingabefelder für die
Informationen zur Datenbankverbindung abgefragt. Wenn Sie Ihre GnuCash-Daten
in einem Datenbanksystem speichern möchten, so benötigen Sie schreibenden
Zugriff auf eine vorhandene Datenbank oder die Berechtigung eine neue Datenbank
anzulegen.

Die exportierte Datei kann über Datei → Öffnen in GnuCash geöffnet werden. Sie müssen dann noch für
alle Konten manuell die Anfangsbestände eintragen.
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Tipp

Öffnen sie hierfür z.B. eine 2. Instanz von GnuCash, um die Schlussbilanz der alten Datei als
Anfangsbestand in die neue Datei zu übertragen.

Konten als CSV exportieren

GnuCash ermöglicht den Export Ihrer Kontenhierarchie im CSV-Format, wobei Sie das
Spaltentrennzeichen an Ihre Bedürfnisse anpassen können. Dies kann sinnvoll sein, um in einer anderen
Anwendung, wie z.B. dem leider nicht mehr gepflegten Gnucash for Android, dieselbe Kontenstruktur
zur Verfügung zu haben.

Hierzu wählen Sie im Menü Datei → Exportieren → Kontenhierarchie nach CSV exportieren… und es
öffnet sich ein Dialog für die Export-Einstellungen.
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Abbildung 5.6. Assistent für den Export der Kontenhierarchie im CSV-Format

Dialogführung

Im linken Fensterbereich sind die einzelnen Schritte des Assistenten aufgelistet. Erläuternder Text und die
Bedienelemente zum Durchführen des jeweiligen Schritts werden im rechten Fensterbereich angezeigt.
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Anmerkung

Die Schaltflächen befinden sich normalerweise im „Aktionsbereich“ an der Unterkante des
Dialogs. Bei einigen Fenstermanagern werden sie in die Titelleiste integriert.

Wichtig

Die nachfolgend beschriebenen Schaltflächen werden immer erst dann aktiviert, wenn die
Navigation vom aktuellen Schritt zum Zielschritt gültig ist. D.h. solange nicht alle notwendigen
Angaben gemacht sind, sind manche Schaltflächen deaktiviert.

Abbrechen oder ESC Beendet den Assistenten, ohne Änderungen an Ihren Daten
oder, bei Exporten, dem Dateisystem vorzunehmen.

Warnung

Wenn Sie auf diese Schaltfläche klicken, gehen alle
Änderungen, die Sie bis zu diesem Punkt in den
Assistenten eingetragen haben, verloren.

Zurück Geht zum vorherigen Schritt. Stehen Sie noch im
ersten Schritt des Assistenten ist das gleichbedeutend mit
Abbrechen.

Weiter Geht zum nächsten Schritt.

Anmerkung

Sind Sie im letzten Schritt, dann wird stattdessen
die Schaltfläche Anwenden eingeblendet.

Anwenden Haben Sie alle notwendigen Daten in dem Assistenten
eingegeben, wird im letzten Schritt die Schaltfläche
Anwenden an Stelle von Weiter eingeblendet. Erst wenn
Sie diese Schaltfläche betätigen werden Ihre Eingaben
verarbeitet und die Daten modifiziert.

Prozedur 5.3. Schritte des Exportdialogs

Die Funktion der Steuerelemente jedes Schritts sind nachstehend beschrieben bzw. werden als Tooltip in
dem Assistenten angezeigt.

1. Export-Einstellungen

In diesem Schritt können Sie verschiedene Vorgaben für die Formatierung der zu exportierenden
Konten machen.

a. Optionen

Dieses Kontrollkästchen kann zusätzlich zu dem Trennzeichen verwendet werden:

• Anführungszeichen verwenden

Umgibt jedes Datenfeld mit Anführungszeichen.

b. Trennzeichen

Mit diesen Optionsfeldern können Sie auswählen, mit welchem Spaltentrenner Ihre Daten
separiert sind:
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i. Komma (,)

Das , sollte im deutschen Sprachraum nicht als Spaltentrennzeichen verwendet werden, es
sei denn, der Punkt dient als Dezimaltrennzeichen in der Datei.

ii. Semikolon (;)

Wählen Sie ein ; um die Spalten zu trennen, wenn das Komma als Dezimaltrennzeichen
verwendet wird.

iii. Doppelpunkt (:)

Verwenden Sie einen : als Spaltentrennzeichen. Wird gerne von GNU-Programmen
verwendet.

iv. Benutzerdefiniert

Verwenden Sie beliebige Zeichen zur Trennung der Spalten, indem Sie diese in das Textfeld
eingeben.

2. Wählen Sie einen Dateinamen für den Export

Es wird ein Dateiauswahldialog, zur Angabe eines Dateinamens und eines Pfades zu dem
Verzeichnis/Ordner, in dem die Datei gespeichert werden soll, angezeigt.

3. Datei jetzt exportieren…

Der Dateiname und Pfad der zu exportierenden Datei und die Anzahl der zu exportierenden Konten
wird angezeigt. Um den Export fortzusetzen betätigen Sie die Anwenden Schaltfläche.

4. Exportzusammenfassung

Zeigt eine Meldung an, wenn die Datei erfolgreich exportiert wurde, oder eine Fehlermeldung mit
Hinweisen warum er gescheitert ist.
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Kapitel 6. Arbeiten mit Buchungen
Jede Buchung entspricht im einfachsten Fall einer Geldbewegung von einem Konto auf ein anderes.
Jedesmal, wenn Sie Geld einnehmen, ausgeben oder zwischen Konten buchen, entspricht dies einer
Buchung. In GnuCash sind an jeder Buchung mindestens zwei Konten beteiligt.

Die Bilanzgleichung [https://code.gnucash.org/docs/de/gnucash-guide/basics-accounting1.html#basics-
accountingequation2] ist das Kernstück der Doppelten Buchführung. Für jede Veränderung im Wert eines
Kontos muss es eine ausgleichende Buchung in einem anderen Konto geben. Dieses Konzept ist bekannt
als das Prinzip des ausgeglichenen Saldos und ist von fundamentaler Bedeutung für das Verständnis von
GnuCash und anderen Systemen zur Doppelten Buchführung. Wenn Sie mit GnuCash arbeiten, werden
Sie immer mit mindestens 2 Konten zu tun haben, damit die Bilanzgleichung ausgeglichen bleibt.

GnuCash verwendet Konten, um Buchungen zu gruppieren und ihre Aufzeichnung zu organisieren. Die
Buchungen werden im Kontobuch eingegeben. In diesem Abschnitt werden die Hilfsmittel von GnuCash
beschrieben, welche eine schnelle Eingabe von Buchungen in das Kontobuch ermöglichen.

GnuCash kennt mehrere Methoden zur Eingabe von Buchungen.

• Der gängigste Weg ist die direkte Eingabe in das Kontobuch.
• Eine andere Möglichkeit bietet der Buchen Dialog.
• Und abschließend das Importieren von Buchungen entweder aus einer Datei oder per Online-Banking.

Verwenden des Buchen Dialogs
Der Buchen Dialog ist im Menü und mit dem Tastenkürzel mittelsAktionen → Buchen… (Strg+T)sowie
durch Verwenden der Schaltfläche Buchen in der Werkzeugleiste des Kontobuchs zu erreichen und dient
in GnuCash zwei Zwecken:

• Eine Möglichkeit, einen einfachen (d.h. zweiteilige) Buchung zwischen beliebigen Konten zu erstellen.
• Erfassen von Wechselkurs- oder Betragsinformationen in einer Buchung mit mehreren Währungen

(siehe „Eine Buchung mit unterschiedlichen Währungen eingeben“).

Anmerkung

Die Bereiche Buchungsinformationen und Gegenkonto im Dialog Buchen werden deaktiviert,
wenn dieser nur zum Erfassen von Wechselkurs- oder Betragsinformationen genutzt wird.

Buchungsinformation
Geben Sie im Bereich Buchungsinformation den Betrag, das Datum und die Beschreibung ein. Die Felder
Nummer und Buchungstext sind optional.

Betrag Der Betrag der Buchung in der Währung des Herkunftskontos .
Datum Das Buchungsdatum, d.h. das Datum zu dem Sie die Buchung in ihrem

Kontobuch erfassen wollen.
Nummer Eine Scheck- bzw. Buchungsnummer.
Beschreibung Eine Beschreibung der Buchung, oft Angaben zum Zahlungspflichtigen

oder Zahlungsempfänger. Der Inhalt dieses Feldes wird von GnuCash
auch dafür verwendet, um vorhandene Buchungen mit importierten
Kontoauszügen abzugleichen.

Bemerkung Zusätzliche Informationen, die Sie zu der Buchung vermerken möchten.
Alles, was Sie hier eingegeben, wird in die Bemerkungs-Felder für beide
Buchungsteile eingetragen.
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Gegenkonto
Die Bereiche der Kontenübersicht Herkunftskonto und Buchen nach werden verwendet, um die Konten
auszuwählen, die an der Buchung teilnehmen sollen. Sie zeigen normalerweise nur Konten vom
Typ Aktiva und Fremdkapital. Wenn Sie ein Ertrags- oder Aufwandskonto in einer dieser Ansichten
verwenden möchten, aktivieren Sie das Kontrollkästchen Erträge/Aufwendungen anzeigen unterhalb der
entsprechenden Ansicht.

• Wählen Sie das Herkunftskonto.
• Wählen Sie das Buchen nach Konto.

Währungsbuchung
Der Bereich Währungsbuchung dient dazu, die notwendigen Angaben zur Umrechnung des Betrags des
Buchen nach Buchungsteils zu erfassen. Sie können entweder einen Wechselkurs oder einen Betrag
eingeben und GnuCash wird das andere berechnen. Wenn Sie den Online Kursabruf installiert haben (siehe
„Vorgehensweise zur Aktivierung der Online-Preisaktualisierung“), können Sie über die Schaltfläche
Wechselkurs abrufen einen aktuellen Kurs abfragen.

Er ist nur aktiviert, wenn die ausgewählten Konten unterschiedliche Währungen verwenden oder der
Dialog Buchen geöffnet wurde, um Kurs- oder Betragsinformationen während der Eingabe einer Buchung
im Kontobuch anzugeben.

Der Bereich ist als Optionsgruppe mit den beiden Auswahlmöglichkeiten Wechselkurs und Zum Betrag
organisiert. Jede besteht aus einem Optionsfeld und einem numerischen Eingabefeld.

Wenn ein entsprechender Kurs in der Kursdatenbank vorhanden ist (siehe „Adding a stock price
manually“), wird der Wechselkurs diesen als Vorgabe verwenden.

Tipp

Um Rundungsfehler zu minimieren, sollten Sie, soweit möglich, den Betrag eingeben.

• Wählen Sie das Optionsfeld Wechselkurs, wenn Sie einen Kurs eingeben wollen, oder verwenden Sie
die Schaltfläche Wechselkurs abrufen.

• Wählen Sie das Optionsfeld Zum Betrag, wenn Sie den Betrag für den Buchen nach Buchungsteil
angeben wollen.

• Geben Sie den Wechselkurs oder den Betrag in das numerische Feld ein, das dem von Ihnen gewählten
Optionsfeld entspricht. GnuCash wird den anderen Betrag für Sie berechnen wenn Sie das Feld
verlassen. Wenn aktiviert, können Sie mit der Schaltfläche Wechselkurs abrufen den aktuellen Kurs aus
der Datenbank verwenden.

Anmerkung

Wenn Sie einen Kurs für das aktuelle Datum in der Kurs-Datenbank eingegeben haben (siehe
„Adding a stock price manually“) wird der Abruf des Wechselkurs den Kurs nicht aktualisieren.
Sie müssen zuerst den manuell erstellten Kurs in der Kurs-Datenbank entfernen bevor Sie die
Wechselkurs abrufen Schaltfläche betätigen.

Anmerkung

Die Schaltfläche Wechselkurs abrufen erzeugt für das aktuelle Datum einen neuen oder ersetzt
einen manuell einen Kurs in der Kurs-Datenbank.
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Fertigstellen
Klicken Sie auf OK, um die Buchung durchzuführen (oder den Kurs bzw. Betrag zu bestätigen) oder
Abbrechen, um den Dialog zu verlassen ohne die Buchung vorzunehmen.

Anmerkung

Beim Abschließen einer Buchung oder Bestätigen eines Wechselkurses wird der Kurs zum
Buchungsdatum in der Kurs-Datenabank aktualisiert. Siehe „Price Editor“ für Details.

Buchungen im Kontobuch eingeben
Nach dem Öffnen eines Kontos wird die Liste der Buchungen angezeigt. Der Name des Kontos erscheint
in der Titelleiste des Fensters. Die Menüs enthalten verschiedene Funktionen, um die Anzeige der
Buchungen zu verändern. Auch die Werkzeugleiste enthält verschiedene Funktionen, die bei der Eingabe
von Buchungen häufig benötigt werden. Eine Beschreibung finden Sie im Abschnitt „Anzeigebereich des
Kontobuchs & Journals“ in dieser Hilfe.

Die Buchungsansicht kann etwas unterschiedlich aussehen, je nachdem, welche Stil-Einstellungen Sie
gewählt haben. Im Folgenden wird die Eingabe von Buchungen unter Verwendung der „einzeiligen“
Darstellung beschrieben. Der Cursor befindet sich standardmäßig im Feld Datum, nachdem das Fenster
geöffnet wurde.

Anmerkung

Wenn Sie in GnuCash an Buchungen arbeiten, beachten Sie, dass die Eingabe Taste und die Tab
Taste sich unterschiedlich verhalten und unterschiedliche Aktionen ausführen.

Die Taste Eingabe wechselt in das erste Feld des nächsten Buchungsteils, unabhängig davon,
in welchem Feld Sie sich befinden. Wenn es keinen nächsten Buchungsteil gibt, wird mit der
Eingabe der nächsten Buchung begonnen. In jedem Fall schließt Eingabe die Bearbeitung der
Buchung ab, und ein mögliche Ausgleichsbuchung wird auf das Ausgleichskonto-CUR gebucht,
wobei CUR die Währung der Buchung ist.

Mit der Taste Tab wechseln Sie zum nächsten Feld im aktuellen Buchungsteil. Wenn es das letzte
Feld ist, geht der Cursor zum nächsten Buchungsteil oder erstellt eine neuen, wenn es keinen gibt.
Wenn der Buchungsteil leer ist, schließt die Taste Tab die Buchung ab und bucht eine etwaige
Ausgleichsbuchung, wie oben beschrieben, in das Ausgleichskonto-CUR.

Prozedur 6.1. Direkte Eingabe im Kontobuch

1. Ein Mausklick auf das Pfeil-Symbol rechts im Feld Datum öffnet einen Datumsauswahldialog.
Wählen Sie mit den Pfeilen den Monat und das Jahr und anschließend das Datum für die Buchung.
Ein weiterer Mausklick auf das Pfeil-Symbol schließt den Datumsauswahldialog. Sie können auch
das Datum direkt eingeben oder einen Teil eintippen, in diesem Fall ergänzt GnuCash automatisch
den Rest.

2. Bewegen Sie den Cursor mit der Tab-Taste weiter oder klicken Sie das Feld Nr an. Hier können Sie
eine Scheck- bzw. Buchungsnummer eingeben.

Tipp

Mit der Taste + wird automatisch die Nummer der letzten Buchung, die eine Nummer hatte,
um eins erhöht und hier eingefügt.
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3. Bewegen Sie den Cursor mit der Tab-Taste weiter oder klicken Sie das Feld Beschreibung an. Hier
geben Sie entweder einen Zahlungsempfänger oder eine andere Beschreibung für die Buchung ein.
Während des Eintippens versucht GnuCash automatisch, den Namen des Zahlungsempfängers zu
ergänzen.

4. Wenn Sie an dieser Stelle die Tab-Taste drücken, passieren zwei Dinge: Falls GnuCash eine
Übereinstimmung mit einer bereits vorhandenen Buchung findet, springt der Cursor auf eines
der Betragsfelder, und das Feld Buchen wird automatisch gefüllt. Falls noch keine entsprechende
Buchung existiert, bewegt GnuCash den Cursor in das Feld Buchen. Wenn Sie stattdessen das Feld
Buchen direkt mit der Maus anklicken (ohne Tabulatortaste), wird es nicht automatisch gefüllt.

5. Konten können entweder durch Eintippen oder durch Betätigen der kleinen Schaltfläche rechts
neben dem Eingabefeld des Feldes Buchen, das eine Auswahlliste mit allen Nicht-Platzhalterkonten
anzeigt,eingegeben werden. Beachten Sie, dass diese Auswahlliste auch ausgeblendete Konten
anzeigt. Wenn Sie ein Konto in Ihrem Kontenplan ausgeblendet haben, sollten Sie das Konto auch
als Platzhalterkonto einrichten, damit es hier nicht angezeigt wird.

Beginnen Sie in dem Feld Buchen mit der Eingabe, versucht GnuCash, das passende Konto
automatisch zu ergänzen; dies geschieht in alphabetischer Reihenfolge. Wenn Sie beispielsweise
Aktiva und Aufwand-Konten auf oberster Ebene haben, führt die Eingabe von A zu Aktiva, weil es
vor Aufwand steht. Wenn Sie weiter ein u eingeben, wird Aufwand ausgewählt. Die Eingabe des
Kontentrennzeichen (standardmäßig :, siehe „Konten“-Einstellungen, um es zu ändern) übernimmt
das aktuell markierte Konto, so dass Sie mit der Eingabe des Namens eines untergeordneten Kontos
fortfahren können.

6. Das nächste Feld A dient zum Abgleichen von Konten. Eine Beschreibung hierzu finden Sie im
Abschnitt „Konto mit einem Kontoauszug abgleichen“.

7. Bewegen Sie den Cursor mit der Tab-Taste zum ersten Betragsfeld. Die Bezeichnungen der beiden
Betragsspalten sind je nach Kontoart unterschiedlich. So heißen sie bei Bank-Konten Einzahlung und
Abhebung, bei Kreditkarten-Konten Abnahme und Zunahme und bei Aktien-Konten Anteile, Preise,
Kauf und Verkauf.

8. Geben Sie den Betrag für die Buchung in das richtige Feld ein. Ist die Buchung „ausgeglichen“
wird durch Drücken der Eingabe Taste, Betätigung der Eingabe Schaltfläche in der  Werkzeugleiste
oder mitBuchung → Buchung eingebendie Buchung abgeschlossen. Durch Anklicken der Abbrechen
Schaltfläche oder mitBuchung → Buchung abbrechenwird die Buchung gelöscht.

9. Bei Buchungen mit nur einem Gegenkonto wird der Name dieses Kontos nach Abschluss der Eingabe
im Feld Buchen angezeigt. (Das Buchen Feld ist das vierte von links im Kontobuch.)

10. Um zu einer leeren Buchung am Ende des Kontobuchs zu wechseln, klicken Sie die Neu Schaltfläche
in der Werkzeugleiste an oder wählen SieAktionen → Leere Buchung (Strg+Bild ab).

Verknüpfen einer externen Datei mit einer
Buchung

Wenn Sie es hilfreich finden, externe Dateien oder URLs, z. B. Bilder von Kassenzetteln, entwerteten
Schecks oder Lieferantenrechnungen, mit ihren Buchungen zu verknüpfen. GnuCash bietet Ihnen diese
Möglichkeit.

Wählen Sie eine Buchung im Kontobuch, klicken Sie mit der rechten Maustaste darauf, um das
Kontextmenü zu öffnen und wählen Sie Verknüpfung bearbeiten…. Es öffnet sich der Dialog
Buchungsverknüpfung bearbeiten.
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Abbildung 6.1. Der „Buchungsverknüpfung bearbeiten“ Dialog

Im oberen Bereich befindet sich eine Optionsgruppe mit den beiden Auswahlmöglichkeiten Verknüpfte
Datei und Verknüpfter Hyperlink. Wenn schon ein Element zugeordnet ist, wird das Optionsfeld die
entsprechende Auswahl anzeigen. Am unteren Rand befinden sich 3 Schaltflächen: Entfernen, Abbrechen
und OK. Mit der Schaltfläche Entfernen wird die aktuelle Zuordnung gelöscht und der Dialog geschlossen;
die anderen beiden führen die üblichen Aktionen aus.

Wenn das Optionsfeld Verknüpfte Datei ausgewählt ist, ist das darunter liegende Steuerelement eine
Schaltfläche für die Dateiauswahl. Es wird der Name der ausgewählten Datei angezeigt oder (keine), wenn
keine Datei vorhanden ist. Wenn Sie auf die Schaltfläche klicken, wird ein Dateiauswahldialog geöffnet
in dem Sie die zu verknüpfende Datei auswählen können.

Wenn das Optionsfeld Verknüpfter Hyperlink ausgewählt ist, befindet sich darunter ein Eingabefeld, in
das Sie eine URL eingeben können.

Sind Sie fertig, so klicken Sie auf die Schaltfläche OK, um Ihre Auswahl zu bestätigen oder auf die
Schaltfläche Abbrechen, um den Dialog zu verlassen, ohne eine Änderung vorzunehmen.

Der Menüeintrag Verknüpfung öffnen ist aktiviert, wenn eine Datei oder eine URL mit der ausgewählten
Buchung verknüpft ist. Wenn Sie diesen auswählen, öffnet sich die Datei in dem Standardprogramm für
den Dateityp bzw. die URL im Standard-Browser.
Abbildung 6.2. Kette und BüroklammerWird das Kontobuch zweizeilig angezeigt, so befindet sich in der zweiten Zeile, also in der Zelle die
unterhalb der Abgleichen- Markierung liegt, das Symbol für die Verknüpfung mit

• einer Büroklammer wenn zu der Buchung eine Datei zugeordnet ist, oder

• einer Kette wenn ein Hyperlink eingetragen ist

und solange diese Symbole von der aktuellen Schriftart für die Zelle unterstützt werden. Wenn Sie den
Mauszeiger über der Zelle platzieren wird der Dateiname oder die URL in einem Tooltip angezeigt und ein
Klick darauf öffnet die Datei oder URL genau so wie der Eintrag des Kontextmenüs Verknüpfung öffnen.

Mehrteilige Buchung eingeben
Das Kontobuch kann etwas unterschiedlich aussehen, je nachdem, welche Stil-Einstellungen Sie
gewählt haben. Das Folgende beschreibt die Eingabe von Buchungen mit mehreren Buchungsteilen im
Grundbuchstil. GnuCash bezeichnet „Teilbuchungen“, wenn Geld auf oder von mehr als zwei Konten in
einer Buchung übertragen wird. Der Cursor wird im Datumsfeld gesetzt, wenn das Registerfenster geöffnet
wird.

Die weiteren Buchungszeilen werden im einzeiligen Kontobuch nicht angezeigt, es sei denn, die
Schaltfläche Vollständig in der Werkzeugleiste oder der MenüeintragAktionen → Mehrteilige Buchungsind
aktiviert.
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Prozedur 6.2.

1. Ein Mausklick auf das Pfeil-Symbol rechts im Feld Datum öffnet einen Datumsauswahldialog.
Wählen Sie mit den Pfeilen den Monat und das Jahr und anschließend das Datum für die Buchung.
Ein weiterer Mausklick auf das Pfeil-Symbol schließt den Datumsauswahldialog. Sie können auch
das Datum direkt eingeben oder einen Teil eintippen, in diesem Fall ergänzt GnuCash automatisch
den Rest.

2. Bewegen Sie den Cursor mit der Tab-Taste weiter oder klicken Sie das Feld Nr an. Hier können Sie
eine Scheck- bzw. Buchungsnummer eingeben. Mit der Taste + wird automatisch die Nummer der
letzten Buchung, die eine Nummer hatte, um eins erhöht und hier eingefügt.

3. Bewegen Sie den Cursor mit der Tab-Taste weiter oder klicken Sie das Feld Beschreibung an. Hier
geben Sie entweder einen Zahlungsempfänger oder eine andere Beschreibung für die Buchung ein.
Während des Eintippens versucht GnuCash automatisch, den Namen des Zahlungsempfängers zu
ergänzen.

4. Wenn Sie an dieser Stelle die Tab-Taste drücken, passieren zwei Dinge: Falls GnuCash eine
Übereinstimmung mit einer bereits vorhandenen Buchung findet, springt der Cursor auf eines der
Betragsfelder, und das Feld Buchen wird automatisch gefüllt. Wenn Sie stattdessen das Feld Buchen
direkt mit der Maus anklicken (ohne Tabulatortaste), wird es nicht automatisch gefüllt. Falls noch
keine entsprechende Buchung existiert, bewegt GnuCash den Cursor auf das Buchen Feld, wobei nur
eine Zeile der Buchung geliefert wird.

5. Beginnen Sie in dem Feld Buchen mit der Eingabe, versucht GnuCash, das passende Konto
automatisch zu ergänzen; dies geschieht in alphabetischer Reihenfolge. Wenn Sie beispielsweise
Aktiva und Aufwand-Konten auf oberster Ebene haben, führt die Eingabe von A zu Aktiva, weil es
vor Aufwand steht. Wenn Sie weiter ein u eingeben, wird Aufwand in der Kontenliste ausgewählt.
Sobald der richtige Abschnitt gefunden ist, können Sie durch Eintippen des Doppelpunktes : zu
den Unterkonten springen. Wenn Sie also nach „Au“ anschließend : tippen, springt der Cursor zum
ersten Unterkonto in den „Aufwand“ Konten. Durch die Eingabe von Buchstabenkombinationen und
: können Sie sich so schnell in der Kontenstruktur bewegen. Das kleine Symbol rechts neben dem
Buchen Feld kann als eine weitere Möglichkeit zur Auswahl von Konten verwendet werden.

6. Das nächste Feld A dient zum Abgleichen von Konten. Eine Beschreibung hierzu finden Sie im
Abschnitt „Konto mit einem Kontoauszug abgleichen“.

7. Bewegen Sie den Cursor mit der Tab-Taste zum ersten Betragsfeld. Die Bezeichnungen der beiden
Betragsspalten sind je nach Kontoart unterschiedlich. So heißen sie bei Bank-Konten Einzahlung und
Abhebung, bei Kreditkarten-Konten Abnahme und Zunahme und bei Aktien-Konten Anteile, Preise,
Kauf und Verkauf.

8. Geben Sie den Betrag für die Buchung in das richtige Feld ein. Bevor Sie Tab oder Eingabe drücken,
lesen Sie bitte den nächsten Schritt.

9. Um die weiteren Buchungsteile einzugeben, drücken Sie die Schaltfläche Vollständig in der
Werkzeugleiste oder wählen SieAktionen → Mehrteilige Buchung. Buchungen mit mehreren Teilen
tragen den Hinweis -- Mehrteilige Buchung -- und zur Anzeige der Details wird die Funktion
Vollständig benötigt.

10. Die Anzeige wird nun erweitert, dabei verändern sich die Bezeichnungen der Betragsspalten, und
die Bezeichnung der Spalte Buchen verschwindet. Die erste Zeile enthält die Beschreibung und
den Gesamtbetrag der Buchung. Die zweite Zeile enthält den Namen des aktuell geöffneten Kontos
im Feld Konto sowie den Betrag. Die dritte Zeile enthält den Namen des Gegenkontos im Feld
Konto. Wenn der Betrag nicht ausgeglichen ist, deutet GnuCash dies durch graue Kästchen in den
Betragsspalten an und weist den Fehlbetrag in einer vierten, leeren Zeile aus.
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11. Wenn Sie eine der kürzeren Zeilen auswählen, verändern sich die Spaltenbezeichnungen. Die
Bezeichnungen der ersten und der letzten Spalte (Datum und Saldo) verschwinden, Nr wird zu Aktion,
Beschreibung zu Buchungstext, und die zuvor unbezeichneten Spalte Buchen ändert sich zu Konto.
Die restlichen beiden Spalten tragen eine Bezeichnung, wie sie in Schritt 7 beschrieben ist.

12. Die Eingaben in den Spalten Aktion und Buchungstext sind an dieser Stelle optional. Mit Aktion wird
beschrieben, welche Art von Buchung stattfindet. Buchungstext ist eine zusätzliche Beschreibung
der Buchung.

13. Bewegen Sie den Cursor zum noch fehlenden Betragsfeld in der dritten Zeile und ergänzen Sie den
Betrag. Durch Drücken der Eingabe Taste, Anklicken der Schaltfläche Eingeben oder mitBuchung
→ Buchung eingebenwird nunmehr der Cursor zur nächsten Zeile bewegt.

14. Die Spalte Konto enthält die Liste der berührten Konten. Dies ist die Spalte, mit der Sie Buchungsteile
hinzufügen können. Wie in Schritt 5 beschrieben, können Sie hier in der leeren Zeile ein weiteres
Konto hinzufügen. Fügen Sie soviele Buchungsteile hinzu wie benötigt.

15. Sobald die Buchung ausgeglichen ist, verschwinden die grauen Kästchen, und in der letzten, leeren
Zeile erscheint kein Betrag mehr.

16. Wenn Sie, wie oben beschrieben, die Eingabe Taste drücken, bis sich der Cursor hinter der Leerzeile
befindet, so springt der Cursor zum nächsten Buchung. Dadurch wird der mehrteilige Vorgang
geschlossen; er kann jedoch auch manuell geschlossen werden, indem Sie die Schaltfäche Vollständig
anklicken oderAktionen → Mehrteilige Buchung.

Eine Buchung mit unterschiedlichen
Währungen eingeben

Jede Buchung, deren Teilbuchungen auf unterschiedliche Währungen lauten, erfordert einen Wechselkurs,
um zwischen den beiden umzurechnen. Weitere Informationen finden Sie in Kapitel 10 von GnuCash
Kurs und Konzepte.

Kontenbücher für Konten des Typs Aktienkonto oder Investmentfonds enthalten die vier Spalten Anteile,
Preis, Kauf und Verkauf (die letzten beiden sind Soll bzw. Haben wenn Sie in den GnuCash Einstellungen
für das Konto die Buchungsüberschriften aus Rechnungswesen aktiviert haben). Geben Sie zwei beliebige
Werte ein und GnuCash berechnet den anderen für Sie; wenn Sie 3 eingeben und das Ergebnis nicht
ausgeglichen ist, fragt GnuCash, welcher Wert geändert werden soll, damit der Buchungsteil ausgeglichen
ist.

Kontobücher anderer Typen haben nur Haben und Soll (Die Namen werden je nach Kontotyp
unterschiedlich sein, wenn Sie Buchungsüberschriften aus Rechnungswesen nicht aktiviert haben.) und
nutzen den Buchen-Dialog, bei dem die meisten Felder deaktiviert sind, um eine Buchung entweder zu
einem Wechselkurs oder Zum Betrag (der Betrag in der anderen Währung) zu erfassen. Bitte lesen Sie
(„Währungsbuchung“) für eine ausführliche Beschreibung des Dialogs.

Anmerkung

Beim Tätigen einer Buchung oder Festlegen eines Wechselkurses kann der Preis für den
Buchungstag in dem Kurs-Datenbank aktualisiert werden. Vergleiche „Price Editor“ für Details.

Buchung bearbeiten
Zur Änderung einer Buchung müssen Sie nur den zu ändernden Buchungsteil auswählen. Sobald Sie
die Änderungen vorgenommen haben, drücken Sie entweder die Eingabe Taste, betätigen die Eingeben
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Schaltfläche oder den MenübefehlBuchung → Buchung eingeben, und der Cursor springt automatisch zur
nächsten Zeile bzw. zur nächsten Buchung.

Um für die Bearbeitung eine detailliertere Ansicht die Buchung zu erhalten, betätigen Sie die Vollständig
Schaltfläche in der Werkzeugleiste oder wählen SieAktionen → Mehrteilige Buchung.

Buchung löschen
Soll eine Buchung aus dem Kontobuch entfernt werden, wählen Sie die Buchung aus und drücken Sie
entweder die Löschen Schaltfläche in der Werkzeugleiste oder verwendenen SieBuchung → Buchung
löschen. Es öffnet sich ein Dialogfenster, um das Löschen zu bestätigen, sofern die Einstellung nicht
geändert wurde. Das Fenster bietet zwei Optionen: Antwort speichern und nicht wieder anzeigen. und
Antwort speichern und in dieser Sitzung nicht wieder anzeigen. Die Antwort wird entsprechend dem
ausgewählten Kontrollkästchen gespeichert. Die Voreinstellung kann auch mittelsAktionen → Warnungen
zurücksetzen. „Warnungen zurücksetzen…“ rückgängig gemacht werden.

Teile einer Buchung können auch entfernt werden, indem Sie die Schaltfläche Vollständig auf der
Werkzeugleiste oder durch Auswahl vonAktionen → Mehrteilige Buchung. Die Teilbuchung, die entfernt
werden soll, kann dann zum Löschen ausgewählt werden.

Stornobuchung hinzufügen
In der formellen Buchhaltung sollten Buchungen niemals gelöscht oder geändert werden. Stattdessen,
wenn ein Fehler gemacht wird, bleibt die ursprüngliche Buchung im Buch, und eine Stornobuchung wird
dem Hauptbuch hinzugefügt. Diese Stornobuchung stellt den Zustand des Hauptbuchs vor dem Fehler
zurück, so dass der Benutzer die Buchungen wieder korrekt eingeben kann.

Natürlich kann ein Benutzer Stornobuchungen durchaus manuell eingeben; GnuCash enthält dafür jedoch
einen Menüoption (Buchungen → Stornobuchung hinzufügen), der die Stornobuchung schnell für Sie
anlegen kann. Diese Option erscheint nur, wenn Sie sich in einem Kontobuch befinden. Wenn Sie eine
Buchung ausgewählt haben, die storniert werden soll, brauchen Sie nur diesen Menüpunkt zu wählen, und
es wird sofort ein Duplikat der Buchung erstellt, die die aktive Buchung storniert.

Anmerkung

Die Stornobuchung wird in dem Konto mit dem aktuellen Datum angelegt. Bei Bedarf können Sie
die neue Buchung am Ende des Kontobuches platzieren und erläuternde Notizen dazu hinzufügen.

Buchungsteil entfernen
Beim Entfernen von Teilen einer Buchungen werden alle Buchungszeilen mit Ausnahme derjenigen
gelöscht, die das aktuell geöffnete Konto berührt. Dies ist nützlich, um eine frühere mehrteilige Buchung
wiederzuverwenden, dessen Buchungsteile geändert werden müssen. (Beachten Sie, dass hierfür nicht
unbedingt der mehrteilige Vorgang geöffnet werden muss. Jedoch wird so die Wirkung besser erkennbar.)

1. Wenn Sie sich in der „einzeiligen“ Ansicht befinden, drücken Sie die Taste Vollständig in der
Werkzeugleiste oder wählen SieAktionen → Mehrteilige Buchungum die Buchung zu öffnen.

2. Verwenden SieBuchungen → Andere Buchungsteile löschen. Es öffnet sich ein Dialogfenster, um das
Löschen zu bestätigen, sofern die Einstellung nicht geändert wurde. Das Fenster bietet zwei Optionen:
Antwort speichern und nicht wieder anzeigen. und Antwort speichern und in dieser Sitzung nicht
wieder anzeigen. Die Antwort wird entsprechend dem ausgewählten Kontrollkästchen gespeichert. Die
Voreinstellung kann auch mittelsAktionen → Warnungen zurücksetzen. „Warnungen zurücksetzen…“
rückgängig gemacht werden.
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3. Alle berührten Konten mit ihren Buchungsdaten werden entfernt, mit Ausnahme des aktuell geöffneten
Kontos.

4. Der Buchungsbetrag ist nun nicht ausgeglichen. GnuCash weist darauf mit grauen Kästchen in den
Betragsspalten hin und zeigt den Fehlbetrag in der letzten, leeren Zeile an.

5. Bearbeiten Sie den Geschäftsvorgang, indem Sie die neuen Buchungsdaten eingeben.

Buchung kopieren
Um Buchungen zu kopieren, können Sie das Menü Buchung verwenden. In dem Menü Buchung gibt es
die Befehle Buchung ausschneiden, Buchung kopieren und Buchung einfügen, mit denen ein kompletter
Geschäftsvorgang ausgeschnitten oder kopiert und anschließend in einer neuen Zeile eingefügt werden
kann. Bei dieser Methode wird als Datum das benutzt, welches in der leeren Zeile für neue Buchungen
steht.

Der MenüpunktBuchung → Buchung duplizierenoder die Schaltfläche Duplizieren in der Werkzeugleiste
bietet, im Gegensatz zur Methode Kopieren die Möglichkeit, ein anderes Datum zu wählen.

• Wählen Sie den zu duplizierenden Geschäftsvorgang aus.
• Wählen SieBuchung → Buchung duplizieren
• Ein Dialogfenster mit dem Titel Buchung duplizieren verlangt die Eingabe eines neuen Datums und

einer Nummer für die Buchung.
• Wählen Sie OK um die Buchung zum Kontobuch hinzuzufügen.

Setzen des Abgleichstatus (Feld A) einer
Buchung.

Im Kontobuch von GnuCash gibt es eine Spalte mit der Bezeichnung A. Dieses Feld zeigt den Status einer
Buchung an. Mögliche Werte sind:

n Neu. Dies ist der Standardwert, wenn eine Buchung erstellt wird.
b Bestätigt. Der Status kann entweder manuell oder durch einen Importprozess zugewiesen werden.
j Ja, abgeglichen. Dieser Status wird ausschließlich durch den Abgleichprozess vergeben (siehe „Konto

mit einem Kontoauszug abgleichen“). Beschränkt optional die Notwendigkeit einer Bestätigung
hinsichtlich der Bearbeitung von Feldern in dieser Buchung.

f Fixiert. Derzeit nicht implementiert
u Ungültig. Der Status wird manuell mit dem MenüpunktBuchung → Buchung ungültig machen(siehe

auch „Kontobuch - Buchung-Menü“) einer Buchung zugewiesen oder freigegeben und gilt für jede Zeile
in der Buchung. Es verbirgt die meisten Buchungsdetails, löscht sie aber nicht. Wird eine Buchung
für ungültig erklärt, so ist ein Grund anzugeben, der rechts neben den Buchungsnotizen erscheint. Die
Notizen und die Begündung sind nur sichtbar, wenn Sie Folgendes aktiviert habenAnsicht → Zweizeilig.

Zu anderem Konten wechseln
Bei der Arbeit im Kontobuch ist es häufig nützlich, ein Konto und gleichzeitig auch das Gegenkonto
einsehen zu können. Dies ermöglicht GnuCash ihnen, indem Sie die Schaltfläche Springen in der
Werkzeugleiste oder den MenübefehlAktionen → Zum Gegenkonto springenin der Anzeige für das
Kontobuch verwenden.

Wählen Sie die gewünschte Buchung im Kontobuch betätigen entweder die Springen Schaltfläche oder
wählenAktionen → Zum Gegenkonto springenim Menü um zugehörigen Gegenkonto in einem neuen
Fenster zu öffnen. Wenn die Buchung mehr als ein Konto berührt, müssen Sie zuerst alle Buchungsteile
anzeigen und das Gegenkonto, zu dem gesprungen werden soll, auswählen
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Buchungen terminieren
Terminierte Buchungen bieten die Möglichkeit, Buchungssätze automatisch zu einem bestimmten
Zeitpunkt in das Kontobuch einzugeben. Mit dem „Bearbeiten von terminierten Buchungen“ lassen sich
Buchungen erstellen und bearbeiten, die automatisch in das Kontobuch eingefügt werden sollen. Dies
erfolgt in Kombination mit dem „Since Last Run Assistant“, mit die anstehende Buchung überprüft und
bearbeitet werden kann. Der Assistent Hypothek & Darlehen („Mortgage & Loan Repayment Assistant“)
dient zum Anlegen einer terminierten Buchung für die Rückzahlung eines Darlehens mit Zinseszins.

Die einfachste Art, eine terminierte Buchung anzulegen, ist die Verwendung eines vorhandenen
Buchungssatzes aus dem Kontobuch als Vorlage. Wählen Sie den Buchungssatz, welchen Sie als Vorlage
verwenden wollen, und anschließend entweder die Schaltfläche Terminiert in der Werkzeugleiste oder den
MenübefehlAktionen → Terminiert…. Anschließend öffnet sich das Dialogfenster Terminierte Buchung
erstellen.

Name Geben Sie hier einen Namen für die terminierte
Buchung an. Dieser wird dann im Feld Beschreibung
des Buchungssatzes verwendet.

Häufigkeit Wählen Sie die gewünschte Zeitspanne zwischen
den regelmäßigen Erfassungsterminen. Die Daten,
zu denen die Buchungen dementsprechend erfasst
würden, erscheinen im Kalenderbereich auf der
rechten Seite.

Anfangsdatum Wählen Sie ein Datum, zu dem die terminierte
Buchung beginnen soll.

Endet nicht Diese terminierte Buchung hat kein Enddatum.
Enddatum Wählen Sie ein Datum, an dem die terminierte

Buchung enden soll.
Anzahl des Auftretens Geben Sie an, wie oft die terminierte Buchung in das

Kontobuch eingegeben werden soll.

Die Schaltfläche Erweitert… öffnet den Editor Terminierte Buchungen bearbeiten. Dieser wird im
Abschnitt „Bearbeiten von terminierten Buchungen“ ausführlich beschrieben.

Übersicht der terminierten Buchungen
Eine Übersicht über die terminierten Buchungen kann aus der Kontenübersicht oder aus dem Kontobuch
heraus mit dem MenübefehlAktionen → Terminierte Buchungen → Terminierte Buchungen Editor…
geöffnet werden.

Die Übersicht für terminerte Buchungen dient dazu, auf eine Liste der geplanten Buchungssätze
zuzugreifen um sie zu erstellen, zu bearbeiten oder zu löschen. Sie bietet auch einen Kalender, der
anstehende geplante Buchungen anzeigt.

Der obere Bereich des Fensters enthält die Liste der geplanten Buchungen die derzeit eingerichtet sind. Es
listet die Namen der Buchung auf, ob die Terminierung aktiviert ist und mit welcher Häufigkeit (Monat
und Tag) sowie wann die Buchung das letzte Mal erstellt wurde und wann die Buchung erneut ansteht.

Auf der rechten Seite des Fensters befindet sich eine Abwärtspfeil-Schaltfläche, mit der ein Menü
geöffent wird um die Auswahl der in der Liste angezeigten Merkmale zu ermöglichen. Wenn Sie den
entsprechenden Eintrag markieren, wird das Merkmal aus der Anzeige entfernt.

Die Werkzeugleiste des Fensters enthält drei Schaltflächen um terminierte Buchungen neu zu erstellen,
zu bearbeiten und zu löschen. Die Neu und Bearbeiten Schaltflächen öffnen den Terminierte Buchungen
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bearbeiten Assistenten. Löschen entfernt die ausgewählte Buchung. Die gleichen Möglichkeiten bietet das
MenüTerminiert → Neu/Bearbeiten/Löschen.

Unterhalb der Liste der geplanten Buchungen befindet sich eine Kalenderübersicht mit den
Bevorstehenden Buchungen. Hier werden bis zu maximal 12 Monaten im Voraus die bevorstehenden
terminierten Buchungen angezeigt. Die farbige Markierung des Datums zeigt an, für welche Tage
Buchungen geplant sind. Wenn Sie den Kalenderbereich anklicken und den Mauszeiger über jedes einzelne
Datum bewegen, erscheint ein kleines Dialogfenster, welches die Geschäftsvorgänge anzeigt die für den
jeweiligen Tag terminiert sind. Um den Schwebedialog zu schließen, klicken Sie ein weiteres Mal.

Bearbeiten von terminierten Buchungen

Anmerkung

Wenn Sie in der Übersicht der Terminerten Buchungen die Schaltfläche Neu betätigen oder
Sie markieren eine Buchung aus der Liste aus und drücken Bearbeiten, so wird der Assistent
Terminierte Buchungen bearbeiten aufgerufen.

Das Fenster Terminierte Buchungen bearbeiten enhält im oberen Bereich das Eingabfeld Name und
darunter einen großen Bereich mit den drei Registerkarten Übersicht, Häufigkeit und Buchungsvorlage.

Der Eintrag in das Feld Name wird als Beschreibung in die terminierte Buchung an übernommen.

Nachfolgend werden die Funktionen auf den drei Register näher beschrieben.

Übersicht In der Übersicht haben Sie die Möglichkeit die Optionen und das
Auftreten für die terminierte Buchung zu konfigurieren.
Optionen Mit den hier beschriebenen Optionen können

Sie das Verhalten für die Durchführung der
terminierten Buchungen steuern.
Aktiv Mit

diesem
Schalter
können
Sie
festlegen,
ob
die
terminierte
Buchung
aktiviert
ist,
also
ausgeführt
werden
soll.

Automatisch erstellen Mit
diesem
Schalter
können
Sie
festlegen,
ob
GnuCash
die
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Buchung
automatisch
für
Sie
anlegen
soll.

Bei Erstellung benachrichtigen Ist
nur
aktiv
wenn
die
Option
Automatisch
erstellen
ausgewählt
ist.
Hiermit
können
Sie
angeben,
dass
Sie
vor
der
automatischen
Ausführung
der
terminerten
Buchung
benachrichtigt
werden.

Im Voraus erstellen Wählen
Sie
aus,
wieviele
Tage
vor
dem
geplanten
Datum
die
Buchung
ausgeführt
werden
soll.

Im Voraus erinnern Hier
können
Sie
angeben,
wieviele
Tage
vor
Durchführung
Sie
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eine
Erinnerung
über
die
anstehende
Buchung
erhalten
wollen.

Auftreten Hier werden die Wiederholungen für die
terminierte Buchungen eingestellt.

Immer Die terminierte Buchung wird
entsprechend der Angaben im
Register Häufigkeit ausgeführt.

Bis Auswahl eines Datums bis zu
dem die terminierte Buchung
ausgeführt wird.

Für Die Anzahl der noch zu
tätigen Buchungen sowie der
auszuführenden Buchungen.

Häufigkeit Mit den Feldern auf der Registerkarte Häufigkeit können die Anzahl
und die Art der Wiederholungen für die terminierte Buchung definert
werden. Auch diese Ansicht ist in drei Bereiche gegliedert deren
Aussehen von der Auswahl im Feld Häufigkeit abhängt.

Der Minikalender im unteren Berich gibt einen Überblick, an
welchem Datum und mit welchem zeitlichen Abstand zueinander die
Buchungen ausgeführt werden.

Häufigkeit Das Feld für die Häufigkeit stellt
eine Auswahlliste für regelmäßige
Wiederholungen zur Verfügung. Mit
Anfangsdatum wird der Beginn der
terminierten Buchungen festgelegt.

Keine Die
Buchung
besitzt
„keine“
Terminierung.

Einmal Die
terminierte
Buchung
wird
„einmal“
am
Anfangsdatum
ausgeführt.

Täglich Bei
Auswahl
von
„Täglich“
erscheint
ein neues
Feld für
die
Angabe
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des
tageweisen
Intervalls,
d.h. die
Buchung
wird alle
x Tage
beginnend
mit dem
Anfangsdatum
ausgeführt.

Wöchentlich Soll eine
Buchung
„wöchentlich“
wiederholt
werden,
so kann
im Feld
alle x
Wochen
das
Intervall
eingestellt
werden
und
zusätzlich
an
welchem
Wochentag
ab dem
Anfangsdatum
die
terminierte
Buchung
erfolgen
soll.

Halbmonatlich Bei einer
„halbmonatlichen“
Terminierung
werden
zwei
Buchungen
pro
Monat im
Intervall
von alle
x Monate
erstellt.
Mit den
Auswahlfeldern
Zuerst am
und dann
am
können
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Sie die
Terminierung
detailiert
steuern.
Sie
können
entweder
gezielt
den Tag
eines
Monats
auswählen,
oder
einen
letzten
Wochentag
festlegen.

Mit den
beiden
Feldern
außer am
Wochenende
können
Sie die
Planung
so
justieren,
dass
GnuCash
die
terminierte
Buchung
nur an
Wochentagen
vornehmen
soll.

Monatlich Ist eine
„monatlich“
terminierte
Buchung
gewünscht,
so kann
hier
ebenfalls
das
Intervall
mit alle
x Monate
eingestellt
werden
und
zusätzlich
an
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welchem
Tag.

Auch hier
kann mit
dem Feld
außer am
Wochenende
die
Planung
für die
Ausführung
der
terminierte
Buchung
feinjustiert
werden.

Buchungsvorlage Wenn Sie den Reiter Buchungsvorlage öffnen, dann sehen Sie eine
Art Kontobuch in dem Sie eine leere Buchung als Vorlage für die
terminierten Buchungen erstellen. Wird die Buchung von GnuCash
an dem gewünschten Termin ausgeführt, wird sie entsprechend
dieser Vorgaben in das Kontobuch eingetragen.

Menüleiste und Werkzeugleiste Die
Elemente,
die in
der
Menüleiste
und
Werkzeugleiste
zum
Bearbeiten
der
Buchungsvorlage
zur
Verfügung
stehen,
sind im
Kapitel
„Menüleiste“
beschriebenen.

Buchungsansicht Im
Bereich
Buchungsvorlage
können
Sie die
Buchungen
so
einrichten,
wie sie
in das
Kontobuch
eingegeben
werden
soll.
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Schecks drucken
In GnuCash können Sie Schecks aus dem Kontobuchfenster heraus bedrucken. GnuCash bietet
die Möglichkeit, Schecks im Standard-Quicken-Format (US-Letter-Papierformat) oder in einem
benutzerdefinierten Scheckformat zu bedrucken. Auch die Scheckposition und das Datumsformat sind
vom Benutzer definierbar.

Um die Funktion zum Drucken eines Schecks in GnuCash zu benutzen, wählen Sie die Buchung aus, für die
Sie einen Scheck bedrucken wollen, und wählen SieDatei → Schecks drucken… (Strg+P). Anschließend
öffnet sich das Dialogfenster Scheck drucken um die ausgewählte Buchung zu drucken.

Wollen Sie mehrere Schecks in GnuCash drucken, führen Sie erst eine Suche aus, um die Buchungen
zu finden, die Sie drucken möchten. Mit dem Suchergebniss im aktuellen Fenster gehen Sie zuDatei
→ Schecks drucken… (Strg+P). Dadurch wird ebenfalls der Dialog Scheck drucken geöffnet, um alle
Buchungen des Suchergebnis zu drucken.

Das Dialogfenster Scheck drucken hat zwei Karteiseiten. Die erste Karteiseite Optionen dient der
Einstellung der Optionen, um einen Scheck zu bedrucken. Die zweite Karteiseite Benutzerdefiniertes
Format ermöglicht es, die Position der verschiedenen Felder auf dem Scheck festzulegen. Es kann sinnvoll
sein, zunächst einen Test-Scheck auf leerem Papier zu drucken und mit dessen Hilfe die benötigten
Anpassungen vorzunehmen.

Die Standardauswahl unter Optionen ist „Quicken/Quickbooks (tm) US-Letter“.

Scheckformat Versuchen Sie zuerst das Quicken-Format.
Wählen Sie den Eintrag „Benutzerdefiniert“
wenn Sie ein anderes Druckformat benutzen
wollen.

Scheckposition Legt fest, ob der obere, mittlere oder untere
Scheck auf der Seite bedruckt werden soll.
Benutzen Sie „Benutzerdefiniert“, falls die
Positionierung der Schecks auf der Seite
fehlerhaft ist.

Schecks auf der ersten Seite Wollen Sie Schecks für mehrere Buchungen
gleichzeitig drucken, so können Sie hier
angeben, ob mehrere Scheckformulare auf
einer Seite ausgedruckt werden sollen.

Datumsformat Die Voreinstellung wird in den GnuCash
Einstellungen im Abschnitt Zahl, Datum,
Zeit festgelegt. Wählen Sie hier ein
abweichendes Datumsformat aus. Sie können
dieses auch mit den Optionen Monate
und Jahre modifizieren. Die Einstellung
„Benutzerdefiniert“ ermöglicht es, das
Datum im Feld Format zu spezifizieren
(%d bedeutet Tag, %m bedeutet Monat,
%Y bedeutet Jahr). Eine Beispieldarstellung
des gewählten Formats wird im unteren
Fensterbereich angezeigt.

Adresse Wenn Sie einen einzelnen Scheck
drucken wird hier die Adresse des
Zahlungsempfängers eingestellt, wenn das
Scheckformat ein Feld dafür vorsieht.

100



Arbeiten mit Buchungen

Die Karteiseite Benutzerdefiniertes Format ist in zwei Beriche unterteilt. Im oberen Eingabebereich
(oberhalb der Trennlinie) wird das „benutzerdefinierte Scheckformat“ definiert. In zwei Spalten geben Sie
die X- und die Y-Koordinaten für jedes einzele Felder auf dem Scheck an. Der Koordinatenursprung ist
die linke obere Ecke der Seite. Die Positionsangaben definieren sich wie folgt: x = 0 am linken Rand des
Schecks und wird nach rechts größer und y = 0 am oberen Rand des Schecks und nimmt nach unten hin zu.

• Zahlungsempfänger
• Datum
• Betrag (in Worten)
• Betrag (in Zahlen)
• Adresse
• Bemerkung
• Buchungstext
• Buchungsteile Betrag
• Buchungsteile Buchungstext
• Buchungsteile Konto

Der zweite Teil (unterhalb der Trennlinie) enthält Felder zur korrekten Positionierung des gesamten
Schecks auf der Seite.

Verschiebung Hiermit wird der Abstand des Schecks von der linken oberen Ecke bestimmt.
Drehung Dreht den Scheck im Uhrzeigersinn um den angegebenen Winkel.
Maßeinheit Gibt die Maßeinheit an, die für alle Eingabefelder auf dieser Karteiseite

Benutzerdefiniertes Format verwendet wird.

Mit der Schaltfläche Format speichern können Sie Ihre mühselige Arbeit belohnen. Es öffnet sich der
Dialog Benutzerdefiniertes Scheckformat speichern in dem Sie einen Namen für dieses Scheckformat
angeben können. Dieser Name wird in dem Auswahlfenster Scheckformat des Scheck drucken-Fenster
ergänzt. Wenn Sie den Namen eines existierenden Scheckformats wählen, wird dieses überschrieben.

Sobald Sie OK im Dialog Scheck drucken drücken, wird der GnuCash Dokumenten-Dialog angezeigt.
Wählen Sie den richtigen Drucker und drücken Sie OK, um den Scheck auszudrucken.

Importieren von Buchungen
Importierte Buchungen werden in der Regel auf ein bestimmtes Konto in Ihrer Kontenübersicht gebucht.
Im Folgenden wird dies als Import- oder Basiskonto bezeichnet. Abhängig von dem Importformat kann
die Kontobezeichnung in den zu importierenden Daten angegeben sein. Es ist normalerweise der erste
Buchungsteil der importiert wird.

Alle Buchungen müssen ebenfalls ein Zielkonto für alle Buchungsteile die mit der Buchung verbunden sind
enthalten. Diese können, abhängig von der Datenquelle und dem Format der Daten, in den importierten
Daten beschrieben sein. Wenn dies nicht der Fall ist versucht GnuCash, vorzugsweise auf Basis der
Importhistorie, die Buchungen einem Konto zuweisen, indem die Inhalte in den importierten Daten mit
Buchungen verglichen werden, die im Importer mit früheren Kontenzuweisungen zugeordnet wurden. Sie
können die automatische Zuweisung jederzeit außer Kraft setzen und die Zuweisung überschreiben oder,
wenn keine automatische Zuweisung möglich ist, ein Konto manuell zuweisen.

Bei mehrzeiligen Buchungen, die aus GnuCash im CSV-Format exportiert werden, werden normalerweise
sowohl das Import- als auch das Zielkonto für die Buchungsteile in der Datendatei angegeben.

Importformate
GnuCash ermöglicht den Import von Buchungen sowohl in einer Vielzahl an strukturierten Formaten
für den Austausch von Finanzdaten als auch im unstrukturierten CSV-Format, ein einfaches Text-
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Tabellenformat, das häufig für den Import und Export von Daten in und aus Tabellenkalkulationen
verwendet wird.

QIF (.qif) Quicken® Interchange format - Daten aus der Finanzsoftware Quicken®
importieren

OFX/QFX (.ofx,.qfx) Open Financial eXchange-Format (QXF ist eine von Intuit/Quicken®
entwickelte Version von OFX)

CSV (.csv) Durch Kommata getrennte Werte

MT940 SWIFT MT940 Kontoauszug zum Tagesende

MT942 SWIFT MT942 Zwischenkontoauszug

DTAUS (.DTAUS) Datenträgeraustauschverfahren

Anmerkung

Dateien, die diese Formate beschreiben, verwenden nicht unbedingt die oben genannten
Dateierweiterungen.

Auf die Importfunktionen der vorgenannten Dateiformate, und noch weitere Möglichkeiten zum
Importieren anderer Datentypen, kann über das UntermenüDatei → Importierenzugegriffen werden.

Import Einstellungen

Die Vorgaben für die Import Einstellungen, die der Benutzer im GnuCash Einstellungen DialogBearbeiten
→ Einstellungenfestlegen kann, wirken sich auf das Importieren der Buchungen aus den unten
beschriebenen Dateien aus.

Importieren von QIF Dateien

Um Daten aus Quicken®, MS Money® oder anderen Programmen zu importieren, die das QIF(Quicken®
Interchange Format) verwenden, müssen Sie Ihre Daten zunächst in eine QIF-Datei exportieren. Eine
Möglichkeit, dies zu tun, ist der Export jedes Konto als eine separate QIF-Datei. Eine einfachere
Möglichkeit, die ab Quicken® 98 verfügbar ist, besteht darin alle Konten auf einmal in eine einzige QIF-
Datei zu exportieren. Prüfen Sie im Handbuch Ihres Programms, ob diese Option verfügbar ist.

Wenn Sie QIF-Dateien importieren wollen, wählen SieDatei → Importieren → QIF-Datei importieren…aus
dem Menü, um das unten abgebildete Dialogfeld „QIF-Datei importieren“ zu öffnen.
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Abbildung 6.3. Der Assistent zum Importieren von QIF-Dateien

Dialogführung

In jedem Fenster kommen diese Navigationsschaltflächen zur Anwendung:

Abbrechen Beendet den QIF-Dateien Import Assistenten.
Zurück Geht zum vorherigen Schritt.
Weiter Geht zum nächsten Schritt.

Anmerkung

Die vorgenannten Schaltflächen werden erst dann aktiv, wenn die Navigation zum Zielschritt
vom aktuellen Schritt aus gültig ist.

Schritte des Importdialogs

Im linken Fensterbereich ist der Fortschritt des Importvorgangs aufgelistet. Das rechte Fenster enthält
Anweisungen und/oder Steuerelemente zur Durchführung der Vorgänge in dem Schritt, der im linken
Fenster markiert ist. Die einzelnen Schritte des Importvorgangs sind:

QIF-Datei importieren Anzeige erster Informationen. Klicken Sie
auf Weiter um fortzufahren.

Zu ladende QIF-Datei auswählen Öffnen des Datei Auswahldialogs mit der
Schaltfläche Auswählen…. Navigieren Sie
zu der Datei, die Sie importieren möchten,
wählen Sie diese aus und klicken Sie auf
Importieren, dann auf Weiter.

QIF Dateien laden Klicken Sie auf die Start Schaltfläche, und
die Datei wird analysiert und geladen. Wenn
Fehler oder Warnungen auftreten, müssen Sie
eventuell die Datei entfernen, sie bearbeiten
und erneut importieren. Wenn keine Fehler
auftreten, klicken Sie auf Weiter.

Ein Datumsformat für diese QIF-Datei setzen Sie ein Datumsformat (m-d-y oder d-m-y),
das dem Gebietsschema der Quelle Ihrer QIF-
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Datei entspricht. In den USA ist dies im
Allgemeinen m-d-y und in Europa d-m-y.
(„d“ bedeutet Tag, „m“ steht für Monat und
„y“ für Jahr).

Den Namen des Standard QIF-Kontos setzen Wenn die QIF- Datei keinen Kontonamen
angibt, geben Sie einen Kontonamen ein.
Beim Importieren von Daten aus einem
anderen Buchhaltungsprogramm, sollten Sie
den in diesem Programm verwendeten
Namen verwenden.

QIF-Dateien, die geladen wurden Dieser Schritt ermöglicht Ihnen die Liste der
zu importierenden Dateien zu bearbeiten und
zusätzliche Dateien zu laden. Um eine Datei
zu entfernen, klicken Sie auf die Zeile und
dann auf Gewählte Datei wieder schließen.
Um eine andere Datei zu laden, klicken
Sie auf die Schaltfläche Eine weitere Datei
öffnen . Wenn Sie alle Dateien, die Sie
importieren möchten geladen haben, klicken
Sie auf Weiter.

Konten und Aktienanteile Anzeige von Informationen. Klicken Sie auf
Weiter um fortzufahren.

QIF-Konten mit GnuCash Konten zusammenführen QIF-Kontonamen werden nach Möglichkeit
mit GnuCash-Konten verknüpft. Neue
GnuCash-Konten werden erstellt, wenn
keine passende Konten gefunden werden.
Für Aktienanteile werden auch die
erforderlichen Kontenstrukturen angelegt.
Erstellte Konten werden durch Aktivieren
des Kontrollkästchens in der Spalte
Neu gekennzeichnet. Zugewiesene Konten
können bearbeitet werden, indem Sie die
entsprechende Zeile auswählen und und
Sie auf die GnuCash-Konten ändern…
Schaltfläche klicken, um den Dialog zur
Auswahl des Kontos aufzurufen.

Erträge und Aufwendungen Anzeige von Informationen. Klicken Sie auf
Weiter.

Verknüpfe QIF-Kategorien mit GnuCash Konten QIF-Kategorien werden, nach Möglichkeit,
mit GnuCash-Konten abgeglichen. Kann
kein passendes GnuCash-Konten gefunden
werden, so wird ein Neues erstellt. Erstellte
Konten werden dadurch gekennzeichnet, dass
das Kontrollkästchen in der Spalte Neu
aktiviert ist. Wenn Sie nicht sicher sind,
welche Änderungen erforderlich sind, ist
es besser, die GnuCash Kontonamen zu
übernehmen. Diese können nachträglich in
GnuCash geändert werden. Zugewiesene
Konten können bearbeitet werden, indem Sie
die entsprechende Zeile auswählen und auf
die Schaltfläche GnuCash-Konten ändern…
klicken, um den Kontenauswahldialog
aufzurufen.
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Zahlungsempfänger, Buchungstext Anzeige von Informationen. Klicken Sie auf
Weiter um fortzufahren.

Gleiche QIF-Zahlungsempfänger/Buchungstext mit
GnuCash Konten ab

QIF Zahlungsempfänger und Buchungstext
werden nach Möglichkeit mit GnuCash
Konten zusammengeführt. Wenn dies nicht
möglich ist, werden neue Konten erstellt,
was durch das Kontrollkästchen in der
Spalte Neu angezeigt wird. Das zugewiesene
Konto kann geändert werden, indem Sie eine
Zeile auswählen und auf die Schaltfläche
GnuCash-Konten ändern… klicken, um den
Dialog zur Auswahl des Kontos aufzurufen.

Wählen Sie die Währung der QIF-Datei Wählen Sie die gewünschte Währung aus der
Dropdown-Liste und klicken Sie auf Weiter
um fortzufahren.

Handelbare Wertpapiere und Währungen Noch nicht realisiert.
QIF-Import Klicken Sie auf die Schaltfläche Importieren

starten, um den Importvorgang auszuführen.
Wenn der Import durchgeführt ist, wechselt
GnuCash geht zum nächsten Schritt
im Importdialog, um die Konten zu
aktualisieren.

Existierende Buchungen zuordnen Noch nicht realisiert.
Mögliche Duplikate auswählen Noch nicht realisiert.
Aktualisieren Ihrer GnuCash Konten Klicken Sie auf Anwenden um den Import

durchzuführen. Je nach Größe der Datei
kann der Import einige Zeit in Anspruch
nehmen. Daher zeigt ein Fortschrittsbalken
den Prozentsatz der Fertigstellung an. Wenn
der Importvorgang abgeschlossen ist, führt
GnuCash Sie zum Hauptfenster zurück, in
dem nun die Namen der importierten Konten
angezeigt werden sollten.

Andere Funktionen sind derzeit nicht
verfügbar.

Zusammenfassung des QIF-Imports Klicken Sie auf die Schaltfläche Schließen
um den Assistenten zu Beenden.

Importieren von OFX/QFX Dateien

Datei → Importieren → OFX/QFX importieren…öffnet einen Dateiauswahldialog. Navigieren Sie zu der
Datei, die Sie importieren möchten, wählen Sie eine Datei mit der entsprechenden Erweiterung (.ofx
oder .qfx), und drücken Sie dann die Importieren Schaltfläche.

GnuCash öffnet dann das Dialogfeld Konto auswählen, um ein Konto aus Ihrer Kontenübersicht
auszuwählem, das mit einem Kontonamen in der Importdatei übereinstimmen soll. Wählen Sie das
entsprechende Konto aus dem Kontobaum und drücken Sie die Taste OK. Bei einem nachträglichen
Import von Dateien aus demselben Quellkonto bleibt das zugeordnete GnuCash-Konto gespeichert und
das Dialogfeld zur Auswahl des Kontos wird nicht angezeigt.

Als Nächstes wird das Dialogfeld für die „Buchungen nach dem Import zuordnen“ geöffnet, um den
Importvorgang fortzusetzen.

105



Arbeiten mit Buchungen

Importieren von CSV Dateien
Die Auswahl vonDatei → Importieren → Buchungen importieren aus CSV…öffnet den unten abgebildete
CSV-Buchungsimport Assistenten.

Abbildung 6.4. Der CSV-Buchungsimport-Assistent - Einführung

Der CSV-Buchungssimport-Assistent ist weitestgehend selbsterklärend und enthält Informationsfenster
die die Funktionalität beschreiben.

Dialogführung

In jedem Fenster kommen diese Navigationsschaltflächen zur Anwendung:

Abbrechen Beendet den CSV-Buchungssimport-Assistenten.
Zurück Geht zum vorherigen Schritt.
Weiter Geht zum nächsten Schritt.

Anmerkung

Die vorgenannten Schaltflächen werden erst dann aktiv, wenn die Navigation zum Zielschritt
vom aktuellen Schritt aus gültig ist.

Schritte des CSV-Importprozesses

Im linken Fensterbereich ist der Fortschritt des Importvorgangs aufgelistet. Erläuternder Text und die
Bedienelemente zum Durchführen des Schritts werden im rechten Fensterbereich angezeigt. Die Funktion
der Steuerelemente für jeden Schritt werden nachstehend beschrieben, und sind in den erläuternden
Informationen in den Fenstern oder in QuickInfos zu einigen Steuerelementen erklärt. Die Arbeitsschritte
in dem CSV Importprozess sind folgende:

Buchungsimport-Assistent Anzeige erster Informationen. Klicken Sie
auf Weiter um fortzufahren.

Wählen Sie eine Datei, die importiert werden soll Öffnen des Datei Auswahldialogs.
Navigieren Sie zu der Datei, die Sie
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importieren möchten, wählen Sie diese aus
und klicken Sie auf Weiter.

Import Vorschau Das Fenster Importvorschau steuert die
Einstelloptionen für den Import von CSV-
Daten und bietet eine Vorschau der zu
importierenden Daten.

Abbildung 6.5. Der CSV Import Vorschau Bereich

Das Vorschaufenster für den CSV-Import mit Einstellungen zum Importieren der angezeigten Daten.

Importvorschau Steuerelemente

Lade- und Speichern-Einstellungen Wenn
Sie
alle
Importparameter
eingestellt
haben,
können
Sie
diese
Einstellung
speichern,
indem
Sie
in
das
Kombinationsfeld
Lade-
und
Speichern-
Einstellungen
einen
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eindeutigen
Namen
eingeben
und
rechts
neben
dem
Feld
auf
das
Symbol
Speichern
klicken.
Eine
zuvor
definierte
Konfiguration
kann
durch
Auswahl
des
entsprechenden
Eintrags
aus
der
Dropdown-
Liste
ausgewählt
werden,
die
durch
den
Abwärtspfeil
am
rechten
Ende
des
Textfelds
angezeigt
wird.
Dies
setzt
alle
zuvor
getroffenen
Einstellungen
auf
die
gespeicherten
Werte.

Mit
dem
Symbol
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Löschen/
Mülleimer
rechts
neben
dem
Symbol
Speichern
können
Sie
die
gespeicherte
Konfigurationen
wieder
löschen,
die
in
der
Dropdown-
Liste
ausgewählt
ist.

Der
Eintrag
Wählen
Sie
das
Export-
Format
aus
der
Dropdown-
Liste
definiert
eine
Konfiguration,
die
für
den
Export
und
Re-
Import
von
GnuCash
Buchungsdaten
verwendet
wird.

Anmerkung

Verwenden
Sie
diese
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Einstellung,
wenn
Sie
Daten
importieren,
die
Sie
zuvor
aus
GnuCash
exportiert
haben.

Konto Wenn
in
den
Daten,
die
Sie
importieren,
das
Quellkonto
für
die
Buchungen
nicht
angegeben
ist,
kann
ein
Konto
aus
der
Dropdown-
Liste
ausgewählt
werden,
woraufhin
alle
Buchungen
in
das
ausgewählte
Konto
importiert
werden.
Lassen
Sie
das
Feld
leer,
wenn
Ihre
importierten
Daten
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ein
Quellkonto
benennen.

Dateiformat Trennzeichen Wenn
Sie
dieses
Optionsfeld
auswählen,
können
Sie
Zeichen
definieren,
die
zur
Unterscheidung
von
Spalten
in
der
Eingabedatei
verwendet
werden.
Die
Vorgabe
ist
kommagetrennt.
In
Ländern
die
das
Komma
als
Dezimaltrennzeichen
verwenden,
ist
das
Semikolon
als
Spaltentrennzeichen
üblich.
Sie
können
auch
Leerzeichen,
Tabulator,
Doppelpunkt,
Semikolon
oder
Bindestrich
sowie
eine
beliebige
Kombination
davon
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zur
Trennung
von
Spalten
in
der
Eingabedatei
verwenden,
indem
Sie
die
entsprechenden
Kontrollkästchen
auswählen.
Sie
können
auch
eigene
Trennzeichen
definieren,
wofür
Sie
die
gewünschten
Zeichen
in
das
Textfeld
eingeben
und
das
Kontrollkästchen
Benutzerdefiniert
markieren.
Dies
kann
auch
in
Kombination
mit
einem
der
vordefinierten
Trennzeichen
verwendet
werden.

Feste Breite Wenn
Sie
dieses
Optionsfeld
auswählen,
können
Sie
die
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Spaltengrenzen
durch
Doppelklick
an
den
entsprechenden
Positionen
in
der
Anzeige
für
die
Musterdaten
in
der
unteren
Tabelle
einfügen.
Durch
einfaches
Rechts-
Klicken
in
eine
Spalte
wird
diese
verschmälert,
verbreitert
oder
zusammengeführt.

Mehrzeilige Buchungen Wenn
Sie
dieses
Kontrollkästchen
aktivieren,
können
die
Buchungsteile
für
eine
einzelne
Buchung
in
aufeinanderfolgenden
Zeilen
innerhalb
der
Datei
definiert
werden,
wobei
jede
Zeile
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einen
einzelnen
Buchungsteil
beschreibt.
Wenn
nicht
ausgewählt,
dann
wird
angenommen,
dass
jede
Zeile
die
Informationen
für
eine
einzelne
Buchung
einschließlich
einem
oder
zwei
Buchungsteilen
enthält.

Verschiedenes In
dieser
Rubrik
können
Sie
weitere
Einstellungen
für
die
zu
importierende
Datei
vornehmen.
Tooltips
geben
ebenfalls
Informationen
über
die
Einstellung
und
Optionen
enthalten.
Zeichenkodierung Dies

ist
normalerweise
UTF-8,
kann
aber
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bei
Dateien
aus
anderen
Quellen
abweichen.

Datumsformat Dies
ist
nicht
die
Standardeinstellung
für
das
Landesformat,
stellen
Sie
also
sicher,
dass
es
mit
den
zu
importierenden
Daten
übereinstimmt.

Währungsformat Wählen
Sie
das
Format
des
Dezimaltrennzeichens
(Punkt
oder
Komma
oder
anderes)
für
die
Währung,
wenn
der
korrekte
Wert
nicht
durch
die
Sprachumgebung
geliefert
wird.

Zeilen am Anfang ignorieren Wählen
Sie
die
Anzahl
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der
zu
überspringenden
Kopfzeilen
in
der
importierten
Datei.

Zeilen am Ende ignorieren Wählen
Sie
die
Anzahl
der
Zeilen,
die
am
Ende
der
Importdatei
ausgelassen
werden
sollen.

Jede 2. Zeile überspringen Jede
zweite
Zeile
in
der
Importdatei
übersprungen.

Das Importfenster zeigt die zu
importierenden Daten so an, wie sie unter
Verwendung der gewählten Einstellungen
zur Definition von Spalten und Formaten
interpretiert werden. Die Dropdown-Listen in
den Kopfzeilen für jede Spalte des Importes
ermöglichen es Ihnen, eine bestimmte Spalte
der importierten Daten mit einem bestimmten
Feld in der Anzeige einer Buchung in einem
Kontobuch zuzuordnen. Zum Importieren
von Daten, müssen mindesten die Spalten in
den importierten Daten, mit den folgenden
Informationen angegeben werden:

Datum Das
Datum
der
Buchung

Konto Das
Konto,
in
das
die
Buchungen
importiert
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werden
sollen
(oder
legen
Sie
alternativ
das
Basiskonto,
wie
oben
beschrieben,
fest).

Beschreibung Die
Beschreibung
der
Buchung.

Einzahlung oder Abhebung Die
Spalten
für
Einzahlung
und
Abhebung
(bzw.
Soll
und
Haben).

Die Dropdown-Liste der GnuCash-
Buchungsdatenfelder, die einer Spalte der
importierten Daten zugeordnet werden
können, enthält Folgendes:

Keine Die
Spalte
ist
keinem
Buchungsdatenfeld
zugeordnet
und
wird
nicht
importiert.

Datum Stellen
Sie
sicher,
dass
das
Datumsformat
in
der
Spalte
mit
den
üblichen
Format-
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Einstellung
übereinstimmt.

Nummer Eine
für
alle
Teilbuchung
gültige
Referenznummer,
z.B.
die
Rechnungs-
oder
Scheck-
Nummer.

Beschreibung Der
Beschreibungstext
einer
Buchung.

Bemerkung Eine
Bemerkung/
Notiz
zu
der
Buchung.

Buchungswährung/-wertpapier Die
Währung
oder
das
Wertpapier
der
Buchung.

Stornierungsbegründung Die
Angabe,
warum
eine
Buchung
storniert
wurde.

Aktion Eine
Aktion
für
den
Buchungsteil.

Konto Diese
Kopfzeile
sollte
mit
einer
Spalte
abgeglichen
werden,
die,
wenn
vorhanden,
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das
Quellkonto
für
eine
Buchung
angibt.
Andernfalls
legen
Sie
das
Quellkonto
in
dem
Kombinationsfeld
Konto
fest.

Einzahlung Wenden
Sie
diese
Überschrift
auf
eine
Spalte
an,
die
den
Betrag
der
Buchung
enthält.
Positive
Beträge
in
der
Spalte
stellen
im
Allgemeinen
eine
Erhöhung
des
Kontostandes
und
negative
Beträge
eine
Verringerung
des
Saldos
(Aktiva
Konten:
Girokonto,
Sparkonto)
dar.
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In
externen
Kontoauszügen
einer
Bank,
ist
eine
Gutschrift
für
ein
Giro-
oder
Sparkonto
normalerweise
eine
Erhöhung
des
Kontosaldos
und
eine
Belastung
eine
Verringerung
des
Kontostands.
In
den
Augen
der
Banken,
ist
Ihr
Spar-
oder
Girokonto
für
sie
eine
Verbindlichkeit.

Wenn
die
Betragsdaten
in
separaten
Spalten
für
Soll
und
Haben
stehen,
müssen
Sie
für
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die
Spaltenüberschriften
sowohl
„Einzahlung“
als
auch
„Abhebung“
verwenden.

Abhebung Wenden
Sie
diese
Überschrift
auf
eine
Spalte
mit
dem
Betrag
der
Buchung
an
wobei
positive
Beträge
in
der
Spalte
eine
Verringerung
des
Kontosaldos
und
negative
Beträge
eine
Erhöhung
des
Saldos
darstellen
(z.
B.
Passivkonto:
Kreditkarte).

Wenn
separate
Spalten
für
Soll
und
Haben
auf
dem
Konto
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verwendet
werden,
stellen
Sie
sie
gegensätzlich
der
Spalte
ein,
die
für
Einzahlungen
angewendet
wird.

Anmerkung

Möglicherweise
sind
einige
Versuche
erforderlich,
um
die
korrekte
Zuordnung
der
Rubriken
„Einzahlung“
und
„Abhebung“
zu
ermitteln.

Preis Der
Preis
für
Wertpapiere
und/
oder
Buchungen
mit
Währungsumtausch.

Buchungstext Zusätzliche
Spalte
mit
beschreibenden
Informationen,
für
einen
Buchungsteil.
Wenn
er
in
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der
ersten
Zeile
einer
mehrzeiligen
Buchung-
Imports
steht,
wird
es
auf
das
Quellkonto
angewendet.
In
nachfolgenden
Zeilen/
Buchungsteilen
wird
es
auf
das
Gegenkonto
übertragen,
das
in
dieser
Zeile
definiert
oder
ihr
bei
der
Buchungszuordnung
zugewiesen
wurde.

Abgeglichen Auf
eine
Spalte
anwenden,
die
den
Abgleichstatus
der
Buchung
anzeigt.
Dies
gilt
generell
nur
für
Daten,
die
zuvor
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von
GnuCash
exportiert
wurden.

Datum des Abgleichs Auf
eine
Spalte
anwenden,
die
das
Datum
des
Abgleichs
angibt,
im
Allgemeinen
nur
für
von
GnuCash
exportierte
Daten.

Buchungsaktion Eine
Aktion
für
die
Buchung.

Herkunftskonto (Haben) Diese
Überschrift
sollte
auf
eine
Spalte
angewendet
werden,
die
das
Gegenkonto
für
den
zweiten
Buchungsteil
eines
einzeiligen
Imports
und/
oder
für
nachfolgende
Buchungsteile
in
mehrzeiligen
exportierten
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Buchungen
enthält.

Buchungstext Auf
eine
Spalte
mit
beschreibenden
Informationen
für
einen
Buchungsteil
anwenden,
die
das
Herkunftskonto
beschreibt.

Buchung abgeglichen Anwenden
auf
eine
Spalte
mit
Informationen
zum
Abgleichstatus
der
für
einen
Buchungsteil
auf
ein
Herkunftskonto
angegeben
ist.

Buchung-Abgleichen-Datum Anwenden
auf
eine
Spalte,
die
ein
Abgleichdatum
für
einen
Buchungsteil
enthält
das
für
ein
Gegentkonto
relevant
ist,
welches
zuvor
in
Herkunftskonto
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(Haben)
angegeben
wurde.

Das Kontrollkästchen Fehler überspringen
übergeht alle Importzeilen, die Fehler beim
zuweisen der Spalten enthalten.

Wenn Sie mit allen Importeinstellungen
zufrieden sind, speichern sie die
Konfiguration, wenn Sie die gleichen
Einstellungen wieder verwenden wollen, und
danach drücken Sie die Weiter Schaltfläche.

Import-Konten mit GnuCash Konten zuordnen In diesem Fenster können Sie die in den
Kontospalten identifizierten Konten (Konto
und Gegenkonto) den Konten in der GnuCash
Kontenhierarchie (Kontoname) zuordnen.
Doppelklicken Sie auf eine Zeile, um einen
Dialog zur Auswahl des passenden GnuCash
Konto auszuwählen. Wenn Sie zuvor
Buchungen in dieses Konto importiert haben
und die Kontenzuordnungen automatisch
vorgenommen werden können, wird dieses
Fenster nicht angezeigt. Wenn Sie für alle
Konten eine Übereinstimmung ausgewählt
haben, klicken Sie auf die Schaltfläche
Weiter.

Buchungsinformationen Dieser Bereich ermöglicht die Überprüfung
der bisher vorgenommen Einstellungen für
die Dateneingabe. Ein Klick auf Weiter
führt eine Prüfungen der Daten durch.
Wenn es Fehler gibt, werden Sie zum
Fenster Importvorschau zurückgeleitet, um
die Einstellungen zu bearbeiten. Ansonsten
fahren Sie mit dem nächsten Schritt fort.

Buchungen zuordnen Wenn Sie auf "Match Transactions" klicken,
wird das Hauptfenster des „Buchungen
nach dem Import zuordnen“ angezeigt.
Das Import-Modul wird in einem separaten
Abschnitt beschrieben;

Importübersicht GnuCash zeigt eine Zusammenfassung der
importierten Daten an. Klicken Sie auf die
Schließen Schaltfläche, um den Assistenten
zu beenden.

Achtung

Importe von mehrzeilig Buchungen mit unterschiedlichen Währungen und Wertpapieren sind
experimentell und es können derzeit einige Fehler auftreten. Bitte erproben Sie diese und melden
eventuell auftretende Fehler.
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Importieren von MT940 & MT942 SWIFT sowie DTAUS
Dateien

In dem MenüDatei → Importierenstehen die folgenden Einträge zur Verfügung:

MT940 importieren Das Format SWIFT MT940 wird für einen Tagesabschluss
von Banken verwendet, die das SWIFT-Netzwerk für den
Datenaustausch nutzen.

MT942 importieren MT942 wird für einen Zwischenauszug im selben System
verwendet. (in der Zeit seit dem letzten Auszug gesendet)

DTAUS importieren DTAUS ist ein Format das seit 1976 mit 9-Spur-
Magnetbändern und später mit anderen Wechselmedien (z.B.
Floppy Disketten) verwendet wurde.

Anmerkung

DTAUS wird seit dem 1. Februar 2016 von den
Banken nicht mehr unterstützt.

Aus dem GnuCash Menü öffnet sich ein Dateiauswahldialog. Navigieren Sie zu der MT940-, MT942-
oder DTAUS-Datei, die Sie importieren möchten, und klicken Sie dann auf die Schaltfläche Schaltfläche
Importieren. Bei dem ersten Import von Daten eines bestimmten Kontos aus der Importdatei wird GnuCash
einen Kontoauswahldialog anzeigen, in dem Sie ein geeignetes Konto auswählen müssen, in das die
Transaktionen in der Datei importiert werden sollen. GnuCash ordnet die Kontobeschreibung in der
Importdatei dem ausgewählte Konto zu und verwendet sie für zukünftige Importe von demselben Konto.
Die importierten Buchungen werden dann in der „Buchungen nach dem Import zuordnen“ zur Überprüfung
angezeigt.

Buchungen nach dem Import zuordnen

Abbildung 6.6. Buchungszuordnung während eines Importvorgangs

Dies ist eine Darstellung des Assistenten für die Buchungszuordnung nach dem Öffnen einer Import-Datei.

Der Buchungszuordnungsassistent prüft, ob eine importierte Buchung mit einer bereits in GnuCash
vorhandenen Buchung, innerhalb einer vordefinierten Zeitspanne von ungefähr 42 Tagen, für das Konto
in das die Buchung importiert werden soll, übereinstimmt. Eine Übereinstimmungswahrscheinlichkeit
wird auf der Grundlage von Datum, Betrag, Buchungs-IDs (falls vorhanden), Schecknummer (falls
vorhanden) und den Feldern Beschreibung sowie bei Teilbuchungen der Buchungstext berechnet. Eine
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exakte Übereinstimmung erzeugt eine hohe Übereinstimmungswahrscheinlichkeit und kennzeichnet eine
Buchung als übereinstimmend mit einer bestehenden Buchung und muss daher nicht erneut importiert
werden. Gibt es eine geringe Trefferqualität mit bestehenden Buchung, kann der importierte Datensatz
nicht zur Aktualisierung von GnuCash-Buchungen verwendet werden. Diese Entscheidung kann von Ihnen
korrigiert werden.

Wenn keine passende Buchung identifiziert werden kann, wird die Buchung für den Import markiert. Der
Buchungszuordnungsassistent versucht, basierend auf Übereinstimmungen von in Listen gespeicherten
Schlüsselwörtern zuvor importierter Buchungen die den Gegenkonten beim Import zugewiesen wurden,
ein passendes Gegenkonto zuzuordnen.

• Bei einer guten Übereinstimmung wird das Gegenkonto zugewiesen und die Buchung wird als bereit
zum Importieren gekennzeichnet.

• Wenn ein Gegenkonto nicht zugeordnet werden kann, wird die Buchung zum Import und somit
zur manuellen Zuweisung des Gegenkontos durch den Benutzer markiert. Wenn kein Gegnkonto
zugewiesen ist, werden die Buchungen beim Import einem Ausgleichskonto zugewiesen. Damit sollen
Sie darauf Aufmerksam gemacht werden, dass noch ein entsprechendes Konto zugewiesen werden
muss.

Der Buchungszuordnungsassistent wird aufgerufen, wenn Buchungsdaten mit einem der folgenden
Formaten importiert werden:

• QIF
• OFX/QXF
• CSV
• MT940
• MT942
• DTAUS
• Nach einer „Abfrage von Kontoumsätzen“ durch das Online-Banking

Das Fenster verfügt über die folgenden Elemente:

Steurungselemente

Liste der importierten Buchungen Die Tabelle zeigt die importierten Buchungen
an.

Kontospalte anzeigen Kontrollkästchen zur Anzeige des Kontos, in
das die Buchungen importiert werden. Dies
ist die zweite Spalte mit der Bezeichnung
Konto im Bildschirmfoto.

Buchungstextspalte anzeigen Das aktivieren dieses Kontrollkästchens
blendet die fünfte Spalte für die Anzeige des
Buchungstext einer Teilbuchung ein.

Zuordnung-Zeile einblenden Wenn der importierten Buchung
einer vorhandene Buchung automatisch
zugeordnet werden kann, dann wird mit
Aktivieren diese Kontrollkästchens die
zugeordnete Buchung in einer zweiten Zeile
angezeigt.

Hilfe Öffnet ein Hilfefenster für diesen
Assistenten.

Abbrechen Schließt das Fenster ohne die Buchungen zu
importieren.
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OK Importiert die Buchungen und schließt das
Fenster.

Die Liste der importierten Buchungen verfügt über die folgenden Spalten, die für jede der einzelnen
Buchungen die folgenden Informationen anzeigen.

Liste der importierten Buchungen

Datum Das Datum, das mit der importierten Buchung
geliefert wurde.

Account Das Import- oder Basiskonto in das die Buchungen
importiert werden sollen. (optional, siehe oben)

Betrag Der Betrag der Buchung (aufgeteilt auf das Import-
oder Basiskonto).

Beschreibung Die Beschreibung der Buchung.
Buchungstext Der Buchungstext für die Teilbuchung auf das

Import- oder Basiskonto der Buchung. (optional,
siehe oben)

Neu Kontrollkästchen, das festlegt, dass die Buchung
als neue Buchung importiert werden soll.

Ü+Abgl Kontrollkästchen, das anzeigt, dass die Buchung
mit einer bestehenden Buchung übereinstimmt,
aber einige Unterschiede aufweist und die
bestehende Buchung mit den unterschiedlichen,
importierten Inhalte aktualisiert wird.

Abgl Kontrollkästchen, das anzeigt, dass die Buchung
mit einer bestehenden Buchung abgeglichen ist
und nicht importiert wird.

Information Für Buchungen, die mit einer bestehenden
Buchung abgeglichen wurden wird ein farbiger
Balken angezeigt, der die Qualität der
Übereinstimmung angibt.

Zusätzliche Kommentare Eine ergänzende Beschreibung, in welcher Weise
mit den importierten Buchungen verfahren wird.

Zusätzlich zu den Kontrollkästchen wird der Importstatus der einzelnen Buchungen durch die
Hintergrundfarbe der Buchungszeile angezeigt. Der Zustand des Kontrollkästchens, die Hintergrundfarben
und ihre Bedeutung sind in Tabelle 6.1, „Importstatus der Buchungen“ beschrieben.

Tabelle 6.1. Importstatus der Buchungen

KontrollkästchenHintergrundfarbe Bedeutung

gold Keine Übereinstimmungen, zur Eingabe markiert und
kein Gegenkonto zugeordnet – Importieren als eine
neue Buchung. Manueller Eingriff erforderlich, um ein
Überweisungskonto auszuwählen.

Neu dunkelgrün Keine Übereinstimmungen erkannt, zur Eingabe markiert
und ein Übertragungskonto wird zugeordnet – Importieren
als neue Buchung. Der Abgleichungszustand wird beim
Import als bestätigt (b) markiert. Ein Eingreifen ist nicht
erforderlich.
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KontrollkästchenHintergrundfarbe Bedeutung

Ü
+Abgl

dunkelgrün Passt zu einer vorhandenen Buchung, aber nicht genau
hinsichtlich Datum und/oder Betrag – Manueller Eingriff
nicht erforderlich, importieren und aktualisieren. Der
Abgleichungszustand wird beim Import als bestätigt (b)
markiert.

Abgl

dunkelgrün Entspricht einer bestehenden Buchung – Wird nicht
importiert. Der Abgleichungszustand der vorhandene
Buchung wird beim Import als bestätigt (b) angezeigt. Ein
Eingreifen ist nicht erforderlich.

 braun Die Buchung hat eine schlechte Übereinstimmungen und
es wurde keine Aktion gesetzt: – Kann nicht importiert
werden. Eine manuelle Handlung ist erforderlich.

 kornblumenblau Die Zeile ist ausgewählt.

Anmerkung

Die hier abgebildeten Farben sind die Standardwerte für GnuCash, die in
gnucash-fallback-310.css [https://github.com/Gnucash/gnucash/blob/maint/gnucash/gnucash-
fallback-310.css]. Wenn die gtk-3.0-CSS-Dateien geändert wurden, können unterschiedliche
Farben auftreten.

Sie können jederzeit manuell eingreifen, und so

• die Importaktion ändern, indem Sie ein anderes Kontrollkästchen (oder keines) aktivieren,
• und/oder manuell ein anderes Gegenkonto zuweisen

nachdem Sie die zugeordneten Buchungen und Konten sowie die automatisch ausgewählten Aktionen
überprüft haben.

Die gleichzeitige Auswahl mehrerer Zeilen ist für die Liste der importierten Buchungen möglich. Die
folgenden Mausaktionen1können an den Einträgen in der Liste durchgeführt werden:

Button1 Klick Die entsprechende Zeile auswählen (Zeile
wird blau hinterlegt angezeigt).

Button1 Doppelklick Wenn die Buchung für den Import markiert
ist (siehe oben), öffnet sich der Dialog
Konto auswählen, um ein Gegenkonto
auszuwählen, das für den zweiten Teil der
importierten Buchung verwendt wird. In
diesem Dialog können Sie bei Bedarf ein
neues Konto über die Schaltfläche Neues
Konto… anlegen. Wenn die Buchung als
übereinstimmend mit einer existierenden
Buchung zum Importieren oder Aktualisieren
gekennzeichnet ist, wird stattdessen der
„Buchungszuordnungsassistent“ geöffnet,
um die ausgewählten Buchungen zu
prüfen und eine korrekte Übereinstimmung
auszuwählen.

1Die Maustasten werden neutral mit Button1 und Button2 bezeichnet. Bei vielen Benutzern entspricht Button1 der linken und Button2 der rechten
Maustaste. Dies kann durch den Anwender in den Einstellungen des Betriebssystems den Bedürfnissen angepasst werden.
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Strg+Button1 Klick Fügen Sie die Zeile zu einer Auswahl
von Zeilen hinzu (mit blauem Hintergrund
angezeigt), auf die ein gemeinsames
Gegenkonto angewendet werden kann.

Shift+Button1 Klick Wählt alle Zeilen zwischen der zuletzt
ausgewählten Zeile und dieser Zeile aus und
fügt sie der aktuellen Auswahl von Zeilen
hinzu.

Button2 Klick Öffnet ein Popup-Menü, das beim Anklicken
wiederum den Dialog Konto auswählen
zur Auswahl eines Gegenkontos startet,
welches dann auf alle aktuell ausgewählten
Buchungen angewendet wird.

Wichtig

Es ist wichtig, jeder Buchung ein Gegenkonto zuzuordnen, bevor Sie die Buchungen importieren.
Andernfalls werden die Schlüsselwörter aus der importierten Buchung nicht in dem Import-
Zuordnungen Editor, zur zukünftigen Verwendung bei der Zuordnen von Buchungen mit dem
Gegenkonten, abgelegt.

Anmerkung

Beachten Sie, dass „abgeglichen“ in diesem Zusammenhang nicht dasselbe bedeutet wie
„abgeglichen“ im Prozess des Abgleichs eines Kontos mit einem externen Kontoauszug. Der
Abgleichungszustatus einer importierten Buchung wird beim Import einer neuen Buchung auf
„bestätigt“ (b) gesetzt.

Wenn eine Zeile mit einer bestehenden Buchung übereinstimmt oder eine bestehende Buchung aktualisiert
werden soll, wird sie mit einem dunkelgrünen Hintergrund dargestellt. Bei ein Doppelklick mitButton1auf
die Zeile wird der „Buchungszuordnungsassistent“ geöffnet, der Details zu den importierten Daten
anzeigt. Sollte das falsche Gegenkonto zugewiesen sein oder der „Buchungszuordnungsassistent“ liefert
kein gültiges Ergebnis, können Sie die Auswahl des Kontrollkästchens ändern und ein Gegenkonto neu
zuordnen (siehe unten).

Ein Doppelklick mitButton1auf eine als Neu markierte Zeile mit einem dunkelgrünem Hintergrund
und einem zugewiesenen Gegenkonto öffnet den Dialog Konto auswählen, in dem Sie ein zusätzliches
Gegenkonto für den zweiten Buchungsteil auswählen können.

Wenn Sie stattdessen einen Doppelklick mitButton1auf einer als Neu markierten Buchung, die den
zusätzlichen Kommentar „nicht ausgeglichen“ enthält und mit einem goldenen Hintergrund versehen
ist, ausführen, wird ebenfalls der Kontoauswahldialog geöffent, damit Sie der Buchung ein passendes
Gegenkonto zuweisen können.

Ein Gegenkonto einer einzelnen Buchung zuweisen

Die zu bearbeitende Zeile wird durch einen Mausklick mitButton1ausgewählt. Darauf hin wird sie mit
einer kornblumenblauen Hintergrundfarbe angezeigt.

Bei einem doppeltem Mausklick mitButton1auf eine Zeile wird diese ausgewählt und das Dialogfeld Konto
auswählen öffnet sich, in dem Sie ein Gegenkonto zuweisen können. Wählen Sie das gewünschte Konto
im Dialog aus und klicken Sie auf OK. Der Dialog hat die Schaltfläche Neues Konto…, mit der Sie ein
passendes Konto erstellen können, wenn es kein vorhandenes gibt, das als Gegenkonto verwendet werden
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kann. Der Hintergrund der Zeile ändert sich zu dunkelgrün und das zugewiesene Konto wird in der Spalte
zusätzliche Kommentare angezeigt.

Oder alternativ, ein Mausklick mitButton1auf die Zeile gefolgt von einem Klick mitButton2zeigt das
kleine Popup- Fenster Gegenkonto zu Auswahl zuweisen um den Dialog Konto auswählen zu öffnen, das
Gegenkonto auswählen und mit OK bestätigen.

Ein Gegenkonto mehreren Buchungen zuweisen

Manchmal möchten Sie auch mehrere Buchungen zu einem gemeinsamen Gegenkonto importieren.
GnuCash unterstützt die gleichzeitige Auswahl mehrerer Buchungen und der Zuordnung des gleichen
Zielkontos auf alle markierten Buchungen.

Wenn Sie Zeilen in einer Auswahl erfassen, werden sie mit einem kornblumenblauem Hintergrund
markiert.

Nur die Zeilen, in denen das Kontrollkästchen Neu aktiviert ist und die entweder eine dunkelgrüne oder
goldene Hintergrundfarbe haben, können in eine Mehrfachauswahl aufgenommen werden. Zeilen mit
einem braunen Hintergrund oder die bei Ü+Abgl oder Abgl angekreuzten sind können nicht in einer
Mehrfachauswahl markiert werden.

So wählen Sie Zeilen aus und fügen Zeilen zu einer Auswahl hinzu:

• Klicken Sie mitButton1auf die erste Zeile und dann mitStrg+Button1auf weitere Zeilen, um die
Auswahl zu ergänzen.

• ODer klicken Sie mitButton1auf die erste Zeile und dann mitUmschalt+Button1auf eine andere Zeile,
um alle Zeilen dazwischen auszuwählen.

• Die Gummibandfunktion ist ebenfalls aktiviert, so dass Sie auchButton1 gedrückt halten und über
Zeilen ziehen können, um eine Auswahl zu erstellen. Um weitere Zeilen hinzuzufügen, betätigen
SieStrg+Button1und ziehen Sie über weitere Zeilen.

Anschließend klicken Sie mit Button2 auf die markierten Zeilen, um ein Popup-Menü anzuzeigen, und
wählen Sie dann Gegenkonto zu Auswahl zuweisen, um das Dialogfeld Kontoauswahl zu öffnen. Wählen
Sie das gewünschte Gegenkonto (legen Sie bei Bedarf ein neues Konto an) und klicken Sie auf die
Schaltfläche OK in dem Dialog.

Fertigstellen des Imports

Wenn Sie die Gegenkonten für alle importierten Buchungen mit den obigen Methoden zugewiesen
haben (alle Zeilenhintergründe werden hellgrün), überprüfen Sie, ob die zugewiesenen Gegenkonten
korrekt sind und drücken Sie dann die Schaltfläche OK unten in dem Assistenten für die Abbildung 6.6,
„Buchungszuordnung während eines Importvorgangs“. Die für den Import ausgewählten Buchungsteile
werden zu den ausgewählten Quell- und Gegenkonten hinzugefügt.

Die Schlüsselwörter der Buchungen, die einem bestimmten Konto zugeordnet wurden, werden beim
Verlassen des Buchungszuordnungsassistenten gespeichert und dazu genutzt, um bei zukünftigen
Importvorgängen die entsprechenden Gegenkonto automatisch zuzuordnen.

Buchungsauswähler
Mit dem Buchungsauswähler können Sie die automatische Zuordnung einer existierenden GnuCash-
Buchung zu einer zu importierenden Buchung überprüfen und bei Bedarf bearbeiten. Wenn Sie im
Buchungszuordnungsassistent auf eine Buchung, die in der Spalte Abgl markiert ist, einen Doppelklick
mitButton1machen, wird der nachfolgende Dialog geöffnet.
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Abbildung 6.7. Der Buchungsauswähler Dialog

Das Dialogfenster zeigt vorhandene GnuCash-Buchungen an, die mit einer importierten Buchung übereinstimmen.

Im oberen Bereich des Buchungsauswähler werden Details zum ersten Teil der zu importierenden Buchung
angezeigt. Die Spaltenbezeichnungen:

• Konto
• Datum
• Betrag
• Beschreibung
• Buchungstext
• Ausgeglichene Buchung

sind die gleichen und haben die gleiche Bedeutung wie in der Liste der importierten Buchungen
beschrieben, mit der Ausnahme der Spalte Ausgeglichene Buchung, die den Betrag des Ausgleichenden-
Buchungsteils angibt.

Der untere Bereich zeigt die Details der vorhandenen GnuCash Buchungen die mit dieser Buchung
übereinstimmen. Wenn keine Buchungen angezeigt werden, aktivieren Sie das Kontrollkästchen
Abgeglichene anzeigen am unteren Rand des Bedienfelds. Die erste Zeile in diesem Fenster ist
normalerweise die automatisch zugeordnete Buchung mit der höchsten Übereinstimmung. In anderen
Zeilen werden weitere vorhandene Buchungen angezeigt, die auch mit der zu importierenden Buchung
übereinstimmen könnten. Die Spalten in diesem Fensterbereich sind:

Genauigkeit In dieser Spalte wird die Genauigkeit, d.h. die
Übereinstimmung mit vorhandenen Buchungen, für die
einzelnen Buchungen sowohl als Balkendiagramm als auch
als Zahlenwert angezeigt. Ragt der Balken in das Grün
hinein, ist die Übereinstimmung gut. Erstreckt sich der
Balken nur in die roten oder gelben Bereiche, ist die Qualität
der Übereinstimmung eher zweifelhaft.

Datum Das Datum der zugeordneten Buchung.
Betrag Wenn dieser nicht genau mit dem Betrag der zu

importierenden Buchung übereinstimmt, aber ansonsten
die Übereinstimmung hoch ist, wird der Betrag der
importierten Buchung verwendet, um die Vorhandene damit
zu aktualisieren.
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Beschreibung Die Beschreibung der Buchung.
Buchungstext Der Buchungstext einer Teilbuchung.
Abgeglichen Zeigt den Abgleichstatus einer passenden vorhandenen

Buchung an.
Ausstehende Aktion ???

Wenn Sie mit der vorhandenen Buchung, die automatisch abgeglichen wurde, nicht zufrieden sind, klicken
Sie mitButton1auf den Eintrag, der zu der importierten Buchung passt, um diese auszuwählen und dann
auf OK. Die Buchung wird mit „manuell gewählte Zuordnung“ in der Spalte zusätzliche Kommentare
des Buchungszuordnungsassistent gekennzeichnet. Um den Dialog zu verlassen ohne die automatische
Anpassung zu übernehmen, klicken Sie auf Abbrechen.

Import-Zuordnungen Editor
Mit dem Import-Zuordnungen Editor können Sie die Daten bearbeiten, die von GnuCash verwendet
werden, um automatisch ein Gegenkonto im Buchungszuordnungsassistent zuzuweisen. Damit können
Sie die Automatisch (Bayesisch), die Nicht-Bayesische und die Online gewonnen Buchungsinformationen
bearbeiten. Um den Editor zu öffnen wählen SieWerkzeuge → Import-Zuordnungen Editoraus der
Menüleiste.

Abbildung 6.8. Der Import-Zuordnungen Editor

Der Import-Zuordnungen Editor, der typische Einträge für den Bayes-Algorithmus zeigt.

Mit den drei Optionsfeldern oben im Dialogfeld wählen Sie die Art der Daten aus, die angezeigt und
bearbeitet werden:

Steuerungselemente

Automatisch (Bayesisch) Der Bayes-Algorithmus weist ein Herkunfts-
oder Gegenkonto anhand der Häufigkeit
der Zuordnung von Schlüsselwörtern
im Buchungszuordnungsassistent für ein
bestimmtes Herkunftskonto zu (Das Konto, für
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das der erste Buchungsteil der importierten
Buchung bestimmt ist).

Nicht-Bayesisch Der Nicht-Bayesisch-Algorithmus ordnet das
Herkunftskonto auf Grund des Vorkommens
eines Schlüsselwortes in Buchungen, die
einem Herkunfts-/Gegenkonto zugeordnet sind,
zu, erfasst jedoch nicht die Häufigkeit
der Zuordnung. Dies war das ursprüngliche
GnuCash Verfahren zur Buchungszuordnung
und wurde in neueren Versionen durch den
Bayes-Algorithmus abgelöst.

Online Online-IDs sind Zeichenfolgen, die bestimmte
Konten an Hand der Informationen
durch die Onlineabfrage kennzeichnen. Sie
können Kontonummern und spezifische
Institutionskennungen (z.B. Bankleitzahl)
enthalten.

Die Informationen des Bayesischen-Algorithmus

Herkunftskonto-Name Dies ist das Konto, in das eine Buchung
importiert wurde, und ist normalerweise der
erste Teil eines importierten Datensatz. Es
kann entweder im Datensatz selbst oder
während des Importvorgangs für alle zu
importierenden Buchungen angegeben werden.
Die Pfeilsteuerung links neben jedem Eintrag
in dieser Spalte kann verwendet werden, um
alle Daten anzuzeigen, die beim Abgleich eines
Herkunfts- oder Gegenkontos für Buchungen
zugeordnet sind, die dieses Konto als
Herkunftskonto haben.

Zuordnungs-Zeichenfolge In dieser Spalte wird das Schlüsselwort
angezeigt, das mit der Zuordnung des Kontos
in der Spalte Zugeordneter Kontoname als
Herkunfts-/Gegenkonto für Überweisungen auf
das Herkunftskonto zugeordnet wurde.

Zugeordneter Kontoname Der Kontoname in dieser Spalte ist ein GnuCash
Kontoname, der als Herkunfts-/Gegenkonto in
Verbindung mit dem Schüsselwort in der Spalte
Zuordnungs-Zeichenfolge steht.

Wie oft verwendet? Dies ist die Anzahl, wie oft das
Schlüsselwort in der Spalte Zuordnungs-
Zeichenfolge in Verbindung mit dem in
Spalte Zugeordneter Kontoname angegebenem
Herkunfts-/Gegenkonto für die in GnuCash
importierte Buchung aufgetreten ist.

Der Nicht-Bayesische Abgleicher zeigt die gleichen ersten drei Spalten wie der Automatischen (Bayesisch)
Abgleicher, und diese haben die selbe Bedeutung wie zuvor beschrieben. Es speichert allerdings keine
Daten über die Häufigkeit, mit der ein bestimmtes Schlüsselwort mit der Zuweisung eines bestimmten
Übertragungs-/Zielkontos verbunden ist. Der Dialog hat eine zusätzliche Spalte, die den Typ des
importierten Datenfeldes angibt, in dem die Zuordnung aufgetreten ist.

Die Option Online zeigt die gleichen Spalten wie der Nicht-Bayesische Abgleicher.
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Steuerelemente im unteren Bereich

Filter Die Textbox am unteren Rand des Dialogs ermöglicht das Filtern
der angezeigten Daten nach der eingegebenen Zeichenkette sowohl
in der Spalte Zuordnungs-Zeichenfolge als auch in der Spalte
Zugeordneter Kontoname. Die Groß- und Kleinschreibung wird
berücksichtigt.

Alle ausklappen Die Schaltfläche erweitert die Anzeige der Daten in den Zeilen für
alle Konten in der Spalte Herkunftskonto-Name.

Alle einklappen Die Schaltfläche verringert die Anzeige der Daten in den Zeilen für
alle Konten in der Spalte Herkunftskonto-Name.

Löschen Die Schaltfläche Löschen entfernt alle Informationen in den
ausgewählten Zeilen.

Schließen Beendet den Import-Zuordnungen Editor.

Exportieren von Buchungen
GnuCash ermöglicht den Export von Buchungsdaten im CSV-Format mit der optionalen Verwendung
alternativer Spaltentrennzeichen. Buchungen können entweder in einem einzeiligen Format (einfaches
Layout) exportiert werden das nur für Buchungen mit zwei Buchungsteilen verwendet werden kann
und möglicherweise nicht alle Daten exportiert, oder in einem mehrzeiligen Format bei dem zwei
und mehr Zeilen für Buchungen mit zwei oder mehr Buchungsteilen ausgegeben werden, wobei jede
Teilinformation in separaten Zeilen geschrieben werden. Buchungsdaten können entweder aus dem aktuell
aktivem Register oder aus ausgewählten Konten exportiert werden. Die Menübefehle zum Exportieren
von Buchungen sind:

• Datei → Exportieren → Buchungen nach CSV exportieren…
• Datei → Exportieren → Aktives Kontobuch als CSV-Datei exportieren….

Diese Befehle starten den nachfolgend dargestellten Assistenten, um den Export einzurichten. Die beiden
Menüpunkte unterscheiden sich nur dadurch, dass im Letzteren der Schritt Kontenauswahl im linken
Fensterbereich nicht verfügbar ist.

Abbildung 6.9. Assistent für den Export von Buchungen

136



Arbeiten mit Buchungen

Der Assistent für den Export von Buchungen öffnet sich im ersten Schritt und führt die im linken Bereich
aufgeführten Schritte durch:

In jedem Fenster kommen diese Navigationsschaltflächen zur Anwendung:

Dialogführung

Abbrechen Beendet den Assistenten, ohne die Buchungen zu exportieren
Zurück Geht zum vorherigen Schritt.
Weiter Geht zum nächsten Schritt.

Anmerkung

Die vorgenannten Schaltflächen werden erst dann aktiv, wenn die Navigation zum Zielschritt
vom aktuellen Schritt aus gültig ist.

Schritte des Exportdialogs

Export-Einstellungen In diesem Schritt können Sie verschiedene
Optionen für die Formatierung der zu
exportierenden Buchungen wählen.
Optionen Die beiden

Kontrollkästchen
können einzeln
oder
zusammen
ausgewählt
werden:
Anführungszeichen verwenden Umgibt

jedes
Datenfeld
mit
Anführungszeichen.

Einfaches Layout ausgewählt Wenn
dieses
Kontrollkästchen
aktiviert
ist,
werden
die
Daten
der
Buchung,
so
wie
sie
in
der
einzeiligen
Buchunsgansicht
angezeigt
werden,
exportiert
und
einige
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Details
der
Buchungsteile
können
verloren
gehen.
Die
Spaltenüberschriften
für
einen
einzeiligen
Export
der
Buchungen
sind:
1. Datum
2. Kontobezeichnung
3. Nummer
4. Beschreibung
5. Voller

Kategorie-
Pfad

6. Abgeglichen
7. Betrag

mit
Währungszeichen

8. Betrag
9. Kurs/

Preis
Einfaches Layout nicht ausgewählt Wenn

die
Option
einfaches
Layout
nicht
aktiviert
ist,
werden
die
Buchungsdaten
in
einem
mehrzeiligen
Format
exportiert.
Die
Spaltenüberschriften
für
einen
mehrzeiligen
Export
der
Buchungen
sind:

138



Arbeiten mit Buchungen

Daten nur in der ersten Zeile 1. Datum

2. BuchungsID

3. Nummer

4. Beschreibung

5. Bemerkung

6. Währung/
Wertpapier

7. Stornierungsbegründung

Daten in der erste Zeile und weiteren Folgezeilen 8. Aktion

9. Buchungstext

10.Volle
Kontobezeichnung

11.Kontobezeichnung

12.Betrag
mit
Währungszeichen

13.Betrag

14.Abgeglichen

15.Datum
des
Abgleichs

16.Kurs/
Preis

Jede
Zeile
enthält
die
für
einen
einzelnen
Buchungsteil
relevanten
Daten,
wobei
die
Daten
der
ersten
7
Spalten
in
der
ersten
Zeile
auch
für
weitere
Buchungsteile
gelten
und
deshalb
nicht
erneut139
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ausgegeben
werden.

Trennzeichen Diese
Optionsfelder
erlauben die
Auswahl eines
alternativen
Spaltentrenners:

Komma (,) Dies
ist
das
Standard-
Trennzeichen

Doppelpunkt (:) Verwenden
Sie
einen
Doppelpunkt,
um
die
Spalten
zu
trennen

Semikolon (;) Verwenden
Sie
ein
Semikolon,
um
die
Spalten
zu
trennen

Benutzerdefiniert Verwenden
Sie
beliebige
Zeichen
zur
Trennung
der
Spalten,
indem
Sie
diese
in
das
Textfeld
eingeben.

Wenn Sie Ihre Einstellungen vorgenommen
haben, geht es mitButton1auf Weiter zum
nächsten Schritt im Assistenten weiter.

Kontoauswahl Dieser Schritt ermöglicht die Auswahl von
einem oder mehreren Konten und die
Angabe des Datumsbereichs der die zu
exportierenden Buchungen enthält.
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Das Bedienfeld Konten zeigt eine
Kontenstruktur an, in der ein oder
mehrere Konten für den Export ausgewählt
werden können. (Strg-Button1undShift-
Button1können verwendet werden, um
Konten auszuwählen). Die Schaltfläche
Unterkonten auswählen wählt alle
Unterkonten eines markierten Kontos aus.
Die Schaltfläche Alle auswählen wählt alle
Konten in der Kontenstruktur für den Export
aus. Die Anzahl der ausgewählten Konten
wird angezeigt.

Im Datumsbereich können Sie angeben,
ob entweder alle Buchungen oder nur
die Buchungen innerhalb eines beliebigen
Datumsbereichs, für die selektierten Konten,
exportiert werden sollen.

Wählen Sie einen Dateinamen für den Export Es wird ein Dateiauswahldialog, zur Angabe
eines Dateinamens und eines Pfades zu
dem Verzeichnis/Ordner, in dem die Datei
gespeichert werden soll, angezeigt.

Datei jetzt exportieren… Der Dateiname und Pfad der zu
exportierenden Datei und die Anzahl der
zu exportierenden Konten wird angezeigt.
Um den Export fortzusetzen betätigen
SieButton1die Anwenden Schaltfläche.

Exportzusammenfassung Zeigt eine Meldung an, wenn die Datei
erfolgreich exportiert wurde, oder eine
Fehlermeldung mit Debugging Vorschlägen,
wenn nicht.

Online Aktionen
Wichtig

Für jedes Konto, auf dem Sie diese Aktionen ausführen wollen, müssen Sie zuvor einmalig „The
Online Banking Setup Assistant“ durchführen.

Anmerkung

Für die Kommunikation mit Ihrem Geldinstitut werden Ihnen ein Sicherheitsmedium, eine HBCI-
Karte oder die Bankkarte, sowie ein "Geheimnis", oft eine PIN, zur Verfügung gestellt. Da
sich die Sicherheitsmechanismen in ihrer Handhabung unterscheiden, wird in dieser Hilfe nicht
näher darauf eingegangen. Weitere Informationen wurden im Wiki unter Online Banking [https://
wiki.gnucash.org/wiki/De/Online-Banking] von fleißigen Anwendern zusammen getragen.

Tipp

Zu Beginn eines Online-Vorgangs werden Sie zur PIN-Eingabe aufgefordert. In diesem Dialog
wird Ihnen die Möglichkeit angeboten, dass GnuCash sich die Eingabe Ihrer PIN vorrübergehend
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merkt. Es ist wurde seitens der Entwickler sichergestellt, dass die PIN mit Beenden von GnuCash
vergessen wird.

Saldenabfrage… MitAktion → Online Aktion → Saldenabfrage…
wird für das ausgewählte Konto eine
Onlineverbindung zu dem Geldinstitut
aufgebaut und der aktuelle Kontosaldo
abgefragt. Nach kurzer Zeit wird Ihnen, im sich
öffnendem Dialogfenster, der Saldo angezeigt
und Sie können direkt im Anschluss das „Konto
mit einem Kontoauszug abgleichen“.

Abfrage Kontoumsätze… Der MenüpunktAktion → Online Aktion →
Abfrage Kontoumsätze…bietet Ihnen die
Möglichkeit, die Umsätze des in der
Kontenstruktur markierten Onlinekontos, oder
des geöffenten Kontobuchs, abzurufen und
im Anschluss in GnuCash zu importieren. Es
wird der Dialog Online Kontoumsätze abfragen
angezeigt, in dem Sie den Zeitraum für die
Umsatzabfrage näher angeben können.

Datumsbereich der abzurufenden
Buchungen

Von Frühest mögliches Datum Diese
Option
gibt
Ihnen
die
Möglichkeit,
bei
dem
Geldinstitut
die
Umsätze
für
den
maximal
verfügbaren
Zeitraum,
meistens
die
letzten
90
Tage,
abzurufen.

Letztes Abrufdatum Hierbei
werden
die
Buchungen
ab
dem
Zeitpunkt
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des
letzten
Abrufs
bei
der
Bank
abgefragt.

Datum eingeben In
dem
nebenstehendem
Datumsfeld
können
Sie
ein
Datum
eingeben
oder
aus
dem
Kalender
auswählen,
ab
dem
die
Umsatzabfrage
beginnen
soll.

Bis Jetzt Die
Umsätze
werden
bis
zu
dem
heutigem
Datum
abgerufen.

Datum eingeben Geben
Sie
ein
Datum
ein,
oder
wählen
es
aus
dem
Kalender
aus,
um
den
letzten
Tag
für
die
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Kontoumsätze
anzugeben.

Nachdem die Kontoumsätze seitens des
Geldinstituts übertragen wurden, wird der
Assistent „Buchungen nach dem Import
zuordnen“ geöffnet und die Buchungen zur
Prüfung und zum Import aufbereitet.

SEPA Einzelüberweisung… Wenn Sie im Menü den EintragAktion → Online
Aktion → SEPA Einzelüberweisung…wählen,
öffnet sich der Dialog

Online-Auftrag Einzelüberweisung

Empfänger (Pflichtfeld)
Tragen
Sie
hier
den
Namen
des
Empfängers
oder
auch
den
Firmmennamen
ein.

IBAN des Empfängers (Pflichtfeld)
Die
IBAN
des
Empfängers.
Die
Eingabe
wird
validiert.
Solange
die
IBAN
nicht
vollständig
bzw.
fehlerhaft
ist,
wird
ein
optischer
Hinweis
am
rechten
Rand
des
Eingabefeldes
angezeigt.
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BIC des Empfängers (optional)
Die
Angabe
ist
nur
bei
Überweisungen
ins
Ausland
notwendig.

Betrag (Pflichtfeld)
Der
zu
überweisende
Betrag.

Verwendungszweck (Pflichtfeld)
als
Information
für
den
Empfänger,
z.B.
Kundennummer,
Rechungsnummer.

noch Verwendungszweck (optional)
bei
Bedarf,
z.B.
die
Anschrift
des
Auftraggebers.

Auftraggeber Der
Kontoinhaber
ist
voreingestellt,
kann
auch
geändert
werden.

Vorlagen Betätigen
Sie
das
kleine,
nach
unten
zeigende
Dreieck,
vergrößert
sich
der
Fensterbereich
um
eine
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Auswahlliste
und
weitere
Schaltflächen.
Sie
haben
hier
die
Möglichkeit
Ihre
Eingaben
als
Überweisungvorlage
zur
Wiederverwendung
zu
speichern
und
gespeicherten
Vorlagen
per
Doppelklick
auf
einen
Eintrag
abzurufen.
Die
gespeicherten
Angaben
werden
dann
in
die
Felder
der
oberen
Fensterhälfte
als
eine
neue
Einzelüberweisung
eingetragen.
Listenfeld der Vorlagen Hier

werden
ihre
gespeicherten
Überweisungsaufträgen
aufgelistet.

Aktuelle hinzufügen Fügt
die
aktuellen
Informationen
aus
der
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oberen
Fensterhälfte
als
neue
Vorlage
der
Liste
hinzu.
Sie
können
noch
eine
Bezeichnung
für
die
Überweisungsvorlage
angeben.

Höher Den,
in
dem
Listenfeld
der
Vorlagen
markierte
Eintrag,
um
eine
Position
nach
oben
verschieben.

Tiefer Den
markierten
Eintrag
nach
unten
verschieben.

Sortieren Sortiert
alle
Einträge
in
dem
Listenfeld
alphabetisch.

Löschen Löscht
die
markierte
Vorlage.

Sind die Pflichtfelder des Überweisungsauftrags
ausgefüllt wird die Schaltfläche Jetzt ausführen
aktiviert. Darauf hin öffnet sich der, mit
den Überweisungsdaten vorausgefüllte, Buchen
Dialog und Sie haben die Möglichkeit die Daten
für den Überweisungsauftrag zu kontrollieren.
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Wenn Sie den Dialog mit OK bestätigen, wird
ein Onlineauftrag an Ihre Geldinstitut gesendet.

Anmerkung

Wenn Sie die Schaltfläche
Abbrechen betätigen wird der
Dialog für die Einzelüberweisung
geschlossen, der Online-Auftrag nicht
ausgeführt und eine zuvor neu
angelegte Überweiungsvorlage nicht
gespeichert.

Interne Umbuchung… Die FunktionAktion → Online Aktion →
Interne Umbuchung…kann der Übersetzer
nicht ausprobieren, weil das Geldinstitut
diesen Geschäftsvorfall für seine Konten nicht
unterstützen.

Journal
Das Journal stellt ein erweitertes Kontobuch dar, im dem Sie Buchungen eingeben können, ohne einzelne
Konten öffnen zu müssen. Die Buchungseinträge aller Konten werden hier in einem einzigen Kontobuch
dargestellt.

Die Eingabe von Buchungen im Journal ist etwas komplizierter als die Eingabe im Kontobuch des
jeweiligen Kontos. Der Vorteil ist jedoch, dass das Journal eine umfassendere Sicht auf die Buchungen
in allen Konten bietet.

Standardmäßig werden im Journal nur die Buchungen des letzten Monats angezeigt. Sie können mit dem
MenüpunktAnsicht → Filter nach…den Datumsbereich eingrenzen.
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Kapitel 7. Business Features
Geehrte Leser, leider hat bisher niemand eine Übersetzung der folgenden Teile erstellt. Falls Sie uns dabei
helfen möchten, folgen Sie bitte der Anleitung in  Gnucash wiki: How to translate the GnuCash guide and/
or help files [https://wiki.gnucash.org/wiki/Translation#Translating_the_GnuCash_Guide_and_Help].
Fragen können auf der deutschsprachigen Mailingliste gnucash-de@gnucash.org diskutiert werden.

The accounting needs of a business are quite different from that of a person. Businesses have customers
that owe money, vendors which are owed money, employee payroll, more complex tax laws, etc. GnuCash
offers business oriented features to facilitate these needs.

Accounts Receivable (A/R) are used by businesses to record sales for which they are not immediately paid.
Accounts Payable (A/P) record bills that they have received, but might not pay until later. These types of
accounts are used primarily when you have a lot of bills and receipts flowing in and out, and do not want
to lose track of them just because you do not pay or get paid right away. For most home users, A/R and
A/P are too complicated to be worth the effort.

Accounts Receivable (or A/R) refers to products or services provided by your company for which payment
has not yet been received. This is represented on the balance sheet as an asset, because the expectation is
that you will receive payment soon.

Accounts Payable (or A/P) refers to products or services bought by your company for which payment has
not yet been sent. This is represented on the balance sheet as a liability because you will have to pay for
them.

Initial Setup
To set up GnuCash to handle accounts receivable and accounts payable for a company the following
preliminary steps must be done.

Account Setup
There are many different ways to set up a business account hierarchy. You can start with the Business
Accounts setup which is available from the New Account Hierarchy assistant, or you could build one
manually. To access the prebuilt Business Accounts, start GnuCash and click on File → New File and
proceed until you see the list of available accounts, select Business Accounts.

Anmerkung

The prebuilt Business Account hierarchy will not meet your needs exactly. You will need to make
adjustments for the hierarchy to function well with your particular situation. It should be close
enough that it is recommended you begin with it.

Tax Tables
Tax Tables can used to determine the tax for customer invoices (or vendor bills).

A tax table can be assigned to an invoice line or bill line.

The default invoice line tax table can be assigned to each customer and the default bill line tax table can
be assigned to each vendor.

The default tax table for new customers or new vendors can be specified in the Book Options  window
which can be accessed by File → Properties → Business tab.
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Tax Tables are maintained using the Sales Tax Table editor which is accessed via menu Business → Sales
Tax Table . The following fields should be entered:

• Name This is the tax table name.

• Type Either Percent % or Value $.

• ValueThis is the percentage or value depending on Type.

• Account This is the account to which tax will be posted. For tax collected from customers, this should
probably be a Liability account as it must be payed to the government. For tax paid to vendors, if tax
laws allow tax paid to vendors to offset tax collected from customers, this should probably also be
a Liability account (even though it will usually have a debit balance) so that the net tax owed to the
government can be easily observed.

If you set up Tax on Purchases and Tax on Sales as subaccounts of Liabilities:Tax then the net tax will
be rolled up and can be seen in the GnuCash Accounts tab.

If unsure about tax law requirements, get professional advice.

Company Registration
After you have built the account structure and defined your tax tables, register the GnuCash file as
belonging to your company by filling in the data requested in the „Reiter Geschäft“ accessible from the
File → Properties menu item.

Counters
Define the format and last used numbers of codes such as customer, invoice, vendor, bill, employee,
expense voucher, job number and order. See „Reiter Nummern-Zähler“.

Business Preferences
Set options on the Business tab of the GnuCash preferences, which is accessed via Edit → Preferences
( GnuCash → Preferences on macOS). See „Geschäft“.

Billing Terms
Billing Terms can be used to determine the payment due date and be a guide for determining discount for
early payment of invoices (or vendor bills).

Anmerkung

As of GnuCash 2.6.7, Billing terms are only partially supported. Date due is calculated but
discount amount is not.

Discount for early invoice payment is not implemented. There are 2 ways this may be done,
although neither is recommended, and professional advice should be used to confirm that
regulations are being complied with:

• After creating and posting a payment which pays the invoice in full, manually edit the payment
transaction (usually strongly discouraged) and split the payment to reduce it by the amount of
the discount and a create a compensating split in an income (discount) account.
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• Alternatively, after creating and posting a payment for the discounted amount, create a credit
note for the discount using a specific negative sales income (discount) account for the transfer
account.

You can specify the billing terms on each invoice/bill. Invoice billing terms will default from the customer
billing terms. Bill billing terms will default from the vendor billing terms.

Billing Terms are maintained using the Billing Terms Editor which is accessed via menu Business →
Billing Terms Editor . The following fields should be entered:

• Name The internal name of the billing term. For some examples of billing term names and descriptions
see https://wiki.gnucash.org/wiki/Payment_Terms

• Description The description of the billing term, printed on invoices

• There are 2 types of billing terms, with different information to be entered

• Type Days

• Due Days The invoice or bill is due to be paid within this number of days after the post date

• Discount Days The number of days after the post date during which a discount will be applied for
early payment

• Discount % The percentage discount applied for early payment

• Type Proximo

• Due Day The day of the month bills are due

• Discount Day The last day of the month for the early payment discount

• Discount % The discount percentage applied if paid early

• Cutoff Day The cutoff day for applying bills to the next month. After the cutoff, bills are applied
to the following month. Negative values count backwards from the end of the month.

Accounts Receivable
GnuCash has an integrated accounts receivable system.

To use GnuCash’s integrated accounts receivable system, you must first set up Accounts Receivable
accounts of type A/Receivable under Assets to accrue income you're owed. It is within this account that
the integrated A/R system will place transactions, debiting it when you post bills and crediting it when
you receive payments.

Basic A/R Account Hierarchy:

-Assets
  -Accounts Receivable
  -Checking
-Income
  -Sales
-Liabilities
  -Tax
    -Tax on Purchases
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    -Tax on Sales

Wichtig

If you deal with customers in more than one currency you will need a separate Accounts
Receivable account for each currency:

-Assets
  -Accounts Receivable
    -CHF
    -EUR
    :

Anmerkung

You need to add additional asset, expense, and income accounts to this hierarchy for it to be
useful. The important aspects of this hierarchy are the use of an income account and the Accounts
Receivable asset account, with account type set to A/Receivable.

The transactions generated by the A/R system are recorded within the Accounts Receivable account. You
generally do not work directly with this account. You generally work with the four integrated GnuCash A/
R application components available through the Business → Customer sub-menu. These four components
are:

„Customers“ People or companies to whom you sell
products or services on credit.

„Invoices“ The physical invoice you send to a customer
to request payment. This invoice contains an
itemized list of things you sold.

„Customer Jobs“ Is where you register Customer Jobs. Jobs
are a mechanism by which you can group
multiple invoices to a particular customer.

„Process Invoice Payment“ Used to register payments you received from
a customer.

The following sections introduce the individual components in more detail.

Customers
Customers are people or companies to whom you sell goods or services. They must be registered within
the A/R system.

New

To register a new customer, enter the menu Business → Customer → New Customer . Fill in customer
information, such as Company Name, Address, Phone, Fax, etc. Below is a list of the other options:

• Identification - Customer Number - can be any number by which you would like to refer to this customer.
You may leave it blank and a number will be chosen automatically. See „Reiter Nummern-Zähler“ for
more info.
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• Identification - Active - differentiates active customers from inactive ones. This is useful when you have
many past customers, and you want to see only those marked active.

• Billing Address - Name - is the contact name of the person to receive the invoices.

• Notes - records any additional comments about the customer.

• Billing Information - Currency - specifies the billing currency for this customer. It will default to the
default currency set in Preferences

Anmerkung

All invoices will be denominated in this currency and GnuCash will require an Accounts
Receivable account in this currency.

• Billing Information - Terms - specifies the default billing terms for this customer. Billing terms must
be preregistered using Business → Billing Terms Editor .

• Billing Information - Discount - gives the customer a default percentage based discount at the time of
invoice creation. Enter a value from 0 to 100. You can override the default discount when you create
an invoice.

• Billing Information - Credit Limit - stores the maximum credit you are willing to extend to the customer.
This field is for your reference purposes only. GnuCash does not use the value.

• Billing Information - Tax Included - this specifies whether nor not tax is included in invoice amounts
by default. You can choose Yes, No, or Use Global.

• Yes means that the tax is already included in amounts on invoices.

• No means tax is not included.

• Use Global means to use the setting made in the global preferences accessible through Edit →

Preferences ( Gnucash → Preferences on macOS).

• Billing Information - Tax Table - specifies a default tax table to apply to invoice line items. Tax tables
must be registered from the Business → Tax Table Editor menu item.

• Shipping Address - records the customer’s shipping address if it is different from the billing address.
The shipping address is for your reference. GnuCash does not use the value.

Find and Edit
To search for an existing customer, use the Business → Customer → Find Customer window. You select a
customer to View/Edit from the results of the search. This window is also used to look up customers when
creating invoices and processing payments.

If many customers match the search criteria you provide, the search can be refined by running an additional
search within the current results. The current result set is searched when the Refine Current Search radio
button is selected. In fact, GnuCash selects this option for you after you run the initial search.

If the customer you are searching for does not match the supplied search criteria, change the search criteria,
click the New Search radio button and then the Find button. The relevant step is the New Search selection.
If the customer is not in the result of the original search, and you only search within this set, the customer
cannot be found, regardless of new search criteria.
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Anmerkung

To return a list of all registered active customers, set the search criterion to matches regex, and
place a single dot "." in the text field area. Make sure Search only active data is checked, then
click Find. The regular expression "." means to match anything.

Invoices
An invoice is the paperwork you send to a customer to request payment for products or services rendered.
GnuCash can generate and track invoices.

A credit note is the paperwork you send to a customer to correct products or services rendered that were
incorrectly invoiced. GnuCash can generate and track credit notes via the same menu entries as invoices.

Anmerkung

This section applies to both invoices and credit notes. In order to avoid repeating everything
twice and to keep the text easier to read it will refer only to invoices. You can apply it equally to
credit notes. Only where the behaviour of credit notes differs from invoices this will be explicitly
mentioned. Credit notes were introduced starting with GnuCash stable release 2.6.0.

New
To send an invoice to a customer you must first create a new invoice. To create an invoice use Business
→ Customer → New Invoice . The New Invoice window must be filled in appropriately:

• Invoice Information - Type: the type of customer document to create - either an invoice or a credit note.

• Invoice Information - Invoice ID (optional): the formated identification number of this invoice. This
is your internal number for this invoice. If you leave it blank, an invoice number will be generated
automatically. See „Reiter Nummern-Zähler“ for more info.

• Invoice Information - Date Opened: the date this invoice was created.

• Billing Information - Customer: the customer who is to receive this invoice. If you remember the
company name you entered in the New Customer window for this customer, start to type it in this
field and GnuCash will try auto complete it for you. Else, press the Select... button to access the Find
Customer window described in „Find and Edit“. Highlight the customer you are looking for with a click
in the search results, then press the Select button.

• Billing Information - Job (optional): associates the new invoice with a customer job (see „Customer
Jobs“). If you remember the job name you entered in the New Job window for this job, start to type it
in this field and GnuCash will try auto complete it for you. Else, press the Select... button to access the
Find Job window. This window is the same to the one described in „Find and Edit“. Highlight the job
you are looking for with a click in the search results, then press the Select button.

• Billing Information - Billing ID: this is the customer’s PO Number or other „customer reference
number“. You should use it to identify your invoices to this customer (and job, if you have one).

• Billing Information - Terms: the payback terms agreement for this invoice. A list of registered terms is
available within the pop up menu. If you specified a default value for the selected customer, this field
is initialized with the default.

• Notes: Here you can enter internal notes.
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When you click the OK button, the Edit Invoice window opens.

Edit
From the Edit Invoice window you can enter an itemized list of goods and services you sold on this invoice
in a manner similar to how the account register works. For credit notes you enter an itemized list of goods
and services you refunded instead.

Anmerkung

Saved column layout works a bit differently in invoices from the account registers: Layouts are
not saved for each invoice; instead a layout can be saved as a default for invoices to override
the calculated widths using the View>Use as Default Layout for Customer Documents and
the calculated widths restored as the default with View>Reset Default Layout for Customer
Documents.

There are 15 columns in the Invoice Entries area:

• Date - The date this item was sold.

• Invoiced? - X means the item is attached to this invoice, an empty box means the item is not attached
to this invoice. The item is attached for you when you proceed to the next line item.

• Description (optional) - is what the item or service is called.

• Action (optional) - is a user defined field. You can place Cost Center information here, or use one of
the 3 predefined actions, Hours, Material, or Project.

• Income Account - selects which income account is credited with this income.

• Quantity - tracks how many of the items you sold.

• Unit Price - is the unit price of the item.

• Discount Type - is the type of discount:

• $ means Discount is a monetary value

• % means Discount is a percentage.

You can click the field to toggle between the discount types.

• Discount How - the discount can be computed as follows:

• > means the discount applies after tax.

• < means the discount applies before tax.

• = means both discount and tax are applied to the pretax value.

You can click the field to change the setting.

• Discount (optional) - is the total discount, in monetary units or percentage, depending on Discount Type.
You can leave it blank for no discount. Any default discount you specified for the customer will be
automatically entered for each new item.

• Taxable? - is this item taxable? X means yes, a blank field means no. You can click the field to toggle
the setting.
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• Tax Included? - has the tax already been included in the unit price? X means yes, a blank field means
no. For example, if there is 1 item of $100 with a tax of 5% then:

• If Tax Included is empty, then subtotal = $100 and tax = $5.

• If Tax included is set (X), then subtotal = $95.23 and tax = $4.77. The computation is: Subtotal =
Total / (1+taxrate) and Tax = Total - Subtotal = Total - (Total / (1+taxrate)).

• Tax Table (optional) - this is a pop up menu of all the available tax tables. If you make the item taxable,
then this table is used to compute the amount of tax. The tax table determines tax percentages and the
accounts to which tax is charged.

• Subtotal (uneditable) - is the computed subtotal for this item (less tax).

• Tax (uneditable) - is the computed tax for this item.

When you have finished entering all the items, you can Post and print the invoice.

Post
When you finish editing an invoice and are ready to print, you must Post the invoice. The invoice does
not have to be posted immediately. In fact, you should only post an invoice when you are ready to print it.
Posting an invoice places the transactions in an accounts receivable account.

The Post Invoice window appears and asks you to enter the following information:

• Post Date - specifies the date for the transactions entered into the accounts receivable account. By default
this is the invoice’s Date Opened (see „New“ for information about that date).

• Due Date - is the date on which payment for the invoice is expected.

• If you specified payment terms when you created the invoice, the date is calculated according to
selected terms, and the entry field is insensitive.

• If you did not specify payment terms, enter the expected payment due date here.

• Description - is an arbitrary description. When invoice transactions are placed in the accounts receivable
account, this description is entered in the memo field of those transactions.

• Post To Account - selects the accounts receivable account in which invoice transactions are posted. You
can select the account from a list of existing A/Receivable accounts.

• Accumulate Splits - determines if invoice items which transfer to the same account are combined into
a single split for that account or entered individually. For the sample invoice which sold Nails and a
Hammer, the setting affects post results as follows:

• Checked (splits are accumulated) - a single transfer of $575.00 from the Income:Sales account is
recorded.

• Not checked - the transaction created in the A/Receivable account, shows two transfers from
Income:Sales account $100.00 and $475.00. The memo fields in the splits indicate the sale of Nails
and the Hammer (the item descriptions entered on the invoice) respectively.

Find
To find an existing invoice, use the Business → Customer → Find Invoice menu item. From the results of
the search, you can select an invoice to edit or view.
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Anmerkung

Before you can edit a posted invoice, you will need to Unpost it.

One of the design goals in GnuCash’s Account Receivable system was to allow different processes to get
to the same state, so you can reach an invoice from different directions based on the way you think about
the problem:

• You can search for the customer first, then list their invoices.

• You can search for invoices by number or by company name.

• You can list invoices associated with a customer job.

Print
After you post an invoice, you should print it and send it to your customer. To print an invoice use File
→ Print Invoice menu item.

Tipp

You can modify the appearance of the invoice, IE: add a company logo, etc. To do so, see the
„Changing the Invoice Appearance“.

Invoices can also be printed from the main window by selecting Reports → Business Reports → Printable
Invoice from the main menu. The resulting report window states that no valid invoice is selected. To select
the invoice to print:

1. Use the Options Toolbar button or select Edit → Report Options from the main menu.

2. Select the General tab of the report options dialog.

3. Click the Select button next to the Invoice Number field.

4. Search for the invoice as usual.

You can also print invoices from within the Process Payment dialog. See the „Process Invoice Payment“
for instructions on how to do so.

Assign Starting Invoice Number
By default, GnuCash starts with invoice number 1 and increments from there. You can manually type an
invoice number into the text box each time you create an invoice, but this gets tiring and sooner or later
leads to duplicate numbers.

You can change the starting invoice number if it is important you. Use File → Properties , access the
Counters tab, change the Invoice number value to be one less than your desired starting invoice number
and click the OK button or the Apply button.

Customer Jobs
Customer Jobs are used to group multiple invoices and credit notes to the same customer. Use of the
Customer Jobs feature is optional. The feature is useful when you have multiple jobs for the same customer,
and would like to view all the invoices and credit notes related to a single job.
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To use customer jobs, you must create them using the Business → Customer → New Job menu item. You
will see the New Job window. The editable fields are:

• Job Info - Job Number (optional) - enter the number for this job. If left blank, a number will be chosen
for you. See „Reiter Nummern-Zähler“ for more info.

• Job Info - Job Name - the name you want to assign to the new job.

• Owner Info - Customer - the customer for whom the job is created. If you remember the company name
you entered in the New Customer window for this customer, start to type it in this field and GnuCash
will try auto complete it for you. Else, press the Select... button to access the Find Customer window
described in „Find and Edit“. Highlight the customer you are looking for with a click in the search
results, then press the Select button.

• Owner Info - Billing ID - the customer’s reference to this job (e.g. their PO Number). This is the "Billing
Identification" that they require to correlated your invoices with their order. The Billing ID you enter is
used to set the billing id for new invoices associated with this job.

• Job Active - toggles this job being active or not. This is useful when you have many inactive jobs, since
it is easier to search only among jobs that are marked active.

To edit an existing customer job, use the Business → Customer → Find Job menu item. Select the desired
job in the search results, and click the View/Edit Job button.

To select from the invoices and credit notes associated with a given job, use Business → Customer → Find
Job menu item. Select the desired job in the search results and click the View Invoices button. A window
listing invoices and credit notes associated with this job appears. Select an invoice or credit note and click
the View Invoice button to open an invoice editor in the main application window.

Process Invoice Payment
Eventually, you will receive payment from your customers for outstanding invoices. To register these
payments, use the Process Payment application found in Business → Customer → Process Payment .

Tipp

There is an alternative way of assigning a payment to (one or more) invoices where the payment
transaction already exists, say in the case where transactions have been imported from a bank.
There is no way to assign a payment to an invoice during the import process, so this must be done
after transactions have been imported.

This can best be done starting from the asset account register holding the imported payment
transaction (like your bank account). In that account, select the payment, right-click (control-
click for macOS) and choose Assign as payment.... The payment window will pop-up, partly
filled in with the information from the transaction. Fill in the missing information like the proper
customer and invoice to complete the payment.

One caveat: the logic behind Assign as payment...won't properly detect credit note
reimbursements and will wrongfully interpret such a transaction as a vendor bill.

The Process Payment application consists of:

• Payment Information - Customer - the customer who paid you. If you remember the company name you
entered in the New Customer window for this customer, start to type it in this field and GnuCash will try
auto complete it for you. Else, press the Select... button to access the Find Customer window described
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in „Find and Edit“. Highlight the customer you are looking for with a click in the search results, then
press the Select button.

• Payment Information - Invoice - the invoice for which payment was received. If you remember the
invoice ID, start to type it in this field and GnuCash will try auto complete it for you. Else, press the
Select... button to access the Find Invoice window described in „Find“. Highlight the invoice you are
looking for with a click in the search results, then press the Select button.

• Payment Information - Date - the date you you received payment.

• Payment Information - Amount - the amount of money received.

• Payment Information - Num - the check number.

• Payment Information - Memo - any comments about this payment.

• Post To - the A/Receivable account to which to post this transaction.

• Transfer Account - the account where the money will be deposited (a checking account for example).

Over Payments or Pre-Payments
If a customer overpays an invoice or pays for goods or services before they have been invoiced, Process
Payment for the total amount received. GnuCash will then keep track of the over-payment (or pre-payment)
in the A/R account and you can use the residual when paying the next invoice.

Partial Payments
Partial payments are possible too. Select the invoice to pay. GnuCash will automatically suggest that
invoice's remaining balance as payment amount. Simply adjust that amount to what you want to pay.

Writing Off a Bad Debt

Anmerkung

Please check with your accountant to ensure the following is acceptable in your region.

The usual way to do this is to process a payment for the invoice to a BadDebt account. Such an account
would be an expense account. However, in GnuCash, you can't process a payment for an invoice directly
to an expense account, so it takes two steps:

• Pay the invoice to an asset or liability account, such as your checking account.

• Change the asset or liability account, in the  non Accounts Receivable split of the payment transaction,
to the BadDebt expense account.

Specifically

• Remove all transactions from the A/R account related to the invoice, except for the invoice's transaction
itself. This includes any payment transactions, and transactions between your BadDebt and A/R account.

In case the payment has associated lot link transactions (1), remove those as well.

If all is well, your Process Payment window for this customer should list the invoice the customer won't
pay, and no prepayments.
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• Pay your invoice to an arbitrary asset or liability account. It can be your checking account. We will fix
that in the next step.

• Open the account register for your A/R account. For this invoice there should now be one payment
transaction. If you are using GnuCash 2.6.0 - 2.6.4 there will also be one lot link transaction (1).

• Select the payment transaction and change the transfer account to your BadDebt account. Make sure to
leave the transaction (eg by clicking on another transaction) to save the changes.

If all is well, your Process Payment window should still be clean: no pre-payments, and the bad debt
invoice gone.

Anmerkung

(1): GnuCash versions 2.6.0 to 2.6.4 created lot link transactions which show in the A/R account
register. This came with its own set of subtle issues. It is recommended to upgrade to the latest
(or at least 2.6.6) version, which fixes a lot of small problems. Version 2.6.5 had a flaw in the
logic cleaning up the lot links. Once upgraded, please run Actions → Check & Repair on your
A/R and A/P accounts to clean up most of the lot link legacy. Don't forget to make a backup
first just in case.

Lots are used internally for relating payments to invoices. Lots themselves are invisible in the
account registers. To see them you need to open the lot viewer, which can be found in Actions →
View lots while in any A/R or A/P account register. Select a lot to see the Splits in lot.

Lot links are transactions which you can see in your A/R and A/P accounts. They are unusual in
the sense that all their splits are in one account (A/R or A/P). Each split in a lot link transaction
is linked (hence the name) to an invoice or payment transaction by means of a lot.

See https://wiki.gnucash.org/wiki/Business_Features_Issues for more information.

Changing the Invoice Appearance
The default Invoice style, as shown in „Print“, is fairly barren. The default invoice style leaves the top
part of the form blank, so you can print on company letterhead paper. There are some things you can do
to change invoice appearance.

Use File → Properties to enter your Company information in the Business tab of the Book Options window.
Some of the entered information is printed on the right side of invoices.

To add a customized background, heading banner or logo to invoices, modify the invoice style sheets.
To do this, go to Edit → Style Sheets and select the New button in the Select HTML Style Sheet window
that will appear.

Give a Name to the new style sheet (e.g. Custom Invoice) and select the Fancy Template. When you click
the OK button, the HTML Style Sheet Properties window is displayed. This window presents you five
sections listed in the left pane: Colors, Fonts, General, Images, and Tables. The Colors section allows you
to change the colors of various items of the invoice. The Fonts section lets you set font type and dimensions.
The General section allows you to set the Preparer and Prepared for information, and to Enable Links. The
Images section allows you to import graphics into the style sheet. The Tables section allows you to adjust
the spacing around the tables which make up the invoice.

To include a company logo, banner heading and background image, use your favorite graphics application
such as The Gimp or OpenOffice Draw to save the images in either GIF or PNG format. Then import them
into the style sheet using the Images section described above.
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Anmerkung

The images are placed in the invoice as follows. The Background Tile is tiled to become the
background image, the Heading Banner goes above the invoice text, and the Logo is placed in the
upper left corner of the invoice to the left of the Heading Banner. You will probably have to try
a few different sized images until you get the invoices to print nicely. Some sizing suggestions
are that the Logo should be 1 square cm (~0.5 inch), and the Heading Banner should be 15 cm
(~6 inches) wide and 1 cm (~0.5 inch) tall.

With the style sheet configured, when you print the invoice, you select the style sheet to use from the
Options menu.

Accounts Payable
GnuCash has an integrated accounts payable system. As with Accounts Receivable you must have an
Accounts Payable account set up under Liabilities for each currency in which you will issue invoices.
The Accounts Payable accounts accrue the amounts you owe to others, so bills credit these accounts and
payments and credit memos debit these accounts. Generally you do not directly work with this account
but use the four integrated GnuCash A/P application components. The A/P components are available from
the Business → Vendor sub-menu.

These A/P components are:

• Vendors are people or companies from which you buy products or services on credit.

• Bills represent the physical bills vendors send to request payment from you. A bill contains an itemized
list of things you purchased.

• Jobs (optional) is where you register Vendor Jobs. Jobs are a mechanism by which you can group
multiple bills from a particular vendor.

• Process Payments is where you register payments to a vendor to whom you owe money.

The following sections introduce the individual Accounts Payable application components.

Vendors
A vendor is a company or person from whom you purchase goods or services. Vendors must be registered
within the A/P system.

New
To register a new vendor, select the Business → Vendor → New Vendor menu item. Fill in general
information about the vendor, such as Company Name, Address, Phone, Fax, etc. Below is a list of the
other options:

• Identification - Vendor Number - can be any number by which you would like to refer to this vendor.
You may leave it blank and a number will be chosen automatically. See „Reiter Nummern-Zähler“ for
more info

• Identification - Active - differentiates active vendors from inactive ones. This is useful when you have
many past vendors, and you want to see only those marked active.

• Payment Address - Name - is the contact name of the person to receive payments you make.
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• Notes - records any additional comments about the vendor. Use it to track names of contact people
within the vendor’s company, for example.

• Payment Information - Currency - specifies the payment currency for this vendor. It will default to the
default currency set in Preferences

Anmerkung

All Bills and Credit Notes will be denominated in this currency and GnuCash will require an
Accounts Payable account in this currency.

• Payment Information - Terms - specifies the default payment terms for this vendor. Payment terms must
be preregistered using Business → Billing Terms .

• Payment Information - Tax Included - specifies if tax is included in bills from this vendor. You can
choose Yes, No, or Use Global.

• Yes means that tax is already included in amounts on bills.

• No means tax is not included.

• Use Global means to use the setting made in the global preferences accessible through Edit →

Preferences ( Gnucash → Preferences on macOS).

• Payment Information - Tax Table - specifies a default tax table to apply to bills from this vendor. Tax
tables must be registered using the Business → Tax Table menu item.

Find and Edit
To search for an existing vendor, use the Business → Vendor → Find Vendor window. You select a vendor
to View/Edit from the results of the search. This window is also used to look up a vendor when entering
bills and processing payments.

If many vendors match the search criteria you provide, the search can be refined by running an additional
search within the current results. The current result set is searched when the Refine Current Search radio
button is selected. In fact, GnuCash selects this option for you after you run the initial search.

If the vendor you are searching for does not match the supplied search criteria, change the search criteria,
click the New Search radio button and then the Find button. The relevant step is the New Search selection.
If the vendor is not in the result of the original search, and you only search within this set, the vendor
cannot be found, regardless of new search criteria.

Tipp

To return a list of all registered active vendors, set the search criterion to matches regex, and place
a single dot „.“ in the text field area. Make sure Search only active data is checked, then click
Find. The regular expression „.“ means to match anything.

Bills
A bill is a request for payment you receive from a vendor. GnuCash can track bills.

A credit note is the document you receive from a vendor to correct products or services rendered that you
were incorrectly charged for on a bill. GnuCash can generate and track credit notes via the same menu
entries as bills.
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Anmerkung

This section applies to both bills and credit notes. In order to avoid repeating everything twice and
to keep the text easier to read it will refer only to bills. You can apply it equally to credit notes.
Only where the behaviour of credit notes differs from bills this will be explicitly mentioned.

New
When you receive a bill from a vendor and want to enter it into GnuCash, you must create a new bill.
To create a new bill use the Business → Vendor → New Bill menu item, and fill in the resulting window
appropriately.

• Bill Information - Type - the type of vendor document to create - either a bill or a credit note.

• Bill Information - Bill ID (optional) - the identification number of the invoice as emitted by the vendor
(IE: the vendor’s internal number for this invoice).

• Bill Information - Date Opened - the date the Invoice was emitted by the vendor.

• Billing Information - Vendor - the issuing vendor. If you remember the company name you entered in
the New Vendor window for this vendor, start to type it in this field and GnuCash will try auto complete
it for you. Else, press the Select... button to access the Find Vendor window described in „Find and Edit“.
Highlight the vendor you are looking for with a click in the search results, then press the Select button.

• Billing Information - Job (optional) - associates a vendor job (see „Vendor Jobs“) with this bill. If you
remember the job name you entered in the New Job window for this job, start to type it in this field
and GnuCash will try auto complete it for you. Else, press the Select... button to access the Find Job
window. This window is very similar to the one described in „Find and Edit“. Highlight the job you are
looking for with a click in the search results, then press the Select button.

• Billing Information - Billing ID (optional) - the vendor’s ID for the bill (e.g.: their invoice #).

• Billing Information - Terms - the pay back terms agreement for this bill. A list of registered terms is
available within the pop up menu. If you specified a default value for the selected vendor, this field is
initialized with the default.

• Default Chargeback Project - Customer (optional) - the customer to associate with this bill. This is used
to charge your customer later.

• Default Chargeback Project - Job (optional) - the customer job to associate with this bill.

When you click the OK the Edit Bill window opens.

Edit
From the Edit Bill window you can enter an itemized list of goods and services you purchased, in a manner
similar to how the account register works. For credit notes you enter an itemized list of goods and services
the vendor refunded instead.

Anmerkung

Saved column layout works a bit differently in invoices from the account registers: Layouts are
not saved for each invoice; instead a layout can be saved as a default for invoices to override
the calculated widths using the View>Use as Default Layout for Vendor Documents and the
calculated widths restored as the default with View>Reset Default Layout for Vendor Documents.

163



Business Features

There are 12 columns in the Invoice Entries area:

• Date - The date this item was sold.

• Invoiced? - X means the item is attached to this invoice, an empty box means the item is not attached
to this invoice. If the box is empty you can attach the item to the invoice by first selecting the item row
and then clicking in this box.

• Description (optional) - is what the item or service is called.

• Action (optional) - is a user defined field. You can place Cost Center information here, or use one of
the 3 predefined actions, Hours, Material, or Project.

• Expense Account - selects the expense account to charge for this item.

• Quantity - tracks how many of the items you bought.

• Unit Price - is the unit price of the item.

• Taxable? - is this item taxable? X means yes, a blank field means no. You can click the field to toggle
the setting.

• Tax Included? - has the tax already been included in the unit price? X means yes, a blank field means no.

• Tax Table (optional) - this is a pop up menu of all the available tax tables. If the item is taxable and tax
has not been included in the unit price, then this tax table is used to compute the amount of tax.

• Subtotal (uneditable) - computed subtotal for this item (less tax)

• Billable - is this item billable to the chargeback customer/job?

When you have finished entering all the items, Post the bill.

Post
When you finish editing a bill, you should Post the bill. You do not have to post the bill, you can close
it and return to it later. You have to post the bill eventually. Posting a bill places its transactions into an
accounts payable account. The Post Bill window appears and asks you to enter information:

• Post Date - specifies the date for the transactions entered into the accounts payable account.

• Due Date - is the date on which payment for the bill is expected.

• If you specified payment terms when you created the bill, the date is calculated according to selected
terms, and the entry field is insensitive.

• If you did not specify payment terms, enter the expected payment due date here.

• Description - is an arbitrary description. When bill transactions are placed in the accounts payable
account, this description is entered in the memo field of those transactions.

• Post To Account - selects the accounts payable account in which bill transactions are posted. You can
select the account from a list of existing A/Payable accounts.

• Accumulate Splits - determines if bill items which transfer to the same account are combined into a
single split for that account or entered individually. For the sample bill for Letterhead and Envelopes,
the setting affects post results as follows:
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• Checked (splits are accumulated) - a single transfer of $100.00 to the Expenses:Office Supplies
account is recorded.

• Not checked - the transaction created in the A/Payable account, shows two transfers to
Expenses:Office Supplies account $75.00 and $25.00. The memo fields in the splits indicate the
purchase of Letterhead and Envelopes (the item descriptions entered on the bill) respectively.

Find
To find an existing bill, use the Business → Vendor → Find Bill menu item. From the results of the search,
you can select a bill to edit, or view.

Anmerkung

Before you can edit a posted bill, you will need to Unpost it.

Anmerkung

There are other ways to access an existing bill. These are similar to accessing invoices for your
customers. See „Find“ for more information.

Vendor Jobs
Vendor Jobs are used to group multiple bills and credit notes from a single vendor. Use of the vendor jobs
feature is optional. The feature is useful when you have multiple jobs for the same vendor, and would like
to view all the bills and credit notes for a single job.

To use vendor jobs, you must create them using the Business → Vendor → New Job menu item. You will
see the New Job window. The editable fields are:

• Job Info - Job Number (optional) - enter the number for this job. If left blank, a number will be chosen
for you.

• Job Info - Job Name - the name you want to assign to the new job.

• Owner Info - Vendor - the vendor for whom the job is created.

• Owner Info - Billing ID - the vendor’s reference to this job (e.g. their PO Number).

• Job Active - toggles this job being active or not. This is useful when you have many inactive jobs, since
it is easier to search only among jobs that are marked active.

To edit an existing vendor job, use the Business → Vendor → Find Job menu item. Select the desired job
in the search results, and click the View/Edit Job button.

To select from the bills and credit notes associated with a given job, use the Business → Vendor → Find
Job menu item. Select the desired job in the search results and click the View Invoices button. A window
listing bills and credit notes associated with this job appears. Select a bill or credit note and click the View
Invoice button to open a bill editor in the main application window.

Process Bill Payment
Eventually, you need to pay your bills. To do so, use the Process Payment application found in Business
→ Vendor → Process Payment .
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Tipp

There is an alternative way of assigning a payment to (one or more) bills where the payment
transaction already exists, say in the case where transactions are imported from a bank.

This can best be done starting from the asset account register holding the imported payment
transaction (like your bank account). In that account, select the payment, right-click (control-click
for macOS) and choose Assign as payment.... The payment window will pop-up, partly filled in
with the information from the transaction. Fill in the missing information like the proper vendor
and bill to complete the payment.

One caveat: the logic behind Assign as payment...won't properly detect credit note
reimbursements and will wrongfully interpret such a transaction as a customer invoice.

The Process Payment application consists of:

• Payment Information - Vendor - the vendor you wish to pay. If you remember the company name you
entered in the New Vendor window for this vendor, start to type it in this field and GnuCash will try
auto complete it for you. Else, press the Select... button to access the Find Vendor window described in
„Find and Edit“. Highlight the vendor you are looking for with a click in the search results, then press
the Select button.

• Payment Information - Bill - the bill you wish to pay. If you remember the bill ID, start to type it in
this field and GnuCash will try auto complete it for you. Else, press the Select... button to access the
Find Bill window described in „Find“. Highlight the bill you are looking for with a click in the search
results, then press the Select button in the search window.

• Payment Information - Date - the date you wish to make the payment, normally the current date.

• Payment Information - Amount - the amount of money to transfer in this payment.

• Payment Information - Num - the check number.

• Payment Information - Memo - any comments about this payment.

• Post To - the A/Payable account to post this transaction.

• Transfer Account - the account from which money for the payments comes from, such as a checking
account.

Over Payments or Pre-Payments
If you wish to overpay an invoice or pay for goods or services before they have been invoiced, Process
Payment for the total amount payed. GnuCash will then keep track of the over-payment (or pre-payment)
in the A/P account and you can use the residual in the future.

Partial Payments
You may wish to partially pay a bill. Select the bill to pay. GnuCash will automatically suggest that bill's
remaining balance as payment amount. Simply adjust that amount to what you want to pay.

Employees
GnuCash can help your company by tracking employees. You can register a „New Employee“, „Find
and Edit“ existing employees, create „New Expense Voucher/Credit Note“ and „Find Expense Voucher/
Credit Note“.
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Expense vouchers are used to reimburse employees for authorized expenses (f.e. travel, parking, food
etc...). Employee credit notes are the opposite of expense vouchers.

New Employee
To register a new employee, select the Business → Employee → New Employee menu item. The New
Employee window will open with two tabs:

• Employee tab

• Access Control tab

Employee tab

• Identification - Employee Number - can be any number by which you would like to refer to this
employee. You may leave it blank and a number will be chosen automatically. See „Reiter Nummern-
Zähler“ for more info.

• Identification - Username (Mandatory) - a unique username to identify the employee.

• Identification - Active (Optional) - differentiates active employees from inactive ones. This is useful
when you have many past employees, and you want to see only those marked Active.

• Payment Address - Name (Mandatory) - the full name of the employee.

• Payment Address - Address (Mandatory) - the address of the employee.

• Payment Address - Phone, Fax, Email (Optional)- other optional contact information for the employee.

• Interface - Language (Optional) -

• Payment Information - Terms (Optional) - specifies the default payment terms for this employee.
Payment terms must be preregistered using Business → Billing Terms .

• Billing - Default Hours per Day (Optional) -

• Billing - Default Rate (Optional) -

• Billing - Currency - specifies the billing currency for this employee. It will default to the default currency
set in Preferences

Anmerkung

All expense vouchers and credit notes for this employee will be denominated in this currency
and GnuCash will require an Accounts Payable account in this currency.

• Billing - Credit Account (Optional) -

Access Control tab

• Access Control List

Find and Edit
To search for an existing employee, use the Business → Employee → Find Employee... menu. You select
an employee to View/Edit from the results of the search. This window is also used to look up an employee
when entering voucher and processing payments.
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If many employees match the search criteria you provide, the search can be refined by running an additional
search within the current results. The current result set is searched when the Refine Current Search radio
button is selected. In fact, GnuCash selects this option for you after you run the initial search.

Anmerkung

If the employee you are searching for does not match the supplied search criteria, change the
search criteria, click the New Search radio button and then the Find button. The relevant step is
the New Search selection. If the employee is not in the result of the original search, and you only
search within this set, the employee cannot be found, regardless of new search criteria.

Tipp

To return a list of all registered active employees, set the search criterion to matches regex, and
place a single dot „.“ in the text field area. Make sure Search only active data is checked, then
click Find. The regular expression „.“ means to match anything.

New Expense Voucher/Credit Note
To register a new expense voucher/ Credit Note, select the Business → Employee → New Expense
Voucher... menu item. The New Expense Voucher window will open. You can enter the following data:

• Voucher information - Type (Optional) - select if you are entering a Voucher or a credit note.

• Voucher information - Voucher ID (Optional) - can be any number by which you would like to refer to
this voucher. You may leave it blank and a number will be chosen automatically. See „Reiter Nummern-
Zähler“ for more info.

• Voucher information - Date opened - the date of the voucher. Click on the button on the right of the
date to open a calendar.

• Billing information - Employee (Mandatory) - the employee to which the voucher refers.

Tipp

The field supports auto-completion so if you start typing GnuCash will try to complete the text
automatically using existing employees name. You can also press the button Select... to open
the Find Employee window.

• Billing information - Billing ID (Optional) - the identification number of the document (f.e. the bill
number for a dinner).

• Billing information - Terms (Optional) - the pay back terms agreement for this bill. A list of registered
terms is available within the pop up menu.

• Default chargeback project - Customer (Optional) - the Customer to which the voucher refers.

Tipp

The field supports auto-completion so if you start typing GnuCash will try to complete the text
automatically using an existing Customer name. You can also press the button Select... to open
the Find Customer window.

• Default chargeback project - Job (Optional) - the Customer Job to which the voucher refers.
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Anmerkung

you can type in this field only if there are one or more jobs registered in GnuCash belonging
to the selected Customer.

Tipp

The field supports auto-completion so if you start typing GnuCash will try to complete the text
automatically using an existing Customer name. You can also press the button Select... to open
the Find Customer window.

• Notes - records any additional comments about the voucher/credit note.

Find Expense Voucher/Credit Note
To search for an existing Expense Voucher, use the Business → Employee → Find Expense Voucher...
menu item. You select an Expense Voucher to View/Edit from the results of the search. This window is
also used to look up an expense voucher when entering vouchers and processing payments.

If many expense vouchers match the search criteria you provide, the search can be refined by running an
additional search within the current results. The current result set is searched when the Refine Current
Search radio button is selected. In fact, GnuCash selects this option for you after you run the initial search.

Anmerkung

If the expense voucher you are searching for does not match the supplied search criteria, change
the search criteria, click the New Search radio button and then the Find button. The relevant step
is the New Search selection. If the expense voucher is not in the result of the original search, and
you only search within this set, the voucher cannot be found, regardless of new search criteria.

Tipp

To return a list of all expense vouchers, set the search criterion to matches regex, and place a
single dot „.“ in the text field area. Make sure Search only active data is checked, then click Find.
The regular expression „.“ means to match anything.

Edit
From the Edit Expense Voucher window you can enter an itemized list of goods and services the employee
bought or performed for the job, in a manner similar to how the account register works. For credit notes
you enter an itemized list of goods and services charged back to the employee instead.

Anmerkung

Saved column layout works a bit differently in invoices from the account registers: Layouts are
not saved for each invoice; instead a layout can be saved as a default for invoices to override
the calculated widths using the View>Use as Default Layout for Employee Documents and
the calculated widths restored as the default with View>Reset Default Layout for Employee
Documents.

There are 10 columns in the Entries area:

• Date - The date this item was sold.
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• Invoiced? - X means the item is attached to this invoice, an empty box means the item is not attached
to this invoice. If the box is empty you can attach the item to the invoice by first selecting the item row
and then clicking in this box.

• Description (optional) - is what the item or service is called.

• Action (optional) - is a user defined field. You can place Cost Center information here, or use one of
the 3 predefined actions, Hours, Material, or Project.

• Expense Account - selects the expense account to charge for this item.

• Quantity - tracks how many of the items you bought.

• Unit Price - is the unit price of the item.

• Subtotal (uneditable) - computed subtotal for this item (less tax)

• Billable - is this item billable to the chargeback customer/job?

• Payment - How the employee was reimbursed. You might enter a check or petty cash voucher number
here.

When you have finished entering all the items, Post the voucher.
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Kapitel 8. Tools & Assistants
Geehrte Leser, leider hat bisher niemand eine Übersetzung der folgenden Teile erstellt. Falls Sie uns dabei
helfen möchten, folgen Sie bitte der Anleitung in  Gnucash wiki: How to translate the GnuCash guide and/
or help files [https://wiki.gnucash.org/wiki/Translation#Translating_the_GnuCash_Guide_and_Help].
Fragen können auf der deutschsprachigen Mailingliste gnucash-de@gnucash.org diskutiert werden.

GnuCash offers many specialized Tools. These tools enable access to the enhanced functionality of GnuCash. They
are accessed via the Tools menu from any window that displays the GnuCash standard menu. Some of these tools may
be deactivated for several reasons:

• the tools is not appropriate for the current window,
• the required software is not found on your system,
• the package maintainer disabled it in the build process.

Find
The GnuCash Find assistant can be used to find transactions or to perform business related research on
your data file.

Find Transaction
Find Transaction is used to search for transactions in GnuCash and display the results in a register window.
To open the Find Transaction dialog in Split Search mode, you can type the keyboard shortcut Ctrl+f .

Exactly which transactions are searched depends on where you invoke the tool from. If you start from the
main accounts hierarchy page, all transactions will be searched. If you start from an individual account
register, only transactions in that account will be searched. And if you filter the transactions in a register
using View  →  Filter By... , then only transactions in that account and shown by the filter will be searched.

Anmerkung

The first row of the Find Transaction dialog indicates that you are performing a Split Search.

There are two panes in the Find Transaction dialog. The top pane contains the Search Criteria buttons and
the bottom pane contains the Type of Search selection.

There are two buttons in the top of the Search Criteria pane. The left button allows you to Add another
criteria row to search for multiple criteria. The existing criteria row needs to be completed before adding a
new row. The right button is used to Search for items where all criteria are met or Search for items where
any criteria are met. The all criteria are met search requires all of the criteria rows to have at least one
match. The any criteria are met search requires only one of the criteria rows to be matched.

The criteria row in the Search Criteria pane is used to combine different criteria buttons (see table
Tabelle 8.1, „Search criteria buttons - Split Search“ for a comprehensive list of combinations)

In the Type of Search pane there are five selections. The first option is always enabled, the following
three are available when you invoke the Find... option from a register window or after performing the first
Find if the Find... command was invoked from any other window. The last option is available only for
Business search.

New Search Perform a new transaction search

Refine current search Search within the results of the previous
search
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Add results to current search Search based on the first set of criteria or the
new criteria

Delete results from current search Discard any results that match the previous
search results

Search only active data Search only if data are marked as active. This
selector is greyed out for the Split Search as it
is meaningful only for business related search

Anmerkung

When selecting search criteria keep in mind that criteria are applied to individual splits or fields in
transactions, and that the entire transaction is included in the results. There is no visual indication
in the results to indicate which split or field met the search criteria.

When search criteria are selected, you can press the Find button. You will be presented with the search
results in a new register tab. A report of the search results may created and printed using Reports → Account
Report . The Account Report has limited formatting options but, like all GnuCash reports, being in html
format, can be copied and pasted into a spreadsheet for further formatting. Alternatively, the Account
Report can be exported to an html file, and the html file may be opened in a spreadsheet.

Anmerkung

Press the Close button to close the Find Transaction dialog.

Tabelle 8.1. Search criteria buttons - Split Search

Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

contains

matches
regex bDescription

a
does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexb

Memoa

does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexb

Numbera

does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

Action matches
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row
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Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

does not
match
regexb

contains

matches
regexb

Notes
does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

is before

is before or
on

is on

is not on

is after

Date Posted

is on or
after

Date
selection
field

Remove
row

less than

less than or
equal to

equal to

not equal to

greater than

has credits
or debits

greater than
or equal to

less than

less than or
equal to

equal to

not equal to

greater than

has credits

greater than
or equal to

less than

less than or
equal to

equal to

not equal to

greater than

Value

has debits

greater than
or equal to

Amount
entry field

Remove
row
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Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

is less than

is less than
or equal to

equals

does not
equal to

is greater
than

Shares

is greater
than or
equal to

Amount
entry field

Remove
row

is less than

is less than
or equal to

equals

is not equal
to

is greater
than

Share Price

is greater
than or
equal to

Amount
entry field

Remove
row

is
Reconcile c

is not
Not Cleared Cleared Reconciled Frozen Voided

Remove
row

is
Balanced

is not
set true

Remove
row

matches
any account

Account d
matches no
accounts

Choose
Accounts

Remove
row

All
Accounts e

matches all
accounts

Choose
Accounts

Remove
row

aThe Description, Memo, Number are common to all lines in a transaction.
bregex means regular expression text search as used in various computer programs such as Perl
cThe Reconcile option applies the selected criteria to each line of a transaction individually. Each transaction line may have only one
of the indicated values, but there is often a mix of values within a complete transaction, so companion lines may not meet the selected
criteria. See separate note defining status values. For a detailed description of transaction statuses see „Setzen des Abgleichstatus
(Feld A) einer Buchung.“
dThe Account option performs a search where the accounts selected in the Choose Accounts dialog will both be searched individually
for results. This means that a match in any of the selected accounts will either be displayed (matches any account) or discarded
(matches no account).
eThe All Accounts option performs a search where accounts selected in the Choose Accounts dialog will only return results that
match in both accounts.

174



Tools & Assistants

Explanations of the Criteria

The Reconcile criterion deserves some more explanation. Think of the selected reconciliation status
buttons (Not Cleared, Cleared, and so on) as a single group, joined with a logical “or”. In other words,
the selection “is ” or “is not” applies to the “or” of the selected status buttons. The buttons which are left
unselected are simply ignored. (It’s not the same as saying the reconciliation status must not be one of
these.)

For example: if you select Reconcile is Cleared Reconciled, that means you’re saying “I want all
transactions which contain cleared splits OR reconciled splits” (imagine an invisible “OR” between all
the selected status buttons). It’s the same as selecting Reconcile is Cleared, then adding another search
criterion with the Add button, then on the new line selecting Reconcile is Reconciled, and finally selecting
Search for items where any criteria are met. In either case, GnuCash will show you exactly the same set
of transactions.

Find Customer, Invoice, Job, Vendor, Bill, Employee,
Expense Voucher

The business find assistant is used to search for business related items (Customer, Invoice, Job, Vendor,
Bill, Employee, Expense Voucher). To open the business search dialog select the desired item to Find
from the Business → Customer/Vendor/Employee submenus.

Tipp

The titlebar and the first row of the assistant dialog reports the item type you are searching for:
Customer, Invoice, Job, Vendor, Bill, Employee, Expense Voucher.

There are two panes in the Find dialog. The top pane contains the Search Criteria buttons and the bottom
pane contains the Type of Search selection.

Search Criteria section

There are two buttons in the top of the Search Criteria pane. The left button allows you to Add another
criteria row to search for multiple criteria.

Anmerkung

The existing criteria row needs to be completed before adding a new row.

The right button is used to Search for items where all criteria are met or Search for items where any criteria
are met. The all criteria are met search requires all of the criteria rows to have at least one match. The any
criteria are met search requires only one of the criteria rows to be matched.

The criteria row in the Search Criteria pane is used to combine different criteria buttons (see tables
Tabelle 8.2, „Search criteria buttons - Customer Search“, Tabelle 8.3, „Search criteria buttons - Invoice
Search“, Tabelle 8.4, „Search criteria buttons - Job Search“, Tabelle 8.5, „Search criteria buttons - Vendor
Search“, Tabelle 8.6, „Search criteria buttons - Bill Search“, Tabelle 8.7, „Search criteria buttons -
Employee Search“ Tabelle 8.8, „Search criteria buttons - Expense Voucher Search“ for a comprehensive
list of combinations)

Type of Search section

In the Type of Search pane there are five selections. The first and alst options are always selectable while
the following three are available only when you perform the first search by setting some search criteria
and pressing the Find button.
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New Search Perform a new search

Refine current search Search within the results of the previous
search

Add results to current search Search based on the first set of criteria or the
new criteria

Delete results from current search Discard any results that match the previous
search results

Search only active data Search only if data are marked as active.

The rest of the search dialog

When search criteria are selected, you can press the Find button. You will be presented with the list of
search results in the same Find dialog.

Tipp

Aside from the results, GnuCash gives you some buttons to manage the highlighted result.

Tipp

In the bottom right of the Find dialog there is a button that allows you to create a New business
item.

Anmerkung

Press the Close button to close the Find assistant dialog.

List of search criteria buttons

Tabelle 8.2. Search criteria buttons - Customer Search

Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

contains

matches
regexbCompany

Name does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexbCustomer

ID does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains
Billing
Contact matches

regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row
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Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

does not
match
regexb

contains

matches
regexbShipping

Contact does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

Tabelle 8.3. Search criteria buttons - Invoice Search

Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

contains

matches
regexb

Invoice ID
does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexbCompany

Name does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

is before

is before or
on

is on

is not on

is after

Date
Opened

is on or
after

Date
selection
field

Remove
row

is
Is Posted?

is not
set true

Remove
row

is before

is before or
on

is on

is not on

is after

Date Posted

is on or
after

Date
selection
field

Remove
row
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Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

is
Is Paid?

is not
set true

Remove
row

contains

matches
regexb

Billing ID
does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexbInvoice

Notes does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

Customer

Vendor

Employee
is

Job

Customer

Vendor

Employee

Invoice
Owner

is not

Job

Criteria
entry field

Select...
Remove
row

Tabelle 8.4. Search criteria buttons - Job Search

Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

contains

matches
regexb

Job Name
does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexbJob

Number does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

Billing ID matches
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row
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Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

does not
match
regexb

isOnly
Active? is not

set true
Remove
row

contains

matches
regexbOwner's

Name does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

Tabelle 8.5. Search criteria buttons - Vendor Search

Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

contains

matches
regexbCompany

Name does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexb

Vendor ID
does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexbBilling

Contact does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

Tabelle 8.6. Search criteria buttons - Bill Search

Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

contains

matches
regexb

Bill ID
does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

Company
Name

contains
Criteria
entry field

Is entry
Case
Insensitive?

Remove
row
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Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

matches
regexb

does not
match
regexb

is before

is before or
on

is on

is not on

is after

Due Date

is on or
after

Date
selection
field

Remove
row

is before

is before or
on

is on

is not on

is after

Date
Opened

is on or
after

Date
selection
field

Remove
row

is
Is Posted?

is not
set true

Remove
row

is before

is before or
on

is on

is not on

is after

Date Posted

is on or
after

Date
selection
field

Remove
row

is
Is Paid?

is not
set true

Remove
row

contains

matches
regexb

Billing ID
does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

Bill Notes
contains

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row
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Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

matches
regexb

does not
match
regexb

Customer

Vendor

Employee
is

Job

Customer

Vendor

Employee

Bill Owner

is not

Job

Criteria
entry field

Select...
Remove
row

Tabelle 8.7. Search criteria buttons - Employee Search

Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

contains

matches
regexbEmployee

Name does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexbEmployee

Username does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexbEmployee

ID does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

Tabelle 8.8. Search criteria buttons - Expense Voucher Search

Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

contains

Voucher ID matches
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row
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Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

does not
match
regexb

contains

matches
regexbEmployee

Name does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

is before

is before or
on

is on

is not on

is after

Due Date

is on or
after

Date
selection
field

Remove
row

is before

is before or
on

is on

is not on

is after

Date
Opened

is on or
after

Date
selection
field

Remove
row

is
Is Posted?

is not
set true

Remove
row

is before

is before or
on

is on

is not on

is after

Date Posted

is on or
after

Date
selection
field

Remove
row

is
Is Paid?

is not
set true

Remove
row

contains

Billing ID matches
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row
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Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

does not
match
regexb

contains

matches
regexbVoucher

Notes does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

Customer

Vendor

Employee
is

Job

Customer

Vendor

Employee

Voucher
Owner

is not

Job

Criteria
entry field

Select...
Remove
row

Since Last Run Assistant
The Since Last Run assistant is run automatically when GnuCash is started. It is used to enter into the
register any transactions that are due to be automatically entered (see „Buchungen terminieren“). The run
on GnuCash start can be altered in the Scheduled Transactions tab of the GnuCash Preferences. To run the
Since Last Run assistant manually, go to Actions → Scheduled Transactions → Since Last Run...

In the Since Last Run assistant window you can see three columns:

Transaction The name assigned in the Scheduled Transaction Editor that identifies the scheduled
transaction.

State The state column of the scheduled transaction can be one of the following:

Tipp

Click on the state field in the row of a transaction to change its state (this
option is available only if the state field is not empty)

Ignored If a scheduled transaction is being displayed, either to be created
or as a reminder, the user can set the status to Ignored to skip this
event. The scheduled transaction will not be entered in the register
and the next reminder for this scheduled transaction will be the
next occurrence. For instance, if you have a scheduled transaction
set up with a reminder to transfer $500 at the end of the month
to your savings account but you bought yourself a computer this
month and don’t have the money for this month’s transfer then
you would set the status to Ignored.

183



Tools & Assistants

Postponed If a scheduled transaction has been listed with a status To-create
but you want to hold it and not have it entered to your register
yet, then you can set it to Postponed. When at some later time
you change it back to To-create it will be created with the
original posted-date. If you want to change that you must edit the
transaction after it's created.

Reminder You are n days from the scheduled transaction due date. The
number of days n to remind in advance, is set either in the
GnuCash Preferences Scheduled Transactions tab or in the
Overview tab of the Scheduled Transaction Editor.

To-create This scheduled transaction will be automatically created when you
press OK.

Empty An empty field means that no operations are pending for the
scheduled transaction.

At the bottom of the window there are two buttons:

• The Cancel button is used to exit the Since Last Run window without creating the transactions scheduled
to be entered.

• The Ok button closes the Since Last Run window and applies the pending operations.

At the bottom right of the Since Last Run window there is also an option that allows to Review created
transactions. If this option is enabled when there are one or more transactions To-create, pressing OK
will open a register window in which are shown the details of the scheduled transactions splits entered
automatically by GnuCash.

Mortgage & Loan Repayment Assistant
This assistant creates a loan repayment scheduled transaction. When used to setup a scheduled transaction,
the assistant creates a variable formula so that the compounding interest is correctly calculated. To start
this assistant manually go to Actions → Scheduled Transactions → Mortgage and Loan Repayment... .

It does not support zero-interest loans, but one doesn't really need an assistant for that: Just create a
scheduled transaction for the principal divided by the number of payments that lasts for the number of
payments. For example, if one has borrowed $1200 for a year at no interest and promised to pay it back
in monthly installments, the repayment schedule is $100 monthly for twelve months.

The Mortgage and Loan Repayment assistant opens with a screen that briefly describes what this assistant
does. The three buttons at the very bottom of the screen will not change while using the assistant.

• The Cancel button is used to exit the assistant and cancel creating the scheduled transaction. Any
selections you have made in this assistant up to this point will be lost.

• The Back button will bring up the previous screen so you can change a selection made on that screen.

• The Forward button will bring up the next screen so you can continue though the assistant.

The next screen allows you to enter the basic loan information. This is usually the information provided
by the bank when loan and disclosure documents are given to the borrower. Here you can also setup an
account that the scheduled transaction will use to enter the payment transaction.
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• Loan Account: Choose an account for the loan payment transactions or use New... to setup a new account
for the transactions.

• Loan Amount: Enter the amount of the loan.

• Interest Rate: Enter the loan interest rate in percent per compounding period. The Assistant supports
rates between .001% and 100%.

• Type: Choose the type of loan. If an adjustable rate is used the frequency screen is enabled.

• Interest Rate Change Frequency: Choose the frequency for the rate change and the start date of the rate
change.

• Start Date: Choose the date the loan is starting on.

• Length: Enter the length of the loan with the number and period, e.g. 60 months or 5 years.

• Months Remaining: This tells the Assistant how many months remain on the loan. The default value
assumes that the loan is paid up through today. For example, if a 5-year loan started on 1 January 2012
and today is 12 July 2015, the default months remaining is 18. If you want to create past payment
transactions you'll set the months remaining accordingly: In our example, if you wanted to create all of
the payments you'd set "months remaining" to 60; if you wanted to start tracking the payments at the
beginning of 2015 you'd enter 24.

The next screen is used to set escrow, insurance and tax options for the loan. It is mainly used for mortgage
payments. When each of the options here is set, this enables additional pages in the assistant to setup those
portions of the payments. All of the pages will be described here, even though some may not show if that
option is not chosen.

• ... utilize an escrow account for payments?: This selection enables the use of an account setup for
tracking escrow payments. If the mortgage or loan uses an escrow account to pay taxes, insurance, etc
then setup an account here.

• ... pay "Taxes"?: adds an additional page to setup a scheduled transaction to pay taxes.

• ... pay "Insurance"?: adds an additional page to setup a scheduled transaction to pay insurance payments.

• ... pay "PMI"?: adds an additional page to setup a scheduled transaction to pay PMI payments.

• ... pay "Other Expense"?: adds an additional page to setup a scheduled transaction to pay other expenses.

The next screen is used to setup the details of the scheduled transaction for the Loan Repayment.

• Transaction Memo: The name entered here will be used as the name for the scheduled transaction, the
description of the scheduled transaction and the memo.

• Payment Amount: Shows the variable used to calculate the payment amount.

• Payment From: Choose an account to pay the loan amount from.

• Principal To: Choose an account to transfer the principal part of the loan to.

• Interest To: Choose an account to transfer the interest part of the loan to.

• Repayment Frequency: Select the Frequency and start date for loan repayments. Note that the start date
will be the posted date of the first scheduled transaction. This is not taken into account for calculating
the remaining duration of the loan, see Months Remaining:. Make sure that you set both to reflect your
intentions or you may get surprising results.
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The next screen is used to setup the details of the scheduled transaction for the Tax payment.

• Transaction Memo: The name entered here will be used as the name for the scheduled transaction, the
description of the scheduled transaction and the memo.

• Amount: Enter the payment amount.

• Payment From: Choose an account to pay the tax amount from.

• Payment To: Choose an account to transfer the tax payment to.

• Repayment Frequency: Select the Frequency and start date for tax payments.

The next screen is used to setup the details of the scheduled transaction for the Insurance payment.

• Transaction Memo: The name entered here will be used as the name for the scheduled transaction, the
description of the scheduled transaction and the memo.

• Amount: Enter the payment amount.

• Payment From: Choose an account to pay the insurance amount from.

• Payment To: Choose an account to transfer the insurance payment to.

• Repayment Frequency: Select the Frequency and start date for insurance payments.

The next screen is used to setup the details of the scheduled transaction for the PMI payment.

• Transaction Memo: The name entered here will be used as the name for the scheduled transaction, the
description of the scheduled transaction and the memo.

• Amount: Enter the payment amount.

• Payment From: Choose an account to pay the PMI amount from.

• Payment To: Choose an account to transfer the PMI payment to.

• Repayment Frequency: Select the Frequency and start date for PMI payments.

The next screen is used to setup the details of the scheduled transaction for the Other Expense payment.

• Transaction Memo: The name entered here will be used as the name for the scheduled transaction, the
description of the scheduled transaction and the memo.

• Amount: Enter the payment amount.

• Payment From: Choose an account to pay the other expense amount from.

• Payment To: Choose an account to transfer the other expense payment to.

• Repayment Frequency: Select the Frequency and start date for other expense payments.

The last screen gives you a list of three choices to finish the assistant.

• The Cancel button is used to exit the assistant and cancel creating a new loan scheduled transaction.
Any selections you have made in this assistant up to this point will be lost.

• The Back button will bring up the previous screen so you can change a selection made on that screen.
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• The Finish button creates the scheduled transaction.

You should now have the Mortgage or Loan Repayment scheduled transaction setup.

Recording a Stock Split
Stock splits commonly occur when a company decides its stock price is too expensive for individual
investors to buy the stock. Splits have the effect of lowering the price of a single share while keeping the
value of shares owned by investors who have already purchased shares.

Stock Split Assistant
GnuCash uses the Stock Split assistant to record stock splits. This provides a way of entering the details
of the stock split and also any change in stock price or cash disbursement as a result of the stock split.

The Stock Split assistant is accessed by going to Actions → Stock Split... .

The Stock Split assistant opens with a screen that briefly describes what this assistant does. The three
buttons at the very bottom of the screen will not change while using the assistant.

• The Cancel button is used to exit the assistant and cancel entering the stock split information. Any
selections you have made in this assistant up to this point will be lost.

• The Back button will bring up the previous screen so you can change a selection made on that screen.

• The Forward button will bring up the next screen so you can continue though the assistant.

The next screen allows you to select a Stock Account. Select an account from the list to record a stock
split or merger.

• Account: Lists the GnuCash account name for the stock.

• Symbol: The stock symbol for the stock associated with this account.

• Shares: The amount of shares that have been purchased in the account.

The next screen lets you set the Stock Split Details. The top part of the screen contains details used in
creating the stock split transaction.

• Date: Choose the date of the stock split.

• Share Distribution: Enter the amount of shares gained from the stock split. For a stock merger enter a
negative number.

• Description: Enter a description or leave as the default.

The bottom part of the screen contains details used to record a price for the split (optional).

• New Price: Enter the price of the shares on the day of the stock split.

• Currency: Choose the currency of the shares.

The next screen lets you enter a transaction for a cash disbursement (Cash In Lieu) as a result of the stock
split (optional).

• Cash Amount: Enter the amount of the Cash disbursement.
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• Memo: Enter a memo or leave as the default.

• Income Account: Choose an Income Account for the disbursement.

• Asset Account: Choose an Asset Account for the disbursement.

The last screen gives you a list of three choices to finish the assistant.

• The Cancel button is used to exit the assistant and cancel creating the Stock Split transactions. Any
selections you have made in this assistant up to this point will be lost.

• The Back button will bring up the previous screen so you can change a selection made on that screen.

• The Finish button creates the transactions for the Stock Split.

You should now have successfully entered the Stock Split or Merger.

The Online Banking Setup Assistant
The Online Banking Setup Assistant is used to create or edit the configuration to enable interaction
with your bank. For this purpose the package AqBanking is used. It contains several modules with
different abilities. Their availability depends on the region. But all can fetch the current balance and recent
transactions.

Tabelle 8.9. AqBanking Supported Protocols

Module Send Orders Region Notes

EBICS AT, CH, DE, FR Usually available for
business users.

FinTS
Yes

DE Submodules: HBCI,
PIN/TAN.

OFX DirectConnect US a Not to confuse with
„OFX WebConnect“!

PayPal

No

intl.
aIf you know about banks in other countries, update the wiki table [https://wiki.gnucash.org/wiki/
OFX_Direct_Connect_Bank_Settings].

Tipp

If Online Banking Setup does not appear in your Tools menu, verify that you are in an Account
Tree or Register tab.

The currently available instructions are still kept in the GnuCash wiki and depend on the used module:

EBICS No users shared their expirience util now.

FinTS This module is only documented in German.
Overview https://wiki.gnucash.org/wiki/De/Online-Banking,
usage of the https://wiki.gnucash.org/wiki/De/Onlinebanking-
Einrichtungsassistent, and details of the different https://
wiki.gnucash.org/wiki/De/PIN/TAN methods.

OFX DirectConnect Instruction for this process are in English at https://
wiki.gnucash.org/wiki/Setting_up_OFXDirectConnect.
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PayPal This module is only documented in German https://
wiki.gnucash.org/wiki/De/Paypal einrichten.

Price Editor
Anmerkung

GnuCash uses the term commodity to mean anything that it counts: Currencies, securities (i.e
intangible assets like stock or mutual fund shares and bonds), or tangible assets like trucks
and computers. When valuing one commodity in terms of another it uses the term Exchange
Rate between two currencies and Price between a non-currency commodity and a currency
commodity. For the rest of this section we'll use "price" to mean both price and exchange rate
and "commodity" to mean any sort of commodity except where currency behavior is different.

The Price Editor is used to list and edit the price of one commodity in another commodity. New prices
can be added, existing prices can be edited, and prices can be retrieved from a variety of sources on the
World-Wide Web when the commodity is properly configured.

Each commodity pair can have one price per day. An existing price will be overwritten by a newer one if the
newer one has the same or a more preferred source. The order of source preference (1 is most preferred) is:

1. user:price-editor: Prices created manually in the Price Editor

2. Finance::Quote: Online quotes

3. user:price: Prices entered explicitly in the Exchange Rateentry of the Transfer Funds dialog box or in
the Price column of a register for an account of types STOCK or MUTUAL

4. user:xfer-dialog: Prices calculated from an entry in the To Amount entry of the Transfer Funds dialog
box.

5. user:split-register: Prices calculated from the Shares and Debit or Credit columns of a register for an
account of types STOCK or MUTUAL

6. user:stock-split: Prices entered in the Stock Split Assistant

Anmerkung

Prices created manually in the Price Editor are preferred over prices retrieved via Finance::Quote
so Finance::Quote will fail to update such manually-created prices.

The Price Editor displays existing prices as follows:

• Security: The Security/commodity being priced. The display is sorted by the Namespace that the
individual securities are listed on. The list is expanded by clicking on the caret on the left of the name.

• Currency: The currency the price is recorded in.

• Date: The date the price was recorded.

• Source: The source of the commodities price quote, listed above.

• Type: There are several different types of stock price quotes.

• Bid: Indicates what a specialist dealer is prepared to pay for a stock.

• Ask: Indicates at what price the dealers are prepared to sell a stock.
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• Last: Indicate the price at which the last trade in that stock/security occurred at. This is the price
most commonly quoted in the media.

• Net Asset Value: Are typically used for mutual funds. They are calculated on the net value of the
fund’s assets each day around the time of the market close and are in effect until the next recalculation.

• Unknown: Use this if the type of price quoted is not known.

• Price: The actual price of the commodity.

Adding a stock price manually
To add a new price, click on Add, and enter the details of the security and price into the dialog box. To
edit an existing price, select the price in the price list, click the Edit button, and edit the figures.

To remove just one price, select the price and click the Remove button. If you want to remove all prices
older than a certain date, click on the Remove Old button and enter the details in the dialog box.

A pop-up will display with the message "Delete all stock prices based upon the criteria below:". Enter
the date of the last price you wish to delete.

Two check-boxes are below the date field;

• Delete manually entered prices - If checked, delete manually entered stock prices dated earlier than the
specified date. Otherwise only stock prices added by Finance::Quote will be deleted.

• Delete last price for a stock - If checked, delete all prices before the specified date. Otherwise the last
stock price dated before the date will be kept and all earlier quotes deleted.

Configuring for use of the Get Quotes button
To support on-line quotations for a particular stock or mutual fund account, you must first enable on-line
price quoting and select a price source in the Security. This is described in detail in „Configuring Securities/
Currencies for On-Line Retrieval of Prices“. Once on-line quotes are enabled, and Finance::Quote is
installed, you can update prices for your stocks and mutual funds manually by clicking the Get Quotes
button.

Security Editor
The Security Editor is used to create and edit commodities that are used by mutual fund and stock type
accounts. It also shows the details of National Currencies that are used by GnuCash.

To show the details for National Currencies click the Show National Currencies check-box at the bottom
of the screen.

Each entry in the editor shows the details used by the security/currency:

• Type: Categories for organizing securities. GnuCash has the following built in:

• CURRENCY or ISO4317: These are used for national currencies and are not editable with the
Security Editor.

• FUND: Ordinarily used for open-ended mutual funds, i.e., those that one purchases from and sells to
only the issuing company and that are priced daily at their net asset value.
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• AMEX, ASX, EUREX, NASDAQ, and NYSE: These represent a few of the exchanges on which
stocks, closed-end mutual funds, and exchange-traded funds are traded.

• Template: This is a reserved word. It will not normally appear in the Security Editor unless you type
it in, and if you do it will cause problems. Don't use it.

If your investment doesn't fit into one of these categories, for example if you trade stocks on the DAX
or LSE, you can easily create your own type simply by typing it into the field. The type of security has
no meaning to Gnucash (except Template, don't use that!), it's there only to make it easier for you to
find the security from the selection lists.

• Symbol: Indicates the symbol or abbreviation for the commodity. This is usually the ticker symbol
(for stocks) or other unique abbreviation for the commodity. If the commodity is traded on any public
exchange, it is important to use the same identifier used on that exchange. For national currencies the
symbol is the ISO-4217 currency code.

• Name: The full name of the commodity is a recognizable name such as US Dollars or IBM Common
Stock.

• Code: This is any numeric or alphanumeric code that is used to identify the commodity. The ISIN code
is an international unique identifying numeric string that is associated with every stock, bond or mutual
fund, and most kinds of traded options, futures and commodities. There are also regional valid codes
available like CUSIP in the North America, WKN in DE, … This code is not required.

• Fraction: This is the smallest traded unit of the commodity, expressed as a fraction of a single nominal
unit. This unit is used by GnuCash accounts as the default fraction for trades in the commodity.

Adding or Editing a Commodity
To add a new commodity (stock, or mutual fund), click on Add, and enter the details of the commodity into
the New Security dialog box. To edit an existing commodity, select the commodity from the Commodities
list, click the Edit button, and edit the Edit Security dialog box. To remove a commodity, select the
commodity and click the Remove button.

The fields in the New/Edit Security screens are the same as defined for the Security Editor „Security
Editor“. Below these fields are the options for Online Quotes.

Configuring Securities/Currencies for On-Line Retrieval
of Prices

To support on-line quotations for a particular stock or mutual fund account, you must first enable on-line
price quoting and select a price source in the Security Editor. Online currency quotes require only that
the check-box for Online quotes and the timezone be selected, and that the „Get Quotes“ box be checked
in the Security Editor.

Detailed instructions are in the section on Creating New Accounts. „Vorgehensweise zur Aktivierung der
Online-Preisaktualisierung“

Loan Repayment Calculator
The Loan Repayment Calculator is used to calculate compound interest. It provides a way of entering four
of the five parameters of a compound interest calculation and then calculating the remaining figure.
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The calculator is split into two panes. The left pane has five fields with a Calculate button and a Clear
button. The Calculate button is used to select the figure to calculate. The Clear button is used to clear any
amount in the field.

• Payment Periods: This field is used to select the number of payments you wish to use in the calculation.

• Interest Rate: This field is used for the interest rate percentage.

• Present Value: This field usually contains the amount you have borrowed. It is the base amount you
wish to compound.

• Periodic Payment: This field contains the amount that is the payment for the period selected (IE
monthly, weekly, etc). If it is for repaying a loan it should be a negative number.

• Future Value: This field contains the final value at the end of the periods above. If we are repaying
a loan in full it would be 0.

The right pane contains buttons to select what sort of payments and compounding is used for the left pane
calculations.

• Compounding: This button allows you to select the interval used if the Discrete Compounding button
is selected.

• Payments: This button allows you to select the interval used for the Payment Periods field.

• End of Period Payments: Use this button if the payment is at the end of the period.

• Beginning of Period Payments: Use this button if the payment is at the beginning of the period.

• Discrete Compounding: This button is used where interest is charged at a discrete interval defined by
the Compounding button above.

• Continuous Compounding: This button is used when the interest is charged continuously.

• Payment Total: This field shows the total amount paid.

Examples of using the Loan Repayment Calculator are given in the Tutorial and Concepts Guide.
GnuCash Tutorial and Concepts Guide’s Chapter on Loans [https://code.gnucash.org/docs/C/gnucash-
guide/loans_calcs1.html]

Close Book
The Close Book dialog box is used for “closing the books,”--an accounting process that resets the balances
of the income and expense accounts. In this process, income account balances are transferred into an
income equity account, while expense account balances are transferred into an expense equity account.
You must specify both these accounts, which may be the same. You must also specify the date for the
closing transfer.

Dialog Box Details
The dialog box has the following parts:

• Closing Date: Specify the date for the closing transfer. You can type in a date or choose one from the
drop-down.

• Income Total: Specify the account into which the total balance of all income accounts will be transferred.
Optionally you can create a new account to receive the transfer using the New button.
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• Expense Total: Specify the account into which the total balance of all expense accounts will be
transferred. Again, you can optionally create a new account to receive the transfer using the New button.

• Description: Specify the description that will be entered in the closing entry.

How It Works
GnuCash closes books by creating one transaction per currency for income accounts, and one transaction
per currency for expense accounts. The transactions all use the date selected by the user, and each
transaction may contain any number of splits. Each split moves the balance out of one income or expense
account. The last split in each closing transaction moves the total offsetting debit/credit balance into the
specified equity account.

Each transaction will use the description provided by the user in the Description: entry.

The fact that GnuCash just uses transactions to close the books makes it very simple to undo a book closing:
just delete the closing transactions.

What It Doesn’t Do
The book closing tool does not delete any accounts or transactions; create any new files; or hide any
accounts.

Necessity
Note that closing the books in GnuCash is unnecessary. You do not need to zero out your income and
expense accounts at the end of each financial period. GnuCash’s built-in reports automatically handle
concepts like retained earnings between two different financial periods.

In fact, closing the books reduces the usefulness of the standard reports because the reports don’t currently
understand closing transactions. So from their point of view it simply looks like the net income or expense
in each account for a given period was simply zero.

Conclusion
If you close your books, be prepared to see inaccuracies in the standard reports. On the other hand, you
will see current-period income and expense figures in the chart of accounts.

Lots in Account
GnuCash uses lots in 2 ways:

• To link security buy transactions to sell transactions so the real cost of the sold securities can be used
to calculate capital gain or loss. See „Lots for Security Capital Gains“.

• To link payments or credit notes to the invoices to which they apply in the Business Features. See „Lots
for Business Features“.

Lots for Security Capital Gains
The Lots in Account SSSS window, where SSSS is the security account, is used to manually or
automatically link security transaction splits to lots and create capital gain/loss transactions to account for
the difference between the costs of buying a security and the value received by selling it.
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To open the Lots in Account window, open the security account register, then select Actions → View Lots .

Abbildung 8.1. Lots in Account window for Security Capital Gains

An image of the Lots in Account  window for a security account.

Screen Elements

Adjusting the Size of Screen Elements

As well as adjusting the size of the whole window, it is possible to adjust the proportions of the window
elements both horizontally and vertically.

There are 2 bars for adjusting the window horizontally. One between the Title and the Lots in This Account
panel, and the other between the Splits free panel and the >> and << buttons.

The window proportions may be adjusted vertically by dragging the vertical bar located to the right of
Show only open lots.

These resizing bars can be hard to see, so move the mouse pointer until it changes to the resize pointer then
click and drag the bar. The resize pointers are different depending on your operating system and theme.
Here are some examples of resize pointers:

 

It is not possible to individually adjust the size of panel columns.

Fields

• Title: Shows the title for the highlighted (selected) lot in the Lots in This Accountpanel. When a new
lot is created by clicking the New Lotbutton, it has a default title of Lot n  where n is a number starting
at 0 (for each security account) and incrementing by 1. Deleting a lot does not reset the next number to
be used, but the title can be changed as required.

• Notes: Notes for the highlighted lot. Users are free to enter anything they wish and the notes can be
changed as required.

Panels

The order of the items in all the panels in this window can be adjusted by clicking on the column headings.

• Lots in This Account panel

This panel shows lots for this security account.

If Show only open lots is checked, only lots that have not been completely sold are shown.

Columns

• Type: Always blank for security lots. This window is also used for business lots (which link payments
to invoices) when coming from an Accounts Payable or Receivable account and in that case, Type
will be I for invoice. Credit Notes are also Type I.

• Opened: Open  if there are no splits in the lot, otherwise the date of the earliest split in this lot.

• Closed:  Open if the lot is not fully sold, otherwise the date of the last sell split.
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• Title: Lot Title.

• Balance: Number of unsold securities in this lot.

• Gains: Calculated gains or losses for this lot.

• Splits free panel

This panel shows buy and sell splits for this security account which are not linked to a lot. Capital Gains
splits (Shares and Price are 0) are not shown.

Columns

• Date: Transaction Date Posted.

• Num: Transaction Num.

• Description: Transaction Description.

• Amount: Number of shares bought or sold from the transaction split. Positive for buys, negative for
sells. If the security transaction split has been split into multiple subsplits (because a split may only be
linked to 1 lot), this amount will not be the full transaction amount, but only the amount for this split.

• Value: Amount x split price.

• Gain/Loss: For sell splits, shows calculated gain or loss. This will be recalculated during scrubbing.

• Balance: Cumulative number of unsold shares for free splits.

• Splits in Lot panel

This panel shows splits linked to the highlighted lot in the Lots in This Account panel. This panel will
be empty until a lot is highlighted in the Lots in This Account panel. Capital Gains splits (Shares and
Price are 0) are not shown.

Columns

• Date: Transaction Date Posted.

• Num: Transaction Num.

• Description: Transaction Description.

• Amount: Split number of shares bought or sold. Positive for buys, negative for sells. If the security
transaction split has been split into multiple subsplits (say by scrubbing because a split may only be
linked to 1 lot), this amount will not be the full transaction amount, but only the amount for this split.

• Value: Amount (No of Shares) x split price.

• Gain/Loss: For sell splits, shows calculated gain or loss. This will be recalculated during scrubbing.

• Balance: The number of unsold shares in this lot after this transaction.

Buttons

• >>: Links a free split (buy or sell) to a lot. This button is not enabled until both a lot and a free split are
highlighted. The split moves from the Splits free panel to the Splits in lot panel.
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Multiple buy splits and multiple sell splits may be linked to the same lot. Refer to following section
about the Scrub Account button for details of the capital gains transactions created in these situations.

• <<: Unlinks a split from a lot. The split moves from the Splits in lotpanel to the Splits free panel. This
button is not enabled until a split in the Splits in lot panel is highlighted. When the last split is unlinked
from a lot, the lot is automatically deleted if there is no capital gain/loss transaction.

• New Lot: Creates a new lot which shows in the Lots in This Account panel. The new lot is not linked
to any split.

• Scrub Account:

• Creates a lot for each buy transaction split that is not already linked to a lot.

A new lot is created for each unlinked buy transaction split because gains on investments, in some
jurisdictions, may be taxed at different rates depending on how long they were held before being sold.
As a separate capital gains transaction is created for each lot, this makes it easier to determine tax on
the capital gains based on the lot opened and closed dates.

If you know that the capital gains from a sale are all to be taxed at the same rate, you can manually
link multiple buys to a lot so scrubbing will only create 1 capital gains transaction.

It is also possible to manually link multiple sell transaction splits to a lot. In this case scrubbing
creates a capital gains transaction per sell transaction split based on the average cost of securities
held at the time of each sale, assuming acquisitions are allocated to sales using the security account
costing method (currently only FIFO). As this makes it complicated to manually verify the costs are
correct, it may be wise to limit this to specific situations, say for example if there are multiple sales
on the same day.

• Links buy and sell transaction splits to lots using FIFO method.

• Calculates gain/loss and creates a separate capital gain/loss transaction for each lot that does not
already have one.

Anmerkung

If gain/loss splits have been manually entered as part of a sell transaction, scrubbing does not
recognize them, so if manually adding gain/loss, always separate the gain/loss splits from
the transaction that reduces the No of Shares, by putting them in a separate transaction.

• Scrub: Scrub only the highlighted lot. This button is only enabled if a lot is highlighted. If no buy splits
are linked to the highlighted lot, nothing is done. The Scrub button will link any free sell splits to the lot
as required until the sum of the sell split amounts equals the sum of the buy split amounts. If the sum
of the sell split amounts is greater than the sum of the buy split amounts, a sell split will itself be split
into 2 splits, with the remaining amount in an unlinked split.

Anmerkung

For both the Scrub Account and the Scrub buttons:

The Gain/Loss for each lot is recalculated and a capital gain transaction is created if needed.
The transaction has 1 split for the security account and the other with account Orphaned Gains-
CCC where CCC is the security currency. The Orphaned Gains-CCC  account is used because
GnuCash doesn't know which capital gain or loss account should be used, so the user must
change it to the required income (or expense) gain or loss account.
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• Delete: Delete the highlighted lot. Any linked splits are automatically freed (unlinked). This button is
only enabled if a lot is highlighted.

• Close: Close the Lots in Account SSSS window.

See Tutorial and Concepts Guide,  Automatic Calculation of Capital Gain or Loss Using Lots [https://
code.gnucash.org/docs/C/gnucash-guide/invest-sell1.html#invest-sellLots] for more details.

Lots for Business Features

Introduction

For business features, lots are used to link payments or credit notes to the invoices to which they apply.
This is for both customer invoices and vendor bills.

There are 2 main uses for the Lots in Account window in relation to the business features:

1. To enquire about which payments or credit notes offset particular invoices. For each invoice and credit
note, GnuCash automatically creates 1 (and only 1) lot. By selecting the lot for the invoice or credit note
in the Lots in This Account panel, all the transaction splits for that lot show in the Splits in Lot panel.

Tipp

Alternatively, print the invoice and check the Payments option on the Display tab in the report
options. The Tax Invoice always shows payments so does not have the Payments option.

2. To correct mistakes that are hard to correct otherwise (either due to bugs in past versions of gnucash
or due to unintended use of said features). Some of these use cases are found on this wiki page [https://
wiki.gnucash.org/wiki/Business_Features_Issues]. In the context of the normal operation of business
features , the Lots in Account window is not used to create, delete, link or unlink lots. Lots are usually
generated and manipulated internally only by the business features programs.

To open the Lots in Account AAAA window, where AAAA is the Accounts Receivable (AR) or Accounts
Payable (AP) account, open the AR or AP account register, then select Actions → View Lots .

Abbildung 8.2. Lots in Account window for business features

An image of the Lots in Accountwindow for an Accounts Receivable account.

Screen Elements

The screen elements of the Lots in Account window for an AR or AP account are the same as for a security
account, although the actions and data are different. As this window is only used for creating, deleting,
linking or unlinking lots in  exceptional circumstances, the differences are not described. See „Screen
Elements“ for a description of the screen elements and what the buttons do when used with the lots of
a security account.
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Kapitel 9. Reports And Charts
Geehrte Leser, leider hat bisher niemand eine Übersetzung der folgenden Teile erstellt. Falls Sie uns dabei
helfen möchten, folgen Sie bitte der Anleitung in  Gnucash wiki: How to translate the GnuCash guide and/
or help files [https://wiki.gnucash.org/wiki/Translation#Translating_the_GnuCash_Guide_and_Help].
Fragen können auf der deutschsprachigen Mailingliste gnucash-de@gnucash.org diskutiert werden.

Anmerkung

This section is a „work in process“. Some of the material has not been reviewed for V2.0. While
it may not be strictly accurate, it is at least a "guide".

Introduction
Reports and Charts give GnuCash the ability to present an overview of financial data in various ways.
This can range from a simple summary of account totals to an advanced portfolio view. This section will
present an explanation of the main GnuCash reports and how to adjust them.

To run a report or chart, click on the Reports menu, then either select a report (it will open with standard
options), or click on Saved Report Configuration to select a report you have previously configured and
saved.

Once the report has opened, click on the toolbar button Options to configure the report as needed, for
example to set the report date or select accounts.

Tipp

If you intend to save a report configuration, you should choose a named report date option such
as Today rather than enter a specific date so it is not necessary to enter a specific date again in
future reports.

Tipp

If you often run a report with a date as at the start or end of an accounting period, set the accounting
period start and end dates in Edit → Preferences → Accounting Period then select appropriate
report date options. See „Buchführungsperioden“.

Tipp

If you cannot find a specific report to suit your requirements, you may be able to use the Find
Transaction assistant ( Edit → Find ) to select a set of transactions, and then report them using
Reports → Account Report . Further formatting or analysis may be done by copying and pasting
the report into a spreadsheet.

After you have configured a report, you can save the configuration for future use by clicking either the
Save Report Configuration or Save Report Configuration As... button.

Saving a Report Configuration
To save a report configuration for future use, while the required report tab is selected, go to the report
options, select the General tab and change the Report Name to a meaningful unique name. Do not confuse
this with the Report Title which prints at the top of a report.
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Click the Save Report Configuration or Save Report Configuration As... button.
This will store your customized report options in a file below your home
directory. The exact location depends on your OS, its version and the GnuCash
version. See wiki:Configuration_Locations#GTK_CONFIG_HOME [https://wiki.gnucash.org/wiki/
Configuration_Locations#GTK_CONFIG_HOME], GNC_DATA_HOME [https://wiki.gnucash.org/
wiki/Configuration_Locations#GNC_DATA_HOME] and Files in GNC_DATA_HOME
[https://wiki.gnucash.org/wiki/Configuration_Locations#In_GNC_DATA_HOME] Then it is
GNC_DATA_HOME/saved-reports-version.

The first time you save a report with a name that has not already been saved, you can use either the Save
Report Configuration or the Save Report Configuration As... button. You can modify the report name
before saving it.

After a report configuration for a specific name has been saved, the Save Report Configuration button will
immediately update the saved report configuration without giving the opportunity to save the configuration
with a new name. Use the Save Report Configuration As... button to save the current report configuration
with a new name.

After your customized report has been saved, it is available for use by the Reports → Saved Report
Configurations menu and it will also be listed when starting Reports → Sample & Custom → Custom
Multicolumn Report .

Working with Saved Report Configurations
Selecting Reports → Saved Report Configurations will open a dialog window with the list of the Saved
Report Configurations you have previously created. In this context Saved Report Configurations means
the set of customized settings for standard reports.

The Saved Report Configurations window lists each of your previously saved report configurations, and
3 small buttons at the end of each. These buttons perform the following actions

• Load (and run) report configuration. Double clicking a report configuration also performs this action.

• Edit report configuration name. This enables a report configuration to be renamed.

• Delete report configuration.

Configuring Reports and Charts
GnuCash reports have many configuration options. First, run the original report itself. Then, access the
report options with the Options button on the toolbar.

Anmerkung

Check changed Graphic Engine Options

Report Options Buttons
After modifying report options, either

• Click the OK button to apply the changes, regenerate the report and close the options window.

or
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• Click the Apply button to apply the changes, regenerate the report and leave the options window open
for possible further changes. In this case, both the Apply and OK buttons will be disabled, indicating
changes have been applied, until further changes are made.

or

• Click the Cancel button to close the options window without applying any unapplied changes.

Common Report Options
Many reports share similar options. Some common ones include:

• Report Name: Set the title of the report. This is also used to print the report for later viewing.

• Date Options: Reports typically specify either a single date, or a date range, for the report. Dates can be
specified in two ways, either directly (using the date selector), or by selecting a relative date from the
menu. Relative dates allow you to specify dates like Beginning of this year or Today.

Tipp

If you often run a report with a date as at the start or end of an accounting period, set the
accounting period start and end dates in Edit → Preferences → Accounting Period then select
appropriate report date options. See „Buchführungsperioden“.

• Step Size: This option is used on bar charts to determine the interval which each bar represents. Typical
values are daily, weekly, monthly, and yearly.

• Accounts: Select the appropriate accounts for the report. Note that in some reports only certain types of
accounts can be selected. For example, an expense piechart only allows expense accounts to be selected.

• Show Long Account Names: This option allows displaying either short account names (for example,
Power) or long account names (for example, Utilities:Power).

• Include Subaccounts?: Summary reports typically have an include all subaccounts option, which if
selected ensures that all subaccounts are included if the parent account is.

• Depth: This option allows the selection of how many levels the report displays subaccounts. If the
subaccounts go deeper than selected, an overall value for all the subaccounts is calculated and included
in a total. To make sure every account selected is individually displayed, select All.

• Style Sheet: Select a Style Sheet. Style sheets control how reports are displayed. At the moment, there
are four style sheets: Default, Easy, Footer and Technicolor. You can customize each of these from the
Edit → Style Sheets... menu item. This is described in the „Stilvorlagen organisieren“ section.

• Plot Dimensions: There are width and height options for most charts, which specify the displayed
dimensions (in pixels).

• Report Currency: Select the report currency. Generally, values will be converted to this currency for
display.

The default Report Currency is defined in Edit → Preferences Reports tab. See „Berichte“.

• Price Source: Select how stock and currency prices are calculated in this report. Choose between:

• Nearest in time (default for most reports): A price retrieved from the prices database on the date
nearest to the date of the report or of the datum for time-series reports.

• Most recent: The latest price in the price database.
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• Average Cost: The amount-weighted net average of all splits exchanging the commodity for another
regardless of account. Gain/loss splits are included in the calculation.

• Weighted Average: The gross amount-weighted average price of all splits exchanging the commodity
for another regardless of account. Gain/Loss splits are not in the calculation.

More information on Average Cost and Weighted Average may be found in the Investments chapter of
The Tutorial and Concepts Guide.

• Totals: Charts display totals in the chart legend if this option is selected.

• Maximum Slices: Controls the maximum number of slices displayed in a piechart - other accounts will
be placed in a slice marked Other.

• Maximum Bars: Controls the maximum number of bars displayed in a barchart.

• Display Columns: Choose columns to show from the register.

Reports Listed By Class
GnuCash has classified the main types of reports into major classes. These are all available under the
Reports menu.

General Reports
The General Reports include the Account Summary Report, the Future Scheduled Transactions Summary,
and the Transaction Report and also the reports in the Sample & Custom menu.

Account Summary

Future Scheduled Transactions Summary

Transaction Report

This report lists transactions in selected accounts during a specified financial period. Two fields may be
optionally used for sorting and totalling.

Report Options

Abbildung 9.1. Transaction Report, Report Options

This is an image of the Transaction Report, Report Options, Display tab.

• Accounts tab

• Accounts: Select one or more accounts to be reported.

There are 4 buttons to aid account selection

Select All Select all accounts

Clear All Clear the selection and unselect all accounts
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Select Children Select all descendants of selected account

Select Default Select the default account selection

• Show Hidden Accounts: Show accounts that have been marked hidden.

• Filter By: Optionally select accounts to be either included or excluded depending on Filter type

• Show Hidden Accounts: Show accounts that have been marked hidden in the Filter By list of accounts

• Filter Type: One of

None Do not do any filtering

Include Transactions to/from Filter Accounts Include Transactions to/from Filter Accounts
only

Exclude Transactions to/from Filter Accounts Exclude Transactions to/from all Filter Accounts

• Reset defaults button: Reset all values to their defaults

• Display tab

• Date refers to the 'posted date' i.e. effective date of a transaction.

• Reconciled Date refers to the 'date of reconciliation' of a transaction.

• Num is commonly used for check numbers.

• Description is a description of the transaction

• Memo is the memo field of a transaction. This can be used as a secondary description of a transaction.

• Notes: Display the notes if the memo is unavailable

• Account Name will print the account name containing the transaction.

• Use Full Account Name if the account name is enabled, this option will display the full account name
hierarchy.

• Account Code this refers to the 'account code' related to the account.

• Detail Level 1 : One of

Single Display 1 line per transaction,

Multi-Line Display a transaction header and 1 line per split.

If Detail Level is Multi-Line, check boxes Other Account Name and Use Full Other Account Name
are automatically deselected and disabled, and the Transfer column is not reported.

• Other Account Name: For multi-split transactions, this parameter should be unticked. See below for
more details.

• Use Full Other Account Name will enable display of full corresponding account name.

• Other Account Code will enable display of corresponding account code.

1Before GnuCash 3.0 Detail Level was called Style on the General tab.
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• Shares: Display number of shares

• Price: Display share prices

• Amount: One of

None Do not display Amount

Single Single column display

Double Two column display

• Subtotal Table will add a summary table for the various subtotals generated in the report. It lists the
same subtotals generated in tabular form.

• Running Balance refers to the running balance of the account holding the transaction.

• Totals will add a 'Grand Total' line adding all transactions in the report.

• Sign Reverses: One of

Global Preference Use reversing option specified in global
preference.

None Do not display signs reversed

Credit Accounts Reverse amount display for Liability, Payable,
Equity, Credit Card and Income accounts

Income and Expense Reverse amount display for Income and Expense
accounts

• Reset defaults button Reset all values to their defaults

• Filter tab

• Account Name Filter will include only selected accounts containing the substring. Alternatively, if
the next option is checked, the account name filter will be matched according to full POSIX regular
expressions.

• Use regular expressions for account name filter toggles regular expressions for account name filter.

• Transaction Filter will include only transactions which contain this substring in the description, notes,
or memo. Alternatively if the next option is checked, the filter will be matched using full POSIX
regular expressions.

• Use regular expressions for transaction filter toggles regular expressions for the transaction filter.

• Reconcile Status

All Show all transactions

Unreconciled Unreconciled only

Cleared Cleared only

Reconciled Reconciled only

• Void Transactions: One of 203
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Non-void only Show only non-voided transactions

Void only Show only voided transactions

Both Show both and include voided transactions in
totals

• Closing transactions: One of

Excluding closing transactions Show only regular transactions

Show both closing and regular transactions Show both regular and closing transactions

Show closing transactions only Show closing transactions only

• Reset defaults button: Reset all values to their defaults

• General tab

• Report name: Enter a descriptive name for this report

• Stylesheet: Select Default, Easy, Footer or Technicolor

• Start Date: Enter or select a specific Start Date

or select one of the following named start date options which will be used to determine the start date
each time the report is run

Today The current date

Start of this month First day of the current month

Start of previous month First day of the previous month

Start of current quarter First day of the current quarterly accounting
period

Start of previous quarter First day of the previous quarterly accounting
period

Start of this year First day of the current calendar year

Start of previous year First day of the previous calendar year

Start of accounting period First day of the accounting period as defined in
the global preferences

• End Date: Enter or select a specific End Date,

or select one of the following named end date options which will be used to determine the end date
each time the report is run

Today The current date

End of this month Last day of the current month

End of previous month Last day of the previous month

End of current quarter Last day of the current quarterly accounting
period

End of previous quarter Last day of the previous quarterly accounting
period
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End of this year Last day of the current calendar year

End of previous year Last day of the previous calendar year

End of accounting period Last day of the accounting period as defined in
the global preferences

• Detail Level1: One of

Single Display 1 line

Multi-Line Display N lines

• Common Currency: Convert all transactions into a common currency

• Report's currency: Select the currency to display values

• Show original currency amount Also show original currency amounts

• Table for Exporting: Formats the table for cut & paste exporting with extra cells

• Add options summary: Adds an informative text describing options that were changed by user. This
is mainly useful for troubleshooting reports.

• Reset defaults button: Reset all values to their defaults

• Sorting tab

• Primary Key: Primary Sort Key. One of

None Do not sort

Account Name Sort and subtotal by account name

Account Code Sort and subtotal by account code

Date Sort by date

Reconciled Date Sort by the reconciled date

Reconciled Status Sort by the reconciled status

Register Order Sort as within the register

Other Account Name Sort by account transferred from/to's name

Other Account Code Sort by account transferred from/to's code

Amount Sort by amount

Description Sort by description

Number Sort by check/transaction number

Memo Sort by memo

• Primary Subtotal: Subtotal according to the primary key

• Primary Subtotal for Date Key: Do a date subtotal. Only configurable if primary key is date or
reconciled date. One of None, weekly, monthly, quarterly or yearly

• Primary Sort Order: One of

Ascending Smallest to largest, earliest to latest
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Descending Largest to smallest, latest to earliest

• Secondary Key: Secondary Sort Key. Same options as Primary Key

• Secondary Subtotal: Subtotal according to the secondary key

• Secondary Subtotal for Date Key: Do a date subtotal. Only configurable if primary key is date or
reconciled date. One of None, weekly, monthly, quarterly or yearly

• Secondary Sort Order: One of

Ascending Smallest to largest, earliest to latest

Descending Largest to smallest, latest to earliest

• Show Full Account Name: Show the full account name for subtotals and subtitles

• Show Account Code: Show the account code for subtotals and subtitles

• Show Account Description: Show the account description for subtitles

• Show Informal Debit/Credit Headers: Show informal names for debit/credit in the subtitles. This
requires that subtotal is enabled, and the primary or sortkey is account or account code.

• Add indenting columns: Add columns to align transactions within the same grouping together, and
can be useful to highlight groups.

• Show subtotals only (hide transactional data): Will hide transactions. This may be useful for reports
whereby only subtotals are required.

• Reset defaults button: Reset all values to their defaults

Displaying Split Account Details

This is controled by the Detail Level1 option on the Display tab.

In Single line mode, there's only one line per transaction. So you can have the account name on one side
of the equation and

a. the other account name if there's only one other split in the transaction or
b. Split if there are multiple other splits in the transaction. You can't display multiple "other" account

names in one line. There's just no room for it.

In the case of Multi-Line mode, this report uses a completely different concept. For each transaction, every
split (both the split in this account and the split(s) in the other account(s) !) is printed on a separate line.
And every split really means every split: both the split which belongs in the account being reported and
the split(s) in the other account(s) that balance the transaction. So even the most basic transaction, with
only two splits (this account and other account) will print two lines in multiline mode.

For a simple transaction like this

Description Account Debit Credit

Cheques Received

Multiple Payers Income Account £30.00

Bank Account £30.00

then on a Transaction Report for the bank account the details appear pretty much as above.
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For clarity of the accounts, you might enter transactions with multiple splits referring to the same account.
For example, the above transaction might well be entered like this

Description Account Debit Credit

Cheques Received

First Payer Income Account £10.00

Second Payer Income Account £20.00

Bank Account £30.00

When this transaction is printed on the bank account's Transaction Report in Single line mode, then under
other account it simply prints the word split instead of the account name.

To display the additional split detail, you need to set Single/Multi-Line to Multi-Line and then tick Display
-> Account Name. Do not tick Display->Other Account Name.

You can choose whether or not to turn off the full account name using Display -> Use Full Account Name.

Use Full Other Account Name has no effect in Multi-Line mode.

Assets & Liabilities
The Assets & Liabilities reports includes the Balance Sheet report, Investment reports and the Net Worth
report.

• Advanced Portfolio:

Columns

• Account: Stock Account

• Symbol: Ticker Symbol/Abbreviation as defined in the Security Editor. A report option can suppress
this column.

• Listing: Type as defined in the Security Editor. A report option can suppress this column.

• Shares: Number of shares (quantity). A report option sets how many decimal places to show. A report
option can suppress this column.

• Price: Unit market price as at report date. A report option can suppress this column.

• Basis: Cost of all shares acquired by any means, including brokerage fees if the option to include
them is checked. Report option Basis calculation method can be set to Average, LIFO or FIFO.

• Value: Number of shares * Unit market price as at report date

• Money In: Sum of the cost of stock purchased, excluding stock acquired as part of a Dividend
Reinvestment Plan. I.e. External money used to purchase shares.

• Money Out: Money from selling shares or a spin off transaction.

• Realized Gain: Money received for selling shares minus basis for shares sold, minus brokerage fees
for the sale if the option to include them in basis is checked.

• Unrealized Gain: Value less Basis for unsold shares

• Total Gain: Realized Gain + Unrealized Gain
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• Rate of Gain: Total Gain / Money In * 100 (from GnuCash 2.6.1 onwards)

• Income: Total of all income transactions associated with a stock account.

Anmerkung

To include income from dividends which are not reinvested (if there is no split to the stock
account in the income transaction, the report has no way of associating the income with a
particular stock) :

Ensure there is a dummy transaction split to the stock account with quantity 0, price 1
and value 0 in the dividend transaction. Enter the dummy stock split with no values in the
dividend account and it will create the transaction with price 1 even though you cannot see
the Price column in that register.

In GnuCash 2.6.6, this report was modified to simplify the recording of dividend and interest
payments. With this change it may not be necessary to include the dummy stock split in
the transaction. The report will find income (and expense) transactions that are in the parent
account of the stock account being reported on. This is done by looking in the parent account
for transactions that have exactly two splits (not counting trading account splits) where the
other split is to an income or expense account with the same name as the stock's account.

For example given an account structure like

Assets (type ASSET)
  Broker (type ASSET)
    Widget Stock (type STOCK)
Income (type INCOME)
  Dividends (type INCOME)
    Widget Stock (type INCOME)

A transaction that debits the "Assets:Broker" account and credits the
"Income:Dividends:Widget Stock" account will count as income even though it doesn't have
a split with account "Assets:Broker:Widget Stock".

This only works if the parent account ("Assets:Broker" in this case) is a Bank or Asset
account and the Income/Expense account has the same name as the stock account. It won't
double count transactions that have a dummy split since they won't have exactly two split
transactions.

It will not work if the income or expense account split is to a subaccount of the account with
the same name as the stock account i.e. "Income:Dividends:Widget Stock:Franked"

• Brokerage Fees: Brokerage Fees

• Total Return: Total Gain + Income

• Rate of Return: Total Return / Money In * 100

Common report options are described in „Configuring Reports and Charts“

Report Specific Options

• Accounts Tab
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• Include accounts with no shares: Unchecked (default) or checked.

• Display Tab

• Show ticker symbols: Checked (default) or unchecked. If unchecked, Symbol column will be
omitted.

• Show listings: Checked (default) or unchecked. If unchecked, Listing column (source of shares
price quotes) will be omitted.

• Show number of shares: Checked (default) or unchecked. If unchecked, Shares column will be
omitted.

• Share decimal places: The number of decimal places to show in the number of shares. Default is 2.

• Show prices: Checked (default) or unchecked. If unchecked, Price column will be omitted.

• General Tab

• Price Source: Nearest in time (default) or Most Recent.

• Basis calculation method: Average (default), FIFO or LIFO.

• Set preference for price list data: Checked (default): Use price list data. If there is no relevant price
list data, transaction prices will be used and there will be a warning. Unchecked: Get prices from
stock transactions.

• How to report brokerage fees: Include in basis (default), Include in gain or Ignore.

• Asset Barchart:

The Asset Barchart report displays bars that present the value of all assets in a GnuCash file over time. By
default, the report shows all accounts in Accounts Receivable, Current Assets, Fixed Assets, Investments
and Special Accounts (if they exist) and it displays monthly bars for the current financial period. This
report provides a graphic view of the assets in the file over time.

Tipp

Like all the generic reports, the user can assign a title and save the report with it's selected
options for re-use later.

The display is in the form of either a stacked barchart or simple barchart with an option to display a
table of the values.

This report calculates and displays a default of 8 bars or up to 24 separate asset accounts value at the end
of the day on several dates through a specified time period. The report automatically selects the most
significant accounts to display with all other selected accounts summed as Other.

The report exploits the outline structure of the chart of accounts to allow the user to select top level
accounts and sub-accounts down to a user-selectable depth. Selected sub-accounts below the selected
depth are automatically summed up into the next level when it is also selected. The default number of
sub-account levels is 2, giving a summary view. Increasing the number of sub-levels increases the detail
available to display. It is possible to un-select a higher level account and leave sub-accounts selected
to force greater detail to appear in the report.
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By default the report includes all asset accounts and sub-accounts, as well as Imbalance and Orphan
Special accounts in whatever currencies or commodities may be present. The report's base currency is
the default currency of the GnuCash file but if the file has data for multiple currencies, then it can be
changed to another currency.

Since each account may be individually selected, the report can be designed to focus on a small subset
of data such as current assets or investments.

The overall interval of the report defaults to start at the start of the current accounting period and to
end at the end of the current accounting period. Numerous other starting choices and ending choices
are available.

The first bar shows the selected values at the end of the day on the first date chosen. There are a number
of choices for step size from day to year with the default being month. Note that if any step date would
fall on the 29th, 30th or 31st in a month that does not have such a date the next interval will be 31 days
later. For that step only the date will slip up to 3 days into the following month. This is true for releases
at least through 2.4.13. Bug 639049 is open in Bugzilla to modify this behavior.

Currently, there is no option to start the report on the last day of any period. There is also no option to
show beginning balances or end of previous step balances. This makes it difficult to correlate this report
to business quarterly reports, for example.

The Net Worth linechart report, Liability barchart report and Net Worth barchart report are similar
except for the graphic type and default account groups selected.

Other features are customizable in a manner similar to other standard reports.

• Asset Piechart:

• Average Balance:

• Balance Sheet: This report summarizes assets, liabilities, and equity. When properly maintained, assets
should equal the sum of liabilities and equity. If that is not the case, there is some kind of internal
imbalance in the accounts.

• Balance Sheet using eguile-gnc:

• General Journal:

• General Ledger:

• Investment Portfolio: This report summarizes the value of the stocks in the current portfolio.

• Liability Barchart:

• Liability Piechart:

• Net Worth Barchart: Net worth is the difference between the value of assets or liabilities.

• Net Worth Linechart: Net worth plotted over time. Net worth is the difference between the value of
assets or liabilities.

• Price Scatterplot:

Business Reports
The Business Reports includes Customer and Vendor Reports and Printable Invoices as well as Aging
reports.
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Customer Report

Customer Summary

Easy Invoice

Employee Report

Fancy Invoice

Job Report

Payable Aging

This report provides a listing of vendors and their aged outstanding balances. Vendors may be included if
they have posted business transactions (e.g. invoices) for the selected accounts payable account. It shows
their current balance, and how much they have due from invoices over time periods 0-30 days, 31-60 days,
61-90 days, and over 90 days. The report also contains links to each vendor and to their current vendor
report.

Optionally, vendor address details may be also shown.

Tipp

To export vendor address details, say in order to do a mail merge, select the optional vendor
address details in the report options display tab, apply the options to regenerate the report, then
copy and paste the report into a spreadsheet. Alternatively, the report can be exported to a .html
file, then read into a spreadsheet.

Report Options

Anmerkung

See Common Report Options in the Configuring Reports and Charts section of this help manual
for more details of the common options.

• General tab

• Report name: Enter a descriptive name for this report - see Common Report Options.

• Stylesheet: Select a style sheet for this report - see Common Report Options.

• To: Select a date to report on or a named date. Transactions up to and including the selected date will
be used to calculate the outstanding aged balances. See Common Report Options.

• Report's currency: Select the currency to display the values in - see Common Report Options

• Price Source: Select the source of price information used for currency conversion if needed. One of
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Average Cost The volume-weighted net average price of all
exchanges.

Weighted Average (default) The volume-weighted gross average price of all
exchanges up to the date of the report

Most recent The most recent recorded price

Nearest in time The price recorded nearest in time to the report
date

• Show Multi-currency Totals: If not selected, all totals are shown in the report currency.

• Sort By: Sort companies by one of

Name (default) Company name

Total Owed Total amount owed to company

Bracket Total Owed Amount owed in oldest bracket. If same, use next
oldest

• Sort Order: One of

Ascending (default) 0 … 999,999.99, A … Z

Descending 999,999.99 … 0, Z … A

• Show zero balance items: Show companies even if they have a zero outstanding balance.

• Due or Post Date: Leading date. Which date to use to determine aging. One of

Due Date (default)

Post Date

• Payable Account: The accounts payable account used to select vendors to be reported. Vendors are
included if they have a posted business transaction (usually an invoice) on or before the report date
and also meet the Show zero balance items criteria.

• Display tab

• Address Name: Display vendor address name. This, and other fields, may be useful if copying this
report to a spreadsheet for use in a mail merge.

• Address 1: Display address line 1.

• Address 2: Display address line 2.

• Address 3: Display address line 3.

• Address 4: Display address line 4.

• Phone: Display address phone number.

• Fax: Display address fax number.

• Email: Display email address. 212
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• Active: Display vendor active status.

Printable Invoice

Receivable Aging

This report provides a listing of customers and their aged outstanding balances. Customers may be included
if they have posted business transactions (e.g. invoices) for the selected accounts receivable account. It
shows their current balance, and how much they have outstanding from invoices over time periods 0-30
days, 31-60 days, 61-90 days, and over 90 days. The report also contains links to each customer and to
their current customer report.

Optionally, customer address details may be also shown.

Tipp

To export customer address details, say in order to do a mail merge, select the optional customer
address details in the report options display tab, apply the options to regenerate the report, then
copy and paste the report into a spreadsheet. Alternatively, the report can be exported to a .html
file, then read into a spreadsheet.

Report Options

Anmerkung

See Common Report Options in the Configuring Reports and Charts section of this help manual
for more details of the common options.

• General tab

• Report name: Enter a descriptive name for this report - see Common Report Options.

• Stylesheet: Select a style sheet for this report - see Common Report Options.

• To: Select a date to report on or a named date. Transactions up to and including the selected date will
be used to calculate the outstanding aged balances. See Common Report Options.

• Report's currency: Select the currency to display the values in - see Common Report Options.

• Price Source: Select the source of price information used for commodity conversion if needed. One of

Average Cost The volume-weighted net average price of all
exchanges

Weighted Average (default) The volume-weighted gross average price of all
exchanges

Most recent The most recent recorded price

Nearest in time The price recorded nearest in time to the report
date

• Show Multi-currency Totals: If not selected, all totals are shown in the report currency.

• Sort By: Sort companies by one of
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Name (default) Company name

Total Owed Total amount owed by company

Bracket Total Owed Amount owed in oldest bracket. If same, use next
oldest

• Sort Order: One of

Ascending (default) 0 … 999,999.99, A … Z

Descending 999,999.99 … 0, Z … A

• Show zero balance items: Show companies even if they have a zero outstanding balance.

• Due or Post Date: Leading date. Which date to use to determine aging. One of

Due Date (default)

Post Date

• Receivables Account: The accounts receivable account used to select customers to be reported.
Customers are included if they have a posted business transaction (usually an invoice) on or before
the report date and also meet the Show zero balance items criteria.

• Display tab

• Address Source: Which customer address fields to display. One of

Billing (default) Address fields from billing address.

Shipping Address fields from shipping address.

• Address Name: Display customer address name. This, and other fields, may be useful if copying this
report to a spreadsheet for use in a mail merge.

• Address 1: Display address line 1.

• Address 2: Display address line 2.

• Address 3: Display address line 3.

• Address 4: Display address line 4.

• Phone: Display address phone number.

• Fax: Display address fax number.

• Email: Display email address.

• Active: Display vendor active status.

Tax Invoice

Vendor Report
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Income & Expense
The Income & Expense reports includes the Cash Flow and Income Statement reports.

• Cash Flow:

• Equity Statement:

• Expense Barchart:

• Expense Piechart:

• Expense vs Day of Week:

• Income & Expense Chart:

• Income Barchart:

• Income Piechart:

• Income Statement: This report summarizes sources of income and expenditure. (This report was called
Profit & Loss in gnucash-1.8.)

• Income vs Day of Week:

• Profit & Loss: This is the same report as the Income Statement but with a different title.

• Trial Balance: This report summarizes sources of income and expenditure.

Sample & Custom

Welcome Sample Report

Custom Multicolumn Report

This report is used to place multiple reports into a single report window to examine a set of financial
information at a glance.

Sample Report with Examples

Budget

Budget Balance Sheet

Budget Barchart

Budget Flow

Budget Income Statement
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Budget Profit & Loss

Budget Report

This report is used to compare budgeted and real amounts for selected accounts. It allows you to review
how well you follow the budget.

The report is generated as a table in which each row represents an account and each set of columns shows
the budgeted amount, the real amount, and the difference between them for each report period.

Each entry in the real amount column is the sum of all the splits in the row's account over the column's
period. For example, if the report is set up for monthly periods, the column is for May, and the row is for
Expenses:Groceries, then the value will be the sum of all Expenses:Groceries splits for that May.

The report supports selecting a range of periods instead all of them. Periods that are out of range can be
included in the report as the consolidated columns around the selected range. This allows you to focus on
particular periods, for example the current one, and is especially useful for budgets with many periods.
For example, if you have a 12 period budget you can make a 3 column report with the format "(all periods
before columns set) (current period columns set) (all periods after columns set)" that is easily fits on the
screen and allows you to match values with account names.

Budget report options

Anmerkung

Here we describe only options that are specific for the Budget Report. You can find information
about standard parameters in „Configuring Reports and Charts“.

• Show budget - include the budgeted values for the period

• Show actual - include the real values for the period

• Show difference - include the difference between budgeted and real values for the period. Enabling this
option does not force including budgeted and actual values in the report

• Show Column with totals - Adds a final column set containing budgeted, real value, and difference
columns summing those values across all periods of the report.

• Rollup budget amounts to parent - not used in the report, can be deleted or should be fixed

• Include accounts with zero total balances and budget values - enables display of accounts with no
budget or splits in any period.

• Budget - Select the budget to use for report generation

• Report for range of budget periods - Enables reporting on a subset of the budget by selecting a beginning
and an ending period.

• Range start - a combobox with a list of options to select the start period:

1. First - select first budget period

2. Previous - select previous period.

3. Current - select current period.

216



Reports And Charts

4. Next - select next period.

5. Last - select last budget period

6. Manual - enables spinbox where you can select exact period

Anmerkung

The current, previous, and next options select the period based on the date on which the report
is run, with current being the period in which the date falls, previous being the one before that,
and next the period after. If the current date falls outside the date range covered by the budget,
the first or last period will be used as appropriate.

• Exact start period - options for select exact start period, enabled only if the range start option is set
to Manual

• Range end - a combobox with a list of options to select the end period. Values are the same as in Range
start options

• Exact end period - the same as Exact start period but for the end of range

• Include collapsed periods before selected - if on, then includes in the report all budget periods, that are
before selected period range, as a single consolidated column set

• Include collapsed periods after selected - if on, then includes in the report all budget periods, that are
after selected period range, as a single consolidated column set.

Country Specific Reports
Some report are only useful in specific regions. Each tax authority has other requirements. The availability
of this reports depend on your Locale Settings [https://wiki.gnucash.org/wiki/Locale_Settings]. As there
is currently not more than one report per country they are merged into the „General Reports“.

Wichtig

To get useful data, the user has to segregate taxable and non taxable income into different
accounts, as well as deductible and non deductible expenses. The user must also set the TXF
category of each tax related account. This can be done by the Income Tax Information dialog,
reachable by Edit → Tax Report Options . Its usage is explained in „Setting Tax Report Options“.

US: Tax Schedule Report and TXF Export

Anmerkung

This report is also visible, if no tax report for your region is available in GnuCash.

The tax schedule report lists all taxable income and deductible expense amounts used in the preparation of
US Income Tax returns. The purpose of the report is to provide a complete audit trail for these amounts. The
report is intended to be used by a tax payer to manually prepare his or her own tax return, or alternatively,
to be provided to a tax preparer for that purpose. The report can also be used to generate an export of all tax
related income and expenses to a TXF (Tax eXchange Format) file (this is in addition to exporting to the
HTML format that all reports allow). The TXF file can be imported into tax filing programs such as TaxCut
or TurboTax. The report should be run, inspected carefully for errors or omissions, and then corrections
made to transactions, report settings, currency conversion rates or the account structure as needed. This
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process should be repeated as often as needed until all the amounts on the report are correct before a final
version is used and saved along with the tax returns.

For accounts specified in the report options (none = all) that are also flagged as Tax-related, all transactions
for the time period selected (also in the report options) are included. The report sorts transactions by date
within account providing subtotals by account within tax code within Form or Schedule line number.
Support is also provided for multiple copies of and for sub-line items for selected Forms/Schedules.
Optionally uses special date processing to include federal estimated tax payments after year end.

All totals are in USD since this is the currency required for filing US Income Tax returns. Non-USD
transaction amounts are converted to USD using the transaction conversion rate to USD, if available. If
not, a conversion rate from the price database is used (either the date nearest the transaction date or nearest
the report date as specified in the report options; if none is available, transaction amounts are converted to
zero and the report provides a comment accordingly). A complete audit trail of conversions is provided.

DE: Steuer-Bericht und ElStEr Export

Anmerkung

This report is only visible, if the language is set to de | deutsch.

Printing or Exporting Reports and Charts
Anmerkung

Verify !!! How customize printing with Gnome?

GnuCash is able to print reports and to export the reports to HTML (web) pages. The Print GnuCash
Document dialog is accessed from the Print button on the toolbar or go to File → Print in the menu. To
Export a report to a web page (HTML) select the Export button on the Toolbar and type in a file name.

Most reports, being presented in HTML, can also be copied and pasted into a spreadsheet.

The Print GnuCash Document dialog is used to select which Printer to send the print job to or to print to
a File. It also contains a Preview button to view the document before printing. Press Print to send the job
to the selected printer or Cancel to dismiss the Print dialog.

Printing from an open register prints the Account Report, which is also called the Register Report. This
lists transactions in the account with a total. Other reports print as viewed in the Report screen.

Creating or Modifying Reports and Charts
It is possible to modify existing or write own reports, if the available ones are not suitable. To do this you
will need to know Guile, GNOME's implementation of Scheme, which again is a LISP-like programming
language, and it is an excellent idea to have a copy of the GnuCash source code available.

Introductory files in the source code

• gnucash/report/doc/report-html.txt [https://github.com/Gnucash/gnucash/tree/maint/gnucash/report/
doc/report-html.txt] documents the reporting interface.

• gnucash/report/reports/example/hello-world.scm [https://github.com/Gnucash/gnucash/tree/maint/
gnucash/report/reports/example/hello-world.scm] is an example demonstrating different types of
options.
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Accessing the GnuCash Application Programming
Interface (API)

To get informations from your GnuCash book for your report it is also necessary to access data from the
GnuCash engine. This binding is generated by Swig and based on a set of Scheme wrapper functions in
bindings/guile [https://github.com/Gnucash/gnucash/tree/maint/bindings/guile]. 2

Tipp

Examine some of the other reports in gnucash/report/ [https://github.com/Gnucash/
gnucash/tree/maint/gnucash/report/] for an indication of how they are used.

Some users started a table in https://wiki.gnucash.org/wiki/
Custom_Reports#The_GnuCash_API.

Because the above file only contains the syntax of the function you can use the nightly Doxygen
generated API documentation online for the bugfix branch [https://code.gnucash.org/docs/MAINT/] or
feature branch [https://code.gnucash.org/docs/MASTER/] to get more information about the functions.

After setting up a build environment [https://wiki.gnucash.org/wiki/Building] you can also generate it
locally by running

# make users:
make doc
# ninja users:
ninja doc

in your build directory and then open BUILDDIR/libgnucash/doc/html/index.html with your
preferred browser.

Report Rendering
At present, reports are produced by calling a HTML-generation API, which outputs a dialect of HTML
and rendering this with a HTML widget. This has limitations, particularly when trying to align objects
precisely, as might be necessary for printing onto pre-printed invoices for example.

See also „Printing or Exporting Reports and Charts“.

2Up to version 2.0.5 G-Wrap was used and the file was src/g-wrap/gnc.html.
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Kapitel 10. GnuCash anpassen
GnuCash kann in vielen Belangen an Ihre persönlichen Vorlieben angepasst werden. Es besteht zum einen
die Möglichkeit die Benutzer Einstellungen vorzunehmen, die von GnuCash in den Einstellungen Ihres
Betriebssystems gespeichert werden und ausschließlich für den jeweiligen Benutzer gelten.

Zum anderen können mit den Buch Einstellungen die Dateieigenschaften beeinflusst werden. Diese gelten
dann für alle Benutzer der Datendatei.

Benutzer Einstellungen
Im Fenster GnuCash-Einstellungen können Sie das Verhalten Ihrer GnuCash Sitzung anpassen, indem
Sie verschiedene Optionen einstellen. Wählen Sie aus dem GnuCash Menü Bearbeiten → Einstellungen
( GnuCash → Einstellungen bei macOS). Das Fenster GnuCash-Einstellungen wird geöffnet. Wählen Sie
auf der linken Seite die gewünschte Kategorie und nehmen Sie rechts die gewünschten Änderungen vor.
Die Einstellungen in diesem Dialog werden pro Benutzer festgelegt und nicht in der Datei gespeichert. Dies
steht im Gegensatz zu den in „Buch Einstellungen“ beschriebenen Einstellungen, die mit der Datei (oder
dem Buch) gespeichert werden und Teil davon sind und als solche für alle Benutzer gemeinsam gelten. Die
GnuCash-Einstellungen gelten somit für alle Dateien des Benutzers als Vorgabe. Sie können aber teilweise
durch individuelle Buch-Optionen für einzelne Dateien außer Kraft gesetzt werden. Bedenken Sie das,
wenn sie Dateien mit anderen Benutzern austauschen, diese möglicherweise eine andere Einstellungen
gewählt haben.

Tipp

Wenn Sie den Mauszeiger einige Sekunden lang über den Optionen in diesen Fenstern halten,
wird eine QuickInfo mit detaillierteren Informationen zu der Auswahl angezeigt.

Anmerkung

Die Änderungen, die Sie an jedem einzelnen Element vornehmen, werden sofort übernommen.
Aus diesem Grund enthält das Fenster weder eine Ok oder Abbrechen- Schaltfläche. Stattdessen
wird das Fenster GnuCash-Einstellungen mit drücken der Schaltfläche Schließen verlassen.

Jede Registerkarte im Fenster GnuCash-Einstellungen wird in einem eigenen Abschnitt weiter unten
behandelt.

Anmerkung

Die Darstellung der folgenden Abschnitte entspricht in seiner Reihenfolge der alphabetischen
Sortierung der englischen Kategorien.

220



GnuCash anpassen

Buchführungsperioden

Abbildung 10.1. Die GnuCash-Einstellungen für die Buchführungsperioden

Auf diesem Reiter können Sie angeben, wie in Ihrem Haushalt, Verein oder Unternehmen im Normalfall
das Geschäftsjahr definert ist. Zusätzlich bietet GnuCash Ihnen auch die Freiheit, unterjährige Zeitbereiche
einzustellen. Die Datumsangaben ermöglichen eine periodenbasierte Finanzberechnungen in diversen
Berichten sowie in der „Zusammenfassungsleiste“.

Anfangsdatum Dieser Eintrag legt das Startdatum der
Abrechnungsperiode fest.
Relativ Hiermit wird der

Beginn durch Heute
oder den Anfang
des aktuellen/vorherigen
Jahres, Quartals, Monats
bestimmt.

Absolut Wählen Sie ein bestimmtes
Datum aus dem Kalender
aus. 1

Enddatum Diese Position legt das Enddatum der
Buchhaltungsperiode fest.
Relativ Hiermit wird das Enddatum

durch Heute oder das Ende

1

Anmerkung
Denken Sie daran, nach dem Geschäftsjahr das Datum neu zu definieren.
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des aktuellen/vorherigen
Jahres, Quartals, Monats
bestimmt.

Absolut Wählen Sie ein bestimmtes
Datum aus dem Kalender
aus. 1

Inhalt Zusammenfassungsleiste
Gesamtsumme anzeigen Wenn

aktiviert,
wird
in
der
Zusammenfassungsleiste
eine
Gesamtsumme,
umgerechnet
in
die
für
Berichte
voreingestellte
Währung,
aller
Konten
angezeigt.

Wertpapier-Gesamtsumme anzeigen Wenn
diese
Option
ausgewählt
ist,
enthält
GnuCash
in
der
Zusammenfassungsleiste
eine
Summe
für
Nicht-
Währungselemente
(z.B.
Anzahl
der
Aktien).
Ansonsten
werden
nur
Währungen
angezeigt.
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Konten

Abbildung 10.2. Die GnuCash-Einstellungen für die Konten

Der Reiter Konten

Dieser Reiter bietet Ihnen zahlreiche Möglichkeiten, um die Darstellung ihrer Konten zu beeinflussen.

Trennzeichen Das Kontentrennzeichen ist das
Zeichen, das ein übergeordnetes
Konto von seinem Unterkonto trennt,
z.B. Versorgungsunternehmen:Strom. Die
Vorgabe ist ein : (Doppelpunkt). Sie können
aber auch / (Schrägstrich), \ (Backslash), -
(Gedankenstrich) oder . (Punkt) wählen, oder
ein beliebiges Unicode-Zeichen, das kein
Buchstabe oder eine Zahl ist.

Betrags-Vorzeichen umkehren für Kontentypen Mit dieser Option können Sie festlegen,
welche Kontosalden als positive oder
negative Zahlen angezeigt werden sollen.
Siehe „Arten von GnuCash Konten“ für
weitere Informationen zu diesen Kontotypen.
Keine Entsprechend

der
https://
code.gnucash.org/
docs/
C/
gnucash-
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guide/
basics-
accounting1.html#accounting_equation_dynamic
werden
Passiva
und
Erträge
negativ
dargestellt.

Habenkonten (Standardvorgabe)
zeigt
einen
positiven
Saldo
für
Kontotypen
an,
die
normalerweise
einen
Habensaldo
aufweisen
würden
(Erträge,
Guthaben,
Verbindlichkeiten,
Eigenkapital).
Dies
entspricht
der
umgeformten
Bilanzgleichung
unter
https://
code.gnucash.org/
docs/
C/
gnucash-
guide/
basics-
accounting1.html#accounting_equation_rearranged.

Erträge & Aufwendungen Weist
Ertragskonten
einen
positiven
Habensaldo
und
Aufwandskonten
einen
negativen
Sollsaldo
zu.

Beschriftungen Wählen Sie Buchungsüberschriften aus
dem Rechnungswesen, wenn Sie
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Spaltenüberschriften in der Kontenansicht
als Soll und Haben bevorzugen. Ansonsten
wird die Vorgabe mit den informellen
Überschriften wie z.B. Abhebung und
Einzahlung, abhängig von der gewählten
Kontoart, verwendet.

Standardwährung Dieser Punkt legt fest, welche Währung
standardmäßig beim Anlegen neuer Konten
ausgewählt wird.

Systemeinstellung Verwenden
Sie
die
Währung
des
Gebietsschemas
Ihres
Betriebssystems
für
alle
neu
erstellten
Konten.

Auswahl Geben
Sie
die
zu
verwendende
Währung,
abweichend
von
Ihren
Systemeinstellungen,
an.

Kontofarbe Mit dieser Option können Sie die
Verwendung der Kontofarbe steuern, die
unter Bearbeiten → Konto bearbeiten
(Strg+E) eingestellt wird.

Kontofarbe als Hintergrund anzeigen Die
Farbe
der
Konten
als
Hintergrundfarbe
des
Kontonamens
in
der
Kontenübersicht
anzeigen.

Kontofarbe auf Reiter anzeigen Zeigt
die
Kontenfarbe
als
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Hintergrund
des
Reiters
für
das
Kontobuch
an.

Geschäft

Abbildung 10.3. Die GnuCash-Einstellungen für das Geschäft

Der Reiter Geschäft

Mit den Optionen auf diesem Reiter legen Sie Einstellung für den Umgang mit Rechnungen fest.

Allgemein Zusätzliche Werkzeugleisten-Knöpfe Wenn
diese
Option
aktiviert
ist,
werden
zusätzliche
Schaltflächen
in
der
Werkzeugleiste
für
häufig
benutzte
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Geschäfts-
Funktionen
angezeigt.

In neuem Fenster öffnen Mit
dieser
Option,
wird
jede
Rechnung
in
einem
eigenen
Hauptfenster
geöffnet.
Ansonsten
wird
die
Rechnung
in
einer
Registerkarte
des
aktuellen
Fensters
angezeigt.

Buchungsteile beim Buchen kumulieren Ist
diese
Option
markiert,
dann
wird
in
dem
Dialog
Buchen
einer
Rechnung
das
Kontrollkästchen
Buchungen
kumulieren?
voreingestellt.

Warnung

Dies
fasst
mehrere
Einträge
einer
Rechnung,
die
zum
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gleichem
Konto
gebucht
werden,
zu
einem
einzigen
Buchungsteil
zusammen,
was
spätere
Auswertungen
erschwert.

Rechnungsausgang, Lieferantenrechnungen Die folgenden Einstellungen gelten sowohl für den
Rechnungsausgang (Kundenrechnung) als auch für
die Lieferantenrechnung (Rechnungseingang).
Bei Fälligkeit benachrichtigen Hier

können
Sie
einstellen,
ob
Sie
beim
Start
von
GnuCash
benachrichtigt
werden
möchten,
wenn
eine
Rechnung
fällig
wird.

Tage im Voraus Geben
Sie
an,
wie
viele
Tage
Sie
vor
dem
Fälligkeitsdatum
der
Rechnungen
hingewiesen
werden
wollen.

Bericht zum Drucken Nur
für
den
Rechnungsausgang:
Ermöglicht
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die
Auswahl
des
zu
verwendenden
Rechnungsformulars
für
die
Druckausgabe.

Inklusive Steuern Mit
dieser
Einstellung
können
Sie
festlegen,
ob
Sie
bei
Rechnungen
(Rechnungsausgang
oder
Lieferantenrechnung)
mit
Brutto-
oder
Nettowerten
arbeiten.
Gibt
an,
ob
die
Steuer
standardmäßig
in
den
Einträgen
auf
Rechnungen
enthalten
ist.
Diese
Einstellung
wird
in
den
Dialogen
Geschäft
→
Kunden
→
Neuer
Kunde…
bzw.
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Geschäft
→
Lieferant
→
Neuer
Lieferant…
verwendet.

Anmerkung

Im
Endkunden-
Geschäft
in
der
EU
sollten
Sie
den
Standardwert
verwenden,
da
es
sonst
zu
unzulässigen
Rundungsfehlern
kommen
kann.

Automatisch verrechnen Wenn
aktiviert,
wird
zum
Zeitpunkt
der
Buchung
automatisch
versucht,
die
Belege
mit
bereits
geleisteten
Vorauszahlungen
und
Gegenbelegen
zu
verrechnen.
2

2
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Zahl, Datum, Zeit

Abbildung 10.4. Die GnuCash-Einstellungen für Zahl, Datum, Zeit

Der Reiter Zahl, Datum, Zeit

Auf diesem Reiter haben Sie die Möglichkeit, die Darstellung von Zahlen, Datum und Zeit festzulegen.

Zahlen Kurse immer als Dezimalzahlen anzeigen Wenn aktiviert wird der
Kurs von Wertpapieren
als gerundete Dezimalzahl
anstelle eines Bruchs
angezeigt. Damit wird
in Kauf genommen, dass
Rundungsfehler entstehen
können.

Negative Beträge in rot anzeigen Wenn Sie diese Option
deaktivieren, zeigt GnuCash
negative Zahlen in schwarzer
Schrift an.

Automatische Dezimalstellen Diese Option fügt automatisch
ein Dezimalkomma in Zahlen
ein, die Sie eingeben. So wird
zum Beispiel die Eingabe von

Anmerkung
Gegenbelege sind Belege mit umgekehrtem Vorzeichen. Zum Beispiel werden für eine Rechnung Gutschriften oder Stornierung als
Gegenbelege betrachtet. Die Vorauszahlungen und Belege müssen natürlich an denselben Kunden respektive Lieferanten gerichtet sein.
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2000 in 20,00 umgewandelt.
Die Position des Kommas
hängt von der Angabe im Feld
Kommastellen ab.

Anmerkung

Wenn eine
Berechnung in das
Feld Betrag
eingegeben wird,
wird das
Dezimalzeichen bei
jedem Operanden
eingefügt, der ein
Dezimaltrennzeichen
auslässt. Diese
Option kann
vormaligen
Benutzern von
Addiermaschinen
den Umstieg zu
Gnucash erleichtern.

Kommastellen In diesem Feld können Sie
die Anzahl der automatisch
ergänzten Dezimalstellen
einstellen.

Datumsformat Diese Option steuert das Erscheinungsbild des
Datums (Sie sehen eine Vorschau des Datums
neben jeder der Auswahlmöglichkeiten). Die
verfügbaren Auswahlmöglichkeiten sind:

• USA

• Großbritannien

• Europäisch

• ISO-8601 Standard

• Systemsprache, (Voreingestellt an Hand der
Systemeinstellung)

Datum vervollständigen Mit dieser Option können Sie den Umstand
verwalten, dass ein Datum ohne Jahreszahl
eingegeben wird.

Im atuellen Kalenderjahr Die
Datumsangaben
werden
so
ergänzt,
dass
sie
innerhalb
des
aktuellen
Kalenderjahres
liegen.
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In einem 12-Monats-Zeitfenster, welches diese Anzahl
Monate vor dem aktuellen Monat beginnt

Termine
werden
so
ergänzt,
dass
sie
nahe
am
aktuellen
Datum
liegen.
Sie
können
die
maximale
Anzahl
der
Monate
eingeben,
die
beim
Vervollständigen
des
Datums
rückwärts
in
einem
Bereich
von
0...11,
mit
6
als
Voreinstellung,
verwendet
werden.

Zeit 24-Stunden-Format Hier können Sie angeben, ob Sie das Zeitformat 24
oder 12 Stunden verwenden möchten. Das heißt, ob
11 Uhr nachts als 11PM oder 23:00 Uhr dargestellt
werden soll. 3

3Diese praktisch unbenutzte Option wird in Gnucah 5.0 entfernt, da sich das reguläre Zeitformat aus den Regionaleinstellungen ergibt. (Siehe https://
bugs.gnucash.org/show_bug.cgi?id=798297)

233

https://bugs.gnucash.org/show_bug.cgi?id=798297
https://bugs.gnucash.org/show_bug.cgi?id=798297


GnuCash anpassen

Allgemein

Abbildung 10.5. Die GnuCash-Einstellungen für alles Allgemeine

Der Reiter Allgemein

Auf diesem Reiter können Sie Vorgaben machen, die unter anderem den Umgang mit der GnuCash-
Datendatei, Logdateien sowie verknüpften Dokumenten betreffen.

Allgemein "Tipp des Tages" anzeigen Mit
dieser
Einstellung
kann
der
Tipp
des
Tages
beim
Programmstart
wieder
angezeigt
werden.

Begrüßungsbild anzeigen Mit
dieser
Option
aktivieren
oder
deaktivieren
Sie
die

234



GnuCash anpassen

Anzeige
des
Startbildschirms
während
des
Startvorgangs
von
GnuCash.
In
der
Anzeige
des
„Splash-
Screen“
wird
Ihnen
mit
Texthinweisen
der
Fortschritt
des
Programmstarts
angezeigt.

Bei neuer Datei erstellen: Konteneinrichtung starten Diese
Option
startet
den
Assistenten
Neuen
Kontenplan
einrichten,
wenn
der
Eintrag
Datei
→
Neue
Datei
(Strg+N)
aus
dem
Menü
ausgewählt
wird.

Bei neuer Datei: Voreinstellung, ob das Aktionsfeld des
Buchungsteils für das Nummerfeld verwendet werden
soll.

Anmerkung

Diese
Einstellung
ist
hauptsächlich
für
ehemalige
Anwender
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anderer
Buchhaltungsprogramme
interessant.

Wenn
ausgewählt,
wird
bei
der
Erstellung
einer
neuen
Datei
im
Assistenten
Neuen
Kontenplan
einrichten
auf
dem
zweiten
Reiter
Buch-
Optionen
für
neues
Buch
das
Kontrollkästchen
Aktionsfeld
des
Buchungsteils
für
Nummer
benutzen
ebenfalls
aktiviert.
Beachten
Sie
hinsichtlich
dieser
Einstellung
die
ausführlichen
Erläuterungen
zu
Aktionsfeld
des
Buchungsteils
für
Nummer
benutzen.
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Anmerkung

Wenn der Dialog Buch-Optionen für neues Buch
in Situationen erscheint, in denen ein neues Buch
eingerichtet wird, bestimmen die Einstellungen aus
dieser Voreinstellung die Standardeinstellung für
das entsprechende Kontrollkästchen im Dialogfeld.
Allerdings muss die Schaltfläche OK im Dialog
Buch-Optionen für neues Buch betätigt werden,
damit die Einstellung vorgenommen werden,
ansonsten wird die Voreinstellung nicht ausgewählt
übernommen.

Dateien Anmerkung

Die folgenden Optionen sind nur für Dateien
relevant, die im XML-Format gespeichert sind.

Datei komprimieren Diese
Option
bestimmt,
ob
die
GnuCash
Datendatei
komprimiert
wird
oder
nicht.
Die
Komprimierung
erfolgt
hierbei
mit
gzip.
Da
viele
Backup-
Lösungen
mit
einer
differentiellen
Sicherung
arbeiten,
sind
unkomprimierten
Dateien
hinsichtlich
Datensicherung
deutlich
effizienter.

Erklärung für Automatisches Speichern anzeigen Wenn
diese
Option
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aktiviert
ist,
zeigt
GnuCash
jedes
Mal
einen
Bestätigungsdialog
an,
bevor
der
automatische
Speichervorgang
gestartet
wird.

Zeitintervall Automatisches Speichern Dieses
Feld
legt
die
Anzahl
der
Minuten
zwischen
jedem
automatischen
Speichern
der
Datei
fest.
Setzen
Sie
es
auf
0,
um
die
automatische
Speicherfunktion
zu
deaktivieren.

Tipp

Möchten
Sie
bei
komplexeren
Vorgänge
nicht
durch
das
Speichern
behindert
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werden,
trotzdem
auf
die
Funktion
des
automatischen
Speicherns
beim
Beenden
nicht
verzichten,
so
können
Sie
z.B.
den
Wert
1440
eintragen.
Das
entspricht
einer
einmaligen,
täglichen
Sicherung
und
beim
Beenden
des
Programms
wird
die
Sitzung
dann
gespeichert.

Aktiviere Wartezeit bei "Geänderte Datei speichern"-
Frage beim Schließen

Wenn
aktiviert,
wird
der
Dialog
Änderungen
beim
Schließen
speichern
nur
eine
begrenzte
Anzahl
von
Sekunden
auf
eine
Antwort
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warten.
Wenn
der
Benutzer
innerhalb
dieser
Zeit
nicht
antwortet,
werden
die
Änderungen
automatisch
gespeichert
und
das
Fragefenster
geschlossen.
Sie
können
die
Anzahl
der
Sekunden
im
Feld
Wartezeit
auf
Antwort
einstellen.

Log-/Sicherungsdateien aufbewahren In
diesem
Abschnitt
können
Sie
Ihre
Präferenzen
bezüglich
der
Log-
Dateien
mit
Hilfe
der
bereitgestellten
Optionsfelder
einstellen.

Tipp

Es
empfiehlt
sich,
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separate
Ordner
für
jede
Ihrer
verwendeten
Datendatei
anzulegen,
und
diese
dort
zu
organisieren,
da
GnuCash
in
dem
selben
Verzeichnis
die
Backup-
und
Log-
Dateien
schreibt,
wenn
Sie
das
aktiviert
haben.

Nie Deaktiviert
die
Erstellung
von
Protokolldateien.

Für Geben
Sie
eine
Anzahl
von
Tagen
ein,
für
die
die
Dateien
aufbewahrt
und
danach
gelöscht
werden
sollen.
Wenn
Sie
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0
einstellen,
dann
werden
die
Log-
und
Sicherungsdateien
nicht
automatisch
gelöscht.Dies
funktioniert
nur,
wenn
Sie
den
Namen
der
GnuCash-
Datendatei
nicht
ändern.

Immer Wenn
Sie
Immer
auswählen,
dann
werden
die
Log-
und
Sicherungsdateien
behalten.

Verknüpfte Dateien Anfang des Dateipfads für verknüpfte Dokumente
(relativer Pfad)

Wenn
Sie
Dateien,
wie
z.B.
digitalisierte
Belege,
mit
Buchungen
verknüpfen
möchten,
so
können
Sie
mit
der
Auswahlliste
einen
Speicherort
festlegen.
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Anmerkung

Haben
Sie
schon
Dokumente
verknüpft,
wird
in
einem
Dialog
auf
die
Änderung
des
Dateipfades
hingewiesen
und
Sie
können
angeben,
wie
Sie
mit
der
Pfadänderung
für
die
schon
verknüpften
Dokumente
umgehen
wollen.
Die
Schaltfläche
Zurücksetzen
macht
die
Änderung
des
Dateipfads
rückgängig.

Tipp

Es
empfiehlt
sich,
separate
Ordner
je
GnuCash-
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Datendatei
für
verknüpfte
Dokumente
anzulegen
und
diese
dort
zu
organisieren.

Such-Dialog Ergebnisanzahl für Neue Suche Standardmäßig
wird
eine
Neue
Suche
verwendet,
wenn
weniger
als
diese
Anzahl
von
Einträgen
gefunden
wird.
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Import

Abbildung 10.6. Die GnuCash-Einstellungen für den Import

Der Reiter Import

Mit den Einstellungen auf diesem Reiter steuern Sie die Funktionsweise von GnuCash während des
Importvorgangs. Der Importvorgang von Buchungen wird in „Importieren von Buchungen“ beschrieben.

Allgemein "Überspringen"-Aktion aktivieren Ist die
„Überspringen“-
Aktion aktiviert,
so wird gemäß
„Buchungen nach
dem Import
zuordnen“ eine
importierte
Buchung
übersprungen (nicht
importiert), wenn
die höchste
Übereinstimmung
mit einer
vorhandenen
Buchung lediglich
im gelben Berich
liegt. Das bedeutet,
der Wert für eine
Übereinstimmung
liegt über der
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Entscheidungsschwelle
für das
automatische
Hinzufügen, aber
unterhalb der
Schwelle für den
automatischen
Abgleich.

Wenn Sie diese
Option nicht
markieren, dann
wird diese
importierte
Buchung, trotz
verhältnismäßig
schlechter
Übereinstimmung,
zum Abgleich mit
einer vorhandenen
Buchung
verwendet.

"Abgleichen und Datenübernahme"-Aktion aktivieren Wenn diese
Funktion aktiviert
ist, wird eine
importierte
Buchung, deren
Punktzahl für die
beste
Übereinstimmung
über dem
Schwellwert für
den automatischen
Abgleich liegt und
die ein anderes
Datum oder einen
anderen Betrag als
die entsprechende
vorhandene
Buchung hat, die
Daten dieser
Buchung
aktualisieren und
abgleichen.

Ist die Option
nicht markiert,
so wird das
Kontrollkästchen
Abgleichen und
Datenübernahme
ausgeblendet und
Sie die können
die vorhandene

246



GnuCash anpassen

Buchung nicht mit
den importierten
Daten aktualisieren.

Bayes-Algorithmus verwenden Verwenden Sie
den Bayes'schen
Algorithmus zum
Abgleich neuer
Buchungen mit
bestehenden
Konten. Weitere
Informationen zu
der Funktiosnweise
können Sie unter
„Import-
Zuordnungen
Editor“ nachlesen.

Entscheidungsschwelle für Anzeige in Zuordnung Die
Mindestpunktzahl,
die eine potenzielle
Übereinstimmung
haben muss, damit
sie in der
Übereinstimmungsliste
angezeigt wird.

Entscheidungsschwelle für automatisches Hinzufügen Eine Buchung,
deren beste
Übereinstimmungspunktzahl
im roten Bereich
liegt (über dem
Anzeigeschwellenwert,
aber unter oder
gleich dem
Schwellenwert für
das automatische
Hinzufügen), wird
standardmäßig
hinzugefügt.

Entscheidungsschwelle für automatisches Abgleichen Eine Buchung,
deren beste
Übereinstimmungspunktzahl
im grünen Bereich
liegt (über oder
gleich dem
Schwellwert für
den automatischen
Abgleich), wird
standardmäßig
abgeglichen.

Entscheidungsschwelle für wahrscheinliche
Datumsübereinstimmung

Liegt das Datum
einer importierten
Buchung innerhalb
diesem Schwellwert
so stimmt diese
wahrscheinlich mit
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einer exisiterenden
Buchung überein.

Entscheidungsschwelle für unwahrscheinliche
Datumsübereinstimmung

Liegt das Datum
einer importierten
Buchung außerhalb
diesem Schwellwert
so ist eine
Übereinstimmung
unwahrscheinlich.

Auszahlungsgebühren Bei der Nutzung
der Geldautomaten
anderer Bank-
Verbünde wird
manchmal eine
zusätzliche
Auszahlungsgebür
auf den
ausgezahlten Betrag
aufgeschlagen und
nicht separat
ausgewiesen. Damit
die importierten
Buchungen zu
den existierenden
Buchungen von
GnuCash richtig
zugeordnet werden
können, haben
Sie hier die
Möglichkeit, einen
solchen Aufschlag
einzustellen.

Automatisch neue Wertpapiere/Währungen erstellen Ermöglicht die
automatische
Erstellung neuer
Wertpapiere/
Währungen, wenn
unbekannte
Wertpapiere/
Währungen
während des
Importvorgangs
erkannt werden.
Wenn diese Option
nicht aktiviert
ist, wird der
Benutzer gefragt,
wie GnuCash mit
jedem unbekannten
Wertpapier/
Währung verfahren
soll.

QIF Import Erklärungsseiten anzeigen Wenn Sie den QIF-
Importer zum ersten
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Mal verwenden,
werden Sie
feststellen, dass der
Import-Assistent
detaillierte
Beschreibungen
enthält die den
Import einer Datei
erläutert. Sobald
Sie sich mit
der Verwendung
des Importvorgangs
vertraut gemacht
haben, können
Sie diese Option
deaktivieren und die
Erklärungsseiten
werden nicht mehr
angezeigt.

Voreingesteller Buchungsstatus (wird überschrieben vom
Status aus der QIF Datei)

In diesem Abschnitt
können Sie den
Standardstatus für
importierte
Buchungen über
die bereitgestellten
Schaltflächen
festlegen:

• Unbestätigt
(Standardvorgabe)

• Bestätigt

• Abgeglichen
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Onlinebanking

Abbildung 10.7. Die GnuCash-Einstellungen für das Onlinebanking

Der Reiter Onlinebanking

Auf diesem Reiter können Sie das Verhalten der Online-Banking Schnittstelle konfigurieren. Sollte diese
Seite nicht angezeigt werden, bitten Sie den Maintainer Ihrer Linux-Distribution, das Programmm neu
zu bauen und die Option WITH_AQBANKING zu aktivieren.

Onlinebanking Fenster nach Verbindungsende schließen Wenn
aktiviert,
wird das
Verlaufsfenster
geschlossen,
sobald der
AqBanking-
Importvorgang
beendet ist.
Sollte das
Online-
Banking
nicht wie
erwartet
funktionieren
ist es
hilfreich,
diese Option
zu
deaktivieren.
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HBCI PIN im Speicher merken Aktivieren
Sie diese
Option,
wenn Sie
möchten,
dass
GnuCash
sich für
die Dauer
der Sitzung
die PIN
merkt, die
Sie für die
Authentifizierung
beim
Online-
Banking
eingeben.
Ansonsten
müssen Sie
die PIN
bei jeder
Onlineaktion
erneut
eingeben.

Anmerkung

Die
PIN
wird
nicht
dauerhaft
gespeichert
sondern
mit
Beenden
von
GnuCash
aus
dem
Speicher
entfernt!

Verwende Nicht-SWIFT Buchungstext Einige
Banken
fügen,
entgegen
der SWIFT-
Spezifikation,
Teile der
Buchungsbeschreibung
als
„transaction
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text“ in
MT940/
MT942-
Dateien ein,
welche
normalerweise
von
GnuCash
ignoriert
werden.
Wenn Sie
diese
Einstellung
aktivieren,
dann wird
der
„transaction
text“ zur
Buchungsbeschreibung
hinzugefügt.

Ausführliche Fehlermeldungen Aktivieren
Sie diese
Option,
wenn
GnuCash
mehr
Informationen
über die
Vorgänge
während der
Kommunikation
mit dem
Geldinstitut
anzeigen
soll. Falls
Probleme
im Online-
Banking
auftreten,
sollten Sie
diese Option
vorübergehend
aktivieren.
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Online Kurse

Abbildung 10.8. Die GnuCash-Einstellungen die Online Kurse

Der Reiter Online Kurse

Auf dem Reiter Online-Kurse können Sie Optionen festlegen, die das Abrufen von Online-Kursen mit
dem Perl-Modul Finance::Quote beeinflussen.

Alpha Vantage API key Möchten Sie Online-Kurse mit Finance::Quote über
die Schnittstelle von Alphavantage abrufen, so muss
hier ein persönlicher Schlüssel eingetragen werden.
Der Schlüssel kann auf der Alpha Vantage Website
[https://www.alphavantage.co/] beantragt werden.

Tipp

Die Kursaktualisierung mit Finance::Quote
wird in „Vorgehensweise zur Aktivierung
der Online-Preisaktualisierung“
beschrieben.

Tipp

Im Anhang werden gängige
„Die Datenquellen in Finance::Quote“
aufgelistet.
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Drucken

Abbildung 10.9. Die GnuCash-Einstellungen für das Drucken

Der Reiter Drucken

Dieser Bereich enthält die Optionen zur Anpassung für die Druckausgabe.

Scheckformulare drucken Datumsformat zusätzlich drucken Aktivieren
Sie
diese
Option,
wenn
Sie
auf
dem
Scheck
unter
dem
eigentlichen
Datum,
zusätzlich
dessen
Format
in
8-
Punkt-
Schrift
drucken
möchten.
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Abschlusszeichen drucken Mit
dieser
Option
wird
vor
und
nach
jedem
Textfeld
eine
Folge
von
drei
Sternchen
„***“
gedruckt,
um
die
Verfälschung
zu
erschweren.

Voreingestellt Schrift Betätigen
Sie
die
Schaltfläche,
um
den
Auswahldialog
Wählen
Sie
eine
Schrift
zu
öffnen,
in
dem
Sie
die
Schriftart
für
den
Scheckdruck
anpassen
können.
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Kontobuch

Abbildung 10.10. Die GnuCash-Einstellungen für das Kontobuch

Der Reiter Kontobuch

In diesem Bereich wird die Arbeit mit Buchungen sowie deren Darstellung beeinflusst.

Aktionen Mit Eingabe gehen Sie zur leeren Buchung Wenn
ausgewählt,
wird der
Cursor
auf eine
neue leere
Buchung
am Ende
des
Kontobuchs
bewegt,
nachdem
der
Benutzer
die
Eingabetaste
drückt.
Andernfalls
wird der
Cursor
eine Zeile
nach
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unten
bewegt.

Tipp

Es
wird
empfohlen,
innerhalb
des
Buchungssatzes
mit
den
Tasten
[Umschalt]+Tab
die
Eingabemarkierung
vor-
und
zurückzubewegen.

Listen automatisch aufklappen Wenn
diese
Option
ausgewählt
ist,
werden
alle
Listen
(Konten-
oder
Auswahllisten)
automatisch
erweitert,
wenn sich
der
Eingabefokus
im
Listenfeld
befindet.
Ist diese
Option
deaktiviert,
dann
öffnen
sich die
Listen
nicht
selbständig
und Sie
müssen
diese bei
Bedarf
selber,
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durch
betätigen
der
kleinen
Schaltfläche,
aufklappen.

Bei Auto-Vervollständigen zum Gegenkonto-Feld
weitergehen

Anmerkung

Diese
Einstellung
funktioniert
nur,
solange
Sie
die
Buchungen
nicht
Vollständig
anzeigen.
(siehe
„Kontobuch
-
Ansicht-
Menü“)

Wenn
aktiviert,
wird beim
automatischen
Ausfüllen
der
Buchung
durch
Drücken
der Tab-
Taste im
Kontobuch
der
Cursor in
das
Buchen
Feld
springen.
Ansonsten
bewegt
sich der
Eingabefokus
in das
Feld Soll/
Einzahlung
oder
Haben/
Auszahlung.
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Ist die
Ansicht
auf
Vollständig
eingestellt,
dann
springt
der
Cursor,
und
abhängig
von
dieser
Option,
immer in
das
Eingabefeld
Aktion.

Kontenabgleich Bestätigte Buchungen automatisch abgleichen Ist diese
Einstellung
aktiviert,
so
versucht
GnuCash
die
bestätigten
Buchungen
im Dialog
Abgleichen
als
abgeglichen
zu
kennzeichnen.
Wenn
nicht,
muss in
dem
Dialog
jede
einzelne
Buchungsposition
manuell
als
abgeglichen
markiert
werden.

Automatische Kreditkartenbezahlung Ist diese
Option
ausgewählt,
erhält der
Benutzer
nach dem
Abgleich
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einer
Kreditkartenabrechnung
die
Möglichkeit,
eine
Überweisung
zur
Kreditkartenzahlung
einzugeben.

Immer zum heutigen Datum abgleichen Wenn
aktiviert,
wird im
Abgleichen-
Fenster,
unabhängig
eines
vorherigen
Abgleichs,
immer
mit dem
heutigen
Datum als
Auszugsdatum
geöffnet.

Grafik Viele Einstellungen zur optischen Anpassung von GnuCash
sind in https://wiki.gnucash.org/wiki/GTK3#Register_Appearance
beschrieben.
Benutze die GnuCash-eigenen Farben Wenn

diese
Option
ausgewählt
ist, wird
in der
Kontenansicht
das
ursprüngliche
GnuCash
Farbschema
(grün/
gelb)
verwendet.
Andernfalls
wird das
Systemfarbschema
angewendet.

Zweizeilenstil: Farben abwechselnd pro Buchungssatz Wenn
markiert,
wird die
Kontenansicht
so
konfiguriert,
dass bei
jedem
Buchungssatz
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zwischen
der
Primär-
und der
Sekundärfarbe
abgewechselt
wird und
nicht bei
jeder
Zeile.

Horizontale Linien zwischen Zeilen zeichnen Wenn
diese
Option
ausgewählt
ist,
zeichnet
GnuCash
eine
horizontale
Linie
zwischen
den
einzelnen
Zeilen.

Vertikale Linien zwischen Spalten zeichnen Wenn
diese
Option
ausgewählt
ist,
zeichnet
GnuCash
eine
vertikale
Linie
zwischen
den
Zellen in
jeder
Zeile.

Layout Zukünftige Transaktionen nach leerer Buchung Wenn
diese
Option
ausgewählt
ist,
werden
Buchungen
mit
einem
Buchungsdatum
in
der
Zukunft
am
Ende
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des
Kontenbuches
nach
einer
leeren
Buchung
angezeigt.
Andernfalls
ist
die
leere
Buchung
die
letzte
Buchung.
Buchungen
mit
einem
zukünftigem
Datum
werden
mit
einer
blauen
Linie
abgegrenzt.

262



GnuCash anpassen

Voreinstellungen Kontobuch

Abbildung 10.11. Die GnuCash-Einstellungen der Voreinstellungen Kontobuch

Der Reiter Voreinstellungen Kontobuch

Die Einstellungen auf der Registerkarte beeinflussen das Verhalten der Buchungsansicht. Geänderte
Einstellungen wirken sich erst bei dem Öffnen eines Kontobuchs aus.

Voreinstellung Buchungsansicht Einzeilig Alle
Buchungssätz
einzeilig
anzeigen.
Im
Zweizeilenmodus
werden
in
der
zweiten
Zeile
zusätzlich
die
Felder
Aktion,
Bemerkung
und
Verknüpfung
angezeigt.

Aktive vollständig Erweitert
automatisch
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die
aktuelle
Buchung,
um
alle
Buchungsteile
anzuzeigen.
Alle
anderen
Buchungen
werden
einzeilig
angezeigt
bzw.
im
Zweizeilenmodus
zweizeilig.

Vollständig Alle
Buchungen
im
Kontobuch
werden
erweitert,
um
alle
Buchungsteile
anzuzeigen.

Andere Voreinstellungen Kontobuch in neuem Fenster öffnen Wenn
Sie
diese
Option
wählen,
wird
das
Kontobuch
in
einem
separaten
Fenster
geöffnet.
Ansonsten
wird
es
in
einem
neuen
Reiter
des
aktuellen
Fensters
angezeigt.

Bemerkung anzeigen Wenn
diese
Option
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aktiviert
ist,
werden
für
jede
Buchung
zwei
Zeilen
anstelle
von
einer
Zeile
angezeigt.
(Zweizeilenmodus)

Nur letzten Kontennamen anzeigen Wenn
aktiviert,
wird
nur
der
Name
des
Kontos
im
Auswahl-
Popup
des
Feldes
Buchen
angezeigt.
Das
Standardverhalten
ist
die
Anzeige
der
vollständige
Kontoname
einschließlich
des
Pfads
in
der
Kontenstruktur.

Warnung

Das
Aktivieren
dieser
Option
setzt
voraus,
dass
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Sie
eindeutige
Namen
für
die
letzte
Kontobezeichnung
verwenden.

Anzahl Buchungen Wie
viele
Buchungen
in
einem
Kontofenster
angezeigt
werden
sollen.
Es
werden,
entsprechend
Ihrer
Vorgabe,
die
letzten
Buchungen
angezeigt.
Setzen
Sie
den
Wert
auf
0,
um
alle
Buchungen
anzuzeigen.
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Berichte

Abbildung 10.12. Die GnuCash-Einstellungen für die Berichte

Der Reiter Berichte

Die Einstellungen auf diesem Reiter beeinflussen das Verhalten von GnuCash- Berichten.

Standardwährung für Berichte Systemeinstellung Verwendet,
für
alle
neu
erstellten
Berichte,
die
systemweit
voreingestellte
Währung.

Auswahl Verwendet
die
angegebene
Währung
für
alle
neu
erstellten
Berichte.

Position Bericht in neuem Fenster öffnen Wenn
Sie
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diese
Option
auswählen,
öffnen
sich
die
Berichte
in
einem
neuen
Fenster,
andernfalls
wird
er
in
einem
neuen
Reiter
des
aktuellen
Fensters
angezeigt.

Voreinstellung Vergrößerung Voreingestellte Vergrößerung Mit
diesem
Skalierungsfaktor
haben
Sie
die
Möglichkeit,
die
Lesbarkeit
der
Berichte
auf
hochauflösen
Monitoren
zu
verbessern
wobei
z.B.
der
Faktor
2
die
Darstellung
des
Berichts
verdoppelt.
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Terminierte Buchungen

Abbildung 10.13. Die GnuCash-Einstellungen für Terminierte Buchungen

Der Reiter Terminierte Buchungen

Die Einstellungen auf der Registerkarte beeinflussen das Verhalten von GnuCash bezüglich der
Funktionsweise von terminierten Buchungen. Weitere Informationen über terminierte Buchungen finden
sich in „Buchungen terminieren“.

Seit-letztem-Aufruf Fenster Anmerkung

Weitere Information hinsichtlich
des Dialog Seit letzem Aufruf finden
Sie unter „Since Last Run Assistant“

Ausführen, wenn eine Datei geöffnet wird Wenn
diese
Option
ausgewählt
ist,
wird
der
Prozess
Seit
letztem
Aufruf
ausgeführt
sobald
eine
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Datei
geöffnet
wird.

Benachrichtungsfenster anzeigen Wenn
diese
Option
ausgewählt
ist,
wird
eine
Liste
der
terminierten
und
erstellten
Buchungen
angezeigt,
sobald
eine
Datei
geöffnet
wird.

Erzeugte Buchungen _durchsehen Hiermit
können
Sie
vorgeben,
dass
das
Kontrollkästchen
Erzeugte
Buchungen
durchsehen
im
Dialog
Seit
letztem
Aufruf
standardmäßig
aktiviert
ist.
Dies
bietet
Ihnen
die
Möglichkeit,
dass
sie
die
Buchungen
in
dem
sich
öffnenden
Kontenblatt
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Buchungen
erstellt
noch
einmal
anschauen
und
bearbeiten
können.

Voreinstellungen Buchungseditor Neue Buchungen automatisch erstellen Wenn
diese
Option
ausgewählt
ist,
werden
neue
terminierte
Buchungen
automatisch
in
das
Kontobuch
eingetragen.
Zusätzlich
können
Sie
mit
der
Auswahl
Benachrichtigen,
bevor
Buchungen
erstellt
werden
angeben,
ob
Sie
die
Erstellung
der
Buchungen
bestätigen
wollen.

Im Voraus erstellen Die
Standardanzahl
von
Tagen,
um
die
die
terminierten
Buchungen
vor
dem
eigentlichen
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Buchungsdatum
erstellt
werden.

Im Voraus erinnern Die
Standardanzahl
von
Tagen,
um
an
neue
terminierte
Buchungen
im
Voraus
zu
erinnern.
So
haben
Sie
die
Möglichkeit,
die
Buchungen
an
Ihre
Liquidität
anzupassen.
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Fenster

Abbildung 10.14. Die GnuCash-Einstellungen für die Fenster

Der Reiter Fenster

Mit den Einstellungen in dem Bereich können Sie das Aussehen und Verhalten von GnuCash-Fenstern
konfigurieren.

Fenster-Einstellungen Fenstergrößen und -positionen speichern Wenn
diese
Option
ausgewählt
ist,
wird
beim
nächsten
Start
von
GnuCash
die
bei
der
letzten
Ausführung
verwendeten
Fenstergröße
und
-
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position
wieder
genutzt.
Dies
erfolgt
unter
Nutzung
der
Möglichkeiten
Ihres
Betriebssystems.
4

Karteikarten-Ansicht Den Knopf "Schließen" bei Karteikarten-Ansicht
anzeigen

Fügt
auf
jedem
Reiter
ein
kleines
Symbol
hinzu,
um
das
Schließen
der
einzelnen
Reiter
zu
erleichtern.
Vielleicht
reicht
Ihnen
aber
auch
der
gemeinsame
Schließen-
Knopf
auf
der
Werkzeugleiste?
Sie
müssen
nur
zuvor
den
gewünschten
Reiter
selektieren.

Den neuen Reiter neben dem aktuellen Reiter öffnen Wenn
aktivert,
werden

4Weitere Details sind in den Configuration Locations [https://wiki.gnucash.org/wiki/De/Configuration_Locations#GSettings] (auf Englisch)
beschrieben.
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neue
Reiter
neben
dem
aktuellen
Reiter
eingefügt,
ansonsten
werden
die
neuen
Reiter
„wie
früher“
am
Ende
angefügt.

Die zuletzt benutzte Karteikarte nach vorne bringen Wenn
Sie
diese
Option
auswählen,
wird
beim
Schließen
eines
Reiters
der
zuletzt
benutzte
Reiter
aktiviert.
Ansonsten
wird
der
Reiter
daneben
angewählt.
5

Breite Die
maximale
Breite
der
Reiterbeschriftung,
ausgedrückt
in
Zeichen.

Anmerkung

Wenn
der

5Welcher Reiter tatsächlich aktiviert wird, hängt von dem gewählten Sprache und dem Gebietsschema ab.
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Text
auf
dem
Reiter
länger
als
dieser
Wert
ist,
dann
wird
die
Reiterbeschriftung
in
der
Textmitte
beschnitten
und
durch
eine
Ellipse
so
ersetzt,
dass
diese
maximale
Breite
erreicht
wird.
Dieses
Verhalten
läßt
sich
nicht
mit
0
deaktivieren.

Position Reiter der Karteikarten Position der Reiter Oben (Standard), Unten,
Links oder Rechts am Rand des Fensters.

Position Zusammenfassungsleiste Positioniert die Zusammenfassungsleiste
Oben oder Unten (Standard) in der jeweiligen
Ansicht.

Buch Einstellungen
Die Datei → Eigenschaften (Alt+Eingabe) können dazu genutzt werden, um Optionen festzulegen oder
zu ändern, die sich auf die Funktionsweise einer bestimmten GnuCash Datei (auch als Buch bezeichnet)
beziehen. Wenn Sie diesen Menüpunkt auswählen, wird der Dialog Buch-Optionen aufgerufen. Dieser
Dialog erscheint auch in der Situation, in der Sie Buchungen in ein neues Buch ohne Kontenstruktur
importieren, dann mit dem Dialogtitel Buch-Optionen für neues Buch. Dies wird automatisch in dieser
neuen Buch-Situation ausgelöst, da diese Einstellungen für die Konvertierung der importierten Daten in
GnuCash Buchungen angewandt werden und daher vor dem ersten Import berücksichtigt und eingestellt
werden sollten (insbesondere die Einstellung Aktionsfeld des Buchungsteils für Nummer benutzen).
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Die Einstellungen in diesem Dialogfeld werden mit der Datei (oder dem Buch) gespeichert und sind Teil
davon. Dies steht im Gegensatz den in „Benutzer Einstellungen“ beschriebenen Einstellungen, die pro
Benutzer festgelegt und nicht mit der Datei gespeichert werden. Die Einstellungen der Buch-Optionen
gelten also für alle Benutzer die die Datei verwenden, und jede Änderung, die von einem Benutzer
vorgenommen wird, wirkt sich auf alle Benutzer dieser Datei aus.

Tipp

Wenn Sie den Mauszeiger einige Sekunden lang über den Optionen auf diesen Registerkarten
anhalten, wird ein Tooltip mit einer ausführlicheren Beschreibung der Auswahl angezeigt.

Die Schaltflächen eines Dialogs oder Assistenten sind im sogenannten Aktionsbereich platziert. Er
befindet sich üblicherweise am untern Rand des Dialogs. Einige Fenstermanager stellen die Schaltflächen
stattdessen in der Titelleiste dar.

Schaltflächen des Assistenten

Voreinstellungen Die Schaltfläche setzt für alle Elemente auf der aktiven Registerkarte
die Wert auf die Standardeinstellung zurück; sie wirkt sich nur auf die
sichtbare Registerkarte aus.

Hilfe Öffnet ein Hilfefenster zu diesem Abschnitt.

Abbrechen Schließt den Dialog, ohne die veränderten Einstellungen zu
übernehmen.

Anwenden Die Schaltfläche ist zunächst deaktiviert, wird aber aktiv, sobald Sie
eine Einstellung geändert haben. Mit Betätigten der Schaltflächen
werden die Einstellungen gespeichert; bei Anwenden bleibt der
Dialog für weitere Einstellungen geöffnet.

OK Die Schaltfläche ist zunächst deaktiviert, wird aber aktiv, sobald Sie
eine Einstellung geändert haben. Mit Betätigten der Schaltflächen
werden die Einstellungen gespeichert und der Dialog beendet.

Tipp

Sobald Sie die Anwenden Schaltfläche betätigen, werden die Änderungen in den betroffenen
Bereichen von GnuCash widergespiegelt, so dass Sie die Auswirkung einer bestimmten
Einstellung sofort sehen können, ohne den Dialog erneut öffnen zu müssen.

Anmerkung

Die Anwenden Schaltfläche ist im Dialog nicht sensitiv, wenn er während eines Buchungsimport
in ein neues Buch angezeigt wird.
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Reiter Konten

Abbildung 10.15. Der Reiter „Konten“ im Fenster der Buch-Optionen

Der Reiter Konten ermöglicht die Angabe von Einstellungen, die die Buchhaltungsfunktion des
Kontobuchs beeinflussen.

Devisenhandel-Konten benutzen Wenn Sie dieses Kontrollkästchen
aktivieren, werden Währungshandelskonten
für Buchungen verwendet, die mehr als eine
Währung oder Wertpapiere beinhalten.

Tipp

Um verschiedene Probleme bei
der Buchführung in mehreren
Währungen zu vermeiden, lesen Sie
Peter Selinger's Tutorial on multiple
currency accounting [https://
www.mathstat.dal.ca/~selinger/
accounting/tutorial.html].

Anzahl Tage, bis Buchungen schreibgeschützt werden
(rote Linie)

In dem Feld können Sie die Anzahl
Tage anngeben, nach dem Buchungen
schreibgeschützt werden und nicht
mehr verändert werden können. Dieser
Schwellenwert wird durch eine rote Linie
in dem Kontenblatt markiert. Ist der Wert
Null, ist der Schreibschutz aufgehoben und
alle Buchungen können bearbeitet werden.
Dieses Auswahlfeld soll vor versehentlichen
Änderungen an langfristigen Buchungen
schützen.

Tipp

Will man die  Grundsätze zur ord-
nungsmäßigen Führung und Aufbe-
wahrung von Büchern, Aufzeich-
nungen und Unterlagen in elektroni-
scher Form sowie zum Datenzugriff
(GoDB) [https://wiki.gnucash.org/

278

https://www.mathstat.dal.ca/~selinger/accounting/tutorial.html
https://www.mathstat.dal.ca/~selinger/accounting/tutorial.html
https://www.mathstat.dal.ca/~selinger/accounting/tutorial.html
https://www.mathstat.dal.ca/~selinger/accounting/tutorial.html
https://www.mathstat.dal.ca/~selinger/accounting/tutorial.html
https://wiki.gnucash.org/wiki/De/Projekte#GoBD
https://wiki.gnucash.org/wiki/De/Projekte#GoBD
https://wiki.gnucash.org/wiki/De/Projekte#GoBD
https://wiki.gnucash.org/wiki/De/Projekte#GoBD
https://wiki.gnucash.org/wiki/De/Projekte#GoBD
https://wiki.gnucash.org/wiki/De/Projekte#GoBD
https://wiki.gnucash.org/wiki/De/Projekte#GoBD


GnuCash anpassen

wiki/De/Projekte#GoBD]
ansatzweise erfüllen, sollte man 1
wählen.

Aktionsfeld des Buchungsteils für Nummer benutzen In der Voreinstellung ist diese
Einstellung deaktiviert. Wenn Sie dieses
Kontrollkästchen aktvieren, dann wird
das Aktionsfeld für die Nummerierung,
Spalte Num, im Bereich Geschäft,
Berichten und Import/Export-Funktionen
anstelle der Buchungsnummer verwendet;
die Buchungssnummer wird dann als T-
Num in Berichten und in der zweiten Zeile
des Kontenblatts angezeigt. Diese Wahl
hat eine entsprechende Auswirkung auf die
Geschäftsfunktionen.

Der Unterschied zwischen den beiden besteht
darin, dass, wenn das Kontrollkästchen
nicht aktiviert ist, dieselbe „Zahl“
für eine bestimmte Buchung angezeigt
wird, unabhängig davon, in welchem
Kontobuch sie angezeigt wird. Wenn das
Kontrollkästchen aktiviert ist, kann für eine
bestimmte Buchung in jedem Kontobuch,
in dem sie angezeigt wird, eine andere
„Nummer“ eingegeben/angezeigt werden. In
beiden Fällen basiert die „Logik der nächsten
Zahl“ der Zelle Num auf dem Konto des
Kontobuchs, in das die Buchung eingegeben
oder von dem aus sie angezeigt wird. Aber
in einem Fall wird die Nummer der Buchung
ausgefüllt, im anderen Fall das Aktionsfeld
des Buchungsteils. In beiden Fällen sind
beide Felder sichtbar und können als Freitext
im Zweizeilenmodus für jeden beliebigen
Wert verwendet werden, den der Benutzer
wünscht.

Warnung
Die Ersteinrichtung von GnuCash Es

wird
erwartet,
dass
diese
Option
nach
sorgfältiger
Abwägung
der
Konsequenzen
gesetzt
wird,
wenn
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eine
neue
GnuCash
Datei
erstellt
wird
und
danach
nicht
mehr
geändert
wird
(siehe
nächste
Warnung).

Aus
diesem
Grund
ist
eine
Einstellung
vorgesehen
(siehe
Allgemeine
Einstellungen)
die
eine
anfängliche
Standardeinstellung
für
neue
Dateien
festlegen
kann,
so
dass,
wenn
Sie
mehr
als
eine
Datei
haben,
es
einfacher
ist,
sie
alle
einheitlich
einzurichten.
Sie
sollten
vielleicht
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eine
Testdatei
einrichten
und
mit
den
beiden
Einstellungen
experimentieren,
um
die
Unterschiede
zu
verstehen,
bevor
Sie
Ihre
erste
echte
GnuCash
Datei
erstellen.

Tipp
Umstieg von Quicken Für

Benutzer,
die
von
anderen
Anwendungen
für
die
persönliche
Buchhaltung,
wie
Quicken
wechseln,
kann
die
Auswahl
dieser
Option
eine
bessere
Übereinstimmung
mit
der
dort
verwendeten
Nummerierung
bewirken,
wodurch
die
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Nummerierung
der
übernommenen
historischen
Daten
beibehalten
werden
kann;
diese
Option
sollte
vor
der
Durchführung
des
ersten
Imports
eingestellt
werden.

Warnung
Ändern dieser Option für eine vorhandene GnuCash
Datei

Wenn
Sie
diese
Option
für
eine
bestehende
Datei
ändern,
werden
die
bisherigen
Daten
nicht
geändert.
Das
bedeutet
wenn
Sie
die
Option
auf
die
eine
Art
einstellen,
Buchungen
eingeben
(oder
importieren),
dann
die
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Option
ändern
und
zusätzliche
Buchungen
eingeben
(oder
importieren)
und
dazwischen
hin-
und
herwechseln,
erhalten
Sie
eine
Datei,
die
scheinbar
eine
inkonsistente
Behandlung
von
Zahlen
in
Kontobüchern,
Berichten
und
Exporten
aufweist.
Der
Grund
dafür
ist,
dass
die
Einstellung
dieser
Option
zum
Zeitpunkt
der
Dateneingabe/
des
Datenimports
bestimmt
wo
die
Zahlendaten
gespeichert
werden,
und
die
Einstellung
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zum
Zeitpunkt
der
Daten
Anzeige/
Berichterstattung/
Export
bestimmt,
welches
Feld
als
Zahl
angezeigt
wird.

Es
gibt
keinen
Grund,
diese
Option
für
eine
bestehende
GnuCash
Datei
nicht
zu
ändern,
wenn
Sie
sich
der
Konsequenzen
bewusst
sind.
Wenn
Sie
sich
für
diese
Änderung
entscheiden,
sollte
sie
möglichst
zwischen
den
Abrechnungsperioden
vorgenommen
werden,
mit
dem
Wissen,
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dass
Zahlendaten
vor
dem
Datum
der
Änderung
der
Option
anders
angezeigt/
berichtet/
exportiert
werden
als
nach
diesem
Datum.

Warnung

Wenn
Sie
diese
Option
ändern
und
Anwenden
oder
OK
drücken,
werden
die
offenen
Kontobücher
und
Beschriftungen
der
Abfrage-
und
Sortierdialoge
aktualisiert,
um
sofort
die
neue
Option
widerzuspiegeln.
Aber
offene
Berichte
müssen
vom
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Benutzer
einzeln
neu
geladen
werden,
damit
sich
die
Änderung
im
Bericht
niederschlägt.

Warnung

Wenn
eine
GnuCash
Datei
aus
einer
früheren
Version
6

geöffnet
wird
und
diese
Einstellung
nicht
verwendet
wird,
verhindert
diese
nicht,
dass
die
Datei
in
der
früheren
Version
von
GnuCash
geöffnet
wird.
Wenn
jedoch
die
Option
gesetzt
ist,

6Die Option Aktionsfeld des Buchungsteils für Nummer benutzen ist seit GnuCash Version 2.6 verfügbar.
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kann
die
Datei
nicht
mit
der
früheren
Version
geöffnet
werden,
auch
wenn
die
Option
wieder
auf
ihre
ursprüngliche
Einstellung
zurückgesetzt
wird.
Es
wird
ein
Warndialog
der
früheren
Version
angezeigt.
Aktivieren
Sie
diese
Option
nicht,
wenn
Sie
die
Datei
mit
einer
früheren
Version
öffnen
wollen.
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Reiter Budgets

Abbildung 10.16. Der Reiter „Budgets“ im Fenster der Buch-Optionen

Der Reiter Budgets ermöglicht die Auswahl eines Budgets, welches für die Berichte verwendet wird, wenn
kein anderes angegeben wurde.

Reiter Geschäft

Abbildung 10.17. Der Reiter „Geschäft“ im Fenster der Buch-Optionen
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Auf dem Reiter Geschäft können Sie Werte eingeben, die vornehmlich von den Geschäftsfunktionen von
GnuCash verwendet werden. Sinnvoll ist es in diesem Zusammenhang, wenn Sie unter Geschäft → USt.-
Steuertabelle… die Tabelle ihrer Verkaufssteuern definieren. Aber auch in einigen privaten Berichten kann
es sich gut machen, z.B. als „Firmenname“ seinen Namen einzusetzen:

Firmenname, Firmenadresse Der Name und die Adresse Ihres
Unternehmens wird in vielen Berichten
verwendet.

Firmen Ansprechpartner Der Name Ihres Ansprechpartners, der auf die
Rechnungen gedruckt werden soll.

Firmentelefonnummer, Firmenfaxnummer, Firmen-E-
Mail-Adresse

Die Kontaktangaben Ihres Unternehmens.

Firmenwebseite URL Die Internetadresse der Website Ihres
Unternehmens.

Firmennummer Eine Identifikationsnummer Ihres Geschäfts,
z.B. USt-IdNr. „DE123…“.

Tipp

Steht keine Identifikationsnummer
auf der Rechnung, wird der
Vorsteuerabzug vom Finanzamt
nicht anerkannt.

Voreinstellung Kunde Steuertabelle, Voreinstellung
Lieferant Steuertabelle

In mehrwertsteuerplichtigen Unternehmen
kann hier die Standard-Steuertabelle
eingetragen werden.

Tipp

Als EU-ansäßiges Unternehmen
wählen Sie den vollen MwSt-Satz
vor und geben bei ihren Schweizer
Kunden explizit 0-Export an und
umgekehrt.

Ausführliches Datumsformat Das Standard-Datumsformat, das für
die Druckdaten (z.B. auf Rechnungen)
verwendet wird.

Anmerkung

Keiner der obigen Werte ist für die Benutzung von GnuCash erforderlich; wenn sie jedoch
angegeben werden, werden sie in allen Bereichen des Programms für dieses Buch, z.B. in
Berichten, Rechnungen usw., verwendet.
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Reiter Nummern-Zähler

Abbildung 10.18. Der Reiter „Nummern-Zähler“ im Fenster der Buch-Optionen

Der Reiter Nummer-Zähler zeigt die zuletzt verwendeten Nummern und gibt Ihnen die Möglichkeit, den
„vorherigen“ Wert für jede Nummer, z.B. Rechnung, Kunde, Mitarbeiter, usw., hochzusetzen, wenn Sie
z.B im laufenden Geschäftsjahr zu GnuCash wechseln. Beachten Sie bitte, dass es sich nicht empfiehlt
die Nummer herunterzusetzen, da dann Dubletten entstehen können. Diese Angaben werden vornehmlich
von der Funktion Kapitel 7, Business Features genutzt. Die zuletzt genutzte Nummer kann auch in der
Kontenübersicht in den Kontenspalten angezeigt werden.

Nummer Der hier eingegebene Wert wird inkrementiert, wenn
die verschiedenen Geschäftsfunktionen einen Wert für ein
entsprechendes Feld in einem Dialogfeld berechnen. Wenn Sie
zum Beispiel keine Lieferantennummer im Dialogfeld Neuer
Lieferant angeben, wird die Nummer im Zählerfeld um 1
erhöht. (Beachten Sie jedoch, dass Sie, wenn Sie den Dialog
Buch- Optionen geöffnet haben, diesen schließen und erneut
öffnen müssen, um die Änderungen zu sehen; die angezeigten
Feldwerte werden nicht automatisch aktualisiert.)
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Format der Nummer Die entsprechenden Felder werden verwendet, um
Formatstrings im Stil von „printf“ anzugeben, die für die
Formatierung des Ausdrucks der Zahl verwendet werden. Um
zum Beispiel das Literal „K - “ vor die Kundennummer zu
setzen, würden Sie „K - %li“ (ohne die Anführungszeichen)
in das Feld Format Kundennummer eintragen. Wenn der Wert
im Feld für die Kundennummer 5 wäre, würde der nächste
hinzugefügte Kunde die Nummer K - 6 erhalten. Ein weiteres
Beispiel: Wenn Sie möchten, dass die Kundennummer mit
führenden Nullen und 5 Zeichen gedruckt werden soll, würden
Sie „K - %05li“ eingeben, wodurch dem nächsten Kunden die
Nummer „K - 00006“ zugewiesen würde.

Tipp

Man kann auch Nummern mit mehrere
Nummernkreise emulieren, indem man z.B. die
Jahreszahl im Format als Konstante eingibt und
dahinter die laufende Nummer mit genügend vielen
führenden Nullen formatiert. Beim Jahreswechsel
erhöht man das Jahr im Format und setzt die laufende
Nummer wieder auf Null.

Anmerkung

Aus historischen Gründen akzeptiert GnuCash mehrere Formatangaben, obwohl sie alle das
gleiche Endergebnis liefern. Sie können zwischen „li“, „lli“ oder „I64i“ wählen.

Reiter Steuern

Abbildung 10.19. Der Reiter „Steuern“ im Fenster der Buch-Optionen

Diese Seite speichert zusätzliche Stammdaten, die für eine elektronische Steuermeldung erforderlich sind.

Geben Sie in das Feld die ElStEr-Steuernummer Ihres Geschäfts ein.

Stilvorlagen organisieren
GnuCash verfügt über mehrere Standardformatvorlagen für Berichte. Diese Stilvorlagen können mit dem
HTML-Stilvorlagen Editor an Ihre Bedürfnisse angepasst oder um neue Vorlagen ergänzt werden. Um
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den Editor aufzurufen, gehen Sie im Menü zu Bearbeiten → Stilvorlagen . Es stehen diese Vorlagen zur
Verfügung:

• Voreinstellung, als Standardvorgabe

• Einfach, ein schlichtes Layout

• Bunt, eine farbig ansprechende Vorlage

• CSS, bietet alle Möglichkeiten um sich ein eigenes Layout zu designen.

Stilvorlagen auswählen

Abbildung 10.20. Die Auswahl von HTML-Stilvorlagen

Mit dem Dialog HTML-Stilvorlagen auswählen können Sie Ihre Stilvorlage organisieren.

Der Dialog HTML-Stilvorlagen auswählen listet alle vorhandene Stilvorlagen auf und bietet Ihnen die
Möglichkeit, die Stilvorlage für Ihre Berichte zu bearbeiten.

Tipp

Wollen Sie eine Stilvorlage für einen bestimmten Bericht anwenden, so können Sie in den
Optionen des Berichts die gewünschte Stilvorlage auswählen. Weitere Informationen finden Sie
unter Kapitel 9, Reports And Charts.

Dialogführung

Bearbeiten Öffnet den Dialog Eigenschaften HTML-Stilvorlagen Voreinstellungen in einem
Editor, mit dem Sie die ausgewählte Vorlage bearbeiten können.

Neu Fügt eine neue Stilvorlage hinzu und der Dialog Neue Stilvorlage wird angezeigt.
Füllen Sie das Feld Name mit dem Namen der neuen Stilvorlage aus und wählen
Sie eine Vorlage, die als Basis für Ihrer neuen Stilvorlage dient.
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Abbildung 10.21. Eine neue Stilvorlagen erstellen

Löschen Löscht die markierte Stilvorlage aus der Liste.
Schließen Beendet den Dialog.

Stilvorlagen bearbeiten
Mit dem Stilvorlagen-Editor können Sie die Einstellungen einer Stilvorlage anzeigen/ändern.

Anmerkung

Wenn Sie die Formatvorlage ändern, wirkt sich das auf alle Berichte, die auf dieser Formatvorlage
basieren, aus. Ein Erneut laden ist erforderlich, um die Änderungen zu sehen, wenn der/die
Bericht(e) aktuell angezeigt werden.

Die Schaltflächen eines Dialogs oder Assistenten sind im sogenannten Aktionsbereich platziert. Er
befindet sich üblicherweise am untern Rand des Dialogs. Einige Fenstermanager stellen die Schaltflächen
stattdessen in der Titelleiste dar.

Schaltflächen des Assistenten

Voreinstellungen Die Schaltfläche setzt für alle Elemente auf der aktiven Registerkarte
die Wert auf die Standardeinstellung zurück; sie wirkt sich nur auf die
sichtbare Registerkarte aus.

Hilfe Öffnet ein Hilfefenster zu diesem Abschnitt.

Abbrechen Schließt den Dialog, ohne die veränderten Einstellungen zu
übernehmen.

Anwenden Die Schaltfläche ist zunächst deaktiviert, wird aber aktiv, sobald Sie
eine Einstellung geändert haben. Mit Betätigten der Schaltflächen
werden die Einstellungen gespeichert; bei Anwenden bleibt der
Dialog für weitere Einstellungen geöffnet.

OK Die Schaltfläche ist zunächst deaktiviert, wird aber aktiv, sobald Sie
eine Einstellung geändert haben. Mit Betätigten der Schaltflächen
werden die Einstellungen gespeichert und der Dialog beendet.
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Stilvorlagen anpassen

CSS Stilvorlage

Tipp

Mit der Nutzung der CSS Stilvorlage haben Sie eine sehr flexible Möglichkeit an der Hand, sich
optisch ansprechende Berichte zu konfigurieren. Ein guter Einstieg in die Arbeit mit CSS finden
Sie z.B. unter https://wiki.selfhtml.org/wiki/CSS

Wenn Sie die CSS-Stilvorlage zur Bearbeitung öffnen, so sehen Sie eine einfachen Texteditor, in dem Sie
die CSS-Anweisungen direkt eingeben können.

Voreinstellung

Die Standardvorlage hat vier Registerkarten, mit denen Sie das Erscheinungsbild der Berichte ändern
können: Farben, Schriftarten, Allgemein und Tabellen.

Der Reiter Farben Zweite Farbe für Tabellenzeile Öffnet
den
Farbauswahldialog,
um
eine
Farbe
auszuwählen,
die
abwechselnd
auf
die
Tabellenzeilen
angewendet
werden
soll.

Der Reiter Schriftarten Titel Wählen
Sie
die
Schriftart
und
-
größe
für
den
Berichtstitel.

Konto-Hyperlink Wählen
Sie
die
Schriftart
und
-
größe
für
Kontonamen
und
Verknüpfungen.
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Zahlenfeld Wählen
Sie
die
Schriftart
und
-
größe
für
normale
Zahlen
aus.

Negative Beträge in rot anzeigen Wählen
Sie
diese
Option,
um
negative
Werte
in
Rot
anzuzeigen.

Zahlenüberschrift Wählen
Sie
die
Schriftart
und
-
größe
für
die
Überschrift
von
Zahlenfeldern
aus.

Textfeld Wählen
Sie
die
Schriftart
und
-
größe
für
normale
Textfelder
aus.

Summenfeld Wählen
Sie
die
Schriftart
und
-
größe
für
Zahlenfelder
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mit
Summen
aus.

Summenbeschriftung Wählen
Sie
die
Schriftart
und
-
größe
für
Beschrifungsfelder
von
Summen
aus.

Zentriertes Textfeld Wählen
Sie
die
Schriftart
und
-
größe
für
zentrierte
Beschriftungsfelder
aus.

Der Reiter Allgemein Hintergrundfarbe Öffnet
den
Farbwähler
zur
Auswahl
einer
neuen
Hintergrundfarbe
des
Berichts.

Hintergrundbild Verwenden
Sie
die
Schaltfläche
Durchsuchen,
um
eine
Grafik,
wie
z.B.
Ihr
Logo
oder
Lieblingsbriefpapier,
auszuwählen,
das
als
Hintergrund

296



GnuCash anpassen

in
den
Berichten
verwendet
wird.
Mit
der
Zurücksetzen-
Schaltfläche
können
Sie
Ihre
Auswahl
wieder
zurücknehmen.

Hyperlinks aktivieren Wählen
Sie
diese
Option,
um
blaue
Verknüpfungen
in
Berichten
zu
aktivieren.

Der Reiter Tabellen Zellen-Abstand Legt
den
Abstand
zwischen
den
Tabellenzellen
fest.

Zellen-Füllung Legt
den
Abstand
zwischen
den
Rändern
der
Tabellenzellen
und
dem
Inhalt
fest.

Tabellen-Randbreite Legt
die
Breite
der
Ränder
von
Tabellen
fest.
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Einfach

Die Stilvorlage Einfach hat fünf Reiter, mit denen Sie das Aussehen von Berichten ändern können: Farben,
Schriftarten, Allgemein, Bilder und Tabellen.

Der Reiter Farben Hintergrund Öffnet
den
Farbwähler
zur
Auswahl
einer
neuen
Hintergrundfarbe
des
Berichts.

Textfarbe Öffnet
den
Farbwähler
zur
Auswahl
einer
neuen
Textfarbe.

Farbe für Tabellenzelle Öffnet
den
Farbwähler,
um
eine
neue
Hintergrundfarbe
von
Textzellen
auszuwählen.

Hyperlink-Farbe Öffnet
den
Farbwähler
zur
Auswahl
einer
neuen
Farbe
von
Verknüpfungen.

Zweite Farbe für Tabellenzelle Öffnet
den
Farbwähler,
um
eine
neue
Hintergrundfarbe
für
die
abwechselnden
Tabellenzeilen
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zu
wählen.

Farbe für Zwischenüberschrift/-summe Öffnet
den
Farbwähler,
um
eine
neue
Farbe
für
die
Tabellenzeilen
mit
Zwischenüberschriften/
Zwischensummen
auszuwählen.

Farbe für Zwischen-Zwischenüberschriften/-summen Öffnet
den
Farbwähler,
um
eine
neue
Farbe
für
die
Zeilen
mit
Überschriften
und
Summen
zweiter
Ordnung
in
der
Tabelle
auszuwählen.

Zellfarbe für Gesamtsumme Öffnet
den
Farbwähler,
um
eine
neue
Farbe
für
die
Gesamtsummenzeilen
zu
wählen.

Der Reiter Schriftarten Die Einstellungen für die Schriftarten wurden
zuvor im Abschnitt Der Reiter Schriftarten
beschrieben.

Der Reiter Allgemein Sachbearbeiter Angabe
des
Namens
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der
Person,
die
den
Bericht
erstellt
hat.

Erstellt für Der
Name
der
Organisation
oder
die
Firma,
für
die
der
Bericht
erstellt
wird.

Berichterstatter-Information anzeigen Zeigt
die
Informationen
zum
Sachbearbeiter
im
Bericht
an.

Hyperlinks aktivieren Wählen
Sie
diese
Option,
um
blaue
Verknüpfungen
in
Berichten
zu
aktivieren.

Fußzeile Geben
Sie
hier
den
Text
ein,
der
in
der
Fußzeile
des
Berichts
angezeigt
werden
soll.
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Der Reiter Bilder Hintergrundkachel Verwenden
Sie
die
Durchsuchen-
Schaltfläche,
um
ein
Bild
auszuwählen,
das
als
Hintergrund
in
den
Berichten
verwendet
werden
soll.
Mit
der
Schaltfläche
Zurücksetzen
können
Sie
die
Auswahl
wieder
löschen.

Titel Verwenden
Sie
die
Schaltfläche
Durchsuchen,
um
ein
Bild
auszuwählen,
das
als
Überschrift
in
Berichten
verwendet
werden
soll.
Mit
der
Schaltfläche
Zurücksetzen
können
Sie
die
Auswahl
löschen.
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Ausrichtung Überschrift Wählen
Sie
aus
der
Pulldown-
Liste:
Links,
Rechts,
Zentriert,
um
die
Ausrichtung
der
Titelzeile
am
oberen
Rand
des
Berichts/
der
Berichte
festzulegen.

Logo Verwenden
Sie
die
Schaltfläche
Durchsuchen,
um
ein
Bild
auszuwählen,
das
als
Logo
in
den
Berichten
verwendet
werden
soll.
Die
Schaltfläche
Zurücksetzen
wird
die
Auswahl
gelöscht.

Der Reiter Tabellen Die Einstellungen für die Tabellen wurden
zuvor im Abschnitt Der Reiter Tabellen
beschrieben.
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Vor- oder Nachspann

Die Stilvorlage für den Vor- oder Nachspann enthält ebenfalls fünf Reiter, mit denen Sie das Aussehen
von Berichten anpassen können: Farben, Schriftarten, Allgemein, Bilder und Tabellen.

Der Reiter Farben Die Einstellungen für die Farben wurden zuvor
im Abschnitt Der Reiter Farben beschrieben.

Der Reiter Schriftarten Die Einstellungen für die Schriftarten wurden
zuvor im Abschnitt Der Reiter Schriftarten
beschrieben.

Der Reiter Allgemein Sachbearbeiter Angabe
des
Namens
der
Person,
die
den
Bericht
erstellt
hat.

Erstellt für Der
Name
der
Organisation
oder
die
Firma,
für
die
der
Bericht
erstellt
wird.

Berichterstatter-Information Zeigt
die
Informationen
zum
Sachbearbeiter
im
Bericht
an.

Empfänger Information anzeigen Fügt
den
Namen
der
Organisation
oder
der
Firma
in
den
Bericht
ein.

303



GnuCash anpassen

Datum anzeigen Schreibt
das
Tagesdatum
in
den
Bericht.

Zusätzlich zum Datum auch die Zeit anzeigen Das
Datum
in
dem
Bericht
kann
mit
der
Angaben
zur
Uhrzeit
ergänzt
werden.

GnuCash-Version anzeigen Fügt
die
GnuCash-
Versionsnummer,
mit
der
der
Bericht
erstellt
wurde,
ein.

Hyperlinks aktivieren Wählen
Sie
diese
Option,
um
blaue
Verknüpfungen
in
Berichten
zu
aktivieren.

Zusätzliche Kommentare In
diesem
Textfeld
können
Sie
weiter
Informationen
zur
Anzeige
im
Bericht
eintragen.
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Angaben zum Berichterstatter am Ende anzeigen Zeigt
die
Informationen
zum
Sachbearbeiter
hinter
den
Berichtsdaten
an.

Empfängerdaten am Ende anzeigen Fügt
den
Namen
der
Organisation
oder
der
Firma
hinter
den
Berichtsdaten
ein.

Datum und Uhrzeit am Ende anzeigen Schreibt
Datum
und
Uhrzeit
an
den
Ende
des
Berichts.

Kommentare am Ende anzeigen Fügt
den
zusätzlichen
Kommentar
hinter
den
Berichtsdaten
ein.

GnuCash-Version am Ende anzeigen Fügt
die
GnuCash-
Versionsnummer,
mit
der
der
Bericht
erstellt
wurde,
am
Ende
des
Berichts
ein.
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Der Reiter Bilder Die Einstellungen für die Bilder wurden zuvor
im Abschnitt Der Reiter Bilder beschrieben.

Der Reiter Tabellen Die Einstellungen für die Tabellen wurden
zuvor im Abschnitt Der Reiter Tabellen
beschrieben.

Fußzeile

Die Stilvorlage Fußzeile hat dieselben fünf Reiter, mit denen Sie das Aussehen von Berichten anpassen
können, wie die Stilvorlage „Einfach“: Farben, Schriftarten, Allgemein, Bilder und Tabellen.

Bunt

Die Stilvorlage Bunt hat dieselben fünf Reiter, mit denen Sie das Aussehen von Berichten anpassen
können, wie die Stilvorlage „Einfach“: Farben, Schriftarten, Allgemein, Bilder und Tabellen.

Setting Tax Report Options
Geehrte Leser, leider hat bisher niemand eine Übersetzung der folgenden Teile erstellt. Falls Sie uns dabei
helfen möchten, folgen Sie bitte der Anleitung in  Gnucash wiki: How to translate the GnuCash guide and/
or help files [https://wiki.gnucash.org/wiki/Translation#Translating_the_GnuCash_Guide_and_Help].
Fragen können auf der deutschsprachigen Mailingliste gnucash-de@gnucash.org diskutiert werden.

The tax report can be used to prepare online tax reports for specific countries, see „Country Specific Reports“. Currently
US and partial DE are supported.

Localization

Before it can be used in other regions, one needs to provide a
localized taxtable. See the instructions in the wiki [https://wiki.gnucash.org/wiki/
Translation#How_to_create_localized_Income_Tax_Tables].

The Income Tax Information dialog is used to set Tax Report Options. The settings on accounts in this
dialog are used by the TXF Export function in reports to select the accounts for export. To access this
dialog go to Edit → Tax Report Options .

Tipp

If the Income Tax features are used, it is strongly recommended that the Tax Info column be made
visible on the accounts tab (click large downward-pointing arrow and select Tax Info check box).
The Tax Info column will display the Form/Schedule and tax category (e.g., Schedule D Dividend,
cap gain distrib.) assigned to an account, if any. Alternatively, it will display the following error
messages which can be corrected through Edit → Tax Report Options :

• Tax-related but has no tax code
• Tax entity type not specified
• Tax type "tax_type": invalid code "code" for account type"
• Not tax-related; tax type "tax_type": invalid code "code" for account type
• Invalid code "code" for tax type "tax_type"
• Not tax-related; invalid code "code" for tax type "tax_type"
• No form: code "code", tax type "tax_type"
• Not tax-related; no form: code "code", tax type "tax_type"
• No description: form "form", code "code", tax type "tax_type"
• Not tax-related; no description: form "form", code "code", tax type "tax_type"
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• Not tax-related; "form"("copy") "desc" (code "code", tax type "tax_type")

The Income Tax Identity must be set in order to assign codes to individual accounts. Click Edit to set the
identity. The Tax Name is optional. If entered, it will be printed at the top of the report. A Type must be
selected in order to activate the tax category selections. The choices are:

• Individual, Joint, etc. - Files US Form 1040 Tax Return
• Partnership - Files US Form 1065 Tax Return
• Corporation - Files US Form 1120 Tax Return
• S Corporation - Files US Form 1120S Tax Return
• None - No Income Tax Options Provided

While the Income Tax Entity Type can be changed after tax categories have been assigned to accounts,
you should be cautioned that you will need to manually change each one if you do so, which could be quite
tedious. The tax categories are unique for each Income Tax Entity Type, so changing the type will make
all previously assigned categories invalid. It is assumed (and highly recommended) that each GnuCash
file is for only one tax entity and this is where you specify its type of tax entity. You should not keep,
for example, personal and partnership accounts mixed in one GnuCash file if you plan to use the Income
Tax Reporting features.

A given TXF code can be assigned to multiple accounts. The Tax Schedule Report will combine accounts
by code and generate a detailed TXF record for each account and a summary TXF record for the total as
calculated by the report.

For codes for which the "Payer Name Source" is not grayed, the payer on the TXF record will be based on
what is specified here, either the account name of the account or the account name of the account’s parent
account. This feature is typically used for interest accounts or stocks or mutual funds that pay dividends
where the individual payees are shown on the tax schedule. For example, if the parent account’s name is
the name of your broker and the sub-account’s names are the names of individual stocks that pay dividends
and the name on the 1099-DIV received is that of the broker, in order to match that name, you would
select ’Parent Account’; the total dividends from the broker would be exported and, if you had several
brokers, there would be an amount exported and a subtotal for each broker, along with each brokers name.
Alternatively, if you had a parent account named Directly Held, for example, and below it sub-accounts
for one or more stocks, you would receive a 1099-DIV from the issuer of each stock separately and, in
order to match that name, you would select Current Account; the total dividends from each stock would
be exported and, if you had several stocks, there would be an amount exported and a subtotal for each
stock, along with each stock’s name as the payer.

Some tax Forms/Schedules need to have multiple copies filed under some circumstances (for example,
Schedule C if a taxpayer and spouse have separate businesses). For tax categories on these Forms/
Schedules, the Copy Number is not grayed out and can be used to segregate accounts by copy number.

• Accounts: This pane contains the list of accounts. Select an account to set a TXF category. If no account
is selected nothing is changed. If multiple accounts are selected, all of the accounts will be set to the
selected item.

• Tax Related: Select this check-box to add tax information to an account then select the TXF Category
below. This setting is displayed on the account edit dialogue but cannot be changed from there.

• TXF Categories: Select the desired one. A detailed description appears just below (if available, otherwise
it says No help available), along with the TXF code for the category and information about what line
number on the form or schedule the amounts are included in by tax year (used for detailed sort on report).

• Payer Name Source: Select an option to determine where the text description that is exported along with
the value of the account is derived from, as described above. This is usually the name of a bank, stock,
or mutual fund that pays dividends or interest. Occasionally, it is a description of a deduction.
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• Copy Number: A copy number that is exported along with the value of the account. This is used to
segregate amounts between different copies of the same Form/Schedule that may need to be filed (e.g.,
Schedule C(1), Schedule C(2), etc.). This is also used to sort the report.

TXF Export - Known Anomalies and Limitations
TaxCut 1999

• Code: N488 "^ Sched B \ Div. income, cap gain distrib."

• Code: N286 "^ Sched B \ Dividend income"

These two codes, from the same payer, are not correlated. The user will have to adjust for this after import.

TaxCut 1999, 2000

• Code: N521 " F1040 \ Federal estimated tax, quarterly"

Does not accept the date field and does not import the individual payment amounts, only the total. The
date and individual payment amounts, only matter if you have to compute the penalty. (this may be a
TurboTax enhancement)

• Code: N460 " W-2 \ Salary or wages, self"

• Code: N506 " W-2 \ Salary or wages, spouse"

• and other related codes.

Use Copy Number to separate information from more than one job.

TurboTax 1999, 2000

• Code: N521 " F1040 \ Federal estimated tax, quarterly"

Does not accept the dates outside of the tax year. This is a problem for the last payment that is due Jan 15.
GnuCash changes the the date of the last payment to Dec 31 for the export unless the "Do not use special
date processing" option is selected in the report options display tab. The user will have to adjust for this
after import. The date only matters if you have to compute the penalty.

TXF Tax eXport Format

• Duplicate Codes

Codes can be assigned to multiple accounts and the amounts will be summed for all the accounts generating
one detail TXF record per account and one summary TXF record for the sum. Codes that let you select
"Payer Name Source" will generate a separate summary TXF account with each change in payer. Selecting
the "Print TXF export parameters" option will cause the report to show to which codes this applies (Payer
Name Source option Y) and, for the accounts assigned to those codes, the Name Source each account is set
to and the TXF item number that will be assigned to each. A summary TXF record will be generated for
each change in assigned item line number. These may not be handled the same by TaxCut and TurboTax.

• Code: N673 "Short/Long gain or loss"

Short term or long term gain or loss from the sale of a security; generates TXF output for only the date
sold and sales amount, with the date acquired and cost basis information left blank (to be separately added
in the tax software). The code can be assigned to either a short-, long-, or mixed-term gain/loss income
account and the security sales transaction should be entered as illustrated in Section 8.7, Selling Shares, of
the GnuCash Tutorial and Concepts Guide. The report uses the transaction split of the gain/loss account to
find one or more other splits in the same transaction with negative share quantities. For each of these found,
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it generates a detailed TXF output record with the quantity sold, the name of the security, the date sold,
and the sales amount. Note that if, for a given transaction, more than one transaction split is to a gain/loss
income account assigned to code 673, TXF output data will be erroneously repeated. That is because the
report will fetch the same data, and re-output it, for each transaction split set to a gain/loss income account
within the same transaction. For this reason, there should be no more than one gain/loss account entered
per transaction to use this tax reporting code properly. (Note that no amounts are used from GnuCash’s
lot-tracking; a future enhancement is expected to use this data to provide capital gain reporting).

Detailed TXF Category Descriptions
Table 32. Detailed TXF Category Descriptions

Tabelle 10.1. Detailed TXF Category Descriptions

Tax Form \ TXF Code

Description

Extended TXF Help messages

< help \ H001

Name of Current account is exported.

Categories marked with a "<" or a "^", require a
Payer identification to be exported. "<" indicates
that the name of this account is exported as this
Payer ID. Typically, this is a bank, stock, or mutual
fund name.

^ help \ H002

Name of Parent account is exported.

Categories marked with a "<" or a "^", require a
Payer identification to be exported. "^" indicates
that the name of the PARENT of this account is
exported as this Payer ID. Typically, this is a bank,
stock, or mutual fund name.

# help \ H003

Not implemented yet, Do NOT Use!

Categories marked with a "#" are not fully
implemented yet! Do not use these codes!

none \ N000

Tax Report Only - No TXF Export

This is a dummy category and only shows up on the
tax report, but is not exported.

Help F1040 \ H256

Form 1040 - the main tax form

Form 1040 is the main form of your tax return.

F1040 \ N261

Alimony received

Amounts received as alimony or separate
maintenance. Note: child support is not considered
alimony.

F1040 \ N257

Other income, misc.

Miscellaneous income such as: a hobby or a farm
you operate mostly for recreation and pleasure,
jury duty pay. Exclude self employment income,
gambling winnings, prizes and awards.

F1040 \ N520

RR retirement inc., spouse

Spouse's part of tier I railroad retirement benefits,
which are treated as a social security benefits. These
will be reported on Form RRB-1099.

F1040 \ N519

RR retirement income, self

The part of tier I railroad retirement benefits, which
are treated as a social security benefits. These will
be reported on Form RRB-1099.

F1040 \ N258 Amounts you receive from your employer while you
are sick or injured are part of your salary or wages.
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Tax Form \ TXF Code

Description

Extended TXF Help messages

Sick pay or disability pay Exclude workers' compensation, accident or health
insurance policy benefits, if you paid the premiums.

F1040 \ N483

Social Security inc., spouse

Spouse's part of any monthly benefit under title II of
the Social Security Act. These will be reported on
Form SSA-1099.

F1040 \ N266

Social Security income, self

The part of any monthly benefit under title II of the
Social Security Act. These will be reported on Form
SSA-1099.

F1040 \ N260

State and local tax refunds

Refund of state or local income tax refund (or credit
or offset) which you deducted or took a credit for
in an earlier year. You should receive a statement,
Form 1099-G. Not reportable if you didn't itemize
last year.

F1040 \ N269

Taxable fringe benefits

Fringe benefits you receive in connection with the
performance of your services are included in your
gross income as compensation. Examples: Accident
or Health Plan, Educational Assistance, Group-
Term Life Insurance, Transportation (company car).

Help F1099-G \ H634

Form 1099-G - certain Government payments

Form 1099-G is used to report certain government
payments from federal, state, or local governments.

F1099-G \ N672

Qualified state tuition earnings

Qualified state tuition program earnings you
received this year.

F1099-G \ N260

State and local tax refunds

Refund of state or local income tax refund (or credit
or offset) which you deducted or took a credit for
in an earlier year. You should receive a statement,
Form 1099-G. Not reportable if you didn't itemize
last year.

F1099-G \ N479

Unemployment compensation

Total unemployment compensation paid to you this
year. Reported on Form 1099-G.

Help F1099-MISC \ H553

Form 1099-MISC - MISCellaneous income

Form 1099-MISC is used to report miscellaneous
income received and direct sales of consumer goods
for resale.

^ F1099-MISC \ N562

Crop insurance proceeds

The amount of crop insurance proceeds as the result
of crop damage.

^ F1099-MISC \ N559

Fishing boat proceeds

Your share of all proceeds from the sale of a catch
or the fair market value of a distribution in kind that
you received as a crew member of a fishing boat.

^ F1099-MISC \ N560

Medical/health payments

The amount of payments received as a physician or
other supplier or provider of medical or health care
services. This includes payments made by medical
and health care insurers under health, accident, and
sickness insurance programs.
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Tax Form \ TXF Code

Description

Extended TXF Help messages

^ F1099-MISC \ N561

Non employee compensation

The amount of non-employee compensation
received. This includes fees, commissions, prizes
and awards for services performed, other forms of
compensation for services you performed for a trade
or business by which you are not employed. Also
include oil and gas payments for a working interest.

^ F1099-MISC \ N557

Other income

The amount of prizes and awards that are not for
services performed. Included is the fair market value
of merchandise won on game shows. Included is
all punitive damages, any damages for nonphysical
injuries or sickness, and any other taxable damages,
Deceased employee's wages paid to estate or
beneficiary.

^ F1099-MISC \ N259

Prizes and awards

The amount of prizes and awards that are not for
services performed. Included is the fair market value
of merchandise won on game shows.

^ F1099-MISC \ N555

Rents

Amounts received for all types of rents, such as real
estate rentals for office space, machine rentals, and
pasture rentals.

^ F1099-MISC \ N556

Royalties

The gross royalty payments received from a
publisher or literary agent.

Help F1099=MSA \ H629

Form 1099-MSA Medical Savings Account

Form 1099-MSA is used to report medical savings
account distributions.

F1099-MSA \ N632

MSA earnings on excess contrib

The earnings on any excess contributions you
withdrew from an MSA by the due date of your
income tax return. If you withdrew the excess, plus
any earnings, by the due date of your income tax
return, you must include the earnings in your income
in the year you received the distribution even if you
used it to pay qualified medical expenses.

F1099-MSA \ N631

MSA gross distribution

The amount you received this year from a Medical
Savings Account. The amount may have been a
direct payment to the medical service provider or
distributed to you.

Help F1099-R \ H473

Form 1099-R - Retirement distributions

Form 1099-R is used to report taxable and non-
taxable retirement distributions from retirement,
pension, profit-sharing, or annuity plans. Use a
separate Form 1099-R for each payer.

^ F1099-R \ N623

SIMPLE total gross distribution

The gross amount of a distribution received from a
qualified SIMPLE pension plan.

^ F1099-R \ N624

SIMPLE total taxable distribution

The taxable amount of a distribution received from a
qualified SIMPLE plan. This amount may be subject
to a federal penalty of up to 25%.
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Tax Form \ TXF Code

Description

Extended TXF Help messages

^ F1099-R \ N477

Total IRA gross distribution

The gross amount of a distribution from a qualified
Individual Retirement Arrangement (IRA) plan.

^ F1099-R \ N478

Total IRA taxable distribution

The taxable amount of a distribution from a
qualified Individual Retirement Arrangement (IRA)
plan.

^ F1099-R \ N475

Total pension gross distribution

The gross amount of a distribution from a qualified
pension or annuity plan. Note: IRA distributions are
not included here.

^ F1099-R \ N476

Total pension taxable distribution

The taxable amount of a distribution from a
qualified pension or annuity plan. Note: IRA
distributions are not included here.

Help F2106 \ H380

employee business expenses

Form 2106 is used to deduct employee business
expenses. You must file this form if you were
reimbursed by your employer or claim job-
related travel, transportation, meal, or entertainment
expenses. Use a separate Form 2106 for your
spouse's expenses.

F2106 \ N387

Reimb. business expenses (non-meal/ent.)

Reimbursement for business expenses from your
employer that is NOT included on your Form W-2.
Note: meals and entertainment are NOT included
here.

F2106 \ N388

Reimb. meal/entertainment expenses

Reimbursement for meal and entertainment
expenses from your employer that is NOT included
on your Form W-2.

Help F4137 \ H503

Form 4137 - tips not reported

Form 4137 is used to compute social security and
Medicare tax owed on tips you did not report to your
employer.

F4137 \ N505

Total cash/tips not reported to employer

The amount of tips you did not report to your
employer.

Help F4684 \ H412

Form 4684 - casualties and thefts

Form 4684 is used to report gains and losses from
casualties and thefts.

F4684 \ N416

FMV after casualty

The fair market value (FMV) is the price at which
the property would change hands between a willing
buyer and seller, each having knowledge of the
relevant facts. The FMV after a theft is zero if the
property is not recovered. The FMV is generally
determined by competent appraisal.

F4684 \ N415

FMV before casualty

The fair market value (FMV) is the price at which
the property would change hands between a willing
buyer and seller, each having knowledge of the
relevant facts. FMV is generally determined by
competent appraisal.
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Tax Form \ TXF Code

Description

Extended TXF Help messages

F4684 \ N414

Insurance/reimbursement

The amount of insurance or other reimbursement
you received expect to receive.

Help F4835 \ H569

Form 4835 - farm rental income

Form 4835 is used to report farm rental income
received as a share of crops or livestock produced
by your tenant if you did not materially participate
in the operation or management of the farm. Use a
different copy of Form 4835 for each farm rented.

F4835 \ N573

Agricultural program payments

Government payments received for: price support
payments, market gain from the repayment of
a secured Commodity Credit Corporation (CCC)
loan for less than the original loan amount,
diversion payments, cost-share payments (sight
drafts), payments in the form of materials (such as
fertilizer or lime) or services (such as grading or
building dams). Reported on Form 1099-G.

F4835 \ N575

CCC loans forfeited/repaid

The full amount forfeited or repaid with certificates,
even if you reported the loan proceeds as income.
See IRS Pub 225.

F4835 \ N574

CCC loans reported/election

Generally, you do not report CCC loan proceeds as
income. However, if you pledge part or all of your
production to secure a CCC loan, you may elect to
report the loan proceeds as income in the year you
receive them, instead of the year you sell the crop.

F4835 \ N577

Crop insurance proceeds deferred

If you use the cash method of accounting and
receive crop insurance proceeds in the same tax year
in which the crops are damaged, you can choose
to postpone reporting the proceeds as income until
the following tax year. A statement must also be
attached to your return. See IRS Pub 225.

F4835 \ N576

Crop insurance proceeds received

You generally include crop insurance proceeds in
the year you receive them. Treat as crop insurance
proceeds the crop disaster payments you receive
from the federal government.

F4835 \ N578

Other income

Illegal Federal irrigation subsidies, bartering
income, income from discharge of indebtedness,
state gasoline or fuel tax refund, the gain or loss on
the sale of commodity futures contracts, etc.

F4835 \ N571

Sale of livestock/produce

Income you received from livestock, produce,
grains, and other crops based on production. Under
both the cash and the accrual methods of reporting,
you must report livestock or crop share rentals
received in the year you convert them into money
or its equivalent.

F4835 \ N572

Total cooperative distributions

Distributions received from a cooperative. This
includes patronage dividends, non patronage
distributions, per-unit retain allocations, and
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Tax Form \ TXF Code

Description

Extended TXF Help messages

redemption of non qualified notices and per unit
retain allocations. Reported on Form 1099-PATR.

Help F6252 \ H427

Form 6252 - income from casual sales

Form 6252 is used to report income from casual
sales of real or personal property when you will
receive any payments in a tax year after the year of
sale (i.e., installment sale).

F6252 \ N429

Debt assumed by buyer

Enter only mortgages or other debts the buyer
assumed from the seller or took the property subject
to. Do not include new mortgages the buyer gets
from a bank, the seller, or other sources.

F6252 \ N431

Depreciation allowed

Enter all depreciation or amortization you deducted
or should have deducted from the date of purchase
until the date of sale. Add any section 179 expense
deduction. Several other adjustments are allowed,
See Form 6252 instructions.

F6252 \ N435

Payments received prior years

Enter all money and the fair market value (FMV)
of property you received before this tax year from
the sale. Include allocable installment income and
any other deemed payments from prior years. Do not
include interest whether stated or unstated.

F6252 \ N434

Payments received this year

Enter all money and the fair market value (FMV)
of any property you received in this tax year.
Include as payments any amount withheld to pay
off a mortgage or other debt, such as broker and
legal fees. Do not include interest whether stated or
unstated.

F6252 \ N428

Selling price

Enter the total of any money, face amount of
the installment obligation, and the FMV of other
property that you received or will receive in
exchange for the property sold.

Help F8815 \ H441

Form 8815 - EE U.S. savings bonds sold for
education

Form 8815 is used to compute the amount of interest
you may exclude if you cashed series EE U.S.
savings bonds this year that were issued after 1989
to pay for qualified higher education costs.

F8815 \ N444

EE US savings bonds proceeds

Enter the total proceeds (principal and interest) from
all series EE and I U.S. savings bonds issued after
1989 that you cashed during this tax year.

F8815 \ N443

Nontaxable education benefits

Nontaxable educational benefits. These benefits
include: Scholarship or fellowship grants
excludable from income under section
117; Veterans' educational assistance benefits;
Employer-provided educational assistance benefits
that are not included in box 1 of your W-2 form(s);
Any other payments (but not gifts, bequests, or
inheritances) for educational expenses that are
exempt from income tax by any U.S. law. Do
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not include nontaxable educational benefits paid
directly to, or by, the educational institution.

F8815 \ N445

Post-89 EE bond face value

The face value of all post-1989 series EE bonds
cashed this tax year.

Help F8863 \ H639

Form 8863 - Hope and Lifetime Learning education
credits

Form 8863 is used to compute the Hope and
Lifetime Learning education credits. IRS rules are
stringent for these credits. Refer to IRS Publication
970 for more information.

F8863 \ N637

Hope credit

Expenses qualified for the Hope credit are amounts
paid this tax year for tuition and fees required for
the student's enrollment or attendance at an eligible
educational institution.

F8863 \ N638

Lifetime learning credit

Expenses qualified for the Lifetime Learning credit
are amounts paid this tax year for tuition and fees
required for the student's enrollment or attendance
at an eligible educational institution.

Home Sale \ N392

Home Sale worksheets (was F2119)

Home Sale worksheets (replaces Form 2119) are
used to report the sale of your personal residence.
See IRS Pub 523.

Home Sale \ N393

Selling price of old home

The selling price is the total amount you receive for
your home. It includes money, all notes, mortgages,
or other debts assumed by the buyer as part of
the sale, and the fair market value of any other
property or any services you receive. Reported on
Form 1099-S.

Help Sched B \ H285

Schedule B - interest and dividend income

Schedule B is used to report your interest and
dividend income.

< Sched B \ N487

Dividend income, non-taxable

Some mutual funds pay shareholders non-taxable
dividends. The amount of non-taxable dividends
are indicated on your monthly statements or Form
1099-DIV.

^ Sched B \ N286

Dividend income, Ordinary

Ordinary dividends from mutual funds, stocks,
etc., are reported to you on a 1099-DIV. Note:
these are sometimes called short term capital gain
distributions. Do not include (long term) capital gain
distributions or non-taxable dividends here, these go
on Sched D

< Sched B \ N287

Interest income

Taxable interest includes interest you receive from
bank accounts, credit unions, loans you made to
others. There are several categories of interest, be
sure you select the correct one!

< Sched B \ N489

Interest income, non-taxable

Non-taxable interest income other than from bonds
or notes of states, counties, cities, the District of
Columbia, or a possession of the United States, or
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from a qualified private activity bond. There are
several categories of interest, be sure you select the
correct one!

< Sched B \ N492

Interest income, OID bonds

Interest income from Original Issue Discount (OID)
bonds will be reported to you on Form 1099-OID.
There are several categories of interest, be sure you
select the correct one!

< Sched B \ N524

Interest income, Seller-financed mortgage

Interest the buyer paid you on a mortgage or other
form of seller financing, for your home or other
property and the buyer used the property as a
personal residence. There are several categories of
interest, be sure you select the correct one!

< Sched B \ N289

Interest income, State and municipal bond

Interest on bonds or notes of states, counties, cities,
the District of Columbia, or possessions of the
United States is generally free of federal income
tax (but you may pay state income tax). There are
several categories of interest, be sure you select the
correct one!

< Sched B \ N490

Interest income, taxed only by fed

Interest income that is taxed on your federal return,
but not on your state income tax return - other than
interest paid on U.S. obligations. There are several
categories of interest, be sure you select the correct
one!

< Sched B \ N491

Interest income, taxed only by state

Interest income that is not taxed on your federal
return, but is taxed on your state income tax return
- other than interest income from state bonds or
notes, the District of Columbia, or a possession of
the United States. There are several categories of
interest, be sure you select the correct one!

< Sched B \ N290

Interest income, tax-exempt private activity bond

Interest income from a qualified tax-exempt private
activity bond is not taxable if it meets all
requirements. This income is included on your
Schedule B as non-taxable interest income. There
are several categories of interest, be sure you select
the correct one!

< Sched B \ N288

Interest income, US government

Interest on U.S. obligations, such as U.S. Treasury
bills, notes, and bonds issued by any agency of the
United States. This income is exempt from all state
and local income taxes. There are several categories
of interest, be sure you select the correct one!

Help Sched C \ H291

Schedule C - self-employment income

Schedule C is used to report income from self-
employment. Use a separate Schedule C to report
income and expenses from different businesses.

Sched C \ N293

Gross receipts or sales

The amount of gross receipts from your trade or
business. Include amounts you received in your
trade or business that were properly shown on
Forms 1099-MISC.
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Sched C \ N303

Other business income

The amounts from finance reserve income, scrap
sales, bad debts you recovered, interest (such as on
notes and accounts receivable), state gasoline or fuel
tax refunds you got this year, prizes and awards
related to your trade or business, and other kinds of
miscellaneous business income.

Help Sched D \ H320

Schedule D - capital gains and losses

Schedule D is used to report gains and losses from
the sale of capital assets.

^ Sched D \ N488

Dividend income, capital gain distributions

Sometimes called long term capital gain
distributions. These are from mutual funds, other
regulated investment companies, or real estate
investment trusts. These are reported on your
monthly statements or Form 1099-DIV. Note: short
term capital gain distributions are reported on Sched
B as ordinary dividends

# Sched D \ N323

Long Term gain/loss - security

Long term gain or loss from the sale of a security.

# Sched D \ N321

Short Term gain/loss - security

Short term gain or loss from the sale of a security.

# Sched D \ N810

Short/Long Term gain or loss

Short term or long term gain or loss from the sale of
capital assets other than securities.

Help Sched E \ H325

Schedule E - rental and royalty income

Schedule E is used to report income or loss from
rental real estate, royalties, and residual interest
in REMIC's. Use a different copy for each rental
or royalty. Use the Schedule K-1 categories for
partnership rental income and loss amounts.

Sched E \ N326

Rents received

The amounts received as rental income from real
estate (including personal property leased with real
estate) but you were not in the real estate business.
(If you are in the business of renting personal
property, use Schedule C.)

Sched E \ N327

Royalties received

Royalties received from oil, gas, or mineral
properties (not including operating interests);
copyrights; and patents.

Help Sched F \ H343

Schedule F - Farm income and expense

Schedule F is used to report farm income and
expense. Use a different copy of Schedule F for each
farm you own.

Sched F \ N372

Agricultural program payments

Government payments received for: price support
payments, market gain from the repayment of
a secured Commodity Credit Corporation (CCC)
loan for less than the original loan amount,
diversion payments, cost-share payments (sight
drafts), payments in the form of materials (such as
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fertilizer or lime) or services (such as grading or
building dams). Reported on Form 1099-G.

Sched F \ N374

CCC loans forfeited or repaid

The amount forfeited or repaid with certificates,
even if you reported the loan proceeds as income.
See IRS Pub 225.

Sched F \ N373

CCC loans reported/election

Generally, you do not report CCC loan proceeds as
income. However, if you pledge part or all of your
production to secure a CCC loan, you may elect to
report the loan proceeds as income in the year you
receive them, instead of the year you sell the crop.

Sched F \ N376

Crop insurance proceeds deferred

If you use the cash method of accounting and
receive crop insurance proceeds in the same tax year
in which the crops are damaged, you can choose
to postpone reporting the proceeds as income until
the following tax year. A statement must also be
attached to your return. See IRS Pub 225.

Sched F \ N375

Crop insurance proceeds received

You generally include crop insurance proceeds in
the year you receive them. Treat as crop insurance
proceeds the crop disaster payments you receive
from the federal government.

Sched F \ N370

Custom hire income

The income you received for custom hire (machine
work).

Sched F \ N377

Other farm income

Illegal Federal irrigation subsidies, bartering
income, income from discharge of indebtedness,
state gasoline or fuel tax refund, the gain or loss on
the sale of commodity futures contracts, etc.

Sched F \ N369

Resales of livestock/items

Amounts you received from the sales of livestock
and other items you bought specifically for resale.
Do not include sales of livestock held for breeding,
dairy purposes, draft, or sport. These are reported on
Form 4797, Sales of Business Property.

Sched F \ N368

Sales livestock/product raised

Amounts you received from the sale of livestock,
produce, grains, and other products you raised.

Sched F \ N371

Total cooperative distributions

Distributions received from a cooperative. This
includes patronage dividends, non patronage
distributions, per-unit retain allocations, and
redemption of non qualified notices and per unit
retain allocations. Reported on Form 1099-PATR.

Help Sched K-1 \ H446

Schedule K-1 - partnership income, credits,
deductions

Schedule K-1 is used to report your share of a
partnership's income, credits, deductions, etc. Use a
separate copy of Schedule K-1 for each partnership.
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Sched K-1 \ N452

Dividends, ordinary

The amount of dividend income the partnership
reported to you on Schedule K-1. (You report this
on Schedule B)

Sched K-1 \ N455

Guaranteed partner payments

A guaranteed payments the partnership reported to
you on Schedule K-1. (You report this on Schedule
E)

Sched K-1 \ N451

Interest income

The amount of interest income the partnership
reported to you on Schedule K-1. (You report this
on Schedule B)

# Sched K-1 \ N454

Net LT capital gain or loss

The long-term gain or (loss) from the sale of assets
the partnership reported to you on Schedule K-1.
(You report this on Schedule D)

# Sched K-1 \ N453

Net ST capital gain or loss

The short-term gain or (loss) from sale of assets the
partnership reported to you on K-1. (You report this
on Schedule D)

# Sched K-1 \ N456

Net Section 1231 gain or loss

The gain or (loss) from sale of Section 1231 assets
the partnership reported to you on Schedule K-1.
(You report this on Form 4797)

# Sched K-1 \ N448

Ordinary income or loss

Your share of the ordinary income (loss) from the
trade or business activities of the partnership. This
is reported to you on Schedule K-1. (You usually
report this on Schedule E, See instructions for
Schedule K-1)

# Sched K-1 \ N450

Other rental income or loss

The income or (loss) from rental activities, other
than the rental of real estate. This is reported to
you on Schedule K-1. (You usually report this on
Schedule E, See instructions for Schedule K-1)

# Sched K-1 \ N449

Rental real estate income or loss

The income or (loss) from rental real estate activities
engaged in by the partnership. This is reported to
you on Schedule K-1. (You usually report this on
Schedule E, See instructions for Schedule K-1)

Sched K-1 \ N527

Royalties

The amount of the royalty income the partnership
reported to you on Schedule K-1. (You report this
on Schedule E)

Sched K-1 \ N528

Tax-exempt interest income

The amount of tax-exempt interest income the
partnership reported to you on Schedule K-1. (You
report this on Form 1040)

Help W-2 \ H458

Form W-2 - Wages earned and taxes withheld

Form W-2 is used by your employer to report
the amount of wages and other compensation
you earned as an employee, and the amount of
federal and state taxes withheld and fringe benefits
received. Use a separate copy of Form W-2 for each
employer.

^ W-2 \ N465

Dependent care benefits, self

The amount dependent care benefits, including
the fair market value of employer-provided
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or employer-sponsored day-care facilities you
received.

^ W-2 \ N512

Dependent care benefits, spouse

The amount dependent care benefits, including
the fair market value of employer-provided or
employer-sponsored day-care facilities your spouse
received.

^ W-2 \ N267

Reimbursed moving expenses, self

Qualified moving expense reimbursements paid
directly to you by an employer.

^ W-2 \ N546

Reimbursed moving expenses, spouse

Qualified moving expense reimbursements paid
directly to your spouse by your spouse's employer.

^ W-2 \ N460

Salary or wages, self

The total wages, tips, and other compensation,
before any payroll deductions, you receive from
your employer.

^ W-2 \ N506

Salary or wages, spouse

The total wages, tips, and other compensation,
before any payroll deductions, your spouse receives
from your spouse's employer.

Help W-2G \ H547

Form W-2G - gambling winnings

Form W-2G is used to report certain gambling
winnings.

^ W-2G \ N549

Gross winnings

The amount of gross winnings from gambling.
This may include winnings from horse racing, dog
racing, jai alai, lotteries, keno, bingo, slot machines,
sweepstakes, and wagering pools. If the amount is
large enough, it will be reported on Form W-2G.

none \ N000

Tax Report Only - No TXF Export

This is a dummy category and only shows up on the
tax report, but is not exported.

Help F1040 \ H256

Form 1040 - the main tax form

Form 1040 is the main form of your tax return.

F1040 \ N264

Alimony paid

Amounts payed as alimony or separate
maintenance. Note: child support is not considered
alimony.

< F1040 \ N265

Early withdrawal penalty

Penalty on Early Withdrawal of Savings from CD's
or similar instruments. This is reported on Form
1099-INT or Form 1099-OID.

F1040 \ N521

Federal estimated tax, quarterly

The quarterly payments you made on your estimated
Federal income tax (Form 1040-ES). Include any
overpay from your previous year return that you
applied to your estimated tax. NOTE: If a full year
(Jan 1, YEAR to Dec 31, YEAR) is specified,
GnuCash adjusts the date to Mar 1, YEAR to Feb 28,
YEAR+1. Thus, the payment due Jan 15 is exported
for the correct year.
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F1040 \ N613

Fed tax withheld, RR retire, self

The amount of federal income taxes withheld from
your part of tier I railroad retirement benefits, which
are treated as a social security benefits.

F1040 \ N614

Fed tax withheld, RR retire, spouse

The amount of federal income taxes withheld from
your spouse's part of tier I railroad retirement
benefits, which are treated as a social security
benefits.

F1040 \ N611

Fed tax withheld, Social Security, self

The amount of federal income taxes withheld from
your part of any monthly benefit under title II of the
Social Security Act.

F1040 \ N612

Fed tax withheld, Social Security, spouse

The amount of federal income taxes withheld from
your spouse's part of any monthly benefit under title
II of the Social Security Act.

F1040 \ N482

IRA contrib., non-work spouse

IRA contribution for a non-working spouse.

F1040 \ N262

IRA contribution, self

Contribution to a qualified IRA. If you or your
spouse are covered by a company retirement plan,
this amount could be limited or eliminated.

F1040 \ N481

IRA contribution, spouse

Contribution of a working spouse to a qualified IRA.
If you or your spouse are covered by a company
retirement plan, the deductible contribution could be
limited or eliminated.

F1040 \ N263

Keogh deduction, self

Contributions to a Keogh or HR 10 plan of a sole
proprietor or a partnership.

F1040 \ N516

Keogh deduction, spouse

Spouse Contributions to a Keogh or HR 10 plan of
a sole proprietor or a partnership.

F1040 \ N608

Medical savings contribution, spouse

Contributions made to your spouse's medical
savings account that were not reported on their Form
W-2.

F1040 \ N607

Medical savings contribution, self

Contributions made to your medical savings
account that were not reported on your Form W-2.

F1040 \ N517

SEP-IRA deduction, self

Contributions made to a simplified employee
pension plan (SEP-IRA).

F1040 \ N518

SEP-IRA deduction, spouse

Spouse contributions made to a simplified employee
pension plan (SEP-IRA).

F1040 \ N609

SIMPLE contribution, self

Contributions made to your SIMPLE retirement
plan that were not reported on your Form W-2.
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F1040 \ N610

SIMPLE contribution, spouse

Contributions made to your spouse's SIMPLE
retirement plan that were not reported on your
spouse's Form W-2.

F1040 \ N636

Student loan interest

The amount of interest you paid this year on
qualified student loans.

Help F1099-G \ H634

Form 1099-G - certain Government payments

Form 1099-G is used to report certain government
payments from federal, state, or local governments.

F1099-G \ N606

Fed tax withheld, unemployment comp

The amount of federal income taxes withheld from
your unemployment compensation.

F1099-G \ N605

Unemployment comp repaid

If you received an overpayment of unemployment
compensation this year or last and you repaid any of
it this year, subtract the amount you repaid from the
total amount you received.

Help F1099-MISC \ H553

Form 1099-MISC - MISCellaneous income

Form 1099-MISC is used to report miscellaneous
income received and direct sales of consumer goods
for resale.

^ F1099-MISC \ N558

Federal tax withheld

The amount of federal income tax withheld (backup
withholding) from 1099-MISC income.

^ F1099-MISC \ N563

State tax withheld

The amount of state income tax withheld (state
backup withholding) from 1099-MISC income.

Help F1099-R \ H473

Form 1099-R - Retirement distributions

Form 1099-R is used to report taxable and non-
taxable retirement distributions from retirement,
pension, profit-sharing, or annuity plans. Use a
separate Form 1099-R for each payer.

^ F1099-R \ N532

IRA federal tax withheld

The amount of federal income taxes withheld from
your IRA distribution.

^ F1099-R \ N534

IRA local tax withheld

The amount of local income taxes withheld from
your IRA distribution.

^ F1099-R \ N533

IRA state tax withheld

The amount of state income taxes withheld from
your IRA distribution.

^ F1099-R \ N529

Pension federal tax withheld

The amount of federal income taxes withheld from
your pension distribution.

^ F1099-R \ N531

Pension local tax withheld

The amount of local income taxes withheld from
your pension distribution.

^ F1099-R \ N530 The amount of state income taxes withheld from
your pension distribution.
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Pension state tax withheld

^ F1099-R \ N625

SIMPLE federal tax withheld

The amount of federal income taxes withheld from
a SIMPLE distribution received.

^ F1099-R \ N627

SIMPLE local tax withheld

The amount of local income taxes withheld from a
SIMPLE distribution received.

^ F1099-R \ N626

SIMPLE state tax withheld

The amount of state income taxes withheld from a
SIMPLE distribution received.

Help F2106 \ H380

employee business expenses

Form 2106 is used to deduct employee business
expenses. You must file this form if you were
reimbursed by your employer or claim job-
related travel, transportation, meal, or entertainment
expenses. Use a separate Form 2106 for your
spouse's expenses.

F2106 \ N382

Automobile expenses

Total annual expenses for gasoline, oil, repairs,
insurance, tires, license plates, or similar items.

F2106 \ N381

Education expenses

Cost of tuition, books, supplies, laboratory fees, and
similar items, and certain transportation costs if the
education maintains or improves skills required in
your present work or is required by your employer
or the law to keep your salary, status, or job,
and the requirement serves a business purpose
of your employer. Expenses are not deductible if
they are needed to meet the minimum educational
requirements to qualify you in your work or
business or will lead to qualifying you in a new trade
or business.

F2106 \ N391

Employee home office expenses

Your use of the business part of your home must
be: exclusive, regular, for your trade or business,
AND The business part of your home must be one
of the following: your principal place of business, a
place where you meet or deal with patients, clients,
or customers in the normal course of your trade
or business, or a separate structure (not attached to
your home) you use in connection with your trade or
business. Additionally, Your business use must be
for the convenience of your employer, and You do
not rent all or part of your home to your employer
and use the rented portion to perform services as an
employee. See IRS Pub 587.

F2106 \ N389

Job seeking expenses

Fees to employment agencies and other costs to look
for a new job in your present occupation, even if you
do not get a new job.

F2106 \ N384 Local transportation expenses are the expenses of
getting from one workplace to another when you
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Local transportation expenses are not traveling away from home. They include
the cost of transportation by air, rail, bus, taxi, and
the cost of using your car. Generally, the cost of
commuting to and from your regular place of work
is not deductible.

F2106 \ N386

Meal/entertainment expenses

Allowable meals and entertainment expense,
including meals while away from your tax
home overnight and other business meals and
entertainment.

F2106 \ N385

Other business expenses

Other job-related expenses, including expenses for
business gifts, trade publications, etc.

F2106 \ N390

Special clothing expenses

cost and upkeep of work clothes, if you must wear
them as a condition of your employment, and the
clothes are not suitable for everyday wear. Include
the cost of protective clothing required in your work,
such as safety shoes or boots, safety glasses, hard
hats, and work gloves.

F2106 \ N383

Travel (away from home)

Travel expenses are those incurred while traveling
away from home for your employer. The cost of
getting to and from your business destination (air,
rail, bus, car, etc.), taxi fares, baggage charges,
and cleaning and laundry expenses. Note: meal and
entertainment expenses are not included here.

Help F2441 \ H400

Form 2441 - child and dependent credit

Form 2441 is used to claim a credit for child and
dependent care expenses.

< F2441 \ N401

Qualifying child/dependent care expenses

The total amount you actually paid to the care
provider. Also, include amounts your employer paid
to a third party on your behalf.

< F2441 \ N402

Qualifying household expenses

The cost of services needed to care for the qualifying
person as well as to run the home. They include
the services of a babysitter, cleaning person, cook,
maid, or housekeeper if the services were partly for
the care of the qualifying person.

Help F3903 \ H403

Form 3903 - moving expenses

Form 3903 is used to claim moving expenses.

F3903 \ N406

Transport/storage of goods

The amount you paid to pack, crate and move your
household goods and personal effects. You may
include the cost to store and insure household goods
and personal effects within any period of 30 days
in a row after the items were moved from your old
home.

F3903 \ N407

Travel/lodging, except meals

The amount you paid to travel from your old home
to your new home. This includes transportation and
lodging on the way. Although not all members of
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your household must travel together, you may only
include expenses for one trip per person. Do not
include meals.

Help F4684 \ H412

Form 4684 - casualties and thefts

Form 4684 is used to report gains and losses from
casualties and thefts.

F4684 \ N413

Basis of casualty property

Cost or other basis usually means original cost plus
improvements. Subtract any postponed gain from
the sale of a previous main home. Special rules
apply to property received as a gift or inheritance.
See Pub 551, Basis of Assets, for details.

Help F4835 \ H569

Form 4835 - farm rental income

Form 4835 is used to report farm rental income
received as a share of crops or livestock produced
by your tenant if you did not materially participate
in the operation or management of the farm. Use a
different copy of Form 4835 for each farm rented.

F4835 \ N579

Car and truck expenses

The business portion of car or truck expenses, such
as, for gasoline, oil, repairs, insurance, tires, license
plates, etc.

F4835 \ N580

Chemicals

Chemicals used in operating your farm, such as
insect sprays and dusts.

F4835 \ N581

Conservation expenses

Your expenses for soil or water conservation or for
the prevention of erosion of land used in farming.
To take this deduction, your expenses must be
consistent with a plan approved by the Natural
Resources Conservation Service (NRCS) of the
Department of Agriculture.

F4835 \ N582

Custom hire expenses

Amounts you paid for custom hire (machine work)
(the machine operator furnished the equipment).
Do not include amounts paid for rental or lease of
equipment you operated yourself.

F4835 \ N583

Employee benefit programs

Contributions to employee benefit programs, such
as accident and health plans, group-term life
insurance, and dependent care assistance programs.
Do not include contributions that are a incidental
part of a pension or profit-sharing plan.

F4835 \ N584

Feed purchased

The cost of feed for your livestock. Generally, you
cannot currently deduct expenses for feed to be
consumed by your livestock in a later tax year. See
instructions for Schedule F.

F4835 \ N585

Fertilizers and lime

The cost of fertilizer, lime, and other materials
applied to farm land to enrich, neutralize, or
condition it. You can also deduct the cost of
applying these materials. However, see Prepaid
Farm Supplies, in Pub 225, for a rule that may limit
your deduction for these materials.
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F4835 \ N586

Freight and trucking

The costs of freight or trucking of produce or
livestock.

F4835 \ N587

Gasoline, fuel, and oil

The costs of gas, fuel, oil, etc. for farm equipment.

F4835 \ N588

Insurance (other than health)

Premiums paid for farm business insurance, such
as: fire, storm, crop, theft and liability protection of
farm assets. Do not include premiums for employee
accident and health insurance.

F4835 \ N589

Interest expense, mortgage

The interest you paid to banks or other financial
institutions for which you received a Form 1098, for
a mortgage on real property used in your farming
business (other than your main home). If you paid
interest on a debt secured by your main home, and
any proceeds from that debt were used in your
farming operation, refer to IRS Pub 225.

F4835 \ N590

Interest expense, other

The interest you paid for which you did not receive
a Form 1098 (perhaps someone else did, and you are
liable too), for a mortgage or other loans for your
farm business.

F4835 \ N591

Labor hired

The amounts you paid for farm labor. Do not include
amounts paid to yourself. Count the cost of boarding
farm labor but not the value of any products they
used from the farm. Count only what you paid
house-hold help to care for farm laborers.

F4835 \ N602

Other farm expenses

Include all ordinary and necessary farm rental
expenses not deducted elsewhere on Form 4835,
such as advertising, office supplies, etc. Do not
include fines or penalties paid to a government for
violating any law.

F4835 \ N592

Pension/profit-sharing plans

Enter your deduction for contributions to employee
pension, profit-sharing, or annuity plans. If the plan
included you as a self-employed person, see the
instructions for Schedule C (Form 1040).

F4835 \ N594

Rent/lease land, animals

Amounts paid to rent or lease property such as
pasture or farm land.

F4835 \ N593

Rent/lease vehicles, equip.

The business portion of your rental cost, for rented
or leased vehicles, machinery, or equipment. But
if you leased a vehicle for a term of 30 days or
more, you may have to reduce your deduction by an
inclusion amount. For details, see the instructions
for Schedule C (Form 1040).

F4835 \ N595

Repairs and maintenance

Amounts you paid for repairs and maintenance of
farm buildings, machinery, and equipment. You can
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also include what you paid for tools of short life or
minimal cost, such as shovels and rakes.

F4835 \ N596

Seeds and plants purchased

The amounts paid for seeds and plants purchased for
farming.

F4835 \ N597

Storage and warehousing

Amounts paid for storage and warehousing of crops,
grains, etc.

F4835 \ N598

Supplies purchased

Livestock supplies and other supplies, including
bedding, office supplies, etc.

F4835 \ N599

Taxes

Real estate and personal property taxes on farm
business assets; Social security and Medicare taxes
you paid to match what you are required to withhold
from farm employees' wages and any Federal
unemployment tax paid; Federal highway use tax.

F4835 \ N600

Utilities

Amounts you paid for gas, electricity, water, etc., for
business use on the farm. Do not include personal
utilities. You cannot deduct the base rate (including
taxes) of the first telephone line into your residence,
even if you use it for business.

F4835 \ N601

Vet, breeding, medicine

The costs of veterinary services, medicine and
breeding fees.

Help F4952 \ H425

Form 4952 - investment interest

Form 4952 is used to compute the amount of
investment interest expense deductible for the
current year and the amount, if any, to carry forward
to future years.

F4952 \ N426

Investment interest expense

The investment interest paid or accrued during
the tax year, regardless of when you incurred the
indebtedness. Investment interest is interest paid or
accrued on a loan (or part of a loan) that is allocable
to property held for investment.

Help F6252 \ H427

Form 6252 - income from casual sales

Form 6252 is used to report income from casual
sales of real or personal property when you will
receive any payments in a tax year after the year of
sale (i.e., installment sale).

F6252 \ N432

Expenses of sale

Enter sales commissions, advertising expenses,
attorney and legal fees, etc., in selling the property.

Help F8815 \ H441

Form 8815 - EE U.S. savings bonds sold for
education

Form 8815 is used to compute the amount of interest
you may exclude if you cashed series EE U.S.
savings bonds this year that were issued after 1989
to pay for qualified higher education costs.

F8815 \ N442

Qualified higher education expenses

Qualified higher education expenses include tuition
and fees required for the enrollment or attendance
of the person(s). Do not include expenses for room
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and board, or courses involving sports, games, or
hobbies that are not part of a degree or certificate
granting program.

Help F8829 \ H536

Form 8829 - business use of your home

Form 8829 is used only if you file a Schedule C,
Profit or Loss from Business, and you meet specific
requirements to deduct expenses for the business
use of your home. IRS rules are stringent for this
deduction. Refer to IRS Publication 587.

F8829 \ N537

Deductible mortgage interest

The total amount of mortgage interest that would
be deductible whether or not you used your home
for business (i.e., amounts allowable as itemized
deductions on Schedule A, Form 1040). Form 8829
computes the deductible business portion.

F8829 \ N539

Insurance

The total amount of insurance paid for your home,
in which an area or room is used regularly and
exclusively for business. Form 8829 computes the
deductible business portion.

F8829 \ N542

Other expenses

If you rent rather than own your home, include rent
paid for your home, in which an area or room is used
regularly and exclusively for business. Form 8829
computes the deductible business portion.

F8829 \ N538

Real estate taxes

The total amount of real estate taxes that would
be deductible whether or not you used your home
for business (i.e., amounts allowable as itemized
deductions on Schedule A, Form 1040). Form 8829
computes the deductible business portion.

F8829 \ N540

Repairs and maintenance

The total amount of repairs and maintenance paid
for your home, in which an area or room is used
regularly and exclusively for business. Form 8829
computes the deductible business portion.

F8829 \ N541

Utilities

The total amount of utilities paid for your home,
in which an area or room is used regularly and
exclusively for business. Form 8829 computes the
deductible business portion.

Help F8839 \ H617

Form 8839 - adoption expenses

Form 8839 is used to report qualified adoption
expenses.

F8839 \ N618

Adoption fees

Adoption fees that are reasonable and necessary,
directly related to, and for the principal purpose of,
the legal adoption of an eligible child.

F8839 \ N620

Attorney fees

Attorney fees that are reasonable and necessary,
directly related to, and for the principal purpose of,
the legal adoption of an eligible child.

F8839 \ N619

Court costs

Court costs that are reasonable and necessary,
directly related to, and for the principal purpose of,
the legal adoption of an eligible child.
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F8839 \ N622

Other expenses

Other expenses that are reasonable and necessary,
directly related to, and for the principal purpose of,
the legal adoption of an eligible child.

F8839 \ N621

Traveling expenses

Traveling expenses (including meals and lodging)
while away from home, directly related to, and for
the principal purpose of, the legal adoption of an
eligible child.

Home Sale \ N392

Home Sale worksheets (was F2119)

Home Sale worksheets (replaces Form 2119) are
used to report the sale of your personal residence.
See IRS Pub 523.

Home Sale \ N397

Cost of new home

The cost of your new home includes costs incurred
within the replacement period (beginning 2 years
before and ending 2 years after the date of sale) for
the following items: Buying or building the home;
Rebuilding the home; and Capital improvements or
additions.

Home Sale \ N394

Expense of sale

Selling expenses include commissions, advertising
fees, legal fees, title insurance, and loan charges
paid by the seller, such as loan placement fees or
"points."

Home Sale \ N396

Fixing-up expenses

Fixing-up expenses are decorating and repair costs
that you paid to sell your old home. For example,
the costs of painting the home, planting flowers, and
replacing broken windows are fixing-up expenses.
Fixing-up expenses must meet all the following
conditions. The expenses: Must be for work done
during the 90-day period ending on the day you sign
the contract of sale with the buyer; Must be paid no
later than 30 days after the date of sale; Cannot be
deductible in arriving at your taxable in-come; Must
not be used in figuring the amount realized; and
Must not be capital expenditures or improvements.

Help Sched A \ H270

Schedule A - itemized deductions

Schedule A is used to report your itemized
deductions.

Sched A \ N280

Cash charity contributions

Contributions or gifts by cash or check you
gave to organizations that are religious, charitable,
educational, scientific, or literary in purpose. You
may also deduct what you gave to organizations
that work to prevent cruelty to children or animals.
For donations of $250 or more, you must have a
statement from the charitable organization showing
the amount donated and the value of goods or
services you received.

Sched A \ N484

Doctors, dentists, hospitals

Insurance premiums for medical and dental care,
medical doctors, dentists, eye doctors, surgeons, X-
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ray, laboratory services, hospital care, etc. See IRS
Pub 502.

Sched A \ N272

Gambling losses

Gambling losses, but only to the extent of gambling
winnings reported on Form 1040. Note: not subject
to the 2% AGI of limitation.

Sched A \ N545

Home mortgage interest (no 1098)

Home mortgage interest paid, for which you did not
receive a Form 1098 from the recipient. The interest
could be on a first or second mortgage, home equity
loan, or refinanced mortgage.

Sched A \ N283

Home mortgage interest (1098)

Home mortgage interest and points reported to you
on Form 1098. The interest could be on a first or
second mortgage, home equity loan, or refinanced
mortgage.

Sched A \ N282

Investment management fees

Investment interest is interest paid on money you
borrowed that is allocable to property held for
investment. It does not include any interest allocable
to passive activities or to securities that generate tax-
exempt income.

Sched A \ N544

Local income taxes

Local income taxes that were not withheld from
your salary, such as local income taxes you paid this
year for a prior year.

Sched A \ N274

Medical travel and lodging

Lodging expenses while away from home to receive
medical care in a hospital or a medical care facility
related to a hospital. Do not include more than $50
a night for each eligible person. Ambulance service
and other travel costs to get medical care.

Sched A \ N273

Medicine and drugs

Prescription medicines, eyeglasses, contact lenses,
hearing aids. Over-the-counter medicines are not
deductible.

Sched A \ N523

Misc., no 2% AGI limit

Other miscellaneous itemized deductions that are
not reduced by 2% of adjusted gross income,
such as casualty and theft losses from income-
producing, amortizable bond premium on bonds
acquired before October 23, 1986, federal estate
tax on income in respect to a decedent, certain
unrecovered investment in a pension, impairment-
related work expenses of a disabled person.

Sched A \ N486

Misc., subject to 2% AGI limit

Safety equipment, small tools, and supplies you
needed for your job; Uniforms required by your
employer and which you may not usually wear away
from work; subscriptions to professional journals;
job search expenses; certain educational expenses.
You may need to file Form 2106.

Sched A \ N485

Non-cash charity contributions

The fair market value of donated property, such as
used clothing or furniture.
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Sched A \ N277

Other taxes

Other taxes paid not included under state and local
income taxes, real estate taxes, or personal property
taxes. You may want to take a credit for the foreign
tax instead of a deduction.

Sched A \ N535

Personal property taxes

Enter personal property tax you paid, but only if it
is based on value alone. Example: You paid a fee
for the registration of your car. Part of the fee was
based on the car s value and part was based on its
weight. You may deduct only the part of the fee that
is based on the car s value.

Sched A \ N284

Points paid (no 1098)

Generally, you must deduct points you paid to
refinance a mortgage over the life of the loan. If
you used part of the proceeds to improve your main
home, you may be able to deduct the part of the
points related to the improvement in the year paid.
See Pub. 936 Use this line for points not reported on
Form 1098.

Sched A \ N276

Real estate taxes

Include taxes (state, local, or foreign) you paid on
real estate you own that was not used for business,
but only if the taxes are based on the assessed value
of the property. Do not include taxes charged for
improvements that tend to increase the value of your
property (for example, an assessment to build a new
sidewalk).

Sched A \ N522

State estimated tax, quarterly

State estimated tax payments made this year.

Sched A \ N275

State income taxes

State income taxes paid this year for a prior year.
Include any part of a prior year refund that you chose
to have credited to this years state income taxes.

Sched A \ N271

Subscriptions

Amounts paid for subscriptions to magazines
or services that are directly related to the
production or collection of taxable income.
(example: subscriptions to investment publications,
stock newsletters, etc.).

Sched A \ N281

Tax preparation fees

Fees you paid for preparation of your tax
return, including fees paid for filing your return
electronically.

Help Sched B \ H285

Schedule B - interest and dividend income

Schedule B is used to report your interest and
dividend income.

< Sched B \ N615

Fed tax withheld, dividend income

The amount of federal income taxes withheld from
dividend income. This is usually reported on Form
1099-DIV.
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< Sched B \ N616

Fed tax withheld, interest income

The amount of federal income taxes withheld from
interest income. This is usually reported on Form
1099-INT.

Help Sched C \ H291

Schedule C - self-employment income

Schedule C is used to report income from self-
employment. Use a separate Schedule C to report
income and expenses from different businesses.

Sched C \ N304

Advertising

The amounts paid for advertising your trade or
business in newspapers, publications, radio or
television. Also include the cost of brochures,
business cards, or other promotional material.

Sched C \ N305

Bad debts from sales/services

Include debts and partial debts from sales or services
that were included in income and are definitely
known to be worthless.

Sched C \ N306

Car and truck expenses

You can deduct the actual expenses of running your
car or truck, or take the standard mileage rate.

Sched C \ N307

Commissions and fees

The amounts of commissions or fees paid to
independent contractors (non employees) for their
services.

Sched C \ N494

Cost of Goods Sold - Labor

Labor costs are usually an element of cost of goods
sold only in a manufacturing or mining business.
In a manufacturing business, labor costs that are
properly allocable to the cost of goods sold include
both the direct and indirect labor used in fabricating
the raw material into a finished, salable product.

Sched C \ N495

Cost of Goods Sold - Materials/supplies

Materials and supplies, such as hardware and
chemicals, used in manufacturing goods are charged
to cost of goods sold. Those that are not used in
the manufacturing process are treated as deferred
charges. You deduct them as a business expense
when you use them.

Sched C \ N496

Cost of Goods Sold - Other costs

Other costs incurred in a manufacturing or mining
process that you charge to your cost of goods sold
are containers, freight-in, overhead expenses.

Sched C \ N493

Cost of Goods Sold - Purchases

If you are a merchant, use the cost of all merchandise
you bought for sale. If you are a manufacturer or
producer, this includes the cost of all raw materials
or parts purchased for manufacture into a finished
product. You must exclude the cost of merchandise
you withdraw for your personal or family use.

Sched C \ N309

Depletion

The amounts for depletion. If you have timber
depletion, attach Form T. See Pub. 535.

Sched C \ N308

Employee benefit programs

Contributions to employee benefit programs that
are not an incidental part of a pension or profit-
sharing plan. Examples are accident and health
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plans, group-term life insurance, and dependent care
assistance programs.

Sched C \ N310

Insurance, other than health

Premiums paid for business insurance. Do not
include amounts paid for employee accident and
health insurance. nor amounts credited to a reserve
for self-insurance or premiums paid for a policy
that pays for your lost earnings due to sickness or
disability. See Pub. 535.

Sched C \ N311

Interest expense, mortgage

The interest you paid to banks or other financial
institutions for which you received a Form 1098, for
a mortgage on real property used in your business
(other than your main home).

Sched C \ N312

Interest expense, other

The interest you paid for which you did not receive
a Form 1098 (perhaps someone else did, and you are
liable too), for a mortgage or other loans for your
business.

Sched C \ N298

Legal and professional fees

Accountant's or legal fees for tax advice related to
your business and for preparation of the tax forms
related to your business.

Sched C \ N294

Meals and entertainment

Total business meal and entertainment expenses.
Business meal expenses are deductible only if they
are (a) directly related to or associated with the
active conduct of your trade or business, (b) not
lavish or extravagant, and (c) incurred while you or
your employee is present at the meal.

Sched C \ N313

Office expenses

The cost of consumable office supplies such as
business cards, computer supplies, pencils, pens,
postage stamps, rental of postal box or postage
machines, stationery, Federal Express and UPS
charges, etc.

Sched C \ N302

Other business expenses

Other costs not specified on other lines of Schedule
C, such as: Clean-fuel vehicles and refueling
property; Donations to business organizations;
Educational expenses; Environmental cleanup
costs; Impairment-related expenses; Interview
expense allowances; Licenses and regulatory
fees; Moving machinery; Outplacement services;
Penalties and fines you pay for late performance
or nonperformance of a contract; Subscriptions to
trade or professional publications.

Sched C \ N314

Pension/profit sharing plans

You can set up and maintain the following small
business retirement plans for yourself and your
employees, such as: SEP (Simplified Employee
Pension) plans; SIMPLE (Savings Incentive Match
Plan for Employees) plans; Qualified plans
(including Keogh or H.R. 10 plans). You deduct
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contributions you make to the plan for yourself on
Form 1040.

Sched C \ N300

Rent/lease other business property

The amounts paid to rent or lease real estate or
property, such as office space in a building.

Sched C \ N299

Rent/lease vehicles, equip.

The amount paid to rent or lease vehicles,
machinery, or equipment, for your business. If you
leased a vehicle for a term of 30 days or more, you
may have to reduce your deduction by an amount
called the inclusion amount. See Pub. 463.

Sched C \ N315

Repairs and maintenance

The cost of repairs and maintenance. Include labor,
supplies, and other items that do not add to the value
or increase the life of the property. Do not include
the value of your own labor. Do not include amounts
spent to restore or replace property; they must be
capitalized.

Sched C \ N296

Returns and allowances

Credits you allow customers for returned
merchandise and any other allowances you make on
sales.

Sched C \ N301

Supplies (not from Cost of Goods Sold)

The cost of supplies not reported under Cost Of
Goods Sold.

Sched C \ N316

Taxes and licenses

Include the following taxes: State and local sales
taxes imposed on you as the seller of goods or
services; Real estate and personal property taxes
on business assets; Social security and Medicare
taxes paid to match required withholding from your
employees' wages; Also, Federal unemployment tax
paid; Federal highway use tax.

Sched C \ N317

Travel

Expenses for lodging and transportation connected
with overnight travel for business while away from
your tax home.

Sched C \ N318

Utilities

The costs of electricity, gas, telephone, etc. for your
business property.

Sched C \ N297

Wages paid

The total amount of salaries and wages for the tax
year. Do not include amounts paid to yourself.

Help Sched E \ H325

Schedule E - rental and royalty income

Schedule E is used to report income or loss from
rental real estate, royalties, and residual interest
in REMIC's. Use a different copy for each rental
or royalty. Use the Schedule K-1 categories for
partnership rental income and loss amounts.

Sched E \ N328

Advertising

Amounts paid to advertise rental unit(s) in
newspapers or other media or paid to realtor's to
obtain tenants.
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Sched E \ N329

Auto and travel

The ordinary and necessary amounts of auto and
travel expenses related to your rental activities,
including 50% of meal expenses incurred while
traveling away from home.

Sched E \ N330

Cleaning and maintenance

The amounts paid for cleaning services (carpet,
drapes), cleaning supplies, locks and keys, pest
control, pool service, and general cost of upkeep of
the rental property.

Sched E \ N331

Commissions

The amounts paid as Commissions to realtor's or
management companies to collect rent.

Sched E \ N332

Insurance

Insurance premiums paid for fire, theft, liability.

Sched E \ N333

Legal and professional fees

The amounts of fees for tax advice and the
preparation of tax forms related to your rental real
estate or royalty properties.

Sched E \ N502

Management fees

The amount of fees to a manager or property
management company to oversee your rental or
royalty property.

Sched E \ N334

Mortgage interest expense

Interest paid to banks or other financial institutions
for a mortgage on your rental property, and you
received a Form 1098.

Sched E \ N341

Other expenses

Other expenses that are not listed on other tax
lines of Schedule E. These might include the
cost of gardening and/or snow removal services,
association dues, bank charges, etc.

Sched E \ N335

Other interest expense

Interest paid for a mortgage on your rental property,
not paid to banks or other financial institutions or
you did not receive a Form 1098.

Sched E \ N336

Repairs

You may deduct the cost of repairs made to
keep your property in good working condition.
Repairs generally do not add significant value to the
property or extend its life.

Sched E \ N337

Supplies

Miscellaneous items needed to maintain the
property, such as: brooms, cleaning supplies, nails,
paint brushes, etc.

Sched E \ N338

Taxes

The amounts paid for real estate and personal
property taxes. Also include the portion of any
payroll taxes you paid for your employees.

Sched E \ N339

Utilities

The costs of electricity, gas, telephone, etc. for your
rental property.

Help Sched F \ H343

Schedule F - Farm income and expense

Schedule F is used to report farm income and
expense. Use a different copy of Schedule F for each
farm you own.
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Sched F \ N543

Car and truck expenses

The business portion of car or truck expenses, such
as, for gasoline, oil, repairs, insurance, tires, license
plates, etc.

Sched F \ N366

Chemicals

Chemicals used in operating your farm, such as
insect sprays and dusts.

Sched F \ N362

Conservation expenses

Your expenses for soil or water conservation or for
the prevention of erosion of land used in farming.
To take this deduction, your expenses must be
consistent with a plan approved by the Natural
Resources Conservation Service (NRCS) of the
Department of Agriculture.

Sched F \ N378

Cost of resale livestock/items

The cost or other basis of the livestock and other
items you actually sold.

Sched F \ N367

Custom hire expenses

Amounts you paid for custom hire (machine work)
(the machine operator furnished the equipment).
Do not include amounts paid for rental or lease of
equipment you operated yourself.

Sched F \ N364

Employee benefit programs

Contributions to employee benefit programs, such
as accident and health plans, group-term life
insurance, and dependent care assistance programs.
Do not include contributions that are a incidental
part of a pension or profit-sharing plan.

Sched F \ N350

Feed purchased

The cost of feed for your livestock. Generally, you
cannot currently deduct expenses for feed to be
consumed by your livestock in a later tax year. See
instructions for Schedule F.

Sched F \ N352

Fertilizers and lime

The cost of fertilizer, lime, and other materials
applied to farm land to enrich, neutralize, or
condition it. You can also deduct the cost of
applying these materials. However, see Prepaid
Farm Supplies, in Pub 225, for a rule that may limit
your deduction for these materials.

Sched F \ N361

Freight and trucking

The costs of freight or trucking of produce or
livestock.

Sched F \ N356

Gasoline, fuel, and oil

The costs of gas, fuel, oil, etc. for farm equipment.

Sched F \ N359

Insurance, other than health

Premiums paid for farm business insurance, such
as: fire, storm, crop, theft and liability protection of
farm assets. Do not include premiums for employee
accident and health insurance.

Sched F \ N346

Interest expense, mortgage

The interest you paid to banks or other financial
institutions for which you received a Form 1098, for
a mortgage on real property used in your farming
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business (other than your main home). If you paid
interest on a debt secured by your main home, and
any proceeds from that debt were used in your
farming operation, refer to IRS Pub 225.

Sched F \ N347

Interest expense, other

The interest you paid for which you did not receive
a Form 1098 (perhaps someone else did, and you are
liable too), for a mortgage or other loans for your
farm business.

Sched F \ N344

Labor hired

The amounts you paid for farm labor. Do not include
amounts paid to yourself. Count the cost of boarding
farm labor but not the value of any products they
used from the farm. Count only what you paid
house-hold help to care for farm laborers.

Sched F \ N365

Other farm expenses

Include all ordinary and necessary farm expenses
not deducted elsewhere on Schedule F, such as
advertising, office supplies, etc. Do not include fines
or penalties paid to a government for violating any
law.

Sched F \ N363

Pension/profit sharing plans

Enter your deduction for contributions to employee
pension, profit-sharing, or annuity plans. If the plan
included you as a self-employed person, see the
instructions for Schedule C (Form 1040).

Sched F \ N348

Rent/lease land, animals

Amounts paid to rent or lease property such as
pasture or farm land.

Sched F \ N349

Rent/lease vehicles, equip.

The business portion of your rental cost, for rented
or leased vehicles, machinery, or equipment. But
if you leased a vehicle for a term of 30 days or
more, you may have to reduce your deduction by an
inclusion amount. For details, see the instructions
for Schedule C (Form 1040).

Sched F \ N345

Repairs and maintenance

Amounts you paid for repairs and maintenance of
farm buildings, machinery, and equipment. You can
also include what you paid for tools of short life or
minimal cost, such as shovels and rakes.

Sched F \ N351

Seeds and plants purchased

The amounts paid for seeds and plants purchased for
farming.

Sched F \ N357

Storage and warehousing

Amounts paid for storage and warehousing of crops,
grains, etc.

Sched F \ N353

Supplies purchased

Livestock supplies and other supplies, including
bedding, office supplies, etc.

Sched F \ N358

Taxes

Real estate and personal property taxes on farm
business assets; Social security and Medicare taxes
you paid to match what you are required to withhold
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from farm employees' wages and any Federal
unemployment tax paid; Federal highway use tax.

Sched F \ N360

Utilities

Amounts you paid for gas, electricity, water, etc., for
business use on the farm. Do not include personal
utilities. You cannot deduct the base rate (including
taxes) of the first telephone line into your residence,
even if you use it for business.

Sched F \ N355

Vet, breeding, and medicine

The costs of veterinary services, medicine and
breeding fees.

Help Sched H \ H565

Schedule H - Household employees

Schedule H is used to report Federal employment
taxes on cash wages paid this year to household
employees. Federal employment taxes include
social security, Medicare, withheld Federal income,
and Federal unemployment (FUTA) taxes.

^ Sched H \ N567

Cash wages paid

For household employees to whom you paid $1,100
(as of 1999) or more each of cash wages that are
subject to social security and Medicare taxes. To
find out if the wages are subject to these taxes, see
the instructions for Schedule H.

^ Sched H \ N568

Federal tax withheld

Federal income tax withheld from total cash wages
paid to household employees during the year.

Help W-2 \ H458

Form W-2 - Wages earned and taxes withheld

Form W-2 is used by your employer to report
the amount of wages and other compensation
you earned as an employee, and the amount of
federal and state taxes withheld and fringe benefits
received. Use a separate copy of Form W-2 for each
employer.

^ W-2 \ N461

Federal tax withheld, self

The amount of Federal income tax withheld from
your wages for the year.

^ W-2 \ N507

Federal tax withheld, spouse

The amount of Federal income tax withheld from
your spouse's wages for the year.

^ W-2 \ N463

Local tax withheld, self

The amount of local taxes withheld from your
wages.

^ W-2 \ N509

Local tax withheld, spouse

The amount of local taxes withheld from your
spouse's wages.

^ W-2 \ N480

Medicare tax withheld, self

The amount of Medicare taxes withheld from your
wages.

^ W-2 \ N510

Medicare tax withheld, spouse

The amount of Medicare taxes withheld from your
spouse's wages.
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Tax Form \ TXF Code

Description

Extended TXF Help messages

^ W-2 \ N462

Social Security tax withheld, self

The amount of social security taxes withheld from
your wages.

^ W-2 \ N508

Social Security tax withheld, spouse

The amount of social security taxes withheld from
your spouse's wages.

^ W-2 \ N464

State tax withheld, self

The amount of state taxes withheld from your
wages.

^ W-2 \ N511

State tax withheld, spouse

The amount of state taxes withheld from your
spouse's wages.

Help W-2G \ H547

Form W-2G - gambling winnings

Form W-2G is used to report certain gambling
winnings.

^ W-2G \ N550

Federal tax withheld

The amount of federal income taxes withheld from
gross gambling winnings.

^ W-2G \ N551

State tax withheld

The amount of state income taxes withheld from
gross gambling winnings.

Warnungen zurücksetzen…
GnuCash gibt Warnungen aus, wenn Sie bestimmte Handlungen durchführen, z.B. das Löschen einer
Buchung oder das Entfernen eines einzelnen Buchungsteils. Da einige Benutzer zu häufige Warnungen
ablenkend fanden, wurde die Möglichkeit geschaffen, diese abzuschalten Die Kontrollkästchen mit den
Bezeichnungen Antwort speichern und nicht wieder anzeigen und Antwort speichern und in dieser Sitzung
nicht wieder anzeigen erlauben das Deaktivieren der Warnungen. Mit dem Menüeintrag Aktionen →
Warnungen zurücksetzen… öffnet sich ein Dialog, der die von Ihnen deaktivierten Warnung auflistet.
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Abbildung 10.22. Das Warnungen zurücksetzen Fenster

Warnungen können selektiv aktiviert werden, wobei der Dialog in zwei Rubriken aufgeteilt ist.

Dauerhafte Warnung Hier werden die Warnungen aufgelistet, die Sie dauerhaft
nicht wieder sehen wollten.

Zeitweise Warnung Unter den zweitweisen Warnung fallen die Hinweise, die Sie
lediglich für die aktuelle Sitzung nicht mehr sehen wollten.

Ändern der Sprache und des Gebietsschemas
Die Sprache der GnuCash Benutzeroberfläche kann nicht direkt über die Programmeinstellungen geändert
werden. Schauen Sie erst einmal in die Einstellungen Ihres Betriebssystems, um diese Einstellungen
anzupassen, weil diese auch für GnuCash erst einmal maßgeblich sind.

Tipp

Weitere und aktuelle Informationen zu diesem Thema finden
Sie auf der Seite Lokalisierung [https://wiki.gnucash.org/wiki/De/
Konfiguration#Lokalisierung_.28Einstellung_der_Sprache.2C_W.C3.A4hrung.2C_Formate_....29]
im GnuCash Wiki und auch auf der Locale Settings page [https://wiki.gnucash.org/wiki/
Locale_Settings] (auf Englisch).

Linux Nutzer der Kommandozeile sollten die Umgebungsvariablen LANGUAGE und LANG 7

setzen, bevor Sie GnuCash starten. Dazu geben Sie in einem Terminal den folgenden
Befehl ein:

LANGUAGE=ll_LL LANG=ll_LL gnucash

7LANGUAGE ist wie im Browser eine Preferenzliste nur von Sprachen, während LANG die Vorgabe für die Formate, wie z.B. Währung, Datum,
Zeit, Zahl usw., aber auch für die Sortierung ist.
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Mit dem Kürzel ll_LL ist das Gebietsschema, in dem Sie GnuCash ausführen möchten,
gemeint. Um die Zusammenhänge etwas zu veranschaulichen, hilft dieses Beispiel:
Starten Sie GnuCash mit diesem Befehl LANGUAGE=tr LANG=de_DE.utf8
gnucash so wird das Programm in türkischer Sprache arbeiten, Sie haben jedoch die
Möglichkeit z.B. eine deutsche Steuererklärung vorzubereiten.

macOS Wenn Sie eine andere als die automatisch gewählte Übersetzung verwenden möchten,
können Sie unter System Settings → Language and Region eine andere Sprache
einstellen.

Windows Start → Einstellungen → Zeit & Sprache → Region und stellen dann das Gebietsschema
ein.
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GnuCash Version 2.6.20 + Finance::Quote Version 1.47, March 2018

Dieses Kapiel enthält einige Hintergrundinformation zu Finance::Quote.

Die Datenquellen in Finance::Quote
Es gibt drei Arten von Quellen. Dabei ist die erste - Währung - fest implementiert und dafür zuständig,
die Wechselkurse der von der ISO registrierten Währungen abzurufen. Die beiden anderen können im
Wertpapier-Editor ausgewählt werden.

Währung

Tabelle A.1. Währungs-Quelle für Finance::Quote

GnuCash Name Finance::Quote Name Anmerkungen

Währung currency

Ende 2017 wurde der Anbieter
gewechselt. Aktualisieren Sie
daher F::Q mindestens auf
Version 1.47 und folgen Sie den
Anweisungen bei Alphavantage
unten.

Einzelquellen

Tabelle A.2. Einzelquellen für Kurse

GnuCash Name Finance::Quote Name URL, Anmerkungen

Alphavantage, US alphavantage

Sie müssen

1. sich auf https://
www.alphavantage.co/
registrieren und

Wichtig

Beachten Sie die
Einschränkungen des
kostenlosen
Schlüssels in der
dortigen FAQ.

2. Ihren dort erhaltenen Schlüssel
in Bearbeiten →  Einstellungen
+Online Kurse eingeben.

3. Um ihn auch mit gnc-fq-
* Befehlen zu verwenden,
müssen Sie ihn auch
in einer Umgebungsvariable
ALPHAVANTAGE_API_KEY
setzen. Ziehen Sie dazu
die Dokumentation Ihres
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GnuCash Name Finance::Quote Name URL, Anmerkungen

Betriebssystems oder
Befehlszeileninterpreters zu
Rate, wie Sie das dauerhaft
erreichen.

Beispiel A.1.
Umgebungsvariable in
.bashrc

export ALPHAVANTAGE_API_KEY=##############

Amsterdam Euronext eXchange,
NL

aex

https://www.aex.nl

includes former sources AEX-
„Futures“ and -„Options“

American International
Assurance, HK

aiahk https://www.aia.com.hk

Association of Mutual Funds In
India, IN

amfiindia https://www.amfiindia.com

Athens Stock Exchange, GR asegr https://www.ase.gr

Australian Stock Exchange, AU asx

https://www.asx.com.au

Benötigt mindestens F::Q 1.41,
um Kurse zu holen, die mit 'X'
beginnen wie „XRO“, aber keine
Indices sind.

BAMOSZ funds, HU bamosz https://www.bamosz.hu

BMO NesbittBurns, CA bmonesbittburns https://bmonesbittburns.com

Bucharest Stock Exchange (Bursa
de Valori Bucuresti), RO

bsero https://www.bvb.ro

Budapest Stock Exchange (BET),
ex-BUX, HU

bse or bet https://www.bet.hu

Citywire Funds, GB citywire https://citywire.co.uk

Colombo Stock Exchange, LK cse https://www.cse.lk

Cominvest Asset Management,
ex-Adig, DE

cominvest

https://www.cominvest-am.de

Veraltet, aktuelles Modul: https://
eggert.org/software/
Comdirect.pm

Deka Investments, DE deka https://www.deka.de

DWS, DE dwsfunds https://www.dws.de

Equinox Unit Trusts, ZA za_unittrusts https://www.equinox.co.za

Fidelity Investments, US fidelity_direct https://www.fidelity.com

Fidelity Fixed, US fidelityfixed
https://www.fidelity.com/fixed-
income-bonds/overview

Finance Canada financecanada https://finance.canada.com
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GnuCash Name Finance::Quote Name URL, Anmerkungen

Financial Times Funds service,
GB

ftfunds https://funds.ft.com

Finanzpartner, DE finanzpartner https://www.finanzpartner.de

First Trust Portfolios, US ftportfolios_direct https://www.ftportfolios.com

Fund Library, CA fundlibrary

https://www.fundlibrary.com

Dieses Modul verwwndet
Symbole, die Sie auf https://
www.fundlibrary.com
nachschlagen müssen.

GoldMoney spot rates, JE goldmoney https://www.goldmoney.com

HElsinki stock eXchange, FI hex https://www.hex.com

Man Investments, AU maninv
https://
www.maninvestments.com.au

Morningstar, GB mstaruk https://morningstar.co.uk

Morningstar, JP morningstarjp https://www.morningstar.co.jp

Morningstar, SE morningstar https://www.morningstar.se

Motley Fool, US fool https://www.fool.com

New Zealand stock eXchange, NZ nzx https://www.nzx.com

Paris Stock Exchange/
Boursorama, FR

bourso https://www.boursorama.com

Paris Stock Exchange/LeRevenu,
FR

lerevenu https://bourse.lerevenu.com

Platinum Asset Management, AU platinum https://www.platinum.com.au

SIX Swiss Exchange Funds, CH sixfunds
https://www.six-swiss-
exchange.com

SIX Swiss Exchange Shares, CH sixshares
https://www.six-swiss-
exchange.com

Skandinaviska Enskilda Banken
funds, SE

seb_funds

https://www.seb.se

Siehe https://taz.vv.sebank.se/cgi-
bin/pts3/pow/Fonder/kurser/
kurslista_body.asp für alle
verfügbaren Fonds.

Sharenet, ZA za https://www.sharenet.co.za

StockHouse Canada, CA stockhousecanada_fund https://www.stockhouse.ca

TD Waterhouse Funds, CA tdwaterhouse
https://
www.tdassetmanagement.com

TD Efunds, CA tdefunds https://www.tdwaterhouse.ca

TIAA-CREF, US tiaacref https://www.tiaa-cref.org

Toronto Stock eXchange, CA tsx https://www.TMXmoney.com

T. Rowe Price, US troweprice_direct https://www.troweprice.com

Trustnet via tnetuk.pm, GB tnetuk https://www.trustnet.com
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GnuCash Name Finance::Quote Name URL, Anmerkungen

Trustnet via trustnet.pm, GB trustnet https://www.trustnet.com

Union Investment, DE unionfunds https://www.union-invest.de

US Treasury Bonds, US usfedbonds https://www.publicdebt.treas.gov

US Govt. Thrift Savings Plan, US tsp https://www.tsp.gov

Vanguard, US vanguard Teil des AlphaVantage-Moduls

VWD, DE (nicht mehr gewartet) vwd
Siehe https://lists.gnucash.org/
pipermail/gnucash-user/2008-
February/023686.html

Yahoo USA

Yahoo Asia

Yahoo Australia

Yahoo Brasil

Yahoo Europe

Yahoo New Zealand

yahoo

yahoo_asia

yahoo_australia

yahoo_brasil

yahoo_europe

yahoo_nz

CSV-Schnittstelle seit 01.11.2017
abgeschaltet

Yahoo as JSON, US yahoo_json
https://finance.yahoo.com/
through "JavaScript Object
Notation"

Yahoo als YQL, US yahoo_yql
https://finance.yahoo.com/
through "Yahoo Query Language"

Zuerich Investments (ersetzt) zifunds
Zürich Invest wurde von der
Deutschen Bank gekauft und in
die DWS integriert.

Mehrfach-Quellen
Hierbei wird eine Liste von Quellen durchlaufen und das erste erfolgreiche Ergebnis zurückgeliefert.

Tabelle A.3. Mehrfach-Quellen für Kurse

Name

Asia verschwand mit Yahoo

Australia (ASX, ...)

Brasil verschwand mit Yahoo

Canada (Alphavantage, TSX, ...)

Canada Mutual (Fund Library, StockHouse, ...)

Dutch (AEX, ...)

Europe (asegr, bsero, hex ...)

Greece (ASE, ...)

Hungary (Bamosz, BET, ...)

India Mutual (AMFI, ...)
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Name

Fidelity (Fidelity, ...)

Finland (HEX, ...)

First Trust (First Trust, ...)

France (Boursorama, LeRevenu, ...)

Nasdaq (Alphavantage, Fool, ...)

New Zealand (NZX, ...)

NYSE (Alphavantage, Fool, ...)

South Africa (Sharenet, ...)

Romania (bsero, ...)

T. Rowe Price

U.K. Funds (citywire, FTfunds, MStar, tnetuk, ...)

U.K. Unit Trusts (trustnet, ...)

USA (Alphavantage, Fool ...)

Quellen: src/engine/gnc-commodity.c:gnc_quote_source (commit c0fd3b3, welche an
Finance::Quote 1.47 angepaßt wurde), GnuCash-Wiki [https://wiki.gnucash.org/wiki/], bugzilla
[https://bugs.gnucash.org/page.cgi?id=browse.html&product=GnuCash], Mailinglistenarchive [https://
wiki.gnucash.org/wiki/Mailing_Lists#Mailing_List_Archives].

Yahoo-Besonderheiten
Yahoo hat Kurse von vielen Börsen und Märkten angeboten. Alphavantage sollte sich künftig ähnlich verhalten, aber
ohne Verzögerung. Außer für US-Märkte ist anzugeben, wo nachgesehen werden soll. Ein typisches Yahoo-Symbol
hat die Form {<ISIN>|<ticker>}<market suffix>.

Punkte in Ticker-Symbolen

Da Yahoo den Punkt . als Separator für die Börse verwendet, werden Punkte in Symbolen wie
„BT.A“ am London Stock Exchange [https://www.londonstockexchange.com] durch Bindstrich
- ersetzt, was dann in „BT-A.L“ resultiert.

Tabelle A.4. Yahoo-Kürzel für Börsen und Märkte

Land Börse oder Index Suffix Verzögerung

Argentina Buenos Aires Stock
Exchange (BYMA)

.BA 30 min

Australia Australian Stock
Exchange

.AX 20 min

Austria Vienna Stock Exchange .VI 15 min

Belgium Euronext Brussels .BR 15 min

Brazil Sao Paolo Stock
Exchange (BOVESPA)

.SA 15 min

Canada Canadian Securities
ExchangeToronto Stock
Exchange

.CN 15 min
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Land Börse oder Index Suffix Verzögerung

Canada NEO Exchange .NE Real-time

Canada Toronto Stock Exchange .TO 15 min

Canada TSX Venture Exchange
(TSXV)

.V 15 min

Chile Santiago Stock
Exchange

.SN 15 min

China Shanghai Stock
Exchange

.SS 30 min

China Shenzhen Stock
Exchange

.SZ 30 min

Czech Republic Prague Stock Exchange
Index

.PR 20 min

Denmark Nasdaq OMX
Copenhagen

.CO Real-time

Egypt Egyptian Exchange
Index (EGID)

.CA 20 min

Estonia Nasdaq OMX Tallinn .TL Real-time

Finland Nasdaq OMX Helsinki .HE Real-time

France Euronext .NX 15 min

France Euronext Paris .PA 15 min

Germany Berlin Stock Exchange .BE 15 min

Germany Bremen Stock Exchange .BM 15 min

Germany Dusseldorf Stock
Exchange

.DU 15 min

Germany Frankfurt Stock
Exchange

.F 15 min

Germany Hamburg Stock
Exchange

.HM 15 min

Germany Hanover Stock Exchange .HA 15 min

Germany Munich Stock Exchange .MU 15 min

Germany Stuttgart Stock Exchange .SG 15 min

Germany Deutsche Boerse
XETRA

.DE 15 min

Global Currency Rates =X Real-time

Greece Athens Stock Exchange
(ATHEX)

.AT 15 min

Hong Kong Hong Kong Stock
Exchange (HKEX)

.HK 15 min (Real-time in HK)

Hungary Budapest Stock
Exchange

.BD 15 min

Iceland Nasdaq OMX Iceland .IC Real-time

India Bombay Stock Exchange .BO Real-time
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Land Börse oder Index Suffix Verzögerung

India National Stock Exchange
of India

.NS Real-time**

Indonesia Indonesia Stock
Exchange (IDX)

.JK 10 min

Ireland Euronext Dublin .IR 15 min

Israel Tel Aviv Stock
Exchange

.TA 20 min

Italy EuroTLX .TI 20 min

Italy Italian Stock Exchange,
former Milano

.MI 20 min

Japan Nikkei Indices N/A 30 min

Japan Tokyo Stock Exchange .T 20 min

Latvia Nasdaq OMX Riga .RG Real-time

Lithuania Nasdaq OMX Vilnius .VS Real-time

Malaysia Malaysian Stock
Exchange

.KL 15 min

Mexico Mexico Stock Exchange
(BMV)

.MX 20 min

Netherlands Euronext Amsterdam .AS 15 min

New Zealand New Zealand Stock
Exchange (NZX)

.NZ 20 min

Norway Oslo Stock Exchange .OL 15 min

Portugal Euronext Lisbon .LS 15 min

Qatar Qatar Stock Exchange .QA 15 min

Russia Moscow Exchange
(MOEX)

.ME Real-time

Singapore Singapore Stock
Exchange

.SI 20 min

South Africa Johannesburg Stock
Exchange

.Jo 15 min

South Korea Korea Stock Exchange .KS 20 min

South Korea KOSDAQ .KQ 20 min

Spain Madrid SE C.A.T.S. .MC 15 min

Saudi Arabia Saudi Stock Exchange
(Tadawul)

.SAU 15 min

Sweden Nasdaq OMX Stockholm .ST Real-time

Switzerland Swiss Exchange (SIX) .SW 30 min

Taiwan Taiwan OTC Exchange .TWO 20 min

Taiwan Taiwan Stock Exchange
(TWSE)

.TW 20 min
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Land Börse oder Index Suffix Verzögerung

Thailand Stock Exchange of
Thailand (SET)

.BK 15 min

Turkey Borsa #stanbul .IS 15 min

United Kingdom FTSE Indices N/A 15 min

United Kingdom London Stock Exchange .L 20 min

United Kingdom London Stock Exchange .IL 20 min

United States of America Chicago Board of Trade
(CBOT)

.CBT 10 min

United States of America Chicago Mercantile
Exchange (CME)

.CME 10 min

United States of America Dow Jones Indexes N/A Real-time

United States of America NASDAQ Stock
Exchange

N/A Real-time*

United States of America ICE Futures US, former
New York Board of
Trade

.NYB 30 min

United States of America New York Commodities
Exchange (COMEX)

.CMX 30 min

United States of America New York Mercantile
Exchange (NYMEX)

.NYM 30 min

United States of America Options Price Reporting
Authority (OPRA)

N/A 15 min

United States of America OTC Bulletin Board
Market

N/A Real-time

United States of America OTC Markets Group N/A 15 min

United States of America S & P Indices N/A Real-time

Venezuela Caracas Stock Exchange .CR 15 min

Quelle: https://help.yahoo.com/kb/SLN2310.html?redirect=true abgefragt am 2020-04-14.

TIAA-CREF-Besonderheiten
TIAA-CREF Annuities (Renten) werden im Gegensatz zu ihren Fonds an keiner Börse gelistet. TIAA-CREF bietet
die Kurse mittels einer CGI-Shnittstelle auf ihrer Website, welche eine CSV-Datei im folgenden Format zurückliefert:

bogus_symbol1,price1,date1
bogus_symbol2,price2,date2
…

Dabei hat bogus_symbol einen der folgenden Werte für die verschiedenen Annuitäten:

Anmerkung

Bei den Symbolen ist die Groß- und Kleinschreibung wichtig, welche sich 2012 änderte.
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Tabelle A.5. Pseudo-Symbole, welche für TIAA-CREF Kursabfragen verwendet
werden können

Name Symbol bogus

CREF Bond Market Account CREFbond 41081991

CREF Equity Index Account CREFequi 41082540

CREF Global Equities Account CREFglob 41081992

CREF Growth Account CREFgrow 41082544

CREF Inflation-Linked Bond
Account

CREFinfb 41088773

CREF Money Market Account CREFmony 41081993

CREF Social Choice Account CREFsoci 41081994

CREF Stock Account CREFstok 41081995

TIAA Real Estate Account TIAAreal 41091375

TIAA-CREF Bond Fund
(Retirement)

TIDRX 4530828

TIAA-CREF Bond Index Fund
(Retirement)

TBIRX 20739662

TIAA-CREF Bond Plus Fund
(Retirement)

TCBRX 4530816

TIAA-CREF Emerging Markets
Equity Fund (Retirement)

TEMSX 26176543

TIAA-CREF Emerging Markets
Equity Index Fund (Retirement)

TEQSX 26176547

TIAA-CREF Equity Index Fund
(Retirement)

TIQRX 4530786

TIAA-CREF Global Natural
Resources Fund (Retirement)

TNRRX 39444919

TIAA-CREF Growth & Income
Fund (Retirement)

TRGIX 312536

TIAA-CREF High Yield Fund
(Retirement)

TIHRX 4530821

TIAA-CREF Inflation-Linked
Bond Fund (Retirement)

TIKRX 4530829

TIAA-CREF International Equity
Fund (Retirement)

TRERX 302323

TIAA-CREF International Equity
Index Fund (Retirement)

TRIEX 300269

TIAA-CREF Large-Cap Growth
Fund (Retirement)

TILRX 4530785

TIAA-CREF Large-Cap Growth
Index Fund (Retirement)

TRIRX 299525

TIAA-CREF Large-Cap Value
Fund (Retirement)

TRLCX 301332
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Name Symbol bogus

TIAA-CREF Large-Cap Value
Index Fund (Retirement)

TRCVX 304333

TIAA-CREF Lifecycle 2010 Fund
(Retirement)

TCLEX 302817

TIAA-CREF Lifecycle 2015 Fund
(Retirement)

TCLIX 302393

TIAA-CREF Lifecycle 2020 Fund
(Retirement)

TCLTX 307774

TIAA-CREF Lifecycle 2025 Fund
(Retirement)

TCLFX 313994

TIAA-CREF Lifecycle 2030 Fund
(Retirement)

TCLNX 307240

TIAA-CREF Lifecycle 2035 Fund
(Retirement)

TCLRX 309003

TIAA-CREF Lifecycle 2040 Fund
(Retirement)

TCLOX 300959

TIAA-CREF Lifecycle 2045 Fund
(Retirement)

TTFRX 9467597

TIAA-CREF Lifecycle 2050 Fund
(Retirement)

TLFRX 9467596

TIAA-CREF Lifecycle 2055 Fund
(Retirement)

TTRLX 34211330

TIAA-CREF Lifecycle Index
2010 Fund (Retirement)

TLTRX 21066482

TIAA-CREF Lifecycle Index
2015 Fund (Retirement)

TLGRX 21066496

TIAA-CREF Lifecycle Index
2020 Fund (Retirement)

TLWRX 21066479

TIAA-CREF Lifecycle Index
2025 Fund (Retirement)

TLQRX 21066485

TIAA-CREF Lifecycle Index
2030 Fund (Retirement)

TLHRX 21066435

TIAA-CREF Lifecycle Index
2035 Fund (Retirement)

TLYRX 21066475

TIAA-CREF Lifecycle Index
2040 Fund (Retirement)

TLZRX 21066473

TIAA-CREF Lifecycle Index
2045 Fund (Retirement)

TLMRX 21066488

TIAA-CREF Lifecycle Index
2050 Fund (Retirement)

TLLRX 21066490

TIAA-CREF Lifecycle Index
2055 Fund (Retirement)

TTIRX 34211328
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Name Symbol bogus

TIAA-CREF Lifecycle Index
Retirement Income Fund
(Retirement)

TRCIX 21066468

TIAA-CREF Lifecycle
Retirement Income Fund
(Retirement)

TLIRX 9467594

TIAA-CREF Lifestyle
Aggressive Growth Fund
(Retirement)

TSARX 40508431

TIAA-CREF Lifestyle
Conservative Fund (Retirement)

TSCTX 40508433

TIAA-CREF Lifestyle Growth
Fund (Retirement)

TSGRX 40508437

TIAA-CREF Lifestyle Income
Fund (Retirement)

TLSRX 40508427

TIAA-CREF Lifestyle Moderate
Fund (Retirement)

TSMTX 40508460

TIAA-CREF Managed Allocation
Fund (Retirement)

TITRX 4530825

TIAA-CREF Mid-Cap Growth
Fund (Retirement)

TRGMX 305499

TIAA-CREF Mid-Cap Value
Fund (Retirement)

TRVRX 315272

TIAA-CREF Money Market Fund
(Retirement)

TIEXX 4530771

TIAA-CREF Real Estate
Securities Fund (Retirement)

TRRSX 300081

TIAA-CREF S&P 500 Index
Fund (Retirement)

TRSPX 306105

TIAA-CREF Short-Term Bond
Fund (Retirement)

TISRX 4530818

TIAA-CREF Small-Cap Blend
Index Fund (Retirement)

TRBIX 314644

TIAA-CREF Small-Cap Equity
Fund (Retirement)

TRSEX 299968

TIAA-CREF Social Choice
Equity Fund (Retirement)

TRSCX 300078

TIAA-CREF Bond Fund
(Institutional)

TIBDX 307276

TIAA-CREF Bond Index Fund
(Institutional)

TBIIX 20739664

TIAA-CREF Bond Plus Fund
(Institutional)

TIBFX 4530820
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Name Symbol bogus

TIAA-CREF Emerging Markets
Equity Fund (Institutional)

TEMLX 26176540

TIAA-CREF Emerging Markets
Equity Index Fund (Institutional)

TEQLX 26176544

TIAA-CREF Enhanced
International Equity Index Fund
(Institutional)

TFIIX 9467603

TIAA-CREF Enhanced Large-
Cap Growth Index Fund
(Institutional)

TLIIX 9467602

TIAA-CREF Enhanced Large-
Cap Value Index Fund
(Institutional)

TEVIX 9467606

TIAA-CREF Equity Index Fund
(Institutional)

TIEIX 301718

TIAA-CREF Global Natural
Resources Fund (Institutional)

TNRIX 39444916

TIAA-CREF Growth & Income
Fund (Institutional)

TIGRX 314719

TIAA-CREF High Yield Fund
(Institutional)

TIHYX 4530798

TIAA-CREF Inflation-Linked
Bond Fund (Institutional)

TIILX 316693

TIAA-CREF International Equity
Fund (Institutional)

TIIEX 305980

TIAA-CREF International Equity
Index Fund (Institutional)

TCIEX 303673

TIAA-CREF Large-Cap Growth
Fund (Institutional)

TILGX 4530800

TIAA-CREF Large-Cap Growth
Index Fund (Institutional)

TILIX 297809

TIAA-CREF Large-Cap Value
Fund (Institutional)

TRLIX 300692

TIAA-CREF Large-Cap Value
Index Fund (Institutional)

TILVX 302308

TIAA-CREF Lifecycle 2010 Fund
(Institutional)

TCTIX 4912376

TIAA-CREF Lifecycle 2015 Fund
(Institutional)

TCNIX 4912355

TIAA-CREF Lifecycle 2020 Fund
(Institutional)

TCWIX 4912377

TIAA-CREF Lifecycle 2025 Fund
(Institutional)

TCYIX 4912384
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Name Symbol bogus

TIAA-CREF Lifecycle 2030 Fund
(Institutional)

TCRIX 4912364

TIAA-CREF Lifecycle 2035 Fund
(Institutional)

TCIIX 4912375

TIAA-CREF Lifecycle 2040 Fund
(Institutional)

TCOIX 4912387

TIAA-CREF Lifecycle 2045 Fund
(Institutional)

TTFIX 9467607

TIAA-CREF Lifecycle 2050 Fund
(Institutional)

TFTIX 9467601

TIAA-CREF Lifecycle 2055 Fund
(Institutional)

TTRIX 34211329

TIAA-CREF Lifecycle Index
2010 Fund (Institutional)

TLTIX 21066484

TIAA-CREF Lifecycle Index
2015 Fund (Institutional)

TLFIX 21066498

TIAA-CREF Lifecycle Index
2020 Fund (Institutional)

TLWIX 21066480

TIAA-CREF Lifecycle Index
2025 Fund (Institutional)

TLQIX 21066486

TIAA-CREF Lifecycle Index
2030 Fund (Institutional)

TLHIX 21066495

TIAA-CREF Lifecycle Index
2035 Fund (Institutional)

TLYIX 21066477

TIAA-CREF Lifecycle Index
2040 Fund (Institutional)

TLZIX 21066474

TIAA-CREF Lifecycle Index
2045 Fund (Institutional)

TLXIX 21066478

TIAA-CREF Lifecycle Index
2050 Fund (Institutional)

TLLIX 21066492

TIAA-CREF Lifecycle Index
2055 Fund (Institutional)

TTIIX 34211326

TIAA-CREF Lifecycle Index
Retirement Income Fund
(Institutional)

TRILX 21066463

TIAA-CREF Lifecycle
Retirement Income Fund
(Institutional)

TLRIX 9467595

TIAA-CREF Lifestyle
Aggressive Growth Fund
(Institutional)

TSAIX 40508428

TIAA-CREF Lifestyle
Conservative Fund (Institutional)

TCSIX 40508425
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Name Symbol bogus

TIAA-CREF Lifestyle Growth
Fund (Institutional)

TSGGX 40508434

TIAA-CREF Lifestyle Income
Fund (Institutional)

TSITX 40508450

TIAA-CREF Lifestyle Moderate
Fund (Institutional)

TSIMX 40508443

TIAA-CREF Managed Allocation
Fund (Institutional)

TIMIX 4530787

TIAA-CREF Mid-Cap Growth
Fund (Institutional)

TRPWX 297210

TIAA-CREF Mid-Cap Value
Fund (Institutional)

TIMVX 316178

TIAA-CREF Money Market Fund
(Institutional)

TCIXX 313650

TIAA-CREF Real Estate
Securities Fund (Institutional)

TIREX 303475

TIAA-CREF S&P 500 Index
Fund (Institutional)

TISPX 306658

TIAA-CREF Short-Term Bond
Fund (Institutional)

TISIX 4530784

TIAA-CREF Small-Cap Blend
Index Fund (Institutional)

TISBX 309018

TIAA-CREF Small-Cap Equity
Fund (Institutional)

TISEX 301622

TIAA-CREF Social Choice
Equity Fund (Institutional)

TISCX 301897

TIAA-CREF Tax-Exempt Bond
Fund (Institutional)

TITIX 4530819

TIAA-CREF Bond Fund (Retail) TIORX 4530794

TIAA-CREF Bond Index Fund
(Retail)

TBILX 20739663

TIAA-CREF Bond Plus Fund
(Retail)

TCBPX 4530788

TIAA-CREF Emerging Markets
Equity Fund (Retail)

TEMRX 26176542

TIAA-CREF Emerging Markets
Equity Index Fund (Retail)

TEQKX 26176545

TIAA-CREF Equity Index Fund
(Retail)

TINRX 4530797

TIAA-CREF Global Natural
Resources Fund (Retail)

TNRLX 39444917

TIAA-CREF Growth & Income
Fund (Retail)

TIIRX 4530790
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Name Symbol bogus

TIAA-CREF High Yield Fund
(Retail)

TIYRX 4530830

TIAA-CREF Inflation-Linked
Bond Fund (Retail)

TCILX 313727

TIAA-CREF International Equity
Fund (Retail)

TIERX 4530827

TIAA-CREF Large-Cap Growth
Fund (Retail)

TIRTX 4530791

TIAA-CREF Large-Cap Value
Fund (Retail)

TCLCX 302696

TIAA-CREF Lifecycle
Retirement Income Fund (Retail)

TLRRX 9467600

TIAA-CREF Lifestyle
Aggressive Growth Fund (Retail)

TSALX 40508429

TIAA-CREF Lifestyle
Conservative Fund (Retail)

TSCLX 40508432

TIAA-CREF Lifestyle Growth
Fund (Retail)

TSGLX 40508435

TIAA-CREF Lifestyle Income
Fund (Retail)

TSILX 40508438

TIAA-CREF Lifestyle Moderate
Fund (Retail)

TSMLX 40508453

TIAA-CREF Managed Allocation
Fund (Retail)

TIMRX 4530817

TIAA-CREF Mid-Cap Growth
Fund (Retail)

TCMGX 305208

TIAA-CREF Mid-Cap Value
Fund (Retail)

TCMVX 313995

TIAA-CREF Money Market Fund
(Retail)

TIRXX 4530775

TIAA-CREF Real Estate
Securities Fund (Retail)

TCREX 309567

TIAA-CREF Short-Term Bond
Fund (Retail)

TCTRX 4530822

TIAA-CREF Small-Cap Equity
Fund (Retail)

TCSEX 297477

TIAA-CREF Social Choice
Equity Fund (Retail)

TICRX 4530792

TIAA-CREF Tax-Exempt Bond
Fund (Retail)

TIXRX 4530793

TIAA-CREF Bond Fund
(Premier)

TIDPX 21066506

TIAA-CREF Bond Index Fund
(Premier)

TBIPX 21066534
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Name Symbol bogus

TIAA-CREF Bond Plus Fund
(Premier)

TBPPX 21066533

TIAA-CREF Emerging Markets
Equity Fund (Premier)

TEMPX 26176541

TIAA-CREF Emerging Markets
Equity Index Fund (Premier)

TEQPX 26176546

TIAA-CREF Equity Index Fund
(Premier)

TCEPX 21066530

TIAA-CREF Global Natural
Resources Fund (Premier)

TNRPX 39444918

TIAA-CREF Growth & Income
Fund (Premier)

TRPGX 21066461

TIAA-CREF High Yield Fund
(Premier)

TIHPX 21066501

TIAA-CREF Inflation-Linked
Bond Fund (Premier)

TIKPX 21066500

TIAA-CREF International Equity
Fund (Premier)

TREPX 21066466

TIAA-CREF International Equity
Index Fund (Premier)

TRIPX 21066462

TIAA-CREF Large-Cap Growth
Fund (Premier)

TILPX 21066499

TIAA-CREF Large-Cap Value
Fund (Premier)

TRCPX 21066467

TIAA-CREF Lifecycle 2010 Fund
(Premier)

TCTPX 21066521

TIAA-CREF Lifecycle 2015 Fund
(Premier)

TCFPX 21066528

TIAA-CREF Lifecycle 2020 Fund
(Premier)

TCWPX 21066518

TIAA-CREF Lifecycle 2025 Fund
(Premier)

TCQPX 21066522

TIAA-CREF Lifecycle 2030 Fund
(Premier)

TCHPX 21066527

TIAA-CREF Lifecycle 2035 Fund
(Premier)

TCYPX 21066517

TIAA-CREF Lifecycle 2040 Fund
(Premier)

TCZPX 21066516

TIAA-CREF Lifecycle 2045 Fund
(Premier)

TTFPX 21066444

TIAA-CREF Lifecycle 2050 Fund
(Premier)

TCLPX 21066526

TIAA-CREF Lifecycle 2055 Fund
(Premier)

TTRPX 34211331
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Name Symbol bogus

TIAA-CREF Lifecycle Index
2010 Fund (Premier)

TLTPX 21066483

TIAA-CREF Lifecycle Index
2015 Fund (Premier)

TLFPX 21066497

TIAA-CREF Lifecycle Index
2020 Fund (Premier)

TLWPX 21066434

TIAA-CREF Lifecycle Index
2025 Fund (Premier)

TLVPX 21066481

TIAA-CREF Lifecycle Index
2030 Fund (Premier)

TLHPX 21066494

TIAA-CREF Lifecycle Index
2035 Fund (Premier)

TLYPX 21066476

TIAA-CREF Lifecycle Index
2040 Fund (Premier)

TLPRX 21066487

TIAA-CREF Lifecycle Index
2045 Fund (Premier)

TLMPX 21066489

TIAA-CREF Lifecycle Index
2050 Fund (Premier)

TLLPX 21066491

TIAA-CREF Lifecycle Index
2055 Fund (Premier)

TTIPX 34211327

TIAA-CREF Lifecycle Index
Retirement Income Fund
(Premier)

TLIPX 21066493

TIAA-CREF Lifecycle
Retirement Income Fund
(Premier)

TPILX 21066470

TIAA-CREF Lifestyle
Aggressive Growth Fund
(Premier)

TSAPX 40508430

TIAA-CREF Lifestyle
Conservative Fund (Premier)

TLSPX 40508426

TIAA-CREF Lifestyle Growth
Fund (Premier)

TSGPX 40508436

TIAA-CREF Lifestyle Income
Fund (Premier)

TSIPX 40508451

TIAA-CREF Lifestyle Moderate
Fund (Premier)

TSMPX 40508456

TIAA-CREF Mid-Cap Growth
Fund (Premier)

TRGPX 21066464

TIAA-CREF Mid-Cap Value
Fund (Premier)

TRVPX 21066455

TIAA-CREF Money Market Fund
(Premier)

TPPXX 21066469
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Name Symbol bogus

TIAA-CREF Real Estate
Securities Fund (Premier)

TRRPX 21066459

TIAA-CREF Short-Term Bond
Fund (Premier)

TSTPX 21066445

TIAA-CREF Small-Cap Equity
Fund (Premier)

TSRPX 21066446

TIAA-CREF Social Choice
Equity Fund (Premier)

TRPSX 21066460

Quelle: Kommentare in https://rt.cpan.org/Ticket/Attachment/1121440/589997/Tiaacref.pm.zip
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Anhang B. GNU Free Documentation
License

Version 1.1, March 2000
Copyright © 2000 Free Software Foundation, Inc.

Free Software Foundation, Inc. 59 Temple Place,
        Suite 330, Boston, MA
        02111-1307  USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it
is not allowed.

0. PREAMBLE
The purpose of this License is to make a manual, textbook, or other written document „free“ in the sense of
freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying it,
either commercially or noncommercially. Secondarily, this License preserves for the author and publisher
a way to get credit for their work, while not being considered responsible for modifications made by others.

This License is a kind of „copyleft“, which means that derivative works of the document must themselves
be free in the same sense. It complements the GNU General Public License, which is a copyleft license
designed for free software.

We have designed this License in order to use it for manuals for free software, because free software
needs free documentation: a free program should come with manuals providing the same freedoms that
the software does. But this License is not limited to software manuals; it can be used for any textual work,
regardless of subject matter or whether it is published as a printed book. We recommend this License
principally for works whose purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS
This License applies to any manual or other work that contains a notice placed by the copyright holder
saying it can be distributed under the terms of this License. The „Document“, below, refers to any such
manual or work. Any member of the public is a licensee, and is addressed as „you“.

A „Modified Version“ of the Document means any work containing the Document or a portion of it, either
copied verbatim, or with modifications and/or translated into another language.

A „Secondary Section“ is a named appendix or a front-matter section of the Document that deals
exclusively with the relationship of the publishers or authors of the Document to the Document’s overall
subject (or to related matters) and contains nothing that could fall directly within that overall subject. (For
example, if the Document is in part a textbook of mathematics, a Secondary Section may not explain any
mathematics.) The relationship could be a matter of historical connection with the subject or with related
matters, or of legal, commercial, philosophical, ethical or political position regarding them.

The „Invariant Sections“ are certain  Secondary Sections whose titles are designated, as being those of
Invariant Sections, in the notice that says that the Document is released under this License.

The „Cover Texts“ are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover
Texts, in the notice that says that the Document is released under this License.
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A „Transparent“ copy of the  Document means a machine-readable copy, represented in a format whose
specification is available to the general public, whose contents can be viewed and edited directly and
straightforwardly with generic text editors or (for images composed of pixels) generic paint programs or
(for drawings) some widely available drawing editor, and that is suitable for input to text formatters or
for automatic translation to a variety of formats suitable for input to text formatters. A copy made in an
otherwise Transparent file format whose markup has been designed to thwart or discourage subsequent
modification by readers is not Transparent. A copy that is not „Transparent“ is called „Opaque“.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input
format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming
simple HTML designed for human modification. Opaque formats include PostScript, PDF, proprietary
formats that can be read and edited only by proprietary word processors, SGML or XML for which the
DTD and/or processing tools are not generally available, and the machine-generated HTML produced by
some word processors for output purposes only.

The „Title Page“ means, for a printed book, the title page itself, plus such following pages as are needed
to hold, legibly, the material this License requires to appear in the title page. For works in formats which
do not have any title page as such, „Title Page“ means the text near the most prominent appearance of the
work’s title, preceding the beginning of the body of the text.

2. VERBATIM COPYING
You may copy and distribute the Document in any medium, either commercially or noncommercially,
provided that this License, the copyright notices, and the license notice saying this License applies to the
Document are reproduced in all copies, and that you add no other conditions whatsoever to those of this
License. You may not use technical measures to obstruct or control the reading or further copying of the
copies you make or distribute. However, you may accept compensation in exchange for copies. If you
distribute a large enough number of copies you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY
If you publish printed copies of the Document numbering more than 100, and the Document’s license
notice requires Cover Texts, you must enclose the copies in covers that carry, clearly and legibly, all these
Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts on the back cover. Both covers
must also clearly and legibly identify you as the publisher of these copies. The front cover must present
the full title with all words of the title equally prominent and visible. You may add other material on the
covers in addition. Copying with changes limited to the covers, as long as they preserve the title of the
Document and satisfy these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed
(as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either
include a machine-readable Transparent copy along with each Opaque copy, or state in or with each
Opaque copy a publicly-accessible computer-network location containing a complete Transparent copy
of the Document, free of added material, which the general network-using public has access to download
anonymously at no charge using public-standard network protocols. If you use the latter option, you must
take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to ensure that this
Transparent copy will remain thus accessible at the stated location until at least one year after the last time
you distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing
any large number of copies, to give them a chance to provide you with an updated version of the Document.
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4. MODIFICATIONS
You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and
3 above, provided that you release the Modified Version under precisely this License, with the Modified
Version filling the role of the Document, thus licensing distribution and modification of the Modified
Version to whoever possesses a copy of it. In addition, you must do these things in the Modified Version:

• A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and
from those of previous versions (which should, if there were any, be listed in the History section of the
Document). You may use the same title as a previous version if the original publisher of that version
gives permission.

• B. List on the Title Page, as authors, one or more persons or entities responsible for authorship of
the modifications in the Modified Version, together with at least five of the principal authors of the
Document (all of its principal authors, if it has less than five).

• C. State on the Title Page the name of the publisher of the Modified Version, as the publisher.

• D. Preserve all the copyright notices of the Document.

• E. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

• F. Include, immediately after the copyright notices, a license notice giving the public permission to
use the Modified Version under the terms of this License, in the form shown in the Addendum below.

• G. Preserve in that license notice the full lists of  Invariant Sections and required Cover Texts given
in the Document’s license notice.

• H. Include an unaltered copy of this License.

• I. Preserve the section entitled „History“, and its title, and add to it an item stating at least the title,
year, new authors, and publisher of the Modified Version as given on the Title Page. If there is no
section entitled „History“ in the Document, create one stating the title, year, authors, and publisher of
the Document as given on its Title Page, then add an item describing the Modified Version as stated
in the previous sentence.

• J. Preserve the network location, if any, given in the Document for public access to a Transparent
copy of the Document, and likewise the network locations given in the Document for previous versions
it was based on. These may be placed in the „History“ section. You may omit a network location for
a work that was published at least four years before the Document itself, or if the original publisher of
the version it refers to gives permission.

• K. In any section entitled „Acknowledgements“ or „Dedications“, preserve the section’s title, and
preserve in the section all the substance and tone of each of the contributor acknowledgements and/or
dedications given therein.

• L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles.
Section numbers or the equivalent are not considered part of the section titles.

• M. Delete any section entitled „Endorsements“. Such a section may not be included in the Modified
Version.

• N. Do not retitle any existing section as „Endorsements“ or to conflict in title with any Invariant
Section.
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If the Modified Version includes new front-matter sections or appendices that qualify as Secondary
Sections and contain no material copied from the Document, you may at your option designate some or
all of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the Modified
Version’s license notice. These titles must be distinct from any other section titles.

You may add a section entitled „Endorsements“, provided it contains nothing but endorsements of your
Modified Version by various parties--for example, statements of peer review or that the text has been
approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as
a Back-Cover Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of
Front-Cover Text and one of Back-Cover Text may be added by (or through arrangements made by) any
one entity. If the Document already includes a cover text for the same cover, previously added by you or
by arrangement made by the same entity you are acting on behalf of, you may not add another; but you
may replace the old one, on explicit permission from the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names
for publicity for or to assert or imply endorsement of any Modified Version .

5. COMBINING DOCUMENTS
You may combine the Document with other documents released under this License, under the terms
defined in section 4 above for modified versions, provided that you include in the combination all of the
Invariant Sections of all of the original documents, unmodified, and list them all as Invariant Sections of
your combined work in its license notice.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections
may be replaced with a single copy. If there are multiple Invariant Sections with the same name but
different contents, make the title of each such section unique by adding at the end of it, in parentheses, the
name of the original author or publisher of that section if known, or else a unique number. Make the same
adjustment to the section titles in the list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections entitled „History“ in the various original documents,
forming one section entitled „History“; likewise combine any sections entitled „Acknowledgements“, and
any sections entitled „Dedications“. You must delete all sections entitled „Endorsements.“

6. COLLECTIONS OF DOCUMENTS
You may make a collection consisting of the Document and other documents released under this License,
and replace the individual copies of this License in the various documents with a single copy that is included
in the collection, provided that you follow the rules of this License for verbatim copying of each of the
documents in all other respects.

You may extract a single document from such a collection, and dispbibute it individually under this
License, provided you insert a copy of this License into the extracted document, and follow this License
in all other respects regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT
WORKS

A compilation of the Document or its derivatives with other separate and independent documents or works,
in or on a volume of a storage or distribution medium, does not as a whole count as a Modified Version
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of the Document, provided no compilation copyright is claimed for the compilation. Such a compilation
is called an „aggregate“, and this License does not apply to the other self-contained works thus compiled
with the Document , on account of their being thus compiled, if they are not themselves derivative works
of the Document. If the Cover Text requirement of section 3 is applicable to these copies of the Document,
then if the Document is less than one quarter of the entire aggregate, the Document’s Cover Texts may
be placed on covers that surround only the Document within the aggregate. Otherwise they must appear
on covers around the whole aggregate.

8. TRANSLATION
Translation is considered a kind of modification, so you may distribute translations of the Document under
the terms of section 4. Replacing  Invariant Sections with translations requires special permission from
their copyright holders, but you may include translations of some or all Invariant Sections in addition to
the original versions of these Invariant Sections. You may include a translation of this License provided
that you also include the original English version of this License. In case of a disagreement between the
translation and the original English version of this License, the original English version will prevail.

9. TERMINATION
You may not copy, modify, sublicense, or distribute the Document except as expressly provided for under
this License. Any other attempt to copy, modify, sublicense or distribute the Document is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so long as such parties remain
in full compliance.

10. FUTURE REVISIONS OF THIS LICENSE
The Free Software Foundation [http://www.gnu.org/fsf/fsf.html] may publish new, revised versions of the
GNU Free Documentation License from time to time. Such new versions will be similar in spirit to the
present version, but may differ in detail to address new problems or concerns. See http://www.gnu.org/
copyleft/ [http://www.gnu.org/copyleft].

Each version of the License is given a distinguishing version number. If the Document specifies that a
particular numbered version of this License „or any later version“ applies to it, you have the option of
following the terms and conditions either of that specified version or of any later version that has been
published (not as a draft) by the Free Software Foundation. If the Document does not specify a version
number of this License, you may choose any version ever published (not as a draft) by the Free Software
Foundation.

Addendum
To use this License in a document you have written, include a copy of the License in the document and
put the following copyright and license notices just after the title page:

Copyright YEAR YOUR NAME.

Permission is granted to copy, distribute and/or modify this document under the terms of
the GNU Free Documentation License, Version 1.1 or any later version published by the
Free Software Foundation; with the Invariant Sections being LIST THEIR TITLES, with
the Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST. A copy
of the license is included in the section entitled „GNU Free Documentation License“.
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GNU Free Documentation License

If you have no Invariant Sections, write „with no Invariant Sections“ instead of saying which ones are
invariant. If you have no Front-Cover Texts, write „no Front-Cover Texts“ instead of „Front-Cover Texts
being LIST“; likewise for Back-Cover Texts.

If your document contains nontrivial examples of program code, we recommend releasing these examples
in parallel under your choice of free software license, such as the  GNU General Public License [http://
www.gnu.org/copyleft/gpl.html], to permit their use in free software.
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